


For	my	artworks,	Sweet	Drawing	Blogs,	and
more,	please	visit:-

For	any	feedback	or	feature
covering	request	E-mail	me	at:-

Mie@SweetMonia.com
http://SweetMonia.com
Table	Of	Contents

Preface............19
Getting	results	from	the	very	beginning............19
Less	reading,	more	learning............19
Learn	Photoshop	on	the	go............20
Clear	Instructions............20
Chapters	Layout............21
The	future	of	this	book............21

Photoshop	user	Interface............22
In	this	chapter............22
A	brief	look	on	Photoshop	user	interface............22



The	options	bar............23
Working	with	Photoshop	Panels............24
Showing	and	hiding	a	panel............25
The	Tools	Panel............29
Working	with	workspaces............33
Creating	A	New	Workspace............34
Creating	New	Files	In	Photoshop............36
The	Hand	Tool	............44
Summary............46

Getting	Started	With	The	Brush	Tool............48
You	can	use	the	Brush	Tool	to:-............48
The	basics	of	the	brush	tool:-............48
Soft	VS	Hard	brush	tip............49
Brush	flow	and	opacity............49
To	get	the	difference	between	the	two,	do	the	following:-............50
The	Pressure	Sensitivity	Option............52
Creating	a	simple	Logo............53
Drawing	a	3D	ball............54
How	to	choose	the	right	values	for	your	brush:-............55
Summary............55

Blending	modes	of	the	brush	tool	............56
Clear............58
Darken............58
The	Normal	Group............59



Normal	Mode............59
Multiply............60
Linear	Burn............61
Darker	color............62
The	Lightening	group............63
Lighten............63
Screen............63
Color	Dodge............64
Linear	dodge............64
The	Contrast	Group............66
Overlay............66
Soft	light............66
Hard	Light............67
Vivid	Light............68
Linear	Light............68
Pin	Light.............69
Difference............71
The	color	components	modes............73
Hue............73
Saturation............73
Luminosity............73
Hue	Blending	Mode............74
Luminosity	Blending	Mode............75
Color............76
Examples............76
Make	them	both	blue:-	............76



Create	Geisha	girls............79
.Make	white	penguins............79
Conclusion............80
Blending	Modes	Resources:-............80
Summary............80

Loading	new	brushes	In	Photoshop	and	creating	new
ones............82
Loading	new	brushes	in	Photoshop	after	downloading
them	from	the	web............88
A	Word	About	downloading	brushes	online	and
copyrights	issues............91
Creating	your	own	brushes	in	Photoshop............92
Examples............95
Drawing	a	space............95
Adding	grasses	to	a	pictures............97
Summary............98

Working	with	layers	and	manipulating	them............99
What	are	layers?............99
Working	with	Photoshop	layers............101
The	layers	panel............102
To	change	the	layer	you	are	drawing	on:-............102
To	change	the	size	of	the	thumbnail	of	the	layers:-............102
To	create	a	new	layer	............104
To	arrange	layers	in	the	layers	panel............104
Deleting	Layers	............105



Renaming	layers	from	the	layers	panel,	the	fast	way............106
Hide	and	show	layer............108
Some	useful	tips	&	tricks	about	layers............111
Selecting	layers	quickly............111
The	layer	lock	modes............112
The	background	layer............114
To	change	the	background	layer	to	a	normal	layer,	do	the
following:-............114
To	make	the	selected	layer	a	background	layer,	do	the
following:-............115
Unserstanding	Layer	Mask............116
Working	With	Layers	Masks............119
Make	an	image	brighter............121
Surround	Eiffel	Tower	With	A	Thread............121
Blending/Mixing	Two	pictures	together............122
Summary............124

Photoshop	selection	tools............126
The	shapes	group............126
The	Rectangular	Marquee	Tool	 ............126

The	Elliptical	Marquee	Tool	 ............127
Single	Row	Marquee	Tool	 ............128
The	Lasso	Group............129
The	Lasso	Tool	 ............129
The	Polygonal	Lasso	Tool	 ............130
The	Magnetic	Lasso	Tool	 ............131



The	Wands	Group............134
The	Wand	Tool	 ............134
The	Quick	Selection	Tool	 ............139
Deciding	what	Photoshop	selection	tool	to	use?............141
More	about	Photoshop	selection	tools............141
New	Selection,	Add,	subtract,	intersection	selection
Options............141
New	Selection............141
Subtract	selection............143
Converting	a	layer	into	selection............146
Moving	the	selection	instead	of	its	contents............149
Modifying	selections	after	making	them............149
Border............150
Smooth............151
Expand............152
Contract............153
The	select	menu	options............154
All............154
Deselect............154
Reselect............154
Inverse............154
Examples............154
Creating	an	army	of	men	............155
Drawing	a	better	sky............155
The	New	Model............156
Summary............158



Using	Photoshop	pen	tool,	and	an	introduction	to	Bézier
curves............160
Advantages	of	Photoshop	pen	tool	over	the	other
tools............160
An	easy	start,	drawing	straight	lines............161
Drawing	curves	using	the	pen	tool............162
Using	Photoshop	pen	tool	In	Practice............167
Drawing	straight	lines	with	Photoshop	Pen	tool............167
Getting	to	draw	carves............169
Drawing	Simple	Arc	With	Photoshop	Pen	Tool	1............169
Drawing	Simple	Arc	With	Photoshop	Pen	Tool	2............171
Drawing	various	curves	using	3	lines............174
Creating	a	simple	curve............174
Creating	a	broken	curve............176
A	Little	Summary	Before	We	Continue............179
Editing	the	path	after	you	created	it............179
The	path	selection	tools	group............180
The	path	selection	tool	 ............180
The	Direct	Selection	Tool	 ............181
The	Pen	Tools	Groups............182
More	on	Photoshop	pen	tool	and	paths............184
Turning	a	pen	curve	into	selection............184
Freedom	pen	tool	 ............185
Filling	a	path	with	pixels	right	away............187
Learn	Photoshop	Pen	tool	with	the	Bézier	Game............194
Examples.............194



Making	a	hard	selection............194
Creating	a	signature............195
Creating	Complex	Drawings............196
Summary............197

Cropping	Images	in	Photoshop	using	the	Crop	Tool	&
Rectangle	Marquee	Tool.	And	An	Introduction	to	aspect
ratio............198
What	cropping	images	means?............198
Cropping	images	in	Photoshop	using	the	Crop	Tool	
............199
About	Aspect	Ratio............201
Using	the	Crop	Tool	to	crop	a	picture	to	a	certain	Aspect
Ratio............206
Using	the	Rectangle	Marquee	Tool	For	Cropping	images............208
Using	the	Rectangle	Marquee	Tool	to	crop	a	picture	to	a	certain
Aspect	Ratio............209
Making	selections	of	a	certain	size............212
More	on	the	Crop	Tool	&	Cropping............214
Changing	the	appearance	of	the	Shield(Photoshop	CS6	and
later)............215
Setting	The	Aspect	Ratio	Of	The	Crop	Tool	from	An	Existing
Image............219
Cropping	pictures	using	a	non-rectangular
selection............221
Cropping	a	picture	to	fit	the	Aspect	Ratio	of	a	forum
avatar.............222
Summary............224



Resizing	Images	in	Photoshop	and	Canvas	............225
Why	would	anyone	resize	images?............225
The	basic	steps	for	resizing	images	in	Photoshop............225
Resizing	the	image	canvas	(instead	of	the	picture
itself)............229
Resizing	the	image	canvas	in	a	certain	direction............233
Adding	the	meme	text	on	the	picture............236
More	about	resizing	images	in	Photoshop............237
A	more	detailed	look	on	the	Image	Resize	Dialog............237
The	pixel	dimensions	section............238
The	Document	Size	Section............238
The	Image	Size	Dialog	(Photoshop	CC	and	later).............239
More	about	resizing	the	canvas............241
Resizing	Canvas:-	Deciding	the	direction	into	which	Photoshop
will............241
The	relative	option	in	the	canvas	size	dialog............243
Word	about	resizing	images	in	Photoshop............244
Summary............246

All	About	Photoshop	type	tools	............247
Photoshop	Type	Tools............247
Adding	text	Photoshop	using	the	Horizontal	Type
Tool............247
Entering	a	vertical	text	using	the	Vertical	Type	Tool............248
Creating	text	selections	using	the	Horizontal	Type	Mask	Tool	and
vertical	Type	Mask	Tool:............250
Photoshop	Type	Tools	options............253



Changing	text	style............254
Text	Anti-Aliasing	Settings............255
Text	Align............257
Text	Color............258
Let’s	take	a	look	at	each	of	these	options	one	by	one:-............259
Vertical	Or	Horizontal	Distortion............260
Displaying	and	hiding	the	character	&	paragraph	panels............261
More	about	Photoshop	Type	Tools............262
Text	layers............263
Converting	text	into	a	raster	layer............263
Formatting	part	of	a	text............264
Explaining	the	Character	Panel............265
Changing	the	space	between	characters:-	............268
Change	the	space	between	lines:-	............269
Characters	kerning:-	............270
Vertical	&	horizontal	scale:-	............271
The	baseline	shift:-	............272
Change	the	text	color:-	............273
Change	the	text	style:-	............273
Reset	characters............278
Explaining	the	Paragraph	Panel............279
How	to	download	and	add	fonts	to	Photoshop............283
Downloading	the	font............284
Installing	the	font	on	your	computer............284
To	install	a	font	in	Mac	OS	X:-............285
Aligning	Text	To	Path.............285



Examples............286
Making	a	better	Internet	memes.............286
Colored	text	+	Blending	Modes............287
Creating	A	Simple	Logo............287
List	of	sites	to	download	fonts	from:-............288
Summary............288

Photoshop	Photo	Manipulation	tools	Part	I:-	Clone	Stamp
Tool,	Healing	Brush	Tool	&	Spot	Healing	Brush
Tool............290
Photoshop	Photo	manipulation	tools............290
First	look	at	the	Stamp	tool	 ............290
How	can	copying	pixels	from	part	of	the	picture	into	another
benefit	me	at	all?............291
The	Clone	Stamp	Tool	in	action............292
The	Healing	Brush	Tool............297
The	Spot	Healing	Brush	Tool............298
The	Align	option	in	Clone	Stamp	Tool	And	Healing	Brush
Tool.............299
Examples:-............302
Changing	the	face	of	someday............302
Artificial	Sunset............303
Removing	cat	eyes............306
Pulling	out	a	Photoshop	Scam............306
Restoring	an	old	Photo............306
Summary............307

Photoshop	Photo	Manipulation	Tools	Part	II:	Patch	Tool,



Photoshop	Photo	Manipulation	Tools	Part	II:	Patch	Tool,
Content-Aware	Move	Tool,	And	Content-Aware
Fill............308
What	is	Content-Aware?............308
The	Patch	Tool	 ............308
The	Content-Aware	Move	Tool 	 ............312
Content-Aware	Fill............314
Using	Content-Aware	Fill............315
Using	Content-Aware	fill	to	extend	a	picture............318
Content-Aware	tools	VS	Spot	Healing	Brush	Tool............321
Examples............322
Moving	a	cat	around............322
Removing	the	mountains............323
Removing	Blemishes............324
Summary............325

Photoshop	Blur	Tool,	Sharpen	Tool	and	the	Smudge
Tool............326
The	Blur	Tool	 ............326

Integrating	a	new	object	into	a	picture	using	the	Blur	Tool............330
Don’t	overdo	it	with	the	Sharpen	Tool............333
The	strength	option	of	the	Blur	Tool	&	The	Sharpen	Tool............334
The	Smudge	Tool	 ............335

Finger	painting............336
Summary............337
Examples............338
Blur	the	surroundings	of	an	object............338



Emphasizing	the	details	of	a	picture............338
Creating	a	logo............339

Photoshop	Dodge	Tool,	Burn	Tool,	And	the	Sponge
Tool............340
The	Dodge	Tool	 ............340

The	Range	option	of	the	Dodge	Tool:-............341
	The	Exposure	setting	of	the	Dodge	Tool:-............342
The	Burn	Tool	 ............343
Range	of	the	Burn	Tool............344
The	Flow	Option	of	the	Sponge	Tool............348
Summary............349
Examples............350
Enhancing	the	eye	looks............350
Painting	lights	on	a	car............351
Burning	the	face	with	the	Burn	Tool............352
Saturating	a	part	of	the	picture............353

Photoshop	Shape	Tools	............354
Photoshop	Shapes	Tools............354
The	Rectangle	Tool	 ............354
Another	way	to	draw	rectangles	using	the	Rectangle	Tool............356
Rounded	Rectangle	Tool	 ............357

Drawing	a	rounded	rectangle	using	the	dialog............358
The	Ellipse	Tool	 ............359
To	create	an	ellipse	interactively,	follow	these	steps:-............359
To	create	an	ellipse	using	the	dialog,	follow	these	steps:-............360



Polygon	Tool	 ............361

To	draw	a	polygon	using	the	Polygon	Tool	interactively,	follow
these	steps:-............361
Smooth	Corners............363
Intent	Sides	By............364
To	Draw	a	polygon	using	the	dialog............365
The	ine	Tool 	 ............367

To	draw	a	line	using	the	Line	Tool,	follow	these	steps:-............367
Arrows	Concavity............370
More	about	the	Photoshop	Shape	Tools............370
Exploring	the	3	different	modes	of	shapes	tools:-	Shape,	Path	And
Pixels............371
The	Shape	Mode............371
The	Path	Mode............371
The	Pixel	Mode............371
The	Shape	Mode	Options............371
Converting	shape	layer	into	normal	layer............376
Summary............378
Examples............379
Creating	an	iPhone-like	Icon............379
Drawing	in	Perspective	using	the	Polygon	Tool............379
Using	the	shapes	tools	to	create	simple	drawings.............379

Photoshop	Custom	Shape	Tool............382
Drawing	a	shape	using	the	Custom	Shape	Tool............383
Loading	new	shape	groups	into	Photoshop............384
To	load	a	new	shape	group,	follow	these	steps:-............384



Downloading	and	Loading	new	shapes	from	the	Internet............387
To	load	the	CSH	file	that	contains	the	shape	into
Photoshop:-............388
Create	New	Shape	From	Scratch............390
To	create	the	thunder	shape,	follow	these	steps:-............391
Sites	where	you	can	download	Custom	Shapes
from............394
Summary............394
Examples............395
Creating	A	Simple	Greeting	card............395
Embedding	shapes	into	text:-............395

Photoshop	Blending	Options............396
Style............398
Default............400
Technique............405
Depth............407
Size............409
Soften............409
Use	Global	Light............411
Gloss	Contour............412
Highlight	Mode............415
Highlight	Opacity............417
Shadow	Mode............418
Contour............422
Contour............422
Contour	Range............423



Texture............424
Pattern............424
Scale............425
Depth............426
Invert............426
Link	With	Layer............427
Stroke............427
Position............428
Stroke	Fill............431
Gradient	Style............434
Gradient	Angle............435
Scale............437
Stroke	Pattern............438
Pattern............438
Scale............439
Link	With	Layer............439
Inner	Shadow............440
Blend	Mode............441
Shadow	Color............442
Shadow	Opacity............442
Distance............444
Choke............445
Size............446
Contour............447
Noise............448
Blend	Mode............450



Opacity............451
Technique............455
Source............456
Choke............457
Contour............461
Range............462
Color............466
Blend	Mode............466
Opacity............467
Angle............467
Distance............468
Size............470
Contour............471
Invert............473
Color............474
Blend	Mode............475
Gradient	Overlay............477
Opacity............478
Gradient............479
Style............479
Angle............480
Scale............482
Blend	Mode............485
Opacity............485
Pattern............486
Scale............487



Link	With	Layer............487
Outer	Glow............488
Blend	Mode............489
Opacity............490
Noise............491
Outer	Glow	Color............492
Single	Glow	Color............492
Gradient............493
Technique............494
Spread............495
Size............496
Contour............497
Range............498
Jitter............499
Blending	Mode............501
Color............502
Opacity............502
Angle............503
Use	Global	Light............504
Distance............505
Spread	&	Size............505
Contour............507
Noise............508
Enabling	and	disabling	Layer	styles	from	the	Layers
Panel............510
Rasterizing	your	Layers	Styles............510



To	merge	the	two	layers,	do	the	following:-............511
Saving	your	Layer	Styles............512
Loading	more	Layer	Styles	into	Photoshop............514
Downloading	and	loading	new	Styles	from	the	Internet............516
Examples............519
Drawing	A	House............519
Creating	a	Logo............520

The	History	Brush	Tool,	and	the	History	Panel............522
The	History	Panel:-............522
Using	the	History	Brush	to	retrieve	part	of	a	previous
state............526
Summary............529

Photoshop	Filters............530
Gaussian	Blur............530
Motion	Blur............532
Add	Noise............540
Median	Filter............542
Liquify	–	The	Best	Photoshop	Filter............546
A	quick	look	at	some	of	the	other	filters............553
Summary............555
Examples............555
Making	the	skin	smoother	using	the	Median	filter............555
Blurring	everything	around	your	subject	in	the	photo............556
Adding	motion	to	a	bullet............556
Enhancing	the	quality	of	a	picture	by	sharpening	it............557



Making	a	cat	more	fluffy	using	the	Liquify	filter............558

Image	Adjusting	Tools............561
Bright/Contrast............562
Levels............565
What	is	the	Histogram?............566
Using	Levels	Dialog	to	adjust	your	images............567
Invert............582
Disadvantages	of	editing	pictures	that	way,	and	what	to
do	about	this............582
Summary............586

Preface
I	have	read	many	Photoshop	books,	while	many	of	these	books	were	written	by	great	Photoshop
users,	and	many	of	those	definitely	are	better	than	me	at	using	it,	the	problem	with	many	of	these
books,	in	my	opinion,	is	that	they	are	kind	of	boring	to	read,	and	they	tend	to	require	you	to	fumble
around	to	do	things	like	finding	a	button	or	icon	the	book	is	talking	about.	I	have	also	noticed	that
these	books	takes	too	much	time	to	read,	they	talk	too	much,	and	they	try	to	cover	the	tools	in	a
logical	way,	not	the	order	you	will	need	these	them.	For	example,	when	they	cover	the	user	interface,
they	talk	about	all	Photoshop	tools,	including	the	ones	that	you	won’t	need	to	know	about	until	much
later,	and	some	of	these	tools	are	ones	you	may	never	use.	In	a	similar	fashion,	they	talk	about	every
single	thing	in	details	that	you	will	need	to	read	hundreds	of	pages	before	you	get	to	see	results
(though	that’s	not	a	bad	thing	for	some	people).
Photoshop	is	already	a	vast	program	that	is	boring	to	learn,	yet	very	fun	to	use,	one	has	be	brave	to
wade	through	one	of	these	books	to	cross	the	boring	learning	curve	to	the	fun	world	of	Photo-editing.

Getting	results	from	the	very	beginning
What	I	tried	to	achieve	using	this	book	is	the	opposite	of	all	that,	I	wanted	to	create	a	bunch	of
chapters	that	allows	you	to	achieve	results	from	the	very	beginning,	you	will	start	to	notice	that	from
the	second	chapter	“Getting	Started	with	the	Brush	Tool”.	If	you	are	familiar	with	Photoshop	user
interface,	you	could	skip	the	user	interface	chapter,	which	I	wrote	for	the	absolute	beginners.	After	the
second	chapter,	I	will	start	building	gradually	on	what	you	have	learned	earlier	so	you	could	achieve
more	things,	even	if	you	read	part	of	this	book,	you	will	still	be	able	to	create	many	things	using
Photoshop.	The	order	of	chapters	in	the	book	a	little	weird	for	some,	but	I	believe	it	will	make	the
learning	process	smoother,	because	of	the	results	you	will	achieve	from	that



Less	reading,	more	learning
The	second	thing	I	wanted	to	achieve	using	this	book	is	to	make	it	kind	of	fast	&	easy	to	read,	which
is	why	I	heavily	depend	on	pictures	to	convey	the	concepts,	which	won’t	only	make	it	fast	to	read,	but
pretty	much	clear	too.	The	average	of	words	in	each	pages	of	this	book	is	less	than	100-200	words;
and	some	pages	have	way	less	than	that.
For	the	most	part,	I	will	depend	on	picture	for	teaching	you	the	concepts.	Which	I	hope	will	make	this
book	appealing	to	read,	especially	for	visual	learners.	I	also	hope	that	will	make	it	much	faster	to
read,	because	I	am	pretty	sure	you	want	to	spend	your	time	using	Photoshop	instead	of	wading
through	walls	of	texts.

Learn	Photoshop	on	the	go
To	some	degree,	this	book	can	be	read	without	having	an	access	to	Photoshop,	this	is	nice	in	case	you
have	a	tablet	or	some	portable	device,	and	wanted	to	make	a	use	of	your	time,	but	bear	in	mind	that
some	Photoshop	concepts	are	much	easier	to	learn	if	you	tried	them	yourself.	And	you	will	get	the
best	results	if	you	do	some	experimenting	of	the	concepts	every	now	and	then

Clear	Instructions
I	did	everything	I	can	to	make	the	instructions	easy	to	read,	taking	into	account	that	many	of	the
readers	are	not	fluent	in	English,	and	for	that	very	reason,	I	tried	as	much	as	possible	to	cut	back	on
the	vocabulary	amount	&	idioms	that	are	used.
Another	thing	I	avoided	in	this	book	is	to	tell	you	to	do	things	without	making	sure	they	make	sense
to	you.	For	example,	I	will	never	tell	you	to	“Click	button	X	that	is	located	between	the	oval	button
and	the	OK	button”.	Instead	of	that,	I	will	show	you	a	picture	of	where	the	button	you	have	to	click	is.
Especially	that	making	you	fumble	around	unnecessarily	is	something	that	can	be	easily	avoided
Also,	I	will	never	give	you	vague	instruction	like	“Set	X	value	to	34.5	then	click	OK”.	Something
many	books	do,	sadly	speaking.	Instead	of	that,	I	will	make	sure	that	I	will	let	you	know	where	I	got
the	value	from,	and	what	that	value	actually	does.
One	of	things	you	will	notice	about	the	screenshots	in	the	book	is	that	they	are	all	taken	with	my
Photoshop	installation	is	set	to	the	Light	color	theme,	which,	in	my	opinion,	make	them	easier	to	read
(According	to	a	research	made	by	Bauer,	D.,	&	Cavonius,	C.,	R.	(1980).	Improving	the	legibility	of	visual	display	units
through	contrast	reversal).	So	unless	you	changed	your	interface	color	to	be	like	mine,	your	Photoshop	user
interface	is	going	to	be	black,	but	that	won’t	hinder	your	ability	to	distinguish	between	the	options
I	am	fully	aware	that	there	is	some	amount	of	repetition	in	the	contents	of	this	book,	but	I	intentionally
didn’t	try	to	lower	that.	Because	I	believe	that	repetition	is	a	very	powerful	learning	tool.	It	won’t	only
make	it	easier	for	you	to	remember	the	concepts	explained	in	this	book,	but	it	will	also	help	you
understand	the	parts	you	find	confusing	at	first,	something	that	can’t	be	avoided	when	it	comes	to
some	Photoshop	concepts.	To	make	the	repetition	less	of	a	problem,	many	of	these	repetitions	will	be
explained	using	different	wordings	to	avoid	getting	you	bored	by	them



Chapters	Layout
Instead	of	walking	you	through	some	fictional	projects	you	probably	don’t	care	about,	each	chapter
will	teach	you	the	tools	directly,	without	wasting	any	of	your	time,	then	it	will	proceed	to	a	summary
sections.	For	most	of	the	chapters,	there	is	going	to	be	an	examples	sections	that	will	show	you	some
good	ways	to	use	the	tools	you	learned.	Some	chapters	don’t	have	examples	section,	mainly	because
there	is	no	viable	examples	to	provide	other	than	what	is	explained	in	the	chapter.
Every	time	you	have	to	encounter	a	Computer	Graphics	term,	I	will	take	a	little	detour	to	explain	that
concept	to	you	before	proceeding,	so	you	don’t	have	to	worry	about	having	a	prior	background	about
graphics	in	order	to	read	the	book.
Some	of	the	most	important	aspects	of	Photoshop,	like	Layers	&	the	Pen	tool,	will	be	taught	to	you
much	earlier	than	some	Photoshop	courses	do,	because	these	concepts	are	so	important,	and	because
many	other	concepts	are	built	on	them.	Plus,	learning	these	concepts	pretty	earlier	will	give	you	a
sense	of	achievement	J

The	future	of	this	book
This	is	still	the	first	edition	of	the	book,	I	still	plan	to	make	many	improvements	to	it,	add	more
information,	and	fix	any	possible	methods	of	teaching	I	have	used.	If	you	have	any	suggestion,	don’t
hesitate	to	send	me	an	E-mail	Mie@SweetMonia.com
While	I	will	try	my	best	to	cover	as	much	of	the	options	you	encounter,	there	are	time	when	I	won’t
really	cover	everything	about	a	certain	tool,	this	to	avoid	loading	you	with	Information	you	probably
won’t	need	(You	don’t	really	need	to	worry	about	learning	every	single	Photoshop	feature	to	work
efficiently	with	it),	but	I	will	try	to	add	those	in	the	upcoming	edition	of	this	book,	maybe	in	their	own
chapters,	so	that	the	original	book	will	stay	the	same



If	you	liked	this	book,	please	recommend	it	to	a	friend	or	tweet	about	it,	it	will	be	a	big	help,	as	it	will
give	me	more	motivation	to	add	more	and	more	chapters	to	it.	And	thank	you	in	advance	for
supporting	this	book	J

Photoshop	user	Interface

This	chapter	will	give	you	a	very	good	idea	about	the	user-interface	of	Photoshop.
If	you	are	already	familiar	with	that,	you	can	skip	this	chapter	and	return	to	it	later	when	you	are	in
the	mood	for	it.

In	this	chapter
A	brief	look	on	Photoshop	user	interface
The	options	bar
Working	with	Photoshop	panels
The	Tools	panel
Working	with	workspaces
Creating	new	documents

A	brief	look	on	Photoshop	user	interface
Getting	to	know	the	main	elements	on	Photoshop	user	interface	will	make	it	easier	to	follow	all	the
instructions	of	this	book.	It	will	also	help	you	use	Photoshop	more	efficiently.



The	main	elements	in	Photoshop	user	interface	are:-

The	Options	Bar:-	Contains	options	that	change	depending	on	the	tool	you	are	working	on.
The	Menus	Bar:-	which	exists	in	all	computer	programs.	The	menu	bar	contains	all

Photoshop	options,	many	of	these	options	are	also	accessible	through	Photoshop	panels.	We
won’t	say	much	about	the	menu	bar	in	this	chapter.	But	many	of	the	main	menu	options	will	be
explained	in	details	in	the	upcoming	chapters.
Panels:-	Panels	are	a	convenient	way	to	access	many	of	Photoshop	tools	and	options.	And

they	are	a	good	way	to	streamline	your	workflow
Tools	Panel:-	While	it	is	considered	a	panel	itself,	it	deserves	to	be	mentioned	on	its	own,

this	panel	contains	all	the	main	Photoshop	tool.	If	you	mastered	using	these	tools,	you	will	be
able	to	do	a	lot	of	things

The	options	bar
The	options	bar	display	options	related	to	the	tool	you	are	using.	The	options	shown	change
dynamically	every	time	you	change	the	tool	you	are	working	on.
Here	is	how	the	options	bar	looks	like	wßhen	the	brush	tool	is	selected:-

And	here	is	how	it	looks	like	for	the	text	tool:-

We	will	take	a	more	detailed	look	at	the	Option	Bar	options	each	time	we	cover	any	of	Photoshop
Tools.

Working	with	Photoshop	Panels
Panels	provide	a	great	way	to	access	the	various	tools	and	options	in	Photoshop.	Arranging	the	panels
to	suit	your	needs	is	essential	to	ensure	you	have	the	best	workflow	possible.
Panels	can	be	floating	on	the	middle	of	the	screen,	like	this:-



Or	they	can	be	grouped	together,along	with	other	panels,	which	is	how	they	are	by	default:-

To	move	a	panel,	whether	it	is	grouped	or	not,	simply	click	on	the	title	of	the	panel,	then	drag
the	mouse	cursor	away.
The	panel	will	be	moved	along	with	the	cursor.	If	you	want	the	panel	to	be	grouped	with	any

other	panel	or	group	of	panels.	Simple	drag	it	over	the	panel(s)	you	want	to	group	it	with.	And



until	the	panel	you	are	moving	becomes	transparent,	like	this:-

Release	the	mouse	button.	And	the	two	panels	will	be	grouped	together

Showing	and	hiding	a	panel
To	show	a	panel	that	is	hidden,	or	to	hide	a	panel	that	is	displayed,	simply	choose	the	panel	name
from	the	Window	menu

If	you	selected	a	panel	that	is	hidden	from	the	Window	menu,	then	Photoshop	will	display	it	for	you.
And	if	you	selected	a	menu	that	is	displayed,	then	Photoshop	will	hide	it	instead.	You	can
toggle/switch	between	hiding	and	displaying	panels	this	way
Note	that	the	panels	that	are	already	displayed	have	a	✓	mark	besides	of	it,	and	the	panels	that	are
hidden	don’t	have	anything	beside	them:-

Collapsing	Panels:-



Panels	can	be	collapsed/shrink	into	tiny	rectangles,	which	is	a	useful	way	to	save	you	some	screen
space	when	you	don’t	need	them	:-

And	the	collapsed	panel	could	be	resized	even	further:-

You	can	still	access	the	options	in	the	smaller	panel	by	clicking	on	the	icon	or	panel	name:-

There	are	two	ways	to	collapse	a	panel	like	that:-

To	resize	the	collapsed	panel,	hover	your	mouse	over	the	edge	of	the	collapsed	panel,	then	the	cursor
turn	into	 .	Click	and	drag	the	panel	to	the	left	or	the	right:-



The	nice	thing	about	collapsing	panels	in	Photoshop	is	that,	when	you	have	more	than	one	panel
docked	below	each	other.	The	whole	panels	will	be	collapsed	together:-

As	I	said,	for	this	to	happen,	the	panels	should	be	docked	below	each	other,	but	how	to	do	that?
This	is	done	the	same	way	you	group	the	panels	together,	except	that	you	hover	the	mouse	at	the
button	of	the	panel(s)	rather	than	its	title,	like	this:-



The	Tools	Panel
The	Tools	panel	is	similar	to	the	other	panels	in	Photoshop,	but	because	it	is	an	important	panel.	It
deserve	to	talk	about	it	in	details
Don’t	worry;	I	won’t	annoy	you	by	stating	every	tool	that	exists	in	the	panel.	You	will	get	to	know
many	of	these	tools	in	the	future.	For	now,	I	will	tell	you	how	to	work	with	the	panel.
Just	like	the	other	panels,	the	Tools	Panel	can	be	collapsed	to	save	you	some	screen	space,	which	is
done	by	clicking	on	the	double	arrow	button	at	the	corner	of	the	panel



Some	tools	are	hidden	below	others.	The	tools	that	have	hidden	tools	below	them	have	a	little	arrow
on	the	corner	of	its	icon:-

To	access	these	hidden	tools,	simply	click	and	hold	on	the	icon	of	the	tool,	and	Photoshop	will	show
you	the	hidden	tools:-

At	the	bottom	of	the	Tools	Panel,	there	are	two	color	icons.	The	foreground	color,	and	the
background	color

The	foreground	color	is	the	color	you	will	use	most	of	the	time.	When	you	paint	with	the	brush	tool,
you	will	see	the	foreground	color	applied	on	the	picture.	Other	tools,	like	the	eraser	tools	applies	the
background	color	instead.	The	difference	between	the	two	colors	will	be	more	obvious	once	you
learn	more	about	all	Photoshop	tools.
The	little	two	arrows	button	besides	the	foreground	&	the	background	colors	will	reverse	the	colors:-



And	the	two	black	&	white	squares	reset	the	foreground	&	background	colors	to	black	&	white.
Which	are	the	default	colors.	In	other	words,	this	little	button	set	the	foreground	color	to	black,	and
the	background	color	to	white.

Clicking	on	any	of	the	foreground	or	the	background	colors	open	the	color	picker	dialog.	Which
allows	you	to	choose	the	color	you	want:-

Working	with	workspaces
Workspace	is	a	way	to	save	the	placement	of	all	the	panels	arrangements	you	have	made.	You	may
want	to	have	a	workspace	to	use	when	you	adjust	your	photos,	and	another	one	for	when	you	paint,
and	so	on.	Having	a	workspace	saved	is	a	good	way	to	switch	between	different	arrangements	so	that
you	won’t	have	to	re-arrange	the	panels	each	time	you	want	to	work	in	a	certain	way
To	switch	from	a	workspace	into	another	,	click	on	the	menu	at	the	upper-right	corner	of	the	screen:-



Which	will	display	the	workspaces	available	for	you:-

You	won’t	see	some	of	the	workspaces	shown	here,	like	“Sophie”	or	“Painting-RT”.	These	are
workspaces	I	created	to	suit	my	own	workflow.
Clicking	on	any	of	the	workspaces	will	make	Photoshop	switch	to	the	workspace	in	an	instant.	Try	it
on	your	computer	and	see	how	it	goes~

Creating	A	New	Workspace
To	create	a	new	workspace,	simply	arrange	the	panels	the	way	you	want,	and	then	choose	the	“New
Workspace”	from	the	workspaces	menu



And	Photoshop	will	display	the	New	Workspace	dialog:-

Type	in	the	name	you	want	for	the	workspace,	in	this	case,	I	named	the	workspace	“TestWorkspace”.
You	also	have	the	option	to	save	the	Menus	or	the	Keyboard	Shortcuts	in	additional	to	the	panels.
Click	“Save”	to	save	the	workspace.
And	the	new	workspace	will	be	available	for	you	to	switch	into	at	any	time	you	want:-

In	case	you	changed	the	panel	arrangement	your	workspace	too	much,	you	can	revert	to	the	original
arrangement	by	selecting	“Reset	Testworkspace”	from	the	same	menu:-

Of	course,	the	name	of	the	option	change	depending	on	the	workspace	selected.

Creating	New	Files	In	Photoshop
If	you	have	worked	with	art	program	other	than	Photoshop,	then	you	have	a	good	idea	on	how	to
create	files	in	Photoshop.	If	you	are	not,	then	don’t	worry,	as	I	will	explain	how	to	do	that	right	away.
Don’t	worry	if	some	of	the	options	in	this	dialog	seemed	confusing	to	you,	they	will	become	much
more	familiar	with	the	most	important	options	the	more	you	get	to	work	with	images	in	Photoshop



To	create	a	new	file	in	Photoshop,	follow	these	steps:-

Select	File->New	from	the	main	menu

The	New	file	dialog	Appears

Photoshop	provides	you	with	a	lot	of	options	for	creating	a	new	file.	Many	of	these	options	are	the
same	across	art	programs,	and	not	just	Photoshop:-



Name:-	Here	is	where	you	can	specify	what	the	file	you	are	creating	will	be	called.	You	can
type	whatever	name	you	want	here.
Preset:-	Presets	are	a	way	to	save	a	certain	settings	so	that	you	could	use	them	later.	For

example,	you	could	have	an	A4	preset	so	that	you	could	create	A4-sized	pictures,	instead	of
typing	the	height	&	width	each	time	you	want	to	create	pictures	of	that	size.	Photoshop
already	comes	with	some	presets,	like	US	Paper,	International	Paper,	and	Web.

Size:-	Unless	you	choose	a	predefined	preset	from	the	Preset	menu,	this	menu	will	be
grayed	out.	Meaning	that	you	won’t	be	able	to	select	anything	form	it.	The	Size	menu
determines	the	size	of	the	document.	For	example,	if	you	choose	International	Paper,	then
you	will	get	to	choose	between	different	paper	sizes,	like	A3,	A4	or	A5:-

Width	&	Height:-	These	fields	are	self-explanatory;	this	is	where	you	specify	the	picture
dimension.	The	bigger	the	dimensions,	the	bigger	the	image	you	will	create	will	be.
Dimensions	units:-	Here	you	can	determines	the	Width	&	Height	unit,	which	is	pixels	by

default.	Other	available	units	are	Centimeters,	Millimeters	&	Inches



Resolution:-	Determines	how	many	pixels	are	there	per	inch	or	per	centimeter;	this	can	be	a
useful	option	in	case	you	want	to	print	the	file.	In	most	cases,	leaving	the	resolution	as	72	is	fine
in	most	cases.

Color	mode:-	Determines	the	color	mode	for	the	picture.	The	choice	of	the	color	mode
depends	on	what	you	plan	to	do	with	the	final	image.	You	can	convert	between	these	modes
even	after	you	create	the	picture	file

Bitmap:-	Bitmap	pictures	can	only	contain	White	or	Black.	But	no	other	color	at	all
Grayscale:-	Grayscale	pictures	contain	only	black,	white	&	gray	pictures,	similar	to

how	old	movies	were	before	the	invention	of	the	colored	cameras.	Grayscale	images
are	useful	to	use	in	digital	painting	to	accurately	assess	how	the	values	are	distributed	in
the	picture.
RGB	Color:-	In	RGB	mode,	much	more	colors	can	be	in	the	picture.	This	is	the	mode

you	will	work	on	most	of	the	time.	In	the	RGB	Color,	colors	are	represented	by	the
value	for	each	of	the	colors	Red,	Blue	&	Green.	For	example,	a	pure	Red	has	255	for
red,	0	for	Green,	and	0	for	Blue.	RGB	mode	is	the	most	suitable	mode	to	use	for	web



pictures.	8-bit	RGB	colors	can	contain	256	different	colors,	16-bit	RGB	contains	65536
different	color,	while	24-bit	RGB	can	contains	16.7	million
CMYK	Color:-	In	this	mode,	the	colors	are	represented	by	the	values	of	Cyan,

Magenta,	Yellow	And	Black.	CMYK	is	a	common	mode	to	use	for	printing
Lab	Color:-	the	LAB	color	mode	depends	on	how	human	see	the	color.	It	describes

the	colors	in	a	similar	way	that	we	humans	do.	Which	makes	the	Lab	mode	suitable	in
adjusting	the	colors	of	any	given	photo

For	the	most	part	during	this	book,	it	will	be	enough	to	know	how	to	create	a	new	file	by	specifying
the	width,	height	and	the	background	color	of	the	image.	But	knowing	about	the	other	options	early
will	help	you	a	lot	the	more	you	get	into	computer	graphics

Background	Color:-	This	is	self-explanatory,	it	determines	the	background	color	the	picture
has	by	default.	You	can	choose	between	white,	transparent,	the	Tools	panel	background	color,
or	other,	which	opens	the	color	picker	dialog	for	you	to	choose	any	color	you	want

Most	of	the	time,	you	will	be	creating	pictures	with	white	or	transparent	backgrounds.
After	you	are	done	with	specifying	the	options	for	the	new	file.	Simply	press	the	OK	button,	and
Photoshop	will	create	a	new	image	file	for	you:-

Using	the	Zoom	Tool	to	take	a	closer	look	on	your	picture
The	zoom	tool	is	one	of	the	most	intuitive	tools	in	Photoshop,	if	you	have	used	another	drawing
application,	like	MS	Paint,	then	you	have	a	very	good	idea	about	this	tool.
The	Zoom	Tool	allows	you	to	zoom	in	&	out	to	see	a	certain	part	of	your	picture	more	closely,



suppose	we	have	the	following	city	picture	opened	in	Photoshop:-

Everything	in	the	picture	can	be	seen	right	now,	suppose	we	want	to	take	a	closer	look	on	the	picture,
to	do	that,	we	use	the	Zoom	tool
Select	the	Zoom	tool	from	the	Tools	panel:-

Now	click	on	the	picture	where	you	want	to	zoom,	and	Photoshop	will	zoom	in	to	the	part,	which
pulls	it	out	closer	to	you,	here	is	how	the	picture	window	looked	for	me,	depending	on	where	you
click,	you	will	get	a	different	result:-

Of	course	you	can	keep	clicking	until	you	are	zoom	to	the	part	you	want,	here	is	how	the	picture
looked	like	after	I	zoomed	in	a	second	time



Now	suppose	you	want	to	zoom	out,	zooming	out	works	the	same	way	as	zooming	in,	except	that	you
have	to	switch	to	the	zoom	out	mode,	which	is	done	by	clicking	on	the	zoom	out	icon	 	in	the
Options	Panel:-

Now	clicking	on	the	picture	will	zoom	out	of	it	instead	of	zooming	in,	which	will	get	you	back	to
where	we	were	a	few	steps	ago:-

You	could	temporarily	switch	to	the	zoom	out	mode	by	holding	the	alt/option	key	on	your	keyboard.
When	you	do	that,	the	+	in	the	zoom	tool	cursor	will	change	into	-.	Which	indicates	that	you	are	in	the
zoom	out	mode
Another	interesting	way	to	use	the	zoom	tool	to	zoom	on	a	certain	part	of	the	picture	is	to	click	and
drag	your	mouse	on	the	part	you	want	to	zoom	to,	depending	on	your	Photoshop	preferences	&
Photoshop	version	you	have	installed,	you	will	either	zoom	in	dynamically	or	Photoshop	will	let	you
to	draw	a	rectangle	over	the	area	you	want	to	zoom	into

The	Hand	Tool
The	hand	tool	is	used	to	change	the	part	of	the	picture	that	is	displayed	while	zoomed	in,	this	is	called



“Panning”.
Suppose	we	have	our	city	picture	right	here,	and	then	we	zoomed	into	the	picture	using	the	Zoom-
Tool:-

Suppose	we	want	the	green	building	to	be	on	the	center	of	what	is	viewed	on	the	picture,	instead	of
being	near	the	edge	of	the	window,	here	is	how	to	do	that:-

Select	the	Hand	Tool	from	the	tools	panel:-

Click	on	the	picture	and	then	drag	to	the	direction	you	want.	As	you	do	that,	you	will	notice
that	the	part	that	is	shown	in	the	picture	is	changing.	Here	is	the	picture	after	I	made	the	green
building	right	on	the	center:-



Note:-	You	can	switch	to	the	Hand	Tool	temporarily	at	any	time	by	holding	the	Space	key,	this	will
save	you	the	time	&	hassle	of	switching	to	the	Hand	tool	every	time	you	want	to	use	it

Summary
Photoshop	user	interface	has	3	major	elements,	The	Menus	bar,	Panels,	and	Options	Bar
The	Options	Bar	displays	contextual	options	depending	on	the	tool	you	are	using
Photoshop	Panels	provide	an	easy	way	to	access	many	of	Photoshop	tools
Photoshop	panels	can	be	docked	somewhere,	or	they	can	be	floating	in	the	middle	of	the

screen
Panels	can	also	be	grouped	together,	they	can	also	be	docked	below	each	other,	which	makes

it	easier	to	arrange	them
Panels	can	be	collapsed	by	double-clicking	on	the	bar	on	the	top	of	it,	or	by	clicking	on	the

double	arrow	on	the	upper-right	corner	of	the	panel
When	you	collapse	a	panel,	any	panel	that	is	grouped	or	docked	with	it	get	gets	collapsed	as

well
The	Tools	Panel	contains	all	the	main	Photoshop	tools.
Many	tools	are	hidden	below	other	tools.	Tools	that	has	a	little	black	arrow	in	the	corner	of

its	icon	has	at	least	one	tool	below	it.
There	are	two	colors	that	are	selected	at	any	given	time,	the	Foreground	Color	and	the

Background	color
The	Foreground	Color	is	used	the	Brush	Tool,	while	the	Background	Color	is	used	by	the

Eraser	Tool
You	can	switch	the	Foreground	&	the	Background	colors	at	any	time	by	clicking	on	the	little

arrows	besides	them
You	can	also	reset	the	Background	&	Foreground	colors	to	black	&	white	by	clicking	on	the

little	white	&	black	square	that	is	also	besides	them
The	color	picker	is	an	intuitive	way	to	change	the	color	you	are	working	with.	You	can

choose	a	color	using	the	mouse	cursor,	or	you	can	enter	the	values	of	the	color	using	any	of	the
known	color	systems.
Workspaces	is	a	great	way	to	save	the	arrangements	of	panels,	so	that	you	want	have	to

arrange	them	yourself	every	time	you	want	to	work	in	a	certain	way
Photoshop	comes	with	a	few	Workspaces	out	of	the	box.	And	you	can	define	any	number	of

workspaces	you	want	too.
Creating	New	files	in	Photoshop	is	easy	and	straightforward.	Photoshop	allows	you	to	create

pictures	by	specifying	their	dimensions,	in	pixels,	inches,	or	many	other	units
You	can	also	specify	many	other	options	while	creating	the	document,	like	the	background

color,	or	the	color	systems	that	will	be	used	in	the	picture



The	zoom	tool	allows	you	to	zoom	in	and	out	a	certain	part	of	the	picture,	which	is	useful	in
case	you	want	to	modify	a	certain	part	of	the	picture	more	precisely
The	Hand	tool	allows	you	to	change	the	part	that	is	shown	on	the	picture	that	is	zoomed	in,

which	can	be	helpful	in	case	you	want	to	move	to	change	the	part	you	want	to	edit.

Getting	Started	With	The	Brush	Tool

The	brush	tool	is	the	ultimate	tool	of	Photoshop.	If	you	mastered	this	tool	on	a	lone,	you	will	be	able
to	do	a	lot	of	things.	And	it	will	help	you	to	understand	many	other	Photoshop	tools,	like	the	eraser	or
the	stamp	tool.	As	they	all	work	the	same	way.	Which	is	why	I	am	going	to	start	with	it.

You	can	use	the	Brush	Tool	to:-
Imitate	many	real	life	brushes	easily,	like	wet	brushes	and	pastels.
Create	patterns	and	textures	like	sand	or	snow	with	a	little	skill.
Change	the	colors	of	all	or	parts	of	a	picture.
Create	pictures	from	scratch	using	graphics	tablet	(Or	using	the	mouse,	but	I	don’t

recommend	that,	for	many	health	concerns).

Of	course	more	that	could	be	created	with	brush	tool.	Actually,	one	of	the	things	that	make	the	brush
tool	really	powerful	is	the	amount	of	customizability	it	provides.	You	can	download	additional
brushes	online,	or	even	create	your	own.	Which	allows	you	to	do	unlimited	number	of	things,	and
that’s	using	only	one	tool.	Isn’t	that	great?	:D

The	basics	of	the	brush	tool:-
There	are	seven	things	you	could	adjust	to	get	immediate	results	from	the	brush	tools.	Master	these
and	you	have	made	your	first	step	into	creating	great	designs.

Soft	VS	Hard	brush	tip



Brushes	in	Photoshop	can	be	either	soft	or	hard,	soft	brush	fades	away	and	blends	better	with	its
surrounding,	while	hard	brush	is	the	opposite	of	that
Adjusting	the	brush	hardness	or	softness	is	easy,	right	click	anywhere	on	your	canvas	and	adjust	the
hardness	slider	(the	less	hard	a	brush	is,	the	softer	it	is).

Brush	size

Brush	stoke	size	can	varies	from	one	pixel	diameter	to	2500	Pixel,	to	change	the	pixel	size,	right	click
anywhere	in	the	canvas,	and	adjust	the	brush	size	using	the	size	slider

	Candy	Tip:-	You	can	change	the	brush	size	using	the	“[”	&	“]”	keys	on	your	keyboard

Brush	flow	and	opacity

Now	come	the	most	important	features	of	the	brush	tool,	the	flow	and	the	opacity.	Both	are	ways	to
create	transparent	or	partial	strokes.	Flow	&	Transparency	are	technically	the	same	thing,	but	they
work	differently.	Understanding	and	exploiting	the	differences	between	the	two	is	one	of	the	things
many	Photoshop	users	often	miss.	And	they	don’t	know	how	much	they	are	missing.

To	get	the	difference	between	the	two,	do	the	following:-
~I	used	a	brush	with	%100	hardness	for	the	sake	of	clarity	here,	but	a	soft	brush	can	work	as	well~

Create	a	new	Photoshop	image	(Chose	File->New.	Then	click	OK	in	the	dialog	that	appears
before	you)
Select	the	brush	tool	Brush	from	the	Tools	Panel
Set	the	flow	to	%25	fro	the	Tools	panel:-



Click	and	drag	your	brush	to	the	right,	you	see	an	overlapping	brush	strokes	get	created	in
front	of	you.	Don’t	release	the	mouse	button	yet	

Now,	drag	the	brush	to	the	opposite	direction.	You	will	notice	how	the	stroke	became	more
opaque

Set	the	Flow	back	to	%100

Now	it	is	time	to	examine	opacity.	Set	the	opacity	%25,	as	seen	in	the	picture:-

Drag	the	same	way	from	the	left	to	the	right,	without	releasing	the	mouse	button.	You	see	a
soft	&	transparent	line	get	created.



Now,	without	releasing	the	mouse	button	from	the	last	step,	drag	on	the	opposite	direction	of
the	stroke	we	started	in	the	last	step,	What	do	you	notice?

As	you	have	seen,	when	you	paint	with	low	opacity,	painting	over	the	same	area	over	and	over	won’t
make	the	strokes	any	darker

Now	release	the	mouse	button.	And	drag	the	mouse	over	the	same	stroke	we	started.	What	do
you	see	now?

Seeing	how	the	stroke	is	becoming	darker	and	more	opaque	with	the	second	stroke.	You	now
know	the	main	difference	between	flow	&	opacity.

The	Pressure	Sensitivity	Option
This	option	works	only

if	you	have	a	graphics	tablet,	like	those	produced	by	Wacom,	graphics	tablets	allow	you	to	draw	much
easily	&	precisely	than	any	mouse	can	do.
Another	key	advantages	of	graphics	tablets	is	that	they	are	pressure-sensitive,	meaning	that	the	more
you	press	the	pen	on	the	tablet,	the	bigger	the	brush	size	will	be,	and	this	is	what	the	Pressure
Sensitivity	option	does



Wacom	Tablet
Following	are	a	couple	of	strokes	(or	lines)	I	made	using	my	Wacom	tablet,	and	with	the	pressure
sensitivity	option	enabled,	the	brush	size	is	the	same	for	all	the	strokes,	but	I	amount	I	pressed	on	the
tablet	was	different	with	each	stroke:-

In	general,	graphics	tablets	are	ideal	if	you	want	to	use	Photoshop	for	drawing	&	painting,	but	even	if
you	want	to	use	Photoshop	for	other	purpose,	like	Photography,	getting	a	graphics	tablet	can	greatly
boost	your	productivity

What	can	you	achieve	using	what	you	have	learned	so
far?
To	give	you	an	idea	on	how	much	you	have	learned.	I	will	show	you	a	good	number	of	things	you
could	do	using	your	new	knowledge.

Creating	a	simple	Logo
This	is	a	simple	logo	I	created	using	the	brush	tool,	using	a	hard	brush.	With	the	flow	&	opacity	all
set	at	%100,	I	painted	few	circles	beside	each	other.	I	tried	to	make	them	look	as	much	parallel	to	each
other.



Drawing	a	3D	ball
You	could	also	create	a	3D	ball	as	well,	created	a	circle	with	a	soft	brush,	then	with	the	flow	set	to
low.	I	added	the	highlight	at	the	corner	to	give	the	3D	look.

Turn	a	cat	into	blue
Changing	the	color	of	pictures	is	easy	if	you	know	how	to	change	the	brush	tool	settings.	Again,
using	a	soft	brush	with	low	flow,	I	made	this	gray	cat	turn	into	blue.	While	there	are	many	other
methods	to	change	the	colors	of	picture,	this	method	is	very	effective	due	to	its	simplicity.

Applying	blush	on	Anime	girls



My	favorite	example	so	far,	with	very	low	flow	(and	low	opacity,	if	you	wish).	You	could	add	blushes
to	Anime	girls	(And	real-life	girls	too).	You	drag	the	mouse	where	to	want	to	have	the	blush	once.
Then	you	make	few	“dabs”	at	the	middle	of	the	blush	to	make	it	look	more	gradual.

How	to	choose	the	right	values	for	your	brush:-
I	am	sure	you	are	wondering	how	I	choose	the	values	of	the	settings	in	this	chapter.	The	simple	and
quick	answer	is:-	by	experiment.	Choosing	the	brush	size	is	straightforward.	Deciding	if	you	need	a
soft	or	hard	brush	is	the	easiest	decision	you	will	learn.	It	can	be	a	bit	tricky	to	choose	between
opacity	and	flow	at	the	beginning.	But	since	you	already	know	the	difference	between	the	two,	you
have	an	advantage	over	many	artists	who	spent	a	lot	of	time	before	getting	to	learn	that.

Summary
The	brush	tool	is	the	most	important	tool	in	Photoshop,	it	can	imitate	real	brushes,	and	many

effects	and	results	can	be	achieved	the	easiest	way	by	knowing	how	to	manipulate	its	options.
The	brush	can	be	resized	so	that	you	can	cover	more	or	less	areas	with	each	stroke	you	make
Brush	opacity	&	flow	allows	you	to	make	some	transparent	strokes,	flow	adds	more	to	the

stroke	even	if	you	didn’t	release	the	mouse	button.	While	opacity	only	adds	to	the	stroke	after
you	release	the	mouse	button	and	then	make	another	stroke	above	the	original	stroke

Blending	modes	of	the	brush	tool	



Now	you	have	a	basic	idea	on	how	to	use	the	brush	tool.	I	am	going	to	add	to	the	knowledge	you
learned	by	explaining	a	useful	feature	in	drawing	and	creating	effects.	Which	is	the	blending	modes
of	the	brush	tool.	Blending	modes	is	a	useful	way	of	mixing	colors	&	creating	many	effects	in
Photoshop.	This	chapter	is	a	bit	long	because	there	are	many	modes	I	need	to	explain,	so	bear	with	me
a	little	bit	please~
	

Here	is	where	you	can	change	the	blend	mode
of	the	brush	tool

	
To	makes	blending	modes	easier	to	understand,	I	will	only	explain	the	general	idea	how	each
mode	work.	Experimenting	with	the	mode	will	help	you	understand	them	even	better,	as	is	the	case
with	many	things	in	Photoshop
	
To	use	Photoshop	blending	modes,	you	select	the	mode	you	want	to	use	from	the	drop-down	list	and
you	paint	away	with	the	brush	tool.	As	long	you	know	the	general	difference	between	the	modes	and
how	the	colors	get	mixed,	you	will	be	fine.	Don’t	worry	about	the	math	behind	these	modes	right	now.
Just	think	of	them	as	specially	effects	used	in	painting



Photoshop	blending	modes	of	the	brush	tool.	Divided	into	6	parts	for	the	sake	of	simplification

	
There	are	many	Photoshop	blending	modes	to	choose	from,	about	29	of	them	to	be	precise.	We	will
take	a	look	at	each	of	them.	And	as	I	said,	I	won’t	explain	everything	about	them	in	full	details.	But	I
will	make	sure	you	will	be	able	to	be	able	to	use	them	effectively.	Because	while	it	is	certainly	useful
to	understand	the	precise	difference	between	all	these	modes.	It	is	better	that	you	get	an	idea	on	how	to
use	them	first.	The	goal	of	learning	these	modes	is	to	get	to	create	the	effect	that	you	want	to.	Which
in	many	cases	can	be	done	using	more	than	one	mode.
	
In	short,	I	want	you	to	spend	less	time	learning	how	the	color	blending	modes	work	and	more	on	how
to	apply	these	modes	on	your	pictures.	Because	that’s	what	you	are	learning	Photoshop	to	do,	right?
;D
	
If	you	found	yourself	confused	during	this	chapter,	don’t	worry	much	about	it.	The	concepts	I	am
explaining	are	confusing	to	anyone	new	to	them.	You	will	find	yourself	familiar	with	them	after	you
play	with	them	for	some	time.	These	modes	are	not	always	straightforward	to	understand
mathematically.	So	try	to	understand	the	close	as	possible	how	the	end	result	usually	is

The	Normal	Group
Normal	Mode
The	normal	mode	if	the	default	blending	mode.	When	you	paint	with	this	mode,	the	color	you	paint
will	cover	any	color	below	it.	Assuming	all	the	brush	tool	settings	like	flow	&	opacity	are	set	to



%100.

Dissolve
Another	straightforward	mode,	when	you	use	this	mode,	the	edge	of	your	strokes	will
become	“fuzzy”.	And	just	like	the	normal	mode.	Your	strokes	will	cover	the	ones	below	them.

Behind
The	Behind	mode	is	special	to	the	Brush	tool,	and	is	not	applicable	to	the	other	modes	that	support
blending	modes.	Usually,	when	you	paint	with	the	brush	tool.	The	color	you	add	covers	the	existing
strokes,	but	with	the	behind	mode.	The	new	strokes	appear	behind	the
ones	that	are	already	there,	like	this:-		

Simply	speaking,	the	behind	mode	only	covers	the	pixels	that	are	transparent	and	ignores	the	ones	that
are	not.

Clear
Another	mode	that	is	special	to	the	brush	tool.	That	mode	simply	turn	your	brush	into	an	eraser:-



The	Darken	Group:-
Think	of	this	group	as	the	group	that	mixes	two	colors	and	always	produce	a	darker	color	than	the
two	colors	we	mixed.	The	results	are	a	little	different	with	each	mode,	but	as	long	you	embrace	the	“it
produce	a	darker	color”	idea.	Everything	about	these	modes	can	be	understood.

Darken
Just	like	the	name	implies.	The	darken	mode	darken	the	color	you	paint	on.	It	does	that	by	selecting
the	darker	color	of	the	two	you	are	mixing	(The	new	color	and	the	one	you	are	painting	on).	And	it
does	that	on	the	red,	green	and	blue	color	components	separately,	so	the	results	may	not	be	exactly
what	you	expect.
	

Multiply
Multiply	works	in	a	similar	way	to	Darken,	in	that	it	also	produces	a	darker	color	of	the	two,	except
that	it	multiply	the	numerical	values	of	the	two	colors	instead	of	selecting	the	darker	values	of	the
green,	red	and	blue.
It	is	tricky	to	differentiate	the	difference	between	Multiply	and	darken,	as	you	can	see	in	the	picture
below	this	section,	the	Multiply	blending	mode	always	produces	the	darker	color.



Color	burn
This	mode	literally	burns	the	colors	by	increasing	the	contrast	in	them,	and	this	is	why	the

end	result	is	usually	too	strong
Painting	with	white	using	this	mode	produces	no	changes

Linear	Burn
Similar	to	color	burn,	in	that	it	seems	like	it	burn	the	colors.	Except	that	it	does	that	in	a	nicer

way
Linear	Burn	decrease	the	brightness	of	the	darker	color	to	achieve	the	end	result.
Using	white	with	this	mode	produces	no	changes



Color	burn	(At	the	left)	VS	Linear	Burn	(At	the
right)

Darker	color
Works	similarly	to	the	Darken	blending	mode,	but	instead	of	using	the	red,	green	and	blue
components	of	each	color.	It	simply	chooses	the	darker	color	of	the	two.	This	is	one	of	the	easiest
blending	modes	to	understand	in	my	opinion
	
Here	are	a	couple	of	strokes	created	using	the	darker	color.	It	doesn’t	matter	which	stroke	is	made
first.	As	the	darker	color	will	always	choose	the	darker	color	of	the	two	all	the	time.	Notice	how
black	always	wins.	While	the	bright	green	to	the	right	is	placed	below	all	the	other	colors.

	Here	is	the	darken	group	modes	side-by-side:-



The	darken	group	side	by	side.	The	darken	and	multiply
work	very	similar	to	each	other.	It	is	easy	to	see	how	the	Color	Burn	the	color	with	a	lot	of	contrast.	Linear	burn	do	the	same	but	in	a
gentle	way.	Because	the	red	I	used	to	paint	in	this	picture	is	darker	than	almost	all	the	colors	of	the	picture.	It	almost	dominated	all	the

colors	of	the	pictures	when	I	used	it	with	Darker	Color.

The	Lightening	group
This	group	is	does	opposite	of	the	darken	group.	These	blending	modes	mix	two	colors	to	produce	a
lighter	one.

Lighten
The	Lightening	group	equivalent	of	the	Darken	mode,	it	chooses	the	lighter	color	of	each	of	red,
green	and	blue	components	of	the	two	mixed	colors.	Which	results	in	a	lighter	color
	

The	lighten	mode	using	light	green,	red,	and	blue
colors,	the	translucent	effect	is	obvious	here



Screen
While	I	am	not	sure	why	this	mode	was	called	by	this	name.	Its	name	is	a	good	way	to	understand
what	it	does.	Think	of	this	mode	as	looking	through	a	tinted	glass	that	makes	colors	lighters.
Black	has	no	effect	on	the	picture	on	this	mode.	The	brighter	the	color	you	use	is,	the	better	the
lightening	effect.
	

The	Screen	Blending	mode	using	the	red,	green	and	cyan

Color	Dodge
The	lighten	group	equivalent	of	the	color	burn	mode.	It	lightens	the	colors	of	the	picture	by
“burning”	its	colors.	The	result	is	a	color	with	a	lot	of	contrast

The	Color	Dodge	after	applying	multiple	colors	on	it.	It
is	easy	to	see	the	contrasting	this	mode	produces

Linear	dodge



Similar	to	color	dodge	in	that	it	burns	the	picture	colors.	But	it	produces	a	more	gentle	result.	This	is
the	lighten	group	equivalent	of	the	Linear	Burn	mode.
Using	black	with	this	mode	doesn’t	have	any	effect	on	the	picture

Lighter	Color
One	of	the	easiest	modes	to	understand,	it	simply	chooses	the	lighter	color	of	the	two	you	are	mixing.
This	mode	works	in	a	similar	way	to	the	Darker	Color	mode.

Applying	green	on	the	picture	using	lighter	color	covers	almost	all	of	it.	But	a	little	of	the	yellow	and	pink	colors	escape	the	change
because	they	are	lighter.	Applying	a	dark	red	on	the	lower	side	on	the	picture	doesn’t	change	much	of	the	colors	because	many	colors

are	lighter	than	it

The	Contrast	Group
The	contrast	group	works	by	manipulating	the	contrasts	between	the	two	mixed	colors.	I	personally
call	it	the	lights	groups.	As	I	to	think	of	them	as	a	way	to	create	different	kind	of	lights	in	my	pictures.



The	contrast	group	increases	the	contrast	by	lightening	the	lighter	colors	and	darkening	the	darker
one	of	the	two	colors	you	are	mixing

Overlay
Another	mode	that	works	as	if	you	are	looking	at	the	picture	through	a	tinted	glass,	one	that	brighten
the	picture.	The	effect	this	mode	produces	similar	to	the	Screen	mode.	But	the	effect	it	produces	is
stronger.	The	following	picture	shows	you	the	difference	between	the	two	modes:-
	
The	reason	these	two	are	similar	because	overlay	uses	both	screen	&	multiply	on	the	pixels,
depending	if	they	are	darker	or	lighter	than	the	color	you	are	applying.

The	overlay	and	the	screen	modes,	the	overlay	is
applied	on	the	top	and	the	screen	below	it.	The	screen	mode	produces	similar	results	than	the	screen	mode,	but	with	a	stronger	effect.

Soft	light
This	is	one	of	my	favorite	modes.	It	is	easy	to	understand	thanks	to	its	name.	It	produces	a	soft	light
on	the	picture;	The	effect	is	so	gentle	and	nice	to	look	at.
	



Multiple	colors	applied	on	the	flowers	picture.	See
how	it	is	nice	to	look	at	the	end	result~

Hard	Light
The	stronger	version	of	the	Soft	Light	mode.	It	is	useful	mode	to	create	spotlight	to	your	pictures

Vivid	Light
Think	of	this	mode	as	you	are	applying	a	very	strong	light	to	the	picture,	to	the	point	that	it,	again,
burns	the	colors.	Along	with	the	Hard	Mix	mode.	This	is	the	strongest	way	to	burn	colors
among	blending	modes



Linear	Light
This	mode	also	applies	an	intense	light	to	the	picture.	To	the	degree	that	the	details	of	the	underlying
picture	can	barely	be	seen	behind	it.

Pin	Light.
From	the	look	at	it,	the	pin	light	is	like	a	mild	version	of	the	linear	light.	It	sheds	a	strong	light	you
can	barely	see	the	underlying	details	of	the	picture,	but	it	produces	a	more	transparent	light,	and	many
of	the	details	of	the	underlying	picture	can	be	seen	through	it.
Pin	light	selects	the	darker	or	lighter	color	of	the	two	colors	you	are	mixing,	depending	whether	the
color	of	the	picture	is	above	or	below	%50	gray	levels.



Hard	Mix
Similar	to	Vivid	Light,	this	mode	works	by	adding	the	red,	green	and	blue	of	the	two	colors	you	are
mixing,	it	creates	a	unique	light	that’s	easy	to	distinguish	from	the	other	modes

The	other	4	modes
So	far,	I	don’t	have	an	accurate	name	to	use	for	these	4	blending	modes.	So	I	called	them	“The	Other
4”.	Think	of	them	as	the	color	invert	group	if	you	like,	or	the	group	that	takes	the	color	away	from
the	picture	you	are	working	on,	because	that’s	kind	of	what	they	seem	to	do.

Difference
This	mode	takes	the	smaller	color	of	the	two	you	are	mixing,	and	subtracts	it	from	the	greater	one.
The	result	is	a	color	that	is	the	difference	between	the	two.	Without	doing	the	math,	it	is	hard	to



predict	what	color(s)	this	mode	will	produce.

Exclusive
Similar	the	Difference	mode,	but	creates	a	result	that	has	less	contrast

Subtract
This	mode	subtract	the	value	of	the	color	of	you	are	applying	from	the	color	of	the	picture,
regardless	whether	the	color	you	are	applying	has	greater	values	or	not,	unlike	the	difference	mode,
which	takes	the	greater	color	and	subtract	the	smaller	one	from	it



Divide
Another	mode	that	does	what	its	name	says.	It	divides	the	color	of	the	picture	with	the	one	you	are
applying
	

On	this	picture,	I	applied	red	(resulted	in	green),	green
(resulted	in	red),	and	blue(resulted	in	yellow),	on	the	flowers	picture	using	the	divide	blending	mode

The	color	components	modes
The	last	4	modes	work	on	the	3	components	of	the	color,	the	Hue,	Color,	Saturation	&	Luminosity,
instead	of	green,	red	and	blue.	For	the	sake	of	making	this	chapter	easier	to	understand,	I	will	assume
that	you	have	no	idea	what	the	Hue,	Saturation,	Color	and	Luminosity	mean.	So	I	am	going	to	give
you	a	brief	description	on	them	here,	if	you	already	know	about	these	four.	You	can	skip	this	part	if



you	like	:)

Hue
Hue	is	color,	when	you	look	at	some	color,	we	tend	to	classify	it	as	red,	blue,	green,	yellow,	orange,
purple,	or	any	other	color,	disregarding	whatever	the	color	is	light	or	dark.	This	is	the	Hue
component	of	the	color.
	

Three	colors	with	different	Hue	values,	it	is	easy	to
classify	these	colors	as	red,	green	and	blue	just	by	looking	at	them,	even	though	the	green	at	the	middle	is	not	the	best	green	you	could

think	of.

Saturation
Represents	the	intensity	of	the	color,	the	bluer	a	blue	is,	the	more	saturation	it	has.
	

Three	blue	circles	with	different	saturation	level.
The	blue	at	the	right	has	the	most	saturation,	the	one	at	the	left	barely	has	any	saturation,	which	makes	it	kind	of	dull.	We	could	still

classify	the	three	colors	as	blue	because	they	have	the	same	hue.

Luminosity
This	component	determines	the	amount	of	light	the	color	receives,	or	how	much	light	or	dark	it	is.

Now	you	are	familiar	with	the	HSL



terms	(short	for	Hue,	Saturation	and	Luminosity).	Let’s	get	to	the	color	modes	of	them~

Hue	Blending	Mode
Applies	the	color	of	your	brush	on	the	picture	while	keeping	the	brightness	and	luminosity	of	the
picture	pixels.	This	is	one	way	to	change	the	colors	in	your	pictures
	
Here,	I	changed	the	color	of	part	of	one	of	the	flowers	at	the	left	by	applying	some	red	to	it:-

Saturation	blending	mode
Applies	the	Saturation	of	the	color	of	your	brush	while	keeping	the	Hue	and	Luminosity
	

If	you	looked	at	the	flower	at	the	middle	(the	one	an
arrow	pointing	at	it,	you	will	notice	its	color	is	more	saturated	than	the	others.	It	is	because	I	applied	an	intense	red	on	it.	On	the	other

hand,	the	flower	on	its	left	became	so	pale	after	I	applied	a	color	with	low	saturation	on	it

Luminosity	Blending	Mode



Applies	the	Luminosity	(or	Light	you	could	say)	of	your	brush	color	to	the	picture.	This	is	a	good
way	to	add	light	to	your	pictures	by	using	a	brush	with	low	flow	value
	

I	added	some	bright	light	to	the	upper	part	of	the	flowers
picture	by	applying	luminosity	using	a	brush	with	low	flow	value.	At	the	bottom	of	the	picture,	I	applied	a	bright	color	to	the	flower	at	the

right,	resulting	in	covering	it	completely.	I	also	applied	a	dark	color	on	the	left	flower,	which	made	it	less	distinguishable.

Color
Applies	Both	Hue	and	Saturation	of	your	brush	color	and	keeps	the	saturation	of	the	picture	color.
This	is	a	very	common	way	to	change	the	colors	in	your	pictures
	

If	you	don’t	like	the	color	of	the	flowers	here,	feel
free	to	change	them.	To	get	the	best	results,	choose	colors	that	are	not	so	bright	and	not	so	dark.	Using	a	soft	brush	with	low	flow	or

opacity	can	help	you	a	lot	here	as	well.

Examples



We	are	finally	done	with	all	the	modes,	it	is	time	to	show	you	more	examples	of	how	to	play	with
these	modes	on	your	pictures.	There	is	virtually	unlimited	ways	to	do	that.	But	giving	you	a	head-start
will	help	you	see	how	great	it	is	to	be	able	to	use	them	effectively:-

Make	them	both	blue:-	
By	using	blue	on	the	cat	yellow	eye,	I	managed	to	turn	it	into	blue	by	using	the	Color

blending	mode.	I	made	sure	to	set	the	flow	low	enough	so	I	won’t	get	to	add	more	blue	than
necessary,	which	would	make	the	end	result	looks	so	unnatural.	More	manipulation	of	the	eye
shades	can	make	the	end	result	even	better

Turn	Day	Into	Light

Turn	the	day	into	night	by	using	Hard	Light	blending	mode	with	and	apply	blue	on	the	entire
picture

Make	your	images	brighter

Make	your	images	brighter	by	applying	overlay	on	them	with	a	bright	color.



Create	a	sunlight

Bask	you	image	in	the	sunlight	by	applying	white	on	your	picture	using	the	soft	color.	You	will	need
to	apply	more	than	one	stroke	to	create	a	similar	effect	to	this	one.

Use	Dissolve	as	an	effect

The	dissolve	mode	can	make	interesting	effect	on	its	own.	I	bet	every	gang	that	has	Photoshop	uses	it
:D



Still	with	the	Dissolve	mode,	I	created	a	simple	grass	effect

by	applying	various	degrees	of	green	on	top	of	each	other	using	that	effect.	Various	things	can	be

created	that	way	in	Photoshop

Create	Geisha	girls
I	turned	this	cute	Japanese	girl	into	a	Geisha	by	darkening	her	lips	with	red.	Darkening	her	eyebrows
with	black,	and	applying	white	over	her	skin	with	Overlay.	Doing	things	like	that	is	easier	with	layers,
which	we	will	get	to	learn	soon



Make	white	penguins
I	turned	this	penguin	to	white	by	soft	light	on	it	many	times.	He	looks	a	little	bit	like	chicken	now.

Conclusion
I	am	aware	that	this	was	a	hard	&	confusing	chapter,	but	this	is	probably	the	hardest	chapter	in	the
whole	book,	blending	modes	can	exist	in	more	than	one	place	in	Photoshop,	and	they	are	a	relatively
easy	way	to	create	effects.	Which	is	why	I	thought	you	should	learn	them	as	soon	as	possible.

Blending	Modes	Resources:-
I	couldn’t	have	wrote	this	chapter	without	some	external	help.	Here	are	two	articles	that	were	very
useful	in	filling	gut	gaps	in	my	knowledge	about	these	modes,	you	could	refer	to	them	to	learn	more
about	these	modes	if	you	like:-

The	official	Adobe	website:-	which	helped	me	more	than	anything~
This	page	explains	the	math	behind	the	blending	modes	in	details.	Something	I	kind	of

avoided.	But	you	may	find	this	very	useful	if	you	want	to	learn	more	about	Photoshop	blending
modes	later

http://helpx.adobe.com/photoshop/using/blending-modes.html
http://photoblogstop.com/photoshop/photoshop-blend-modes-explained


Summary
Blending	Modes	is	one	of	the	most	powerful	yet	confusing	aspect	of	Photoshop,	but	because

they	are	useful	in	multiple	of	ways,	it	is	important	to	get	to	know	them	as	early	as	possible
It	is	normal	to	feel	confused	about	Blending	Modes,	at	first,	and	it	is	okay	if	you	still	feel	so

right	now,	but	you	will	get	used	to	them	the	more	you	experience	working	with	them
To	make	them	easier	to	understand,	I	divided	Blending	Modes	into	5	groups,	depending	on

what	the	modes	in	each	group	do
The	Normal	Group	is	the	most	straightforward	among	the	blending	modes,	as	they	do	simple

but	useful	things,	like	making	fuzzy	strokes	or	going	behind	the	current	pixels.	The	Behind	&
Clear	Modes	are	only	available	to	the	brush	Tool
The	darken	group	mix	the	two	colors	and	produce	a	darker	color	along	the	way
The	Lighten	group	does	the	opposite	of	that,	it	mix	the	two	colors	to	produce	a	lighter	one
The	contrast	group	produce	different	types	of	lights,	while	this	may	not	be	an	accurate	way	to

describe	them,	it	does	the	job	very	well.
The	other	4	modes	takes	the	color	away	from	your	pictures	by	subtracting	or	dividing	the

color	and	the	like



The	color	components	group	allows	you	to	apply	certain	parts	of	your	colors	on	your
picture,	for	example,	the	color	blending	mode	allows	you	to	change	the	colors	of	your	picture
to	the	one	of	your	brush

Loading	new	brushes	In	Photoshop	and	creating
new	ones

One	of	the	best	features	of	the	brush	tool	is	the	ability	to	change	the	brush	you	are	using.	And	choose
from	various	brushes	available	in	Photoshop.	And	if	those	were	not	enough,	you	could	download
more	brushes	online	and	even	create	your	own.	Making	your	brushy	world	unlimited	in	space	and
capabilities.
	
To	change	the	brush	you	are	using,	just	right	click	anywhere	on	the	canvas,	and	then	select	the	brush
you	would	like	to	use.	You	could	also	do	that	by	opening	the	brushes	preset	panel	by	selecting
Window->Brush	Presets.



The	brushes	dialog,	where	you	can	change	the	brush	you
are	using

The	brushes	presets	panel

Play	around	with	the	various	brushes	to	see	how	they	look	like.	Here	are	6	examples	of	some	of	the
brushes	that	come	with	Photoshop:-





Loading	new	brushes	to	Photoshop	from	presets.
Photoshop	comes	with	more	brushes	than	displays	in	the	brushes	option	dialog	or	the	brush
preset	panel.	But	you	have	to	tell	it	to	load	them	for	you.	
	

Click	on	the	triangle	at	the	corner	of	the	brushes	option	dialog	or	the	brushes	preset	panel.
You	see	a	various	set	of	brush	presets	you	could	load.



	

Select	the	preset	you	want	to	load,	I	selected	the	M	Brushes	preset	myself



	

Photoshop	will	ask	you	if	you	want	to	replace	the	current	loaded	presets	with	the	one	you	are
loading.	If	you	choose	“OK”,	Photoshop	will	unload	all	the	brushes	you	have	and	only	keep	the
ones	in	the	new	preset.	Which	is	not	what	we	want	to	do.	So	select	“Append”	to	load	the	new
preset	to	the	brushes	panel,	while	keeping	the	ones	we	already	loaded.

	
Et	Voilà,	the	brushes	will	be	there	in	the	brushes	dialog	or	the	brushes	panel.	Ready	for	you	to	use~

Loading	new	brushes	in	Photoshop	after	downloading
them	from	the	web



The	online	world	is	full	of	brushes	you	could	download	and	use,	usually	for	free.	And	there	are	many
sites	specialized	in	brushes	where	you	can	download	from.	For	this	part	of	the	chapter,
we	are	going	to	download	and	add	the	Starfields	Brushes	from	MyPhotoshopBrushes.com
	

Go	to	the	following	URL,	which	is	where	I	found	the	StartField
brushes:-	http://myphotoshopbrushes.com/brushes/id/3390/
Click	on	the	download	brush	bottom.	Marked	by	the	blue	rectangle	in	the	following	picture:-

	

Unpack	the	zip	file	you	downloaded,	for	instructions	on	how	to	do	that,	click	here
On	my	computer,	simply	clicking	on	the	resulting	unzipped	file	adds	the	new	brushes	to

Photoshop.	But	just	in	case,	I	will	explain	how	to	add	the	brushes	to	Photoshop	manually

Click	on	the	triangle	at	the	corner	of	the	brushes	option	dialog	or	the	brushes	preset	panel

http://sweetmonia.com/Sweet-Drawing-Blog/wp-admin/MyPhotoshopBrushes.com
http://myphotoshopbrushes.com/brushes/id/3390/
http://www.wikihow.com/Open-a-.Zip-File-Without-Winzip


	

	

Select	Load	Brushes	from	the	menu,	which	will	open	the	Open	dialog

	

Locate	the	brushes	you	downloaded	in	the	file	system,	and	then	press	OK.



And	we	are	done;	the	brush(s)	will	be	available	to	you	just	like	any	other	brushes,	ready	for
you	to	use	them.

Here	are	some	sites	where	you	could	download	more	brushes:-

Deviant	art
http://www.brusheezy.com
http://myphotoshopbrushes.com

A	Word	About	downloading	brushes	online	and
copyrights	issues
I	am	not	a	lawyer	and	can’t	really	give	you	a	legal	advice,	but	it	is	important	to	give	you	a	word	about
what	you	could	do	with	the	brushes	you	download	online
The	person	who	created	the	brushes	is	the	one	who	chooses	where	the	copyright	terms	goes.	He	can
give	it	away	or	sell	it	for	a	certain	amount	of	money.	The	terms	are	different	based	on	what	the	author
states	in	the	brushes	description.	Some	are	free	to	use	for	non-commercial	purposes.	But	you	will
have	to	pay	to	be	able	to	use	them	commercially.	Some	requires	you	to	give	attribution	to	the	author
when	you	use	them,	and	without	having	to	pay	anything.	So	make	sure	you	read	the	brushes
description	carefully	before	using	them:-

http://www.deviantart.com/browse/all/?q=photoshop+brushes
http://www.brusheezy.com/
http://myphotoshopbrushes.com/


Brusheezy	term	for	a	certain	brush,	the	creator	states	that	the	brushes	are	free
of	royalties,	meaning	you	won’t	have	to	pay	to	be	able	to	use	them

Some	brushes	more	terms	associated	with	them,
like	having	to	pay	for	them	for	use	in	commercial	purpose.	So	you	have	to	check	the	site	you	download	the	brushes	from	just	in	case



The		Starfields	Brushes	we	added	to	Photoshop
just	now	are	free	for	both	personal	and	commercial	purpose.

Creating	your	own	brushes	in	Photoshop
One	of	the	best	things	about	brushes	in	Photoshop	is	the	ability	it	gives	you	to	create	your	own
brushes,	which	gives	you	an	unlimited	range	of	abilities.	Right	now,	we	are	going	create	a	double
brush.	A	brush	that	simply	create	two	parallel	strokes	instead	of	one.
	

Create	a	new	Photoshop	document	(select	File->New	from	the	main	menu)
Select	the	brush	tool	from	the	Tools	Panel
Add	two	strokes	that	are	side	by	side,	like	what	you	see	here:-

Select	the	two	strokes	using	the	Rectangular	Marque	Tool	



Select	Edit->Define	Brush	Preset	from	the	main	menu

A	dialog	appears	asking	you	to	name	the	brush,	let’s	call	it	“Double	Brush”

Click	OK	And	we	are	done,	and	the	new	brush	will	be	available	in	the	brushes	dialog	or	the
Brushes	Presets	Panel



Now	let’s	try	the	new	brush,	as	you	can	see,	it	creates	two	parallel	strokes	instead	of	one	:D

Examples
Drawing	a	space
Creating	a	space	using	the	star	field	brushes,	I	did	two	examples,	one	that’s	simple	that	represents	a
simple	and	tranquil	space.	And	the	other	which	represents	a	glamorous	one.



Creating	a	banner
For	those	learning	Photoshop	to	create	signatures	and	banners,	I	created	this	simple	banner	using	few
brushes	that	represent	plants.	And	also	used	some	butterflies	brush.	If	you	looked	carefully,	you	will
notice	that	I	applied	the	color	dodge	at	the	middle	of	the	border	to	make	it	a	bit	lighter.	More	tweaking
of	the	banner,	plus	applying	a	bit	more	of	other	Photoshop	tools	(like	the	Type	tool),	can	make
this	banner	look	even	better	:D



Grasses	Owl
With	the	grass	brush,	I	hid	this	cute	owl	behind	some	grasses;	The	contrast	between	the	colors	in	this
brush	is	what	I	like	about	it

Adding	grasses	to	a	pictures
In	this	seemingly	complex	example,	I	added	new	grass	on	each	side	of	the	road.	To	give	the	grasses	a
more	natural	look,	I	drew	simple	shades	on	them	using	black	with	small	flow	value	of	the	brush,	and	I
applied	the	Hard	Color	blending	mode	on	them	frequently.	I	also	applied	a	little	white	using	the	soft
Light	Blending	mode	to	brighten	the	entire	picture	a	little	bit.



Summary
The	benefits	of	the	brush	tool	doesn’t	stop	at	adjusting	its	properties	or	having	a	lot	of

blending	modes	to	use,	but	it	extend	to	being	able	to	use	from	many	brushes	as	well
There	are	more	brushes	that	Photoshop	doesn’t	show	to	you	by	default,	but	you	tell	it	to	load

them	for	you	with	few	easy	steps
Beside	being	able	to	select	from	many	of	the	available	brushes,	you	can	also	make	your	own

as	well
And	to	make	things	even	better,	you	can	download	even	more	brushes	from	the	Internet,	there

are	virtually	an	unlimited	number	of	those	out	there,	and	many	of	those	are	free	to	use
Just	to	be	in	the	safe	side,	it	is	important	to	read	the	Brush	license	before	you	download	it,

specially	if	you	plan	to	use	it	for	a	commercial	purpose

Working	with	layers	and	manipulating	them

Layers	are	an	essential	part	of	Photoshop.	They	are	one	of	two	features	that	make	it	easy	to	create	and
edit	pictures	in	Photoshop	(Besides	the	selection	tool,	which	we	will	cover	in	the	next	chapter).
In	this	chapter,	I	will	teach	you	a	wide	range	of	layer	options.	I	will	focus	only	on	the	basics	of	layers
right	now.	But	I	will	consider	adding	more	contents	that	explain	the	more	advanced	options	of	layers
in	upcoming	editions	of	this	book
	
Photoshop	layers	haven’t	changed	at	all	since	forever	in	Photoshop,	so	whatever	you	are	using	one	of
the	later	versions	of	Photoshop	like	CS5,	CS6	or	CC,	or	an	old	version	like	Photoshop	6	or	7,	most



of	the	instructions	here	will	apply	to	your	version.

What	are	layers?
In	any	Photoshop	file,	Each	layer	can	be	considered	a	picture	on	its	own,	and	Photoshop	creates
the	final	picture	you	are	working	on	by	pilling	up	all	these	pictures/layers	on	each	other.	For
example,	take	a	look	at	the	following	sheep	picture.	Each	element	in	the	picture	is	drawn	in	a	separate
layer,	the	sky	is	in	its	own	layer,	so	is	the	meadow,	the	grass,	the	sheep,	and	the	sun~

The	final	sheep	image	is	made	by	putting	all	the	layers	one	over	the	other,	like	that:-



Simpler	drawing	programs	like	Microsoft	Paint	don’t	have	layers.	So	it	is	safe	to	say	that	in	Paint,	the
picture	consists	of	only	one	layer.	Which	makes	it	very	hard	to	create	many	things	that	are	easy	to
create	using	Photoshop	or	any	other	program	that	supports	layers.	

Working	with	Photoshop	layers
Now	you	understand	how	layers	work.	It	is	time	to	explain	how	to	work	with	them.	Like	how	to
create,	delete	and	arrange	layers,	and	a	few	other	things.	I	will	focus	on	how	to	do	that	from	the	layers
panel.	But	all	these	things	can	be	done	from	the	layer	menu	(in	the	main	menu)	as	well.

The	layers	panel



The	Layers	Panel	is	where	you	work	with	layer,	this	is	where	you	can	create,	arrange,	and	delete

layers.

	
~If	you	can’t	see	the	layers	panel,	choose	Window->Layers	from	the	main	menu	to	display	the	panel~

	

To	change	the	layer	you	are	drawing	on:-
Simply	click	on	the	layer	you	want	to	edit	in	the	layers	panel,	and	then	draw	on	your	canvas,	anything
you	draw	now	will	be	added	to	the	layer	you	selected

To	change	the	size	of	the	thumbnail	of	the	layers:-
Click	on	the	triangle	at	the	corner	of	the	layers	panel



Select	Panel	Options	from	the	menu

The	layer	panel	options	appear,	where	you	can	select	one	of	the	four	options	sizes	for	the
thumbnail	of	the	layer.	You	can	either	have	no	thumbnail.	Small,	medium,	or	big	one.	Select	the
size	you	want	then	click	OK.

To	create	a	new	layer	
Click	on	the	create	new	layer	button	in	the	layers	panel



A	new	layer	will	appear	in	the	layers	panel	above	your	currently	selected	layer.

To	arrange	layers	in	the	layers	panel
Sometimes	you	want	a	certain	layer	to	be	above	another,	you	probably	created	a	new	layer,	and	it	was
not	in	the	position	you	wanted	it	to	be.	Or	you	are	experiencing	with	different	kinds	of	effects.
Rearranging	layers	in	Photoshop	is	easy,	all	you	have	to	do	is:-

Click	on	the	layer	you	want	to	change	its	place.	And	keep	holding	the	mouse	bottom
Drag	the	layer	up	or	down	where	you	want	it	to	be.	Photoshop	will	mark	where	the	new	layer

will	be	after	you	release	the	mouse	button,	like	you	see	in	the	following	picture:-

If	you	found	it	a	bit	hard	to	place	your	layer	where	you	want	it,	you	can	change	the	size	of	the	layer



thumbnail	like	I	explained	above.	

Deleting	Layers	
Sometimes	you	create	layers	and	end	up	not	using	them	at	all.	And	sometimes	you	realize	that	a
certain	layer	is	totally	unneeded.	You	can	easily	delete	a	layer	by:-

Selecting	the	layer	you	want	to	delete	from	the	layers	panel
Then	pressing	the	delete	button	at	the	bottom	of	the	panel

Renaming	layers	from	the	layers	panel,	the	fast	way
Double	click	the	name	of	layer	you	want	to	rename.	Make	sure	you	don’t	click	outside	the

name	of	the	layer,	which	opens	the	blending	options	dialog.
Type	the	new	name	of	the	layer	that	you	want
Press	Enter,	and	the	layer	name	will	be	changed~



Changing	the	name	and	color	layers	from	the	layers
properties	dialog(Photoshop	CS5	and	earlier)
The	layer	properties	dialog	allows	you	to	change	the	name	and	color	of	the	selected	layer.
Choosing	colors	for	your	layers	is	a	helpful	feature	that	makes	it	easier	to	organize	your	layers;	this
is	especially	useful	when	you	have	a	lot	of	layers	in	your	picture.	
	

To	display	the	layer	properties	dialog,	simply	right-click	on	the	layer	you	want	to	change	its
name	or	color.	Then	select	“Layer	Properties”	from	the	context	menu

The	Layer	Properties	dialog	appears.

Now	feel	free	to	rename	your	layer	and	select	a	color	for	it.	Here	is	how	the	layer	panel
looks	like	after	I	chose	a	color	for	all	the	layers	in	the	sheep	picture



	

Hide	and	show	layer
You	can	hide	any	layer	at	any	time;	This	is	useful	to	see	the	picture	without	one	of	the	objects	of	it.	To
hide	a	layer,	simple	click	on	the	eye	icon	besides	the	thumbnail	of	the	layer,	as	shown	here:-

To	display	the	layer	again,	click	again	where	the	eye	icon	was.	Here	is	the	cute	sheep	picture
after	hiding	the	sheep	from	it:-



Your	old	friends	are	here	as	well,	fill,	opacity	and
blending	mores	applies	to	Photoshop	layers	as	well
I	focused	on	these	features	in	the	first	few	chapters	because	they	are	available	in	more	than	one	place
in	Photoshop.	Which	means	that	if	you	became	used	to	working	with	them,	you	will	be	able	to
use	them	many	times	over.

For	detailed	explanation	about	opacity	and	fill	of	the	brush	tool.	You	can	refer	to	“Getting
Starting	With	The	Brush	Tool”	chapter
For	blending	modes	explanation.	You	can	read	the	“Blending	Modes	Of	the	Brush	Tool”

chapter
The	good	thing	about	layers	blending	modes	is	that	you	can	change	them	however	you	want,

and	if	you	don’t	like	a	certain	blending	mode,	you	can	change	it	to	another	without	any
problem.

	
Let’s	start	by	changing	the	fill	of	the	Sheep	layers,	which	turned	them	into	ghosts~

Here,	I	changed	the	blending	mode	of	the	grass	layer	to	linear	light,	making	it	so	bright



	Then	I	changed	it	into	difference,	which	made	them	look	so	dark

Changing	the	blending	mode	of	layers	is	one	of	my	favorite	tricks	that	I	always	use	when	I	edit	and
create	pictures.	In	the	examples	section	at	the	end	of	the	chapter,	I	will	show	you	a	few	more	ways	on
how	to	use	that.

Some	useful	tips	&	tricks	about	layers
The	chapter	is	officially	done.	But	I	felt	that	these	tricks	should	never	be	omitted,	and	the	earlier	you
learn	them	in	your	journey	to	learn	Photoshop,	the	better.

Selecting	layers	quickly
Sometimes,	selecting	a	certain	layer	from	the	layers	panel	can	be	tedious	and	time	consuming.
Especially	when	you	have	too	many	layers	in	your	document	to	choose	from.	Fortunately,	there	is	a
little	trick	on	how	to	choose	layers	quickly	using	the	move	tool.	
	



Select	the	move	tool	from	the	tools	panel:-

Make	sure	that	the	Auto-Select	option	is	selected	from	the	options	panel

	

Now,	click	on	any	object	on	the	picture	and	Photoshop	will	automatically	switch	to	the	layer
of	that	object.	In	our	sheep	picture,	clicking	on	one	of	the	sheep	will	select	the	sheep	layer.	And
clicking	on	the	sun	will	select	the	sun	layer,	and	so	on.
Also,	you	can	Right-click	on	the	object	you	want	to	select	and	Photoshop	will	display	a	list	of

the	layers	that	has	pixels	where	you	clicked.	This	is	useful	when	it	hard	to	select	a	certain	layer,
especially	if	its	contents	are	hidden	below	another	layer:-

	 	

The	layer	lock	modes
Lock	modes	is	a	way	to	prevent	you	from	accidentally	modifying	a	certain	aspect	of	a	layer.	If	you
locked	one	of	these	aspects,	you	won’t	be	able	to	modify	that	aspect	until	you	unlock	it	again.	This	is
useful	when	you	want	to	protect	your	layers	from	being	changed	accidentally.	This	can	also	be	used
as	a	trick	to	edit	picture	in	certain	ways.	
There	are	4	lock	modes	available	to	each	layer,	which	we	will	take	a	look	at	below.	



The	4	lock	modes	available	to	each	layer	are:-
	

Lock	Transparent	Pixels:-		If	you	locked	the	transparent	pixels	of	a	certain	layer	(the	empty
pixels	in	the	picture),	you	won’t	be	able	to	paint	on	them.	And	only	the	pixels	that	are	already
there	will	be	editable	until	you	unlock	the	transparent	pixels	again.

Let’s	say	I	wanted	to	change	the	sheep	in	the	pictures	to	be	black	instead	of	white.	So	I	go	on	and	lock
the	transparent	pixels.	Now	that	I	can’t	add	any	new	pixels	to	the	sheep	layer,	I	simply	paint	over	the
sheep	with	black	to	change	their	color:-

Locks	Image	Pixels:-	Locking	the	image	pixels	means	that	you	won’t	be	able	to	paint	on	that
layer	at	all.	The	only	thing	you	could	do	to	the	layer	is	to	move	it	using	the	move	tool	or	other



moving	tools
Lock	position:-	If	you	locked	the	position	of	a	certain	layer,	it	means	that	you	won’t	be	able

to	move	the	objects	inside	of	it	using	any	of	the	moving	tools.	But	you	will	be	able	to	paint	on
it.
	Lock	All:-	Lock	everything	in	the	layer:-	Meaning	that	you	won’t	be	able	to	neither	paint	on

the	picture	or	move	the	objects	in	it

The	background	layer
Have	you	ever	wondered	what	is	this	background	layer	you	see	every	time	you	create	a	new	image	in
Photoshop?	The	background	is	a	layer	just	like	any	layer	except	that:-

It	can’t	contain	any	transparent	pixels.	A	transparent	pixel	simply	means	that	there	are	no
pixels	in	that	certain	part	of	the	layer.	Or	empty	pixels	you	could	say,	and	that	you	can	see	the
pixels	of	the	layer	below	it	(if	there	is	a	layer	below	it).
You	can’t	move	it,	rotate	it,	or	resize	it.
The	background	layer	is	always	at	the	bottom.	There	can’t	be	any	other	layer	below	it.

To	put	it	simply,	the	background	layer	is	a	layer	that	is	all	locked,	and	can’t	be	unlocked	using	the
lock	buttons	in	the	layers	panel.	It	can’t	have	transparent	pixels.	So	unless	you	converted	the
background	layer	into	a	normal	layer,	which	is	useful	if	you	want	your	final	picture	to	have
transparent	pixels,	you	can	only	paint	on	that	layer	and	nothing	else.

To	change	the	background	layer	to	a	normal	layer,	do	the
following:-

Select	Layer	>	New	>	Layer	From	Background	from	the	main	menu

The	new	layer	dialog	appears.	Type	a	name	for	the	new	layer,	and	then	click	on	the	OK	button



The	background	layer	became	a	normal	layer	now,	which	can	be	treated	just	like	any	other
layer	in	your	Photoshop	file.

	

To	make	the	selected	layer	a	background	layer,	do	the
following:-

In	the	layers	panel,	select	the	layer	you	want	to	turn	into	background	layer
Select	Layer->New->background	From	layer	from	the	main	menu

The	current	layer	is	converted	into	a	background	layer	and	is	placed	below	all	the	other
layers

Unserstanding	Layer	Mask
Layer	Mask	is	a	way	to	hide	or	conceal	some	of	the	pixels	in	a	given	layer,	but	without	actually

deleting	them.	This	means	that	by	modifying	the	mask,	you	can	determine	which	pixels	are	visible	in

the	layer	and	which	are	not.

When	you	create	a	Layer	Mask,	a	small	rectangle	appears	besides	the	layer	you	added	the	mask	to:-



The	black	areas	in	the	mask,	the	one	you	see	in	the	layers	panel	picture	above,	determine	the	areas	that
are	hidden,	and	the	white	areas	determine	the	area	that	are	shown	(and	as	you	may	have	guessed,	the
gray	areas	become	transparent)
To	illustrate	how	Layer	masks	work,	take	a	look	at	the	following	train	picture,	which	has	no	mask
applied	to	it	yet:-

After	applying	the	following	mask	to	it,	which	is	all	white	&	black:-



We	get	the	following	picture:-

And	besides	white	and	black,	you	can	apply	gray	as	well,	like	this	mask:-



Which	produces	the	following	result:-

Since	you	know	now	how	Layers	Mask	work.	Let’s	get	to	how	to	create	Layer	Masks

Working	With	Layers	Masks
To	create	a	layer	mask,	all	you	have	to	do	is	to	select	the	layer	you	want	to	add	mask	for,	and	then
click	on	the	“Add	Layer	Mask“	button	in	the	same	panel



After	you	click	on	the	“Add	Layer	Mask”	button,	the	mask	will	appear	besides	the	layer	int	he	Layers
Panel:-

Now,	clicking	on	the	mask	then	painting	on	the	picture	allows	you	to	change	the	parts	of	the	picture
that	are	shown	and	those	that	are	not:-



Examples
Make	an	image	brighter
All	the	tricks	you	learned	in	the	blending	modes	chapter	can	be	applied	here	as	well,	I	made	the
following	penguins	picture	brighter	by	creating	a	new	layer	above	it.	Filling	that	layer	with	white,
then	changing	that	layer ’s	blending	mode	to	Soft	Light

Surround	Eiffel	Tower	With	A	Thread
I	made	the	thread	in	the	following	picture.	Which	revolves	around	the	Eiffel	Tower	by	placing	it	in	3
layers,	two	that	are	below	the	Eiffel	Tower	layer,	and	one	that	is	above	it



Here	are	how	the	layers	were	made	and	arranged:-
	

Blending/Mixing	Two	pictures	together
Blending	two	different	images	using	blend	modes	is	an	easy	way	to	create	a	various	kind	of	tricks,
let’s	say	we	have	the	following	two	flowers	pictures:-
	



	
We	can	mix	the	two	pictures	using	the	Lighten	blending	mode	(or	any	blending	mode	you	like)	to
create	the	following	picture:-

And	at	the	end,	I	would	like	give	a	special	thank	to	Wikipedia	for	the	flowers	&	penguin	pictures	I
used	in	this	chapter.

Summary
Layers	are	a	transparent	picture	you	can	draw	on.	Photoshop	produces	the	final	picture	by

piling	up	all	the	layers	above	each	other
Every	time	to	paint	using	the	brush	tool	or	any	other	tool,	Photoshop	will	add	the	newly

painted	pixels	to	the	currently	selected	picture	in	the	layers	panel
You	can	create	as	many	layers	as	you	want,	creating	layers	can	be	done	by	clicking	the	New

Layer	button	in	the	Layers	panel
And	the	same	can	be	said	about	deleting	layers,	as	clicking	the	Delete	Layer	button	in	the

Layers	Panel	removes	the	currently	selected	one
Renaming	layers	can	be	done	by	double-clicking	on	their	name	and	entering	the	new	layer

name
Prior	to	Photoshop	CS6,	you	could	open	the	Layer	Properties	dialog	and	enter	a	new	name

for	the	layer,	as	well	as	changing	the	name	of	that	layer

http://wikipedia.org/


As	from	Photoshop	CS6,	you	can	no	longer	change	the	colors	of	your	layers	as	far	as	I	know
:(
Each	layer	in	Photoshop	has	its	own	Blending	Mode,	which	can	makes	it	easier	to	achieve

many	things	compared	to	doing	them	using	the	brush	tool	only
Besides	Blending	modes,	each	layer	has	its	own	fill	&	opacity	settings,	which	work	the	same

as	we	have	seen	with	the	Brush	Tool
The	Move	Tool	can	be	used	to	easily	select	the	layers	as	long	the	Auto-Select	checkbox	is

selected
There	are	4	lock	mode	for	each	layer,	these	lock	modes	prevent	you	from	editing	the	pixels

of	the	layer,	editing	the	transparent	pixels,	moving	the	contents	of	the	layer,	or	all	of	those
The	Background	layer	is	a	special	layer	that	is	always	below	the	other	layers,	can’t	be	moved

and	can’t	have	transparent	pixels
The	Background	layer	can	be	converted	to	a	normal	layer	if	needed,	and	you	can	also	pick	up

any	layer	and	convert	it	into	a	background	layer,	in	which	case	it	will	be	forced	to	become	the
bottom	layer

Photoshop	selection	tools

Photoshop	Selecting	tools	are	among	of	the	most	handy	tools	in	the	program.	Using	these	tools,	you
will	be	able	to	control	which	part	of	the	picture	can	be	modified.	Which	is	one	of	the	main	features
that	separate	Photoshop	from	simple	drawing	programs,	like	Microsoft	Paint
	
In	this	chapter,	I	divided	Photoshop	selection	tools	into	3	groups,	the	shapes	groups,	the	lasso/	thread
group	and	the	wands	group.	I	won’t	cover	the	pen	tool	right	now,	because	I	think	it	deserves	its	own
dedicated	chapter.

The	shapes	group



Just	as	the	name	suggests,	the	shapes	group	makes	selections	that	takes	after	a	shape.	The	Rectangular

Marquee	Tool	makes	a	selection	of	the	shape	of	a	rectangle.	The	Elliptical	Marquee	Tool	makes

elliptical	shapes.	And	the	Single	Row	Marquee	tool	and	the	Single	Column	Marquee	Tool	make	a

single	row	or	column	of	pixels	respectively.	We	will	take	a	look	at	each	of	them	in	turn:-

The	Rectangular	Marquee	Tool	
Obviously,	the	Rectangular	Marquee	Tool	makes	rectangular	selections.	This	is	useful	if	the	area	you
want	to	edit	is	of	the	shape	of	a	rectangle	or	a	square.	It	is	also	a	nice	way	to	draw	rectangles	by
selecting	an	area,	and	then	filling	it	with	the	brush	tool	or	any	other	tool.
	
After	you	make	a	selection.	The	area	you	selected	will	be	surrounded	by	a	dashed	lines,	like	this:-

You	are	now	free	to	paint	inside	this	area	however	you	want,	without	worrying	whatever	any	of	your
strokes	will	escape	the	area	you	selected.

	
Candy	Tip:-	Hold	the	shift	button	while	making	the	selection	to	create	a	square	selection.	You	can



also	hold	the	alt/option	button	to	make	the	selection	center	around	the	point	you	clicked	on	to	start	the
selection

The	Elliptical	Marquee	Tool	
Similar	to	the	Rectangular	Marquee	Tool,	the	Elliptical	Marquee	Tool	makes	elliptical	selections.
This	is	a	nice	way	to	draw	circles	in	your	pictures.

Note:-	To	access	the	Elliptical	Marquee	Tool,	click	and	hold	your	mouse	button	over	the	Rectangular
Marquee	Tool.	After	a	little	time,	the	rest	of	the	shape	selection	tools	will	appear,	this	is	applicable	to
all	Photoshop	tools	that	has	a	small	triangle	at	the	corner	of	their	icon.	Like	this:-	
	
	

Accessing	the	rest	of	Photoshop	Selection	Tools

	
Candy	Tip:-	The	same	trick	of	holding	shift	or	alt/option	while	making	the	selection	applies	to	the
Elliptical	Selection	Tool	as	well

Single	Row	Marquee	Tool	
The	Single	Row	Marquee	Tool	selects	one	full	row	of	pixels	with	one	click.	You	can	make	the	exact
same	selection	with	some	effort	by	using	the	Rectangular	Marquee	Tool,	and	then	selecting	one	row
of	pixels	from	your	picture.	To	be	honest,	this	is	a	kind	of	a	useless	selection	tool.	The	only	time	I
used	this	is	when	I	am	working	on	a	very	low-resolution	picture.	Like	a	forum	avatar,	and	wanted	to
select	one	row	of	the	border	of	the	image.
	
In	this	low-resolution	picture,	I	was	able	to	select	one	row	of	the	pixels	with	one	click	of	the	mouse
using	the	Single	Row	Marquee	Tool



Single	Column	Marquee	Tool	
Similar	To	The	Single	Column	Marquee	Tool,	the	Single	Column	selects	one	column	of	pixels	with
one.	And	again,	you	could	also	do	the	same	effect	using	the	Rectangular	marquee	tool.
	
Here	is	how	I	selected	one	row	of	pixels	with	one	click	of	the	Single	Column	Tool

The	Lasso	Group

According	to	The	Free	Dictionary,	Lasso	means:-
“A	long	rope	with	a	running	noose	at	one	end,	used	especially	to	catch	horses	and	cattle.	Also	called
lariat”.
The	lasso	tool	in	Photoshop	works	the	same	way,	but	instead	of	catching	cows	with	it.	You	catch	the
pixels	you	want	to	edit.
	
There	are	3	types	of	Lasso	tools.	The	Lasso	Tool,	and	Polygonal	Lasso	Tool	and	the	Magnetic	Lasso
Tools

The	Lasso	Tool	
If	I	were	to	give	a	name	to	the	Lasso	Tool,	it	would	be	“The	Free	Selection	Tool”.	The	lasso	tool
allows	you	to	draw	a	curve/thread	around	the	pixels	you	want	to	select.	This	is	specially	useful	way	to
make	selections	if	you	have	a	graphics	tablet.	But	even	with	that,	the	final	select	tend	to	be	less
accurate	compared	to	the	other	selection	tools
	
Here	is	a	rough	selection	I	made	of	a	cat	face	using	the	Lasso	Tool:-

http://www.thefreedictionary.com/lasso


The	Polygonal	Lasso	Tool	
The	Polygonal	Lasso	Tool	works	the	same	way	as	the	Lasso	Tool.	Except	that	instead	of	letting	you
freely	draw	the	line	you	want	to.	It	allows	you	to	draw	a	polygonal	shape	around	the	pixels.	This	is
very	useful	if	the	shape	you	want	to	select	is	rectangular	or	polygonal	in	general.	Like	this	gift	box:-
	

The	Magnetic	Lasso	Tool	
This	is	one	of	the	most	interesting	selection	tools.	It	is	one	of	the	reasons	you	will	be	happy	you
learned	Photoshop.	This	tool	works	like	the	Lasso	tool.	But	instead	of	letting	you	draw	the	selection
completely	on	your	own,	Photoshop	will	simply	do	the	work	for	you	by	detecting	the	edges	in	the



picture.
	
To	use	the	Magnetic	Lasso	Tool,	all	you	have	to	do	is	to	click	somewhere	near	the	edge	of	what	you
want	to	select.	Then	keep	dragging	the	cursor	around	it	until	it	is	selected.	Photoshop	will	do	most	of
the	work	for	you,	but	you	can	control	the	selection	more	by	adding	more	anchor	points	while	you	are
drawing	(by	clicking	on	the	left	mouse	button).
	
I	was	easily	able	to	select	the	man	in	the	following	picture	using	the	magnetic	lasso	tool,	it	took	me
only	a	minute	or	two	to	do	that

Then	I	pasted	the	man	into	another	picture.	Some	other	parts	of	the	background	were	caught	in	the
selection.	So	I	erased	it	using	the	eraser	tool	 .	Which	works	exactly	like	the	brush	tool	in	the	Clear
Blending	mode.



Some	of	the	Magnetic	Selection	Tool	settings

You	can	adjust	the	magnetic	selection	tool	settings	to	make	it	easier	to	make	your	selections	with	the
Magnetic	Lasso	Tool.

Width:-	Determines	how	many	pixels	away	from	the	mouse	cursor	Photoshop	examines	to
look	for	the	edges	in	the	object	you	are	selecting.
Contrast:-	Similar	to	the	tolerance	of	the	Wand	tool	(explained	below).	This	setting

determines	how	much	the	two	adjacent	pixels	should	be	different	for	Photoshop	to	consider
them	as	an	edge.
Frequency:-	Determines	how	many	anchor	points	(the	Points	of	the	path	you	draw	to	make

the	selection)	Photoshop	places	while	you	drag	the	mouse.	The	more	the	frequency	is,	the	more
points	Photoshop	will	add	to	the	path	you	make	the	selection.

The	Wands	Group

Instead	of	drawing	the	selection	yourself	just	like	you	do	using	the	Shapes	or	the	Lasso	group.	The
Wands	group	selections	are	made	with	one	or	few	clicks.	And	Photoshop	will	make	the	selection	by
looking	for	all	the	adjacent	and	nearby	pixels	that	are	close	in	color	to	the	pixel	you	clicked	on.	This
is	useful	when	you	want	to	select	a	large	portion	of	a	picture	that	looks	similar,	like	the	sky.

http://sweetmonia.com/Sweet-Drawing-Blog/wp-content/uploads/2014/11/The-Wands-Group.png


The	Wand	Tool	
To	use	the	Wand	tool,	all	you	have	to	do	is	to	click	where	you	want	to	make	the	selection,	and
Photoshop	will	do	the	work	for	you.
	
In	this	picture.	I	was	easily	able	to	select	the	green	rectangle	with	one	click	of	the	want	tool

And	it	was	not	that	hard	to	select	the	sky	in	this	picture	with	very	few	clicks	of	the	Wand	Tools

The	tolerance	of	the	Wand	Tool
The	wand	tool	has	an	interesting	setting,	called	the	tolerance.	It	is	found	at	the	settings	toolbar	(See	the
picture).

This	setting	allows	you	to	determine	how	much	the	adjacent	pixels	should	be	similar	to	the	one	you



clicked	on	to	be	included	in	the	selection.	0	tolerance	means	that	Photoshop	will	only	select	the	pixels
that	are	exactly	the	same	as	the	one	you	clicked	on.	The	more	the	tolerance	you	set,	the	less	similar
the	pixels	have	to	be.	Setting	the	tolerance	to	255	will	cause	the	Wand	tool	to	select	all	the	pixels	in	the
picture.
	
Experimenting	with	tolerance	level	can	be	useful	when	you	use	the	Wand	tool.	A	good	tolerance	level
to	start	with	is	30.	If	you	are	having	a	hard	time	selecting	the	area	you	want	using	that	tool	Then
consider	switching	to	another	selection	tool.
	
The	following	infographic	simplify	how	the	tolerance	setting	works:-
	

The	contiguous	setting	of	the	Wand	Tool
Another	interesting	setting	of	the	Wand	tool	is	the	contagious	check	box:-	

When	the	Contiguous	setting	is	checked,	the	Wand	tool	works	exactly	like	we	saw	before.	By
examining	the	pixels	adjacent	to	the	one	you	clicked	on	until	there	is	no	more	pixels	to	select.	When
this	setting	is	unchecked,	the	Wand	Tool	examines	all	the	pixels	in	the	picture.	Disregarding	where	it
is	or	whatever	it	is	besides	the	pixel	you	clicked	on	or	not,	which	results	in	selecting	multiple	areas	of
the	picture	with	one	click.



Notice	how	all	the	red	pixels	where	selected	in	the	following	picture	with	one	click	after	using	the
Want	tool	(with	Contiguous	unchecked),	despite	being	away	from	each	other

Sometimes,	if	you	tried	to	select	the	sky	with	Contiguous	unchecked.	Some	other	elements	of	the
picture	can	get	selected.	Like	how	parts	of	the	river	got	selected	in	the	following	picture:-	

When	to	avoid	using	the	wand	tool
Generally	speaking.	I	highly	advise	you	not	to	use	the	wand	tool	when	the	object	you	are	selecting	is
too	blended	with	the	background,	an	example	of	that	is	a	picture	of	a	girl	wearing	a	black	skirt,	and
part	of	the	black	skirt	is	blended	with	a	black	background	(or	another	black	object).	Making	selections
like	that	with	the	want	tool	can	be	hard	and	time	wasting,	but	at	the	end.	It	is	your	decision	to	decide	if
the	Wand	tool	is	best	for	the	job	or	now.

Sample	All	Layers
When	this	option	is	checked,	Photoshop	will	examine	all	the	visible	pixels	in	the	picture	you	are
working	on	to	see	if	they	fit	within	the	tolerance	level	of	the	Wand	Tool.	When	you	uncheck	this
option,	Photoshop	will	only	examine	the	pixels	in	the	layer	you	are	working	on.



	
To	demonstrate	how	this	option	work.	I	created	a	picture	with	a	black	square	on	one	layer,	and
another	smaller	black	box	on	the	layer	above	it,	Unless	you	can	see	the	layer	panel,	you	won’t	know
that	the	small	box	actually	exists,	here	is	how	the	layers	panel	looks	like:-

Making	a	selection	with	the	“Sample	All	Layers”	checked,	and	clicking	on	the	center	of	the	black	box
will	select	all	the	black	pixels	of	the	black	box.	Because	Photoshop	is	examining	all	the	pixels	in	the
picture,	disregarding	whether	they	are	part	of	the	selected	layer	or	not.

Now,	let’s	make	a	selection	with	“Sample	All	Layers”	is	unchecked,	and	with	the	small	box	layer
selected.	Clicking	on	the	center	of	the	black	box	will	create	the	following	small	selection.	Which	are
the	contents	of	the	current	layer	(the	one	that	contains	the	small	box)
	



The	Quick	Selection	Tool	
Sometimes	using	the	Wand	tool	won’t	deliver	you	the	results	you	wanted	with	one	click.	Like	when
you	have	a	picture	where	you	want	to	select	the	cloudy	sky.	But	the	clouds	won’t	be	selected	because
they	have	a	very	different	color	from	the	sky	itself.	In	many	cases,	clicking	using	the	wand	tool	again
and	again	(and	adding	to	the	selection	each	time	you	click.	Something	I	will	explain	how	to	do
shortly)	can	work	until	you	select	the	whole	sky.	But	this	can	be	done	easier	using	the	Quick	Selection
Tool.	Which	you	could	think	of	as	a	Wand	Tool	that	works	like	a	bush.	Instead	of	clicking	on	the
canvas	like	you	do	with	the	Wand	Tool.	You	drag	the	cursor	while	holding	the	mouse	button	as	if	you
were	painting.	And	Photoshop	will	keep	expanding	the	selection	for	you	based	on	the	pixels	you	are
“painted”	on.
	
If	you	like,	try	to	select	the	sky	in	the	following	picture	using	the	Wand	tool	and	see	how	easy/hard	it
is	to	select	it	using	the	it	(It	is	possible,	but	that	is	not	the	easiest	way	to	do	so).	After	that,	switch	to	the
Quick	Selection	Tool	and	keep	“painting”	little	on	the	sky.	Photoshop	will	create	a	very	accurate
selection	on	the	sky.

Here	is	how	my	selection	looked	like:-



What	about	the	Pen	Tool?	
The	pen	tool	is	one	of	the	most	powerful	drawing	and	selecting	tools	in	Photoshop.	I	am	still	not
aware	why	it	got	such	a	misleading	name,	as	it	doesn’t	do	what	a	pen	is	supposed	to	do,	which	is	to
write	or	draw.	But	don’t	let	that	confuse	you.
The	pen	tool	draws	virtual	lines	on	the	picture,	these	virtual	lines	are	called	vector	graphics.	After
you	draw	these	lines	with	the	pen	tool,	you	can	do	many	things	with	them,	like	converting	them	into	a
selection.
	
Because	of	many	of	its	huge	benefits,	the	pen	tool	is	worth	learning,	but	because	all	new	Photoshop
users	tend	to	get	confused	with	it,	many	of	them	tend	to	ignore	it	for	a	long	time.	Which	is	a	big	waste
for	them.	Because	of	the	importance	of	this	tool,	and	because	of	the	amount	of	explanation	it
requires.	I	have	decided	to	talk	about	it	in	its	own	chapter,	where	I	could	talk	about	it	in	details.
	
The	pen	tool	may	sound	boring	or	confusing	to	use	at	the	beginning,	but	you	should	push	yourself	to
learn	it	as	soon	as	possible.

Deciding	what	Photoshop	selection	tool	to	use?
At	this	point	of	this	chapter,	you	may	be	wondering	what	is	the	best	tool	to	use	in	each	occasion.	To
save	you	the	trouble,	just	use	whatever	tool	you	like	darling.	And	don’t	worry	much	about	which	tool
is	the	best	for	the	job.	Just	try	to	use	as	much	of	them	as	possible	when	you	are	new	to	them.	After
working	with	various	selection	tools	for	a	while,	you	will	be	able	to	make	your	own	decision	on
which	tool	to	use,	as	you	already	know	the	basic	differences	of	all	the	selection	tools	now	you
reached	this	part	of	the	chapter.

More	about	Photoshop	selection	tools
This	chapter	is	officially	done	here,	and	now	I	will	go	through	some	useful	options	that	are	so
helpful.	If	you	like,	you	can	read	this	part	later	and	go	straight	to	the	examples	at	the	end	of	the
chapter.



New	Selection,	Add,	subtract,	intersection	selection
Options

While	using	selection	tools,	you	may	have	noticed	some	little	squares	icons	at	the	side	of	the	options

panel.	These	are	the	options	that	determine	what	would	Photoshop	do	to	the	selection	you	made	when

you	create	a	new	one.	I	will	use	the	Marquee	Tool	to	show	you	examples	of	each	one	of	these	modes

New	Selection

By	default,	every	time	you	make	a	selection,	the	old	one	completely	disappears,	and	the	new	one
replaces	it.

	
With	the	new	selection	option	is	selected.	I	have	the	iMac	portion	of	the	following	picture	selected:-

And	once	I	started	to	make	a	new	selection,	the	old	selection	was	gone:-



Add	to	selection

When	this	option	is	selected.	Any	new	selection	you	make	is	added	to	the	current	one,	both	the	new

selection	and	the	old	one	stay.	This	is	especially	useful	with	the	Wand	tool	to	make	many	consecutive

selections	to	select	a	certain	area	in	the	picture.	If	the	new	selection	is	completely	within	the	original

selection,	nothing	really	happens

	
In	the	iMac	picture,	a	new	selection	was	made	in	addition	to	the	first	one,	increasing	the	area	we	can
edit	in	the	picture.



Then	I	made	a	third	selection	that	is	partly	inside	the	original	one,	which	made	Photoshop	expands	the
original	one	to	include	the	new	selected	area

Subtract	selection
With	this	option,	the	new	selection	is	subtracted	from	the	current	one.	If	the	new	selection	is
completely	outside	the	original	one,	nothing	happens
	
I	subtracted	a	part	of	the	iMac	selection	in	out	picture	using	the	Subtract	selection	option.



Then	I	subtracted	more	from	the	selection	the	same	way.	Creating	a	gap	in	the	original	selection

Intersection	with	selection

With	this	selection	mode,	Photoshop	creates	a	new	selection	that	consist	of	the	shared	area	of	the	two

selections.	

If	the	new	area	you	selected	is	completely	outside	the	area	of	the	old	selection,	both	selections	will
disappear,	and	you	will	get	the	following	message:-



I	made	the	new	selection	intersect	with	the	old	one	on	purpose	here,	here	is	how	the	selections	looked
like	before	I	released	the	mouse	button

Which	resulted	in	the	following	selection:-

Converting	a	layer	into	selection
Sometimes	you	want	to	create	the	selection	that	represents	all	the	pixels	of	a	certain	layer,	which	is



useful	in	an	innumerable	number	of	ways
	
Using	the	Magnetic	Lasso	Tool,	I	have	selected	the	following	Louis	Vuitton	bag	and	placed	it	in	a
separate	layer,	so	if	I	want	to	select	the	content	of	that	layer-	which	is	the	bag-	I	can	simply	turn	the
content	of	the	bag	layer	into	a	selection	with	the	following	steps:-

	

Hover	your	mouse	over	the	thumbnail	of	the	layer	you	want	to	turn	into	a	selection

Hold	the	Control	button	if	you	are	using	Windows,	for	Mac	users,	hold	the	Command

button.	The	mouse	cursor	change	from	a	hand	 	to	a	hand	with	a	selection	rectangle	alongside
it
Now	click	on	the	thumbnail	of	the	layer,	et	voilà,	the	layer	contents	has	been	turned	into	a

selection



Moving	the	content	of	a	selection
You	can	easily	move	the	selection	you	made	using	the	move	tool,	all	you	have	to	do	is	to	select	the
move	tool	 	and	then	drag	the	contents	of	the	selection	where	you	want	to
In	this	picture,	I	moved	the	contents	of	the	laptop	screen	after	I	selected	it	with	the	Rectangle	Marquee
Tool:-

	　　　Candy	Tip:-	hold	the	Alt/Option	button	before	and	while	you	drag	your	mouse	to
create	a	copy	of	the	selection	instead	of	moving	the	original	one.

	　　　Candy	Tip:-	You	can	move	the	contents	of	the	selection	using	the	arrow	keys	in	your
keyboard	as	well,		just	make	sure	that	the	move	tool	is	selected.

Moving	the	selection	instead	of	its	contents
Sometimes	you	make	a	mistake	while	making	a	selection,	And	so	you	want	to	move	the	selection	you
made	instead	of	making	a	new	one	from	scratch,	to	do	that,	make	sure	you	select	any	Photoshop	tool
other	than	the	move	tool	(It	doesn’t	really	matter	which	one),	then	move	the	selection	using	the	arrow

http://sweetmonia.com/Sweet-Drawing-Blog/wp-content/uploads/2014/11/Selected-Louis-Vuitton.png


keys	in	your	keyboard
	
In	the	following	example,	I	made	a	mistake	while	trying	to	select	the	laptop	screen,	but	I	fixed	that	by
moving	the	selection	a	little	to	the	right,	and	a	little	to	the	top:-

Candy	Tip:-	Holding	the	shift	button	while	moving	the	selection	using	the	arrow	keys	makes
the	selection	move	faster
	
	

Modifying	selections	after	making	them

You	can	make	some	nice	modifications	to	selections	after	making	them,	which	is	useful	in	many	ways
when	you	create	things	from	scratch	or	if	you	use	Photoshop	for	digital	painting.	Of	course,	you	can
use	them	in	more	ways	than	just	that.	The	modifying	options	I	am	talking	about	can	be	found	by
selecting	Select->Modify	from	the	main	menu.	To	be	able	to	use	these	options,	you	have	to	make	a
selection	or	the	images	will	be	grayed	out

Border
Border	creates	a	new	selection	that	from	the	outline	of	the	current	selection;	this	is	useful	way	to



create	empty	rectangles.

To	use	Border,	choose	border	from	the	Select->Modify	menu,	the	Border	Dialog	will	appear,	where
Photoshop	will	ask	you	to	select	the	width	of	the	border	selection.

Do	you	remember	all	the	pictures	in	this	book	of	chapters	where	I	mark	the	tool	I	am	talking	about
with	a	colored	rectangle	on	them?	The	ones	that	look	like	this:-

All	these	rectangles	were	created	by	making	a	rectangular	selection	with	the	Rectangular	marquee

tool	then	using	Border	to	create	an	outline	selection,	Which	I	then	paint	on	using	the	brush	tool^^

Smooth
Smooth	does	a	very	nifty	thing,	makes	the	corners	of	the	selection	more	rounded,	depending	on	the
radius	you	type	when	you	apply	this	option
Once	you	select	Smooth	from	the	Select->Modify	menu,	Photoshop	will	ask	you	to	input	the	radius
for	the	selection,	the	bigger	the	value	you	enter,	you	more	rounded	the	selection	will	become.

Here	is	a	summary	of	how	the	smooth	options	works:-



You	can	use	Smooth	selection	to	make	a

pictures	more	interesting	by	making	its	corners	rounder,	like	this:-

Expand
Makes	the	current	selection	bigger	by	the	amount	of	pixels	you	chose
The	following	selection	has	been	expanded	greatly;	notice	how	the	corners	became	rounder	because
of	that

Contract
Works	in	similar	fashion	to	the	Expand	options,	except	that	it	makes	the	selection	smaller	instead	of
bigger
This	following	selection	has	been	contracted	by	40	pixels,	notice	how	the	corners	have	not	been



affected	by	the	contraction	at	all

The	select	menu	options

The	Select	menu	has	4	nice-to-know	features	that	can	make	your	Photoshop	life	easier,	those	options

are,	All,	Deselect,	Reselect	&	Inverse.

All
Select	all	the	pixels	in	the	canvas/picture;	this	is	equivalent	to	selecting	all	whole	the	picture	using	the
Rectangle	Marquee	Tool.

Deselect
Make	the	current	selection	disappear;	if	there	is	no	selection	made,	this	option	will	not	be	selectable.

Reselect
Recreate	the	last	selection	you	made	but	then	deselected



Inverse
This	option	inverse	the	current	selection,	it	deselects	all	the	pixels	included	in	the	selection,	and	select
all	the	ones	that	are	not.

Examples
Time	to	play	a	little	with	the	selection	tools	we	looked	at,	like	always,	I	will	give	a	brief	explanation
how	I	worked	on	all	the	examples	below	:)

Creating	an	army	of	men	
Remember	our	friend	from	the	Magnetic	Lasso	Tool	Example?	I	decided	to	clone	him	and	send	him
with	his	clones	on	a	ship	to	invade	the	world,	here	are	my	troops:-

	
And	at	the	end,	we	reached	America~

Drawing	a	better	sky
This	is	one	of	the	most	common	tricks	done	with	the	selection	tools	in	Photoshop,	in	the	following



picture,	where	the	sky	looks	cloudy	and	dull,	I	selected	the	sky	using	the	Wand	tool	(With	30
tolerance).	And	then	pained	some	blue	on	it	using	the	brush	tool.
To	get	realistic	results,	I	reduced	the	fill	of	the	brush	tool	and	didn’t	paint	over	some	of	the	pixels	at
the	bottom	of	the	sky,	this	is	because	the	selection	of	the	Wand	Tool	was	not	%100	accurate.	If	I
pained	all	over	the	pixels	I	selected,	it	will	be	very	obvious	that	the	picture	has	been	Photoshopped.

The	New	Model
And	here,	I	added	a	new	model	to	in	the	gap	between	the	two	at	the	front.	All	I	had	to	do	is	to	make	a
selecting	of	the	model	at	the	front,	then	Place	her	in	its	own	layer.	And	then	paste	the	new	model	into
the	picture,	which	I	had	to	select	from	her	picture	the	same	way	too).
After	I	placed	The	model	in	her	place,	I	made	a	few	daps	with	the	brush	tool	so	the	Luminosity	of	the
new	girl	is	the	same	as	the	others,	or	else	to	will	be	so	obvious	that	the	girl	was	Photoshopped	into	the
picture

Moving	the	match	somewhere	else	
Changing	the	background	of	images	is	a	common	use	of	selection	tools.	Here,	I	selected	the
background	using	the	Wand	Tool.	Then	I	manually	erased	the	pixels	the	wand	tools	failed	to	capture,
and	then	pasted	the	new	background	picture,	which	I	made	sure	it	has	the	same	perspective	of
the	original	background



Superpower
I	don’t	want	you	to	forget	about	blending	modes.	As	they	can	be	useful	in	many	situations.	In	this
example,	I	removed	the	background	of	Gary	Oldman	picture,	placed	him	on	the	sky	of	the	field
picture.	Blended	him	with	the	sky	using	the	Overlay	blending	mode.	And	then	I	reduced	the	fill	of	the
layer	to	make	him	look	like	that.	I	made	a	few	strokes	of	the	brush	tool	using	the	Soft	Light	blending
mode	to	create	his	superpower.

Creating	a	simple	avatar
And	let’s	not	forget,	modifying	selections	is	a	great	way	to	add	borders	for	images,	just	like	how	I
did	crate	the	following	border	to	Yuina’s	forum	avatar:-
	

I	really	hope	you	benefited	from	this	Photoshop	selection	tools	chapter.	As	a	reward	for	you	for
completing	this	chapter,	I	would	like	to	tell	you	that	I	placed	a	copy	of	our	magnetic	tool	man	in	every
pictures	in	the	examples	sections,	so	go	over	them	again	and	have	some	lols	^^

Summary
Selection	tools	allow	you	to	select	a	certain	area,	and	after	you	make	your	selection,	only	that



part	can	will	be	editable	until	you	cancel	the	selection
The	shapes	group	selection	tools	allow	you	to	create	selections	that	looks	like	a	shape,	like	a

rectangle	or	a	circular	selections.	As	well	as	selecting	a	single	row	or	columns	of	pixels
The	Lasso	group	tools	allow	you	to	create	more	kinds	of	selections,	from	drawing	the

selections	freely	(using	the	Lasso	Tool),	to	draw	a	selection	by	drawing	a	polygon	(Using	the
Polygonal	Lasso	Tool),	to	selecting	a	certain	area	by	detecting	the	edges	of	the	object	you	want
to	select	(Using	the	Magnetic	Lasso	Tool)
The	Wand	Group	tools	create	selections	by	comparing	all	the	adjacent	pixels	with	the	one

you	clicked	on,	and	add	it	to	the	selection	if	it	falls	within	the	tolerance	of	the	used	tool.
The	Wand	Tool	Contaguous	option	determines	whether	the	tool	will	examine	all	the	pixels	in

the	picture,	or	only	those	adjacent	to	the	ones	added	to	the	selection
By	default,	the	Wand	tool	examines	only	the	pixels	in	the	current	layer,	but	by	checking	the

Sample	All	Layers	checkbox,	it	can	examines	all	the	pixels	in	all	the	layers	of	your	picture
And	by	default,	any	selection	you	make	replaces	the	existing	one,	but	you	can	tell	Photoshop

to	add	the	selection	to	the	currently	existing	one,	subtract	it	from	the	old	one,	or	make	a
selection	that’s	the	intersection	of	the	two
The	contents	of	each	layer	can	be	converted	into	a	selection	by	holding	down	the

Command/Control	button,	and	then	clicking	on	the	layer	thumbnail	in	the	layers	panel
Any	selection	you	make	can	be	moved	using	the	move	tool	to	any	place	you	want	in	your

pictures
And	as	long	the	move	tool	is	not	selected,	clicking	and	dragging	the	selection	will	move	the

selection	itself	instead	of	its	contents
There	are	5	selection	modifier	in	Photoshop:-	Border,	Smooth,	Expand,	Contract	&	Feather.

And	the	first	4	of	these	have	been	covered	in	this	chapter
Border	creates	a	selection	from	the	outline	of	your	selections,	think	of	it	as	a	way	to	select

the	borders	of	your	selection
And	Smooth	makes	the	edges	of	your	selection	rounder	or	smoother
Expand	makes	your	selection	bigger	by	the	amount	you	enter,	while	contract	makes	it	smaller

by	that	amount
The	Select	menu	has	4	useful	options,	which	are	All,	which	selects	all	the	pixels	in	your

picture,	Deselect,	which	makes	sure	no	pixel	is	selected,	Reselect,	which	remakes	the	last
selection	to	deselected	and	inverse,	which	deselects	all	the	selected	pixels,	and	selects	all	the
ones	that	are	not

Using	Photoshop	pen	tool,	and	an	introduction	to
Bézier	curves



I	personally	can’t	imagine	using	Photoshop	without	the	pen	tool.	It	is	a	common	tool	you	will	find	in
tons	of	graphics	software,	like	Adobe	Illustrator.
	
Photoshop	pen	tool	draws	Bézier	Curves.	Which	are	named	after	their	founder,	the	French	Engineer
Pierre	Bézier.	The	name	Bézier	has	nothing	to	do	with	what	the	curves	do.	These	Bézier	curves	have
many	uses.	Like	to	make	selection	or	to	be	filled	with	pixels.	We	will	take	a	look	at	each	of	these
functionality	in	details.

A	Word	From	The	Heart:-	Please	take	your	time	to	learn	Photoshop	pen	tool.	And	don`t
skip	this	chapter.	Photoshop	beginners	tend	to	ignore	this	tool	for	the	longest	time	possible.	Which	is
quite	a	loss	for	them.	Giving	the	amount	of	things	the	tool	can	allow	them	to	do.

Advantages	of	Photoshop	pen	tool	over	the	other	tools
Gives	you	lot	of	control	over	the	lines	you	draw
Pen	tools	curves	are	vector	graphics.	Vector	graphics	is	a	term	that	refers	to	a	kind	of	lines

and	shapes	the	computer	draw	using	mathematical	equations	instead	of	laying	down
pixels	beside	each	other	(which	is	called	raster	graphics.	Which	is	the	kind	of	picture	we	mostly
work	on	in	Photoshop).	The	advantage	of	vector	graphics	is	that,	no	matter	how	much	you
resize	them,	they	retain	their	quality.	That	is	because	the	computer	draws	them	from	scratch
when	needed	(again,	using	mathematical	equations).



Comparison	between	vector	graphics	&	raster	graphics,
picture	credit:-	Wikipedia

The	ability	to	make	complex	selections:-	Specially	in	the	situations	where	the	other
selections	tools	fail	or	can	hardly	make	the	selection.

An	easy	start,	drawing	straight	lines
Drawing	straight	lines	with	the	pen	tool	is	easy.	All	you	have	to	do	is	to	select	the	pen	tool	

.	Click	once	on	the	canvas	(where	you	want	your	line	to	start),	and	then	click	again	where	you
want	it	to	end.	And	Photoshop	will	draw	the	line	for	you.

After	that,	each	time	you	click	on	the	canvas	with	the	pen	tool,	you	create	a	new	anchor	point
(the	square	points	that	you	create	every	time	you	click	on	the	canvas).	And	a	new	line	will	be
added	starting	from	the	last	anchor	point	you	inserted.



Drawing	curves	using	the	pen	tool
Before	I	show	you	how	to	create	curves	using	the	pen	tool.	It	is	better	to	look	on	how	Bézier	curves
work.	Don’t	worry	much	about	how	to	create	these	curves	in	Photoshop	for	now.	This	will	be	covered
shortly.	Just	focus	on	understanding	the	concepts	for	now.

	Note:-	The	lines	you	draw	using	the	Pen	tool	are	called	Paths,	I	used	the	term	“Curves”	just
for	simplification.	So	when	I	say	curve	or	Path.	I	mean	the	same	thing.	

When	you	draw	using	the	pen	tool.	You	simply
draw	the	tangents	of	the	curve	you	are	creating,	instead	of	drawing	the	curve	itself.	And	Photoshop
will	draw	the	curves	for	you	interactively	for	you
	
These	tangents.	Which	you	control	using	the	handles	(small	lines	that	come	out	of	anchor	points),	are
what	determine	how	the	curve	looks	like
	

Let’s	take	a	look	at	the	following	straight	line,	which	is	straight	because	there	are	no	handles
coming	out	from	the	anchor	points.	And	the	curves	goes	from	the	first	point	to	the	second	one



After	I	made	handle	comes	out	from	the	anchor	point	at	the	bottom	(I	forced	it	to	come	out	of
the	point,	more	on	how	to	do	that	soon)	The	straight	line	has	turned	into	a	curve,	notice	how	the
line	seems	to	get	attracted	to	the	handle	and	try	to	follow	it.	So	by	moving	that	handle,	you
control	how	the	curve	looks	like.	The	good	thing	is,	you	come	back	at	anytime	and	modify	the
points	and	their	handles,	so	no	need	to	worry	about	making	mistakes	while	creating	the	curves.

	Note:-	Anchor	Points	that	have	no	handles	are	called	corner	points,	and	the	ones	that	have
them	are	called	curve	points.

To	illustrate	how	the	curve	seems	to	follow	the	handle	of	the	curve,	I	made	an	extreme	move
using	the	handle,	which	made	the	curve	arcs	sharply.



Notice	how	there	is	only	one	handle	coming	out	of	the	point.	It	doesn’t	really	matter	if	the	second
handle	exists	or	not.	Because	in	this	example,	the	second	handle	would	be	useless.	Because	it	controls
a	line	that	doesn’t	exist	(it	is	supposed	to	control	the	line	on	the	other	side	of	the	point,	as	we	will	see
shortly)	In	the	next	example,	you	will	see	how	important	the	second	handle	is.
	

Moving	to	another	example	with	three	points	instead	of	two,	as	it	may	seems	obvious	now.
Having	simple	points	with	no	handles	coming	out	of	them	produces	a	straight	line

After	creating	the	handles	that	comes	out	of	the	anchor	point,	the	straight	line	turned	into	a
curve	from	both	sides	of	the	point.	This	is	why	the	second	handle	point	is	important,	it
controls	the	line	on	the	other	side	of	the	anchor	point,	which	did	not	exist	in	the	first	example.



Again,	I	will	sharply	twist	the	curve	to	show	you	how	the	curve	follows	the	handles	of	the
anchor	point:-

And	of	course,	the	two	handles	don’t	have	to	be	on	the	same	line,	this	is	just	the	default	way
the	handles	are	when	they	are	created	in	Photoshop.

Here	are	few	examples	where	the	handles	are	not	in	the	same	line,	which	create	curves	with	a
pointy	edge.	That	is	because	for	the	curves	to	follow	the	handles,	they	have	to	meet	in	such
way:-



Notice	how	in	third	examples	the	second	handle	doesn’t	exists	(I	placed	it	inside	the	anchor
point),	making	the	line	it	controls	straight	again.
	
Once	you	understand	these	concepts.	You	will	be	able	to	draw	all	the	kind	of	shapes	using
Photoshop	pen	tools.	Which	is	useful	in	an	innumerable	ways.	Like	making	selections,	drawing
shapes	or	creating	creative	brushes	&	patterns.	Here	are	some	of	the	shapes	you	could	create	using
the	pen	tool:-

Various	shapes	that	has	been	created	using
Photoshop	pen	tool

	
Even	if	you	don’t	know	how	to	draw,	you	could	still	draw	things	that	way.	Since	Photoshop	will	do
most	the	work	for	you,	though	that	doesn’t	mean	you	shouldn’t	take	a	drawing	course	if	you	are	into
drawing.	Practicing	how	to	draw	shapes	like	that	is	important	to	get	used	to	the	tool.	If	you	spent	some
time	working	with	the	tool,	it	will	become	intuitive	to	you,	and	it	will	become	one	of	the	main	tools
you	use	in	your	photo	editing.

A	Word	From	The	Heart:-	If	you	still	feel	confused	about	what	you	learned	so	far,	don’t
worry	about	this.	It	is	normal	to	feel	that	way	the	first	way	you	learn	these	concepts,	but	you	will	get
used	to	them	after	some	time.	Many	of	these	concepts	will	be	repeated	in	the	next	few	paragraphs	to



ensure	you	end	up	with	a	good	understanding	of	them.

Using	Photoshop	pen	tool	In	Practice
Now	is	the	time	to	delve	into	how	to	use	the	pen	in	Photoshop;	we	will	start	with	straight	lines,	and
then	move	curves.	And	while	we	are	at	it,	I	will	show	you	some	useful	shortcut	that	will	make	it	faster
to	work	with	the	pen	tool

Drawing	straight	lines	with	Photoshop	Pen	tool
We	first	pick	the	pen	tool	 ,	which	is	located	in	the	tools	panel.
Then	we	click	to	create	the	first	anchor	point

Then	we	click	again	somewhere	in	the	canvas	to	create	the	second	anchor	point.	Once	you
create	the	second	point.	Photoshop	will	draw	a	line	between	these	two	points.

	

You	can	keep	clicking	until	you	are	done	creating	the	shape	we	want	to



If	you	want,	you	can	create	a	closed	shape	be	clicking	on	the	first	point	you	created	when	you
started	drawing	the	shape.	A	little	circle	º	will	appear	besides	the	cursor	once	you	hover	the
mouse	over	it.	Here	is	the	shape	after	I	closed	it:-

Getting	to	draw	carves
Drawing	curves	with	the	pen	tool	 	is	similar	to	drawing	straight	lines.	But	because	this	is	the	most
confusing	part	about	the	tool,	I	will	explain	it	in	more	than	a	way.
	

Drawing	Simple	Arc	With	Photoshop	Pen	Tool	1



Select	the	Pen	tool	
Click	on	the	canvas	to	create	the	first	anchor	point,	just	like	you	did	when	you	created	the

straight	lines	just	now

Now	click	on	the	canvas	to	create	the	second	point	anchor	point.	But	this	time,	instead	of
releasing	the	mouse	button.	Keep	holding	mouse	and	drag	it	in	any	direction.	The	two	handles
will	emerge	out	of	the	anchor	points	as	you	do	that.	And	the	straight	line	will	turn	into	a	curve.
Adjust	the	handles	however	you	want	then	release	the	mouse	button

	

Drawing	Simple	Arc	With	Photoshop	Pen	Tool	2



These	steps	are	similar	to	the	previous	one,	but	instead	of	creating	handles	out	of	the	second	anchor
point,	we	will	do	that	from	the	first	one
	

Select	the	Pen	tool	from	the	tools	panel	
Click	on	the	canvas	to	create	the	first	anchor	point,	but	instead	of	releasing	the	mouse	button,

keep	holding	it	and	drag	it	somewhere;	The	handles	will	come	out	of	the	newly	created	anchor
point.	But	since	you	only	created	one	anchor	point	so	far.	Nothing	will	appear	on	the	screen,	but
that	will	change	right	now

Click	somewhere	on	the	canvas	to	create	the	second	anchor	point.	And	Photoshop	will	create
a	curve	that	goes	from	the	first	anchor	point	to	the	other.	Depending	on	how	you	dragged	the
handles	in	the	first	step



Drawing	Simple	Arc	With	Photoshop	Pen	Tool	3
I	admit	that	you	may	have	gotten	bored	by	now.	But	it	is	important	to	emphasize	on	these	steps	in
different	ways,	because	if	you	understood	them	well,	you	can	manage	anything	else	in	this	chapter.

Select	the	Pen	tool	from	the	tools	panel	
Click	on	the	canvas	to	create	the	first	anchor	point.	But	instead	of	releasing	the	mouse	button.

Keep	holding	it	and	drag	it	somewhere.	The	handles	will	come	out	of	the	newly	creating	anchor
point

Click	on	the	canvas	to	create	the	second	point	anchor	point.	And	again,	instead	of	releasing
the	mouse	button,	keep	holding	it	and	drag	it	in	any	direction.	The	two	handles	will	emerge	out



of	the	anchor	points	as	you	do	that.	And	the	curved	will	be	emphasized.	Adjust	the	second	pair
of	handles	then	release	the	mouse	button
We	now	have	a	curve	that	is	controlled	by	both	the	handles	of	the	two	anchor	points	you

created.

Drawing	various	curves	using	3	lines
Now	you	are	familiar	with	drawing	an	arc	using	two	anchor	points.	It	is	time	to	move	to	drawing	a
curve	using	3	anchor	points.	And	while	we	are	at	it,	I	will	show	you	a	few	tips	on	how	to	control	the
handles	of	the	curve	to	achieve	very	nice	results.	Drawing	using	3	or	more	anchor	point	is	the	same
as	we	have	seen	so	far,	plus	a	one	or	two	more	things~
	

Since	you	are	now	aware	that	you	can	create	a	handle	from	any	point	you	draw,	I	will	stop	emphasizing	on	that	from	now	on~	:)
	

　　　 Candy	Tip:-	If	you	made	a	mistake	while	you	are	drawing	your	anchor	point,	simply
choose	Edit->Step	Backward	and	Photoshop	will	undo	the	last	step	you	made,	this	is	applicable	to
anything	you	do	in	Photoshop,	not	just	drawing	paths

Creating	a	simple	curve
Select	the	Pen	tool	from	the	tools	panel	
Click	somewhere	in	the	canvas	to	create	the	first	anchor	point



Click	and	drag	the	mouse	button	to	create	an	anchor	point	with	handles,	adjust	the	handles
however	you	want	then	release	the	mouse	button

Click	somewhere	in	the	canvas	to	create	the	3rd	anchor	point.



Creating	a	broken	curve
All	the	curves	we	have	drawn	so	far	are	smooth	ones,	that’s	because	the	two	handles	we	learned	to
create	are	on	the	same	line,	like	that:-a

To	create	a	broken	curve,	one	that	has	a	corner	at	one	of	its	anchor	point,	your	handles	should	look
similar	to	this:-



	
To	create	a	curve	like	that,	follow	these	steps:-

Select	the	Pen	tool	from	the	tools	panel	
Click	to	create	the	first	anchor	point

Like	you	did	when	you	created	the	curves.	Click	and	hold	the	mouse	button,	then	drag	the
cursor	to	make	the	handles	appear.	But	after	you	adjust	the	handle.	Don’t	release	the	mouse
button.	But	instead,	hold	the	Alt/Option	key	along	with	it.	This	will	cause	one	of	the	handles	to
freeze	in	its	place,	allowing	you	to	control	the	other	one.



Once	you	are	done	adjusting	the	second	handle,	release	the	mouse	button.
You	are	now	free	to	continue	drawing	the	curve	by	adding	more	points	to	it.	I	added	a	third

point	to	my	curve	after	I	was	done	with	it.

Drawing	curves	like	that	is	useful	in	more	than	a	way,	as	it	allows	you	to	controls	the	curves
you	are	drawing	more	efficiently.	Just	like	how	it	allowed	me	to	draw	the	following	cat	so
quickly:-	:3

	Candy	Tip:-	Holding	the	shift	button	while	you	draw	the	anchor	points	allows	you	to	draw
anchor	points	that	are	of	the	multiple	45	degree	from	each	other,	like	this:-



A	Little	Summary	Before	We	Continue
Anchor	points	without	handles	create	straight	line.	So	if	there	is	no	handles,	no	curves.
You	can	create	a	curve	by	creating	a	handle	out	of	any	of	the	anchor	points	you	are	inserting.
Anchor	points	without	handles	are	called	corner	points;	the	ones	with	handles	are	called

curve	points.
Handles	can	be	on	the	same	line.	Which	creates	smooth	curves.	Or	they	can	be	on	a	different

line,	making	the	curve	appear	abrupt	or	even	broken.

Editing	the	path	after	you	created	it
With	the	concepts	I	explained	so	far.	You	can	draw	any	curve	you	want	with	Photoshop	pen	tool	after
some	training.	But	that	doesn’t	mean	there	are	not	easier	ways	to	achieve	the	same	things.
Being	able	to	modify	your	curve	after	you	already	drawn	it	means	that	you	won’t	have	to	worry	about
getting	it	right	the	first	time	you	draw	it.	This	is	done	using	the	path	selections	tools	and	the	pen	tools
groups

The	path	selection	tools	group

This	group	consists	of	two	tools,	the	Path	Selection	Tool	 ,	and	the	direct	selection	tool	 .	These



two	tools	may	seem	similar	at	first.	But	they	are	completely	different	actually.

The	path	selection	tool	
The	path	selection	tool	allows	you	to	do	one	thing.	It	allows	you	to	select	a	curve	and	move	it
wherever	you	want.	All	you	have	to	do	is	to	select	the	path	selection	tool.	And	select	and	drag	the	path
you	want	with	your	mouse.
	
The	Path	Selection	Tool	is	very	useful	when	you	have	a	path	that	consists	of	more	than	one	curve.
Where	you	could	select	each	of	them	independently.
	

Moving	a	path	with	your	mouse	using	the	direct	selection	tool:-

Candy	Tip:-	Holding	the	Alt	/	Option	button	before	and	while	you	move	the	path	allows	you	to	create
a	copy	of	it	instead	of	moving	the	original	thing

The	Direct	Selection	Tool	
The	Direct	Selection	Tool	is	much	more	interesting	than	the	“boring”	Path	Selection	Tool.	It	allows
you	to	select	and	move	any	of	the	anchor	points	you	made.	Here	is	how	I	edited	the	simple	polygonal
path	of	the	previous	example:-



If	the	anchor	point	you	selected	with	the	tool	has	handles,	simply	clicking	on	it	with	the	direct
selection	tool	will	make	the	handles	appear	again,	allowing	you	to	edit	them	again:-

Unfortunately,	I	don’t	know	any	way	to	make	the	corner	point	(a	point	that	has	no	handles)	turn	into	a
curve	point	(one	that	has	handles)	and	vice	versa	using	this	tool.	But
that	can	be	done	using	other	tools,	like	the	Convert	Point	Tool	 ,	which	I	will	explain	in	the	next
section.

The	Pen	Tools	Groups

Add	Anchor	Point	Tool	
This	tools	allows	you	to	add	new	anchor	points	to	your	path	with	one	click.	All	you	have	to	do	is	to



select	the	tool	and	hover	the	mouse	on	the	part	of	the	cursor	where	you	want	to	add	your	point,	once
you	do	that.	The	cursor	will	have	a	little	“+”	sign	besides	of	it.	And	a	new	anchor	point	will	be	added
to	the	path	once	you	make	your	click:-

	

Delete	Anchor	Point	Tool	
The	tool	does	apposite	to	the	Add	Anchor	Point	Tool,	it	deletes	any	of	the	points	you	have	on	the	path,
all	you	have	to	do	is	to	hover	your	mouse	on	the	point	you	want	to	delete,	and	the	cursor	will	have	a
“-”	sign	besides	of	it.	Once	you	click	on	the	point,	it	will	be	gone.

The	Convert	Point	Tool	
The	convert	point	tool	is	-	in	my	opinion-	the	most	useful	tool	among	the	ones	in	this	group,	it	gives
you	the	ability	to	convert	corner	points	to	curve	points	and	vice	versa,	and	to	move	each	of	the
handles	of	the	anchor	points	separately.
	
Let’s	take	a	look	at	the	following	path,	which	has	both	corner	and	curve	points.	Clicking	on	the	curve
point	at	the	right	causes	the	handles	to	disappear.	Thus	turning	it	into	a	corner	point



And	clicking	and	dragging	on	the	corner	point	at	the	left	using	the	Convert	Point	Tool	causes	the
handles	to	appear	out	of	the	corner	point

And	this	nice	tool	allows	you	to	move	each	of	the	handles	separately,	which	is	so	convenient:-

Freedom	pen	tool	
Because	this	tool	has	nothing	to	do	with	modifying	curves,	I	made	it	the	last	one	to	be	explained	on
purpose.	The	Freedom	Pen	tool	works	like	the	Lasso	selection	tool.	It	allows	you	to	freely	draw	the
path	you	want	instead	of	inserting	points	and	adjusting	their	handles.	This	is	very	useful	if	you	have	a
graphics	tablet	and	wanted	to	create	a	complex	shapes	quickly.	And	of	course,	you	could	edit	the
resulting	path	the	same	ways	we	explained	above.
	
It	took	me	only	seconds	to	draw	the	following	“R”	using	the	Freedom	Pen	Tool:-



More	on	Photoshop	pen	tool	and	paths
And	like	always,	the	chapter	is	officially	done.	But	more	are	explained	in	a	dedicated	part	of	it.	If	you
don’t	feel	like	reading	this	part	right	now,	you	can	skip	to	the	examples	section

Turning	a	pen	curve	into	selection
As	mentioned	in	the	selections	chapter,	the	Pen	tool	is	considered	one	of	the	selection	tools.	And	it	is
among	of	the	most	powerful	ones.	Any	path	you	create	with	it	can	turn	into	a	selection	with	only	one
click.

First	create	the	path	you	want	to	turn	into	selection:-

If	you	can’t	see	the	Paths	Panel	anywhere	on	your	workspace,	choose	Window->Paths	from
the	main	menu.	And	the	paths	Panel	appears.



Hover	your	mouse	over	the	path	you	want	to	turn	into	a	selection,	and	then	hold	the	Control
button	(Command	if	you	are	using	a	Mac),	and	the	cursor	will	have	a	little	square	 	besides	of
it.

Now	click	on	the	path	icon	in	the	paths	panel.	And	the	path	will	turn	into	a	selection	right
away.

	

Feel	free	to	use	that	selection	however	you	want,	I	filled	the	selection	to	create	a	house
shape:-



Candy	Tip:-	Pressing	Control	+	Enter	(Command	+	Enter	for	Mac	users)	on	your	keyboard	is	another
way	to	turn	the	current	path	into	a	selection	;)

Filling	a	path	with	pixels	right	away
Instead	of	turning	the	path	into	a	selection	then	filling	it	with	pixels	like	we	just	did.	You	could	fill	the
path	with	one	click.	To	do	that,	follow	these	steps:-
	

Right	Click	on	the	path	you	want	to	fill,	and	then	choose	“Fill	Path”	From	the	Context	Menu

The	Fill	Path	dialog	appears.

Photoshop	allows	you	many	options	of	how	to	fill	the	path;	some	of	these	options	are	explained	in	the
Infographic	below.	And	some	of	them	will	be	explained	at	a	later	chapter,	but	for	now,	let’s	focus	on
filling	the	path	with	a	simple	color.



After	you	choose	the	color	you	want	to	fill	the	path	with.	Click	the	OK	button.	And	Photoshop
will	fill	the	path	for	you	with	the	color	you	chose.

Stroking	the	path
Stroking	the	path	means	making	it	looks	like	you	have	drawn	the	path	using	the	brush	tool	or	any
other	tool.	If	the	path	stayed	in	vector	state	(not	filled	with	pixels),	there	won’t	be	much	use	for	it.

To	stroke	a	any	path	you	created,	follow	these	steps:-	
Right	Click	on	the	path	you	want	to	turn	into	a	selection,	and	then	choose	“Stroke	Path”	from

the	Context	Menu	(If	the	path	has	more	than	one	part,	you	will	see	“Stroke	Subpath”	options
indeed	of	stroke	path).



The	Stroke	Path	dialog	appears

	

The	stroke	path	dialog	allows	you	to	select	the	tools	to	stroke	the	path	with.	The	settings	of
the	tool	you	select	depends	on	how	you	left	them	last	time	you	used	it.	For	example,	if	the	last
time	you	used	the	brush	tool	you	had	a	soft	brush,	the	path	will	be	stroked	with	that	soft	brush,
so	make	sure	you	adjust	the	tool	you	want	to	use	before	you	use	it	to	stroke	the	path.

Once	you	select	the	tool	to	stroke	the	path	with,	click	on	OK	on	the	dialog,	and	the	path	will
be	stroked.	Here	is	the	house	shape	after	stroked	with	two	kind	of	brushes:-



	

Stroking	paths	is	a	common	way	to	make	precise	drawings	in	Photoshop,	though	if	you	want
to	do	that	extensively,	I	highly	recommend	you	to	use	dedicated	vector	graphics	software,	like
Adobe	Illustrator.

Candy	Tip:-	Pressing	Enter	on	your	keyboard	will	stroke	the	selected	path	with	the	selected
tool	in	the	tools	panel,	for	example,	if	you	pressed	enter	while	you	have	the	brush	tool	selected,	the
selected	path	will	be	stroked	with	the	brush	tool.

Creating	more	than	one	path	in	a	single	Photoshop	document
You	can	have	more	than	one	path	in	your	Photoshop	document,	which	you	can	manage	from	the	Paths
Panel	(Choose	Window->Paths	to	view	it).	Creating	more	than	one	path	is	a	bit	unintuitive	for	new
users.	But	it	is	not	hard	at	all.
	

Draw	a	path	like	we	always	did	so	far,	I	drew	a	random	shape	right	here.	And	as	you	can	see,
the	path	will	appear	in	the	Paths	panel.



Now,	double-click	on	the	path	in	the	paths	panel.

The	“Save	Path”	dialog	appears.	Allowing	you	to	pick	a	name	for	the	path.	I	will	keep	the
default	name.	Press	OK	after	you	are	done	naming	the	path.

Make	sure	the	path	is	unselected	in	the	paths	panel	when	the	path	is	unselected.	It	is	unselected
when	the	name	of	the	path	won’t	be	highlighted,	And	the	path	won’t	be	visible	in	the	canvas,	like
this:-

	Note:-	If	you	forget	to	deselect	the	Path,	anything	you	draw	next	with	the	Pen	Tool	will	be
added	to	the	path.	Instead	of	being	made	into	a	newly	created	path.

Now	choose	the	Pen	Tool	and	draw	another	path,	the	new	path	will	appear	in	the	Path	panel.	If
you	want	to	keep	that	path	to	use	later,	you	will	have	to	save	it	as	well	by	double	clicking	on	its
name	in	the	paths	panel.



You	can	switch	between	the	paths	you	have	by	clicking	on	the	path	you	want	to	work	on	from
the	Paths	Panel.

Creating	a	path	with	more	than	one	part	/	curve
Paths	can	have	more	than	one	part;	the	house	shape	we	have	been	working	on	so	far	can	look	more
like	a	house	if	it	had	a	door	or	maybe	a	window.	So	in	this	exercise,	we	will	draw	the	house	from
scratch,	and	then	add	a	door	to	it.
	
After	you	draw	the	house,	each	part	of	the	house,	like	the	door	and	the	house	itself,	can	be	selected
and	moved	using	the	Path	Selection	Tool	
	

First,	draw	the	path	of	the	house	itself.	Just	like	we	previously	learned	before.	Holding	shift
while	adding	the	points	makes	it	very	easy	to	create	straight	and	45º	angles	lines.

Deselect	the	path	by	switching	to	the	Direct	Selection	Tool	and	clicking	anywhere	in	the
document.



Select	the	pen	tool	again	
Draw	the	door	part	where	you	want	to	with	the	Pen	tool.

You	can	keep	repeating	the	steps	of	deselecting	the	path	then	drawing	another	part	of	the
house	as	much	as	you	like.	I	added	two	more	parts	to	the	house	the	same	way	here:-

Candy	Tip:-	You	can	switch	to	the	direct	selection	tool	quickly	by	holding	the	control	button
(command	in	Mac)	while	you	are	using	the	Pen	Tool.

Candy	Candy	Tip:-	You	can	continue	adding	points	to	a	path	you	already	deselected	by
clicking	on	the	last	point	you	inserted	with	the	pen	tool,	and	then	continue	draw	like	nothing
happened.

	Note:-	The	path	you	are	working	on	has	to	be	selected	in	the	path	panels	all	the	time	during
these	steps.	This	is	especially	the	case	if	you	have	more	than	one	path	in	your	Photoshop	document



Learn	Photoshop	Pen	tool	with	the	Bézier	Game
This	is	a	game	I	found	a	while	ago	through	Twitter,	it	interactively	teaches	you	how	to	use	the	Pen
tool	to	draw	various	shapes.	And	it	is	a	great	way	to	apply	many	of	the	things	you	learned	here.	The
game	may	sound	hard	after	a	few	stages.	But	the	more	you	play	it	the	easier	the	game	will	become,	I
talked	about	the	game	with	some	details	in	this	post.
	
To	play	the	Bézier	Game,	click	here	to	go	to	its	website~

Examples.
Making	a	hard	selection
The	pen	tool	is	a	very	capable	selection	tool,	especially	in	the	situations	where	the	Wand	Tool	and	the
Magnetic	Lasso	Tool	fail	miserably.	In	the	following	picture,	the	picture	is	black	and	white.	And	the
man	at	the	middle	is	wearing	a	black	suit.	While	sitting	among	men	who	are	also	wearing	black	suits.
All	the	selection	tools	we	learned	about	so	far	will	fail	to	select	the	man,	but	the	pen	tool	can	easily
does	the	job

	

Though	the	lack	of	details	can	make	the	selection	process	hard,	refining	the	selection	after	making	it
can	mitigate	the	problem.

Creating	a	signature
The	Freedom	Pen	Tool	is	a	good	way	to	make	signatures	in	Photoshop,	specially	with	how	you	can
easily	edit	the	lines	in	case	you	messed	things	up.	I	will	consider	creating	a	signature	with	it	to	end	all
my	posts	with	it^^

http://sweetmonia.com/Sweet-Drawing-Blog/learn-the-pen-tool-of-photoshop-illustrator-easily-with-the-bezier-game/
http://bezier.method.ac/


Creating	Complex	Drawings
With	all	honesty,	this	line	art	has	been	created	in	Adobe	Illustrator.	Which	has	a	much	better	Vector
Graphics	capabilities	than	Photoshop,	but	I	found	it	a	very	good	way	to	show	you	how	vector
graphics	are	capable	of	creating	many	things.

Lolita	artwork	that	has	been	created	using	Photoshop	pen	tool,	But	can	be	created	using
Photoshop	pen	tool	as	well.	Though	that	can	be	harder

	

Summary
The	Pen	tool	is	one	of	the	most	important	tools	in	Photoshop.	And	yet	it	is	the	tool	shunned

by	most	new	Photoshop	users,	which	is	more	the	resaon	to	talk	about	it	early	in	this	book



The	Pen	tool	can	be	considered	as	one	of	the	selection	tools,	and	it	is	probably	the	most
powerful	one	among	them
The	pen	tool	draws	Bézier	curves,	if	you	know	how	this	kind	of	curves	work,	then	you

already	have	a	good	understanding	of	how	to	use	the	Pen	tool
Each	point	in	the	Bézier	curve	is	called	an	anchor	point,	and	the	handles	out	of	it	control	the

curve	before	and	after	it
Anchor	points	without	handles	are	corner	points,	as	the	curve	tend	to	stop	abruptly	at	this

kind	of	points
Understanding	how	to	work	with	the	anchor	points	and	handles	allows	you	to	draw	all	sorts

of	shapes
The	Path	Selection	Tool	allows	you	to	select	the	whole	path	&	move	it	to	anywhere	you	want
The	Direct	Selection	Tool	selects	individual	anchor	points	instead	of	the	whole	path,	you	can

use	that	tool	to	move	the	anchor	points	and	adjust	their	handles
The	Add	Anchor	Point	Tool	makes	it	easy	to	add	a	new	anchor	point	to	an	existing	curve,

while	the	Delete	Anchor	Point	Tool	removes	an	existing	anchor	point	from	it
The	Convert	Point	Tool	is	the	most	flexible	tool	for	modifying	the	anchor	points,	it	allows

you	to	convert	a	corner	point	to	a	curve	point	and	vice	versa.	It	also	allows	you	to	move	the
handle	of	any	anchor	point
The	Reedom	Pen	Tool	create	Bézier	curves	by	allowing	you	to	draw	them	freely	on	the

canvas,	which	is	similar	ot	what	the	Lasso	selection	tool	does
Any	curve	you	draw	using	the	pen	tool	can	be	turned	into	a	selection,	which	is	useful	for

creating	powerful	selections	in	Photoshop
Besides	getting	turned	into	a	selection,	any	path	can	be	filled	with	pixels	or	stroked,	and	all

that	can	be	done	from	the	Paths	Panel
Unless	you	saved	the	path	you	created,	Photoshop	will	replace	it	once	you	deselect	it	and	start

creating	another	path
Paths	in	Photoshop	can	consist	in	more	than	once	path,	this	can	be	useful	in	case	you	want	to

use	the	tool	to	create	simple	drawings	with	more	than	one	part,	like	a	house

Cropping	Images	in	Photoshop	using	the	Crop
Tool	&	Rectangle	Marquee	Tool.	And	An

Introduction	to	aspect	ratio



Cropping	images	in	Photoshop,	and	adjusting	their	sizes	of	images,	are	among	basic	uses	of
Photoshop,	as	well	as	other	graphics	software.	And	some	Photoshop	courses	start	with	how	to	do
that.	
In	this	chapter,	I	am	going	to	show	you	different	ways	of	cropping	images.	I	will	also	explain	the
concept	of	aspect	ratio	and	how	adjusting	the	aspect	ratio	is	useful.

What	cropping	images	means?
According	to	Wikipedia,	Cropping	images	refers	to	the	removal	of	the	outer	parts	of	an	image	to
improve	framing.
In	my	own	definition,	cropping	is	taking	part	of	the	picture	and	get	rid	of	the	rest.	If	that	didn’t	make
sense	to	you,	take	a	look	at	the	following	penguins	picture,	there	are	4	adult	penguins	in	it:-

If	I	only	want	the	penguin	at	the	right	and	I	don’t	need	the	rest	of	the	picture.	I	could	crop	the	picture
so	that	it	contains	only	that	penguin:-

http://en.wikipedia.org/wiki/Framing_(visual_arts)


There	are	many	techniques	for	cropping	images	like	that.	The	simplest	way	to	do	it	at	all	is	to	use
the	Crop	Tool	

Cropping	images	in	Photoshop	using	the	Crop	Tool	
The	crop	tool	is	the	easiest	way	to	crop	a	picture,	to	demonstrate	how	it	works,	I	will	show	you	how
to	crop	the	penguins	picture	above	using	it,	using	the	following	steps:-

Select	The	Crop	tool	 	from	the	Tools	Panel
Click	and	drag	around	the	part	you	want	to	crop.	The	same	way	you	make	rectangular

selections	using	the	Rectangular	Marquee	Tool:-

The	illuminated	area	is	where	the	picture

will	become	like	once	you	are	done	cropping,	and	the	black	area	(which	is	called	the	“Shield”)	is	the

parts	that	will	be	discarded	once	you	are	done	cropping.

Using	the	handles	of	the	rectangle	you	made,	you	can	adjust	the	rectangle	as	much	as	you
want	at	this	stage.	So	you	don’t	need	to	worry	about	making	mistakes	here.	I	adjusted	the



selection	here	to	contain	only	the	Penguin	I	wanted	and	nothing	else

After	you	are	done	adjusting	the	area	you	want	to	crop.	You	can	do	one	of	two	things	now:-

Press	Enter	on	your	keyboard	and	you	will	end	up	with	the	part	of	the	picture	you	selected
Or	If	you	changed	your	opinion	and	didn’t	want	to	want	to	cancel	the	cropping	altogether.

You	could	press	the	Escape	button	(The	Esc	button	at	the	corner	of	the	keyboard),	to	cancel	the
cropping	operation.

he	penguin	we	wanted,	fit	as	a	fiddle~

	Candy	Tip:-	Instead	of	pressing	Enter	Or	Escape	to	make	or	cancel	the	operation,	you	could
press	the	√	or	⍉	on	the	Crop	Tool	option	bar	to	complete	or	cancel	the	cropping.

And	the	crop	tool	cropped	the	image	really	nicely,	but	there	is	a	nicer	way	to	do	it.	Which	is	to



specify	the	Aspect	Ratio	of	the	area	to	be	cropped,	which	has	many	applications,	as	you	will	see
below.
Before	I	go	about	how	to	do	that,	let	me	first	introduce	you	to	the	concept	of	Aspect	Ratio

About	Aspect	Ratio
Aspect	ratio	is	the	term	that	refers	to	how	much	width	a	rectangle	has	compared	its	height.
For	example,	the	Aspect	Ratio	of	a	square	is	always	1:1	(one	to	one).	Meaning	that	for	each
Centimeter	(or	Inch,	or	any	unit	really)	of	the	width	of	the	square,	there	is	1	centimeter	of	height	in	it.
In	other	words,	if	the	width	of	a	square	is	10	centimeter,	it	means	that	the	height	of	the	square	is	also
10	centimeter.	Keeping	this	aspect	ratio	is	important	for	a	square	to	remain	a	square,	or	else	it	will
become	a	rectangle.
Knowing	the	aspect	ratio	means	that	if	you	know	the	width	or	the	height	of	a	rectangle,	you	can	know
the	other	quite	easily;	can	you	tell	me	what	is	the	height	of	the	square	whose	width	is	3.14	cm?	:)
There	is	no	difference	in	saying	that	the	aspect	ratio	of	the	square	is	1:1	or	10:10,	what	matters	is	the
relationship	between	the	two	numbers,	not	the	numbers	themselves.

Now	let’s	take	a	look	at	the	Aspect	Ratio	of	rectangles,	when	we	say	that	the	Aspect	Ratio	of	a
rectangle	is	2:1	it	means	that	for	each	2	Centimeters	of	the	width	of	the	rectangle,	there	is	1	centimeter
to	the	height	of	that	rectangle.	In	other	words,	the	width	of	the	rectangle	is	double	its	height,	and	it
will	look	like	that:-



The	width	of	such	rectangle	is	double	its	height,	meaning	it	has	the	aspect	ratio	of	2:1,	or	20:10.	(Or
even	30:15,	it	doesn’t	matter,	as	long	the	first	number	of	double	the	second	one).
And	if	we	said	that	the	aspect	ratio	of	a	certain	rectangle	is	the	opposite,	1:2	instead	of	2:1,	it	basically
means	that	the	height	of	a	rectangle	is	double	its	width.	And	it	will	look	like	that:-

Let’s	take	another	example,	when	we	say	that	the	Aspect	Ratio	of	a	rectangle	is	2.5:1,	it	means	that	for
each	2.5	centimeter	of	its	width,	there	is	1	centimeter	to	its	height.	To	make	this	aspect	ratio	easier	to
understand,	I	will	multiply	the	numbers	by	2,	and	now	the	aspect	ratio	becomes	5:2	instead	of	2.5:1.
Meaning	that	for	each	5	centimeter	of	the	width	of	the	rectangle,	there	is	2	centimeter	to	its	height
(you	could	have	multiplied	it	by	3	or	4	if	you	want,	I	just	choose	2	because	it	produces	the	best
numbers	in	my	opinion).
The	width	of	the	following	rectangle	is	two	and	half	its	height.	The	colors	segmentation	of	the	width
makes	that	more	obvious.



This	is	all	nice	and	all,	but	what	use	does	this	really	have?
I	hope	all	the	repetition	of	the	concept	has	made	you	familiar	of	it	by	now.	And	you	are	most	likely
wondering	how	knowing	the	Aspect	Ratio	could	benefit	you	at	all.
Lets	say	your	screen	resolution	is	1366x768	pixels	(there	are	many	ways	to	get	to	know	that,	one	of
them	is	to	go	to	http://www.whatismyscreenresolution.com/	and	it	will	display	your	resolution	for
you).	Meaning	that	the	width	of	your	screen	is	1366	pixels	and	its	height	is	768	pixels.
Suppose	you	want	to	change	the	background	picture	of	your	desktop.	Ideally,	if	you	have	a	picture
that	is	1366x768	pixels	you	are	good	to	go.	And	the	background	will	fit	to	your	screen	right	away.

But	if	your	picture	is	like	2000	X	1500	Pixels,	like	this	one:-

http://www.whatismyscreenresolution.com/


Setting	the	background	to	that	picture	will	make	it	stretch	and	it	won’t	look	nice	at	all.	That’s	because
it	has	a	different	aspect	ratio	than	your	screen	resolution.	See	how	the	poor	Llama	got	stretched.
Depending	on	how	different	the	picture	aspect	ratio	from	your	screen’s	is,	the	picture	will	be	more	or
less	distorted	than	this	example

Here,	the	2000	X	1500	Llama	picture	doesn’t	fit	well
with	the	1366	X	768	screen.	And	it	is	all	stretched	because	of	the	different	aspect	ratio	it	has	from	the	screen.

The	solution	to	this	problem	is	to	crop	your	picture	so	it	will	have	the	same	aspect	ratio	as	your
screen.	Which	can	be	done	using	the	Crop	tool,	as	well	as	your	old	friends,	the	Rectangle	Marquee
Tool.

Using	the	Crop	Tool	to	crop	a	picture	to	a	certain	Aspect
Ratio
Cropping	our	2000	X	1500	image	so	that	it	will	fit	to	our	1366	X	768	Screen	is	very	easy	to	do	with



the	crop	tool.	All	you	have	to	do	is	to	specify	the	aspect	ratio	you	want	before	cropping	the	image,
here	is	how	to	do	that:-

Select	The	Crop	Tool	 	from	the	tools	Panel.
In	the	Crop	Tool	options,	select	“Ratio”	fromt	the	ratio	menu,	for	Photoshop	CS5	&	earlier,

simply	entering	the	aspect	ratio	you	want	in	the	Width	&	Height	fields	will	allow	you	to	make
selections	that	abide	by	that	ratio.

Ptohoshop	CS5	&	earlier	has	it	easy,	as	they	can	enter	the
width	&	height	values	directly

Since	we	want	to	crop	the	picture	to	fit	with	our	1366	X	768	screen,	I	entered	these	values	in
the	Width	&	Height	fields.

Ptohoshop	CS5	&	earlier	only	have	to	enter
the	Width	&	Height	values	directly	in	the	options	panel

Now	drag	to	select	the	area	you	want	to	crop,	you	will	notice	that	the	size	of	the	rectangle
will	be	restricted	in	a	certain	way.
After	you	make	the	selection,	feel	free	to	adjust	the	area	you	want	to	crop,	and	once	you	are

done,	press	Enter,	and	Photoshop	will	crop	the	picture	for	you.
Here	is	what	I	got:



And	here	is	how	it	fits	to	the	screen	of	the	laptop,	without	being	stretched	at	all.

Using	the	Rectangle	Marquee	Tool	For	Cropping	images
The	Marquee	Selection	Tool	 	(And	other	selection	tools	as	well)	can	be	used	as	cropping	tools	in
addition	to	selecting	pixels.	For	a	starter,	I	will	show	you	how	to	do	normal	cropping	first:-

Select	the	Rectangle	Marquee	Tool	 	from	the	tools	panel
Select	the	Area	you	want	to	crop	in	your	picture,	here	I	am	interested	in	the	having	the

brownie	in	its	own	picture

From	the	main	menu,	select,	Image	->Crop,	and	Photoshop	will	crop	the	picture	to	the	part
you	selected.



There	is	not	much	different	between	the	Marquee	Selection	Tool	and	the	Crop	tool.	And
cropping	seems	is	easier	using	the	Crop	tool,	because	it	allows	you	to	adjust	the	area	you	selected
before	you	crop	the	image.	But	it	doesn’t	hurt	to	know	both,	because	you	may	want	to	crop	an	image
based	on	a	certain	selection	you	already	made,	like	selecting	a	man	and	cropping	the	image	to	have
only	the	parts	that	contains	him.

Using	the	Rectangle	Marquee	Tool	to	crop	a	picture	to	a
certain	Aspect	Ratio
Let’s	revisit	the	Llama	picture	and	its	aspect	ratio	that	don’t	fit	with	our	1366x768	screen,	cropping
the	image	to	fit	that	aspect	ratio	using	the	Crop	Tool	solved	that	problem.	And	here	is	how	to	do	that
with	Rectangle	Marquee	Tool	as	well:-

Select	the	Rectangle	Marquee	Tool	 	from	the	Tools	Panel
From	the	Style	menu	in	the	Marquee	Tool	Options,	select	“Fixed	Ratio”,	this	will	force	you

to	only	make	selections	of	a	certain	aspect	ratio.	Based	on	the	“Width”	And	“Height”	options:-

	



The	Width	&	Height	options	makes	you	specify	the	aspect	ratio	to	use	when	you	make	a
selection,	the	aspect	ratio	here	is	1:1,	meaning	that	it	will	create	a	square	selection.

Since	we	want	the	cropped	picture	to	abide	by	the	1366x768	aspect	ratio	of	our	screen,	setting
the	width	to	1366	and	the	height	to	768	will	most	likely	solve	out	problem.	So	let’s	do	enter
1366	into	the	Width	field	and	768	in	the	height	field,	just	like	we	did	with	the	Crop	Tool	earlier.

But	it	turns	out	that	Photoshop	won’t	allow	you	to	enter	1366	in	the	width	field.	As	it	is	the
maximum	allowed	value	of	999.99.	But	that’s	not	a	problem;	instead	of	inserting	1366	&	768
into	he	fields,	we	will	divide	both	numbers	by	10.	Which	will	get	us	136.6	&	76.8,	which	are	a
suitable	numbers	to	be	inserted	in	the	Width	&	Height	Fields.

The	Width	&	Height	fields	after	adjusting	the	aspect	ratio.

Now	we	are	free	to	select	the	part	of	the	Llama	picture	we	want	to	crop.	To	do	that,	click	and
drag	like	you	make	any	rectangular	selection,	the	selection	size	will	be	restricted	to	fit	the
aspect	ratio,	here	is	the	Llama	selection	I	made:-



。。。。。。　
Candy	Tip:-	You	can	move	the	selection	a	little	bit	using	the	arrow	keys	on	your	keyboards,	holding
shift	while	you	are	pressing	the	keys	will	make	the	selection	moves	faster.

Now,	select	Image->Crop	from	the	main	menu,	and	Photoshop	will	crop	the	selection	for
you.	The	new	image	I	got	had	the	resolution	of	1957	X	1000,	which	fits	to	the	aspect	ratio	of	out
monitor.	Even	though	that	won’t	seem	obvious	right	away,	here	is	the	picture	I	got:-

And	here	is	how	it	fits	to	the	screen	of	the	laptop,	without	being	stretched	at	all.



Cropping	images	in	Photoshop	is	a	great	way	to	change	the	aspect	ratio	of	a
picture	to	fit	a	computer	screen

Making	selections	of	a	certain	size
Suppose	that	instead	of	making	selection	that	abides	by	a	certain	aspect	ratio,	you	wanted	to	select	an
area	with	a	certain	size,	say	1000	X	1000	pixel,	the	Rectangle	Marquee	Tool	allows	you	to	do	that:-

Select	the	Rectangle	Marquee	Tool	 	from	the	Tools	Panel
From	the	Style	menu	in	the	Marquee	Tool	Options,	select	“Fixed	Size”	from	the	Style	menu

Enter	the	size	of	the	selection	you	want	to	make;	I	typed	“1000	px”	in	both	fields	to	make	a
1000	X	1000	selection.

Just	click	on	the	document	where	you	want	the	upper-left	corner	of	the	selection	to	be,	and
Photoshop	will	make	the	selection	to	you



A	1000	X	1000	Selection	I	made	using	the	Rectangle	Marquee	Tool

Now,	select	Image->Crop	from	the	main	menu,	and	Photoshop	will	crop	the	selection	for
you,	here	is	the	final	1000	X	1000	picture	of	the	teapot	I	got:-

	Candy	Tip:-	You	can	make	selections	using	units	other	than	pixel	using	the	Marquee
Selection	Tool.	To	do	that,	simply	type	CM	or	IN	or	any	unit	you	want	after	the	value	in	the	Width	or
Height	Fields.	Here	I	set	Photoshop	to	make	a	20	X	20	inch	selection:-

Here	are	units	you	could	use:-

Unit	Name Photoshop	Short	Name



Pixels Px

Inches In

Centimeterscm

Millimeters Mm

Points Pt

Picas Pica

More	on	the	Crop	Tool	&	Cropping
As	always,	the	chapter	is	officially	done.	But	I	still	have	a	few	things	to	talk	about,	if	you	don’t	feel
like	it	right	now,	feel	free	to	skip	to	the	examples	section

Changing	the	appearance	of	the	Shield(Photoshop	CS6
and	later)
You	can	choose	the	way	the	cropping	grid	looks	like	by	choosing	the	grid	type	from	the	Overlay
options:-

There	are	a	quite	few	grid	types	to	choose	from:-

Here	is	how	each	of	the	options	look	like:-



Changing	the	appearance	of	the	shield	(Photoshop	CS5	&
earlier)
The	Crop	Tool	allows	you	to	change	the	color	of	the	shield	in	more	than	a	way	from	the	options
panel:-

First	let’s	take	a	look	at	the	Color	option,	which	allows	you	to	change	the	color	of	the	area	that	is
going	to	be	cropped	(the	shield),	which	is	black	by	default



Clicking	on	this	option	will	open	the	color	picker

Which	allows	you	to	choose	the	color	for	the	cropped	out	area.	Here	is	how	I	changed	it	to	green:-

The	shield	check	box	determines	whatever	the	shield	is	visible	or	not

Here	is	how	the	crop	tool	looks	like	when	the	option	is	unchecked.	See	how	the	shield	is	gone:-



And	the	opacity	option	determines	how	much	transparent	the	dimmed	out	area	will	be:-

And	the	Crop	Guide	Overlay	menu	determines	how	divided	the	cropping	grid	will	be

This	option	can	be	“Not	divided	at	all”,	“Divided	By	Third”,	Or	“Divided	By	Grid”.	Here	is	how	each
of	the	options	will	look	like:-	

Setting	The	Aspect	Ratio	Of	The	Crop	Tool	from	An
Existing	Image
Again,	suppose	you	want	to	change	the	background	picture	of	your	computer,	but	instead	of	going



through	all	the	trouble	of	calculating	the	aspect	ratio,	you	could	get	the	aspect	ratio	from	your	current
background	image,	and	then	crop	your	new	background	picture	right	away.	Here	is	how	to	do	that:-

Open	your	current	background	picture,	or	any	picture	you	went	to	“capture”	its	aspect	ratio.
Let’s	assume	it	is	this	picture:-

Select	The	Crop	Tool	 	from	the	Tools	Panel
From	the	Crop	Tools	option,	simply	choose	“Front	Image“	from	the	Ratios	menu,	or	if	you

are	using	Photoshop	CS5	or	earlier	click	on	the	“Front	Image”	button

The	crop	tool	will	immediately	take	the	aspect	ratio	of	the	image	you	are	working	on.	Don’t
worry	if	you	didn’t	understand	what	the	numbers	you	got	mean,	they	simply	represent	the
aspect	ratio	of	the	image	you	had	at	the	front	the	moment	you	clicked	the	button.

Now	you	have	the	aspect	ratio	you	want,	switch	to	the	image	you	want	to	crop,	and	crop	your	new
background	image	just	like	we	did	before:-



	

Cropping	pictures	using	a	non-rectangular	selection
As	you	have	most	likely	guessed,	you	could	crop	pictures	using	any	of	the	other	selection	tools.	But
be	aware	that	you	will	always	end	up	with	a	rectangular	image	at	the	end,	one	that	best	fits	around	the
area	you	selected.
So,	simply	cropping	the	circle	in	this	picture:-



Will	produce	the	following	image:-

Examples:-

Cropping	a	picture	to	fit	the	Aspect	Ratio	of	a	forum
avatar.
One	of	the	online	forums	I	am	registered	at	has	avatar	size	of	100	X	125,	which	requires	me	crop	the
part	I	want	to	create	the	avatar	of	to	fit	that	aspect	ratio.	Let’s	say	we	have	the	following	Polar	Bear
picture.	Which	I	want	to	create	an	avatar	of	the	bear	face

All	I	have	to	do	is	to	set	the	aspect	ratios	to	100	X	125,	and	then	select	the	bear	face	(I	used	the
Rectangle	Marquee	Tool	here,	but	you	could	do	the	same	with	the	Crop	Tool	as	well)



Then	cropping	the	picture	by	choosing	Image	->Crop	got	me	the	following	picture:-

Which	I	now	could	resize	to	125	X	100	easily	by	choosing	Image->Image	Resize	dialog	from	the
main	menu,	something	that	will	be	covered	in	the	following	chapter.

Summary
Cropping	images	allows	you	to	select	a	certain	area	of	the	image,	and	eliminate	the	rest	of	it,

or	another	word,	it	allows	you	to	cut	the	part	of	the	picture	you	want.
Cropping	images	can	be	done	using	the	Crop	tool	or	the	Rectangle	Marquee	Tool
By	default,	these	tool	allow	you	to	freely	select	the	area	you	want	to	crop,	but	sometimes	you

may	want	to	select	an	area	that	abides	by	a	certain	Aspect	Ratio
Aspect	Ratio	is	a	term	that	describes	the	ratio	between	the	width	&	height	in	a	certain

rectangle,	Aspect	Ratio	is	important	if	you	want	to	crop	a	picture	to	fit	in	a	specific	area,	like
the	background	of	your	desktop
Photoshop	also	allows	you	to	crop	pictures	by	specifying	the	size	of	the	area	you	want	to

crop,	you	can	specify	the	dimensions	using	more	than	one	unit,	like	CMs,	MMs,	Pixels,	Inches
and	more
Photoshop	provides	you	many	ways	to	change	how	the	Crop	tool	looks	like	during	cropping,

you	can	change	the	grid	size	of	the	selected	tool	or	the	color	of	the	shield



The	cropping	tool	allows	you	to	crop	pictures	based	on	the	aspect	ratio	of	another	image,
while	you	always	have	the	option	to	insert	the	Aspet	Ratio	manually,	getting	the	Aspect	Raio
from	another	image	is	so	convenient
Cropping	always	produce	a	rectangular	image,	even	if	the	selection	you	made	is	not

rectangular

Resizing	Images	in	Photoshop	and	Canvas

Important	Note:-	To	make	it	easy	for	everyone	to	follow	this	chapter,	this	chapter	explains	Resizing
Images	in	Photoshop	for	both	Photoshop	CC	&	the	earlier	versions.	So	there	is	a	dedicated
explanation	for	both	Photoshop	CC	&	Photoshop	CS6	and	older	in	more	than	one	place.

Why	would	anyone	resize	images?
Besides	cropping	images,	resizing	them	is	another	common	feature	found	in	probably	all	the
graphics	applications.	Including	MS	Paint.	In	case	resizing	images	don’t	make	sense	to	you.	Doing	so
has	many	benefits	and	uses:-

It	allows	you	to	send	them	faster	over	the	Internet.	Specially	if	the	image	is	too	big	or	your
Internet	connection	is	not	that	fast.
For	web	site	owners.	Resizing	the	images	to	the	size	they	will	be	displayed	at	on	the	site

makes	the	site	pages	load	faster.
If	you	made	a	forum	or	social	media	avatar.	Just	like	we	did	in	the	cropping	chapter.	You

must	resize	the	image	before	uploading	it	to	the	forum	server.	As	forum	software
pose	restrictions	on	the	size	&	dimensions	of	the	uploaded	pictures.

The	basic	steps	for	resizing	images	in	Photoshop
Suppose	we	have	the	following	sleeping	cat	picture,	whose	dimensions	are	2000	X	1333	Pixels:-



Let’s	say	I	want	to	resize	it	so	that	its	width	is	1000	pixel	instead	of	2000.	To	do	that,	all	you	have	to
do	is	to	select	Image->Image	Size	from	the	main	menu.	And	the	Image	Resize	dialog	will	appear,	the
dialog	you	will	see	will	depend	on	the	version	of	Photoshop	you	are	using,	but	the	basics	on	how	to
use	it	are	the	same

The	Image	Size	dialog	in
Photoshop	CC



										 The	Image	Size	dialog	in	Photoshop
CS6	and	earlier

The	2000	&	1333	in	the	Width	&	Height	fields	represents	the	dimensions	of	the	image	in	pixels.	We
already	know	that	the	width	of	the	picture	is	2000	pixel	and	its	size	is	1333.	But	this	would	be	very
nice	to	know	if	we	did	not~	;D

Simply	typing	1000	in	the	Width	field	will	be	enough	to	specify	the	new	size	we	want.	Notice	how
Photoshop	changed	the	height	field	as	you	typed	the	new	width.	It	does	that	to	preserve	the	Aspect
Ratio	of	the	picture.



If	you	are	unfamiliar	with	the	concept	of	Aspect	Ratio,	consider	reading	the	cropping	chapter,
which	contains	an	in-depth	explanation	about	the	concept	of	the	Aspect	Ratio.

Now	you	specified	the	new	width	of	the	picture.	Click	OK	and	Photoshop	will	resize	the	image	for
you.	Here	is	the	new	image	after	it	was	resized.

Resizing	the	image	canvas	(instead	of	the	picture	itself)
In	additional	to	resizing	the	picture,	Photoshop	allows	you	to	change	the	size	of	the	canvas.	The
difference	between	the	two	is	that	resizing	a	picture	creates	a	bigger	or	smaller	version	of	it.	While
changing	the	canvas	size	merely	adds	empty	pixels	for	you	to	paint	on.	While	keeping	the	size	of	the
original	picture	intact.
To	demonstrate	how	that	works.	Suppose	I	want	to	create	an	Internet	Meme	from	the	adorable	cat
picture	I	just	resized.	To	do	that,	I	need	to	surround	the	picture	with	black	pixels,	with	more	black
pixels	on	the	bottom	to	write	some	text	on	using	the	Type	Tool	(which	will	be	explained	later	in	this
book),	here	is	how	to	do	that:-

Select	Image	->	Canvas	Size	from	the	main	menu



The	Canvas	Size	Dialog	appears

If	you	are	using	Photoshop	CC.	The	dialog	will	look	like	this	(It	can	be	black	as	well,
depending	on	your	interface	settings).	Other	than	the	difference	in	the	look.	There	is	no
difference	in	the	functionality	between	the	two	dialogs.

Enter	the	new	width	or	height	in	the	corresponding	field.	You	can	choose	to	add	pixels
horizontally	by	entering	a	bigger	width	value.	Or	vertically	by	entering	a	bigger	height.	Since



we	want	both	here.	I	am	going	to	enter	bigger	values	for	both.		Here	the	dialog	with	the	values	I
chose	(I	go	these	values	by	experimenting):-

From	the	canvas	extension	color	option,	choose	black.	This	will	cause	the	new	added	pixels	to	be
black	(instead	of	white	or	any	other	color).

Now	press	OK,	and	Photoshop	will	resize	the	canvas	of	the	picture	with	newly	added	black	pixels.
Here	is	how	the	cat	picture	looked	like	for	me:-



Note:-	Checking	the	Relative	checkbox	from	the	Canvas	Resize	dialog	allows	you	to	type	how	many
pixels	or	centimeters	you	want	to	add	instead	of	typing	the	absolute	new	width	or	height

Resizing	the	image	canvas	in	a
certain	direction
Now	we	have	resized	the	canvas	of	the	sleeping	cat	picture.	You	may	have	noticed	that	at	the	bottom
of	the	picture.	There	is	no	enough	space/pixels	at	the	bottom	of	the	picture	to	insert	the	meme	text	in
it.	That’s	fine.	We	can	add	additional	pixels	to	the	bottom	of	the	page	using	the	Canvas	dialog.

Choose	Image	->	Canvas	Resize	from	the	main	menu.	The	canvas	resize	dialog	appears



	 	

In	the	anchor	option.	Change	the	direction	into	which	Photoshop	will	add	pixels.	So	that	it
won’t	add	pixels	to	the	top	of	the	image	(Just	click	where	it	is	indicated	on	the	picture)

After	changing	the	direction	to	add	pixels.	My	dialog	looks	exactly	like	this:-



Type	35.52	in	the	height	field,	I	had	to	experiment	a	little	bit	to	get	this	value.	In	the	previous
step.	We	specified	that	Photoshop	wouldn’t	add	any	pixels	to	the	top	of	the	picture.	So	it	has	no
option	but	to	add	them	to	the	bottom,	until	the	height	of	the	picture	become	35.52	CM.	Select
OK	to	see	the	result.
Here	is	how	the	picture	looks	like	for	me:-

Adding	the	meme	text	on	the	picture
While	this	chapter	is	mainly	about	resizing	images	in	Photoshop.	I	didn’t	think	it	would	be	nice	to
start	making	a	meme	without	adding	text	to	it.	So	we	will	take	a	little	detour	to	add	it.	Adding	text	to
images	is	discussed	in	its	own	chapter~

Select	the	Horizontal	Text	Tool	 	from	the	tools	panel.



Let’s	change	the	text	color	to	white.	From	the	tool	options,	click	on	little	colored	square~

The	color	picker	appears:-

Select	white	from	the	color	picker,	which	is	located	at	the	upper-left	corner	of	the	color
picker.

Click	OK	to	close	the	dialogue.
From	the	text	size	menu,	choose	the	text	size	72;	I	picked	this	one	because	it	is	the	most

suitable	one	for	my	picture.	And	again,	I	know	this	because	I	kept	experiencing	with	different
sizes.

Click	where	you	want	your	text	to	start	then	start	typing	the	meme	text.	From	what	I	know.



Internet	Memes	tend	to	have	a	big	title	and	a	smaller	line	of	text	below	it.	But	for	the	sake	of
simplicity,	we	will	ignore	that.
Here	is	how	my	meme	looks	like(I	centered	the	text	to	make	it	look	better	by	the	way):-

More	about	resizing	images	in	Photoshop
Like	every	time,	this	chapter	is	officially	done.	And	in	the	rest	of	the	chapter	will	focus	on	giving	tips
and	explaining	more	of	the	dialogs	option,	we	encountered	so	far.
Because	there	are	nothing	about	to	demonstrate	about	resizing	images,	there	won’t	be	an	examples
section	in	this	chapter~

A	more	detailed	look	on	the	Image	Resize	Dialog
The	Image	Resize	Dialog	(Photoshop	CS6	&	earlier)
The	Resize	Image	dialog	may	look	a	little	bit	intimidating	at	first,	but	the	options	in	it	are	fairly
simple	and	straightforward,	as	it	is	explained	in	the	following	picture:-



Don’t	worry	if	you	didn’t	understand
everything	in	the	picture.	I	will	explain	again	all	these	options	in	more	details	right	away~

The	pixel	dimensions	section
The	width	&	height	fields:-	These	two	fields	allow	you	to	enter	the	new	size	of	the	picture,

entering	a	bigger	size	will	make	Photoshop	enlarge	the	picture.	And	entering	a	smaller	values
will	make	it	scale	it	down.	By	default.	Changing	one	of	the	two	fields	automatically	change	the
other,	this	is	so	the	picture	will	retain	its	Aspect	Value(Which	is	explained	in	detail	in	my
cropping	tutorial)
The	unit	drop-down	menus(besides	the	Width	&	Height	fields):-	This	option	allows	you

to	choose	whatever	you	enter	the	new	image	size	by	pixel	or	by	percent	of	the	current	size.	The
percent	unit	makes	it	easier	to	resize	an	image	to	be	double	or	half	its	size.

The	Document	Size	Section
This	section	is	very	similar	to	the	pixels	dimensions	one,	except	that	it	allows	you	to	specify	the
picture	size	in	real-life	units	instead	of	pixels	or	percent,	which	is	very	useful	if	you	want	to	print	the
picture.

As	with	the	pixel	dimension,	you	can	enter	the	new	Width	or	Height	of	the	picture	in	their
correspondent	field.	And	as	you	do	that,	the	pixels	dimensions	field	of	the	picture	will	change
accordingly.
You	can	choose	the	unit	of	the	width	&	height	from	the	drop	down	menus	beside	the	Width	&

Height	Fields.	The	following	units	are	available	for	you	to	choose	from:-
Percent
Inches
CM
MM
Points
Pica



Column
The	constrains	Proportions	checkbox	ensures	that	the	picture	will	retain	its	aspect	value,

meaning	that	as	you	enter	a	new	Width	or	Height	value	in	the	dialog.	Photoshop	will
automatically	change	the	other	value	so	the	Aspect	Ratio	stays	the	same.	Unchecking	this	option
allows	you	to	create	squashed	images,	like	this:-

The	resample	Image	checkbox	Changes	the	number	of	pixels	in	the	picture.	By	unchecking
this	option.	The	Width	&	Height	fields	on	the	top	of	the	dialog	won’t	be	editable.	But	you	can
change	the	real-life	dimensions	of	the	document.	But	that	won`t	change	the	number	of	the	pixels
in	the	image.	To	be	honest,	I	always	used	the	Image	Dialog	with	this	option	checked,	so	I	can’t
say	more	about	it.
The	drop-down	menu	below	the	”Resample	Image”	checkbox	allows	you	to	choose	the

way	(or	algorithm,	in	technical	terms)	Photoshop	use	to	resize	your	image.	Talking	about	them
in	detail	is	out	of	the	scope	of	this	book.	But	you	can	refer	to	this	article	if	you	want	to	know
about	their	mathematical	details.

The	Image	Size	Dialog	(Photoshop	CC	and	later).
The	Image	Resize	dialog	has	been	overhauled	in	Photoshop	CC.	Compared	to	how	it	used	to	be	in
Photoshop	CS6	and	the	older	version.	Some	Photoshop	users	didn’t	like	how	the	Image	Resize,	which
dates	back	to	very	old	versions	of	the	program	(I	know	it	has	been	there	in	Photoshop	5)	got	changed
the	way	it	got.	While	there	are	some	obvious	enhancements	in	the	new	dialog,	I	personally	feel	a	bit
skeptical	about	the	new	dialog.	But	only	time	will	tell	if	this	is	good	for	us	or	now~

http://entropymine.com/resamplescope/notes/photoshop/


The	Image	Resize	Dialog	in	Photoshop	CC

Some	guidelines

about	choosing	the	resizing	way	(Or	algorithm):-

The	Nearest	Neighbor	option	preserves	the	hard	edges	in	the	resized	image.	Notice	how	the
small	square	below	retained	its	hard	edge	after	it	was	resized	by	4	times	using	this	option.
Compared	to	resizing	it	using	Bicubic.	Which	is	the	default	way	of	resizing,	which	produced	a
square	with	blurred	edges:-



Bicubic	Smoother	is	better	for	increasing	the	size	of	images.
Bicubic	Sharper	is	better	for	reducing	the	size	of	images

More	about	resizing	the	canvas
Resizing	Canvas:-	Deciding	the	direction	into	which
Photoshop	will
The	Anchor	option	in	the	Resize	Canvas	dialog,	which	consists	of	nine	squares	with	an	arrow	on
most	of	them,	allows	you	to	choose	the	direction	into	which	Photoshop	will	add	the	new	pixels.	By
default,	Photoshop	will	add	pixels	in	all	directions.	Meaning	that	if	you	increased	the	width	by	2
pixels,	and	the	height	by	2	pixels	as	well.	Then	Photoshop	will	add	1	pixel	in	all	the	directions	around
the	canvas.	(The	same	works	for	the	other	units,	like	centimeter.	But	I	am	using	pixels	here	for
simplicity).
The	other	squares	allow	you	to	exclude	one	or	two	directions	from	gaining	any	new	pixels.	For
example,	if	you	restricted	the	pixels	from	being	added	to	the	top	of	the	canvas,	and	then	you	added	2
pixels	to	the	height	of	the	pixels.	Photoshop	will	add	2	pixels	to	the	button	of	the	canvas.



Here	is	how	the	anchor	option	visually	works:-

The	relative	option	in
the	canvas	size	dialog

The	relative	option	of	the	canvas	dialog	allows	you	to	enter	how	many	pixels	to	add	to	the	canvas,
instead	of	specifying	the	absolute	width	or	height	values.
Suppose	you	have	a	canvas	that	is	1000	X	1000	pixels,	and	you	entered	100	pixels	in	both	the	width
and	height	field	while	the	Relative	option	is	checked.	You	will	end	up	with	a	canvas	that	is	1100	X
1100	pixels.	You	will	get	the	same	results	by	typing	1100	pixels	into	the	width	&	height	fields	while
the	Relative	option	is	unchecked.



Word	about	resizing	images	in	Photoshop
Trying	to	enlarge	a	picture	will	create	a	larger	picture	indeed,	but	the	quality	of	the	picture	will
deteriorate.	As	Photoshop	image	resizing	only	resize	images	by	inserting	new	pixels	guessed	based
on	the	existing	ones	in	the	picture
On	the	other	hand,	resizing	an	image	to	create	a	smaller	one	is	easily	possible.	To	do	that,	Photoshop
eliminates	some	of	the	pixels	from	the	pictures~
Take	a	look	at	the	following	cat	picture.	See	how	all	clear	the	details	in	the	pictures	are,	and	how	it
contains	no	blur	or	anything	of	that	sort.

Now	look	at	how	it	became	after	it	was
greatly	resized,	a	lot	of	details	can’t	be	seen	in	the	picture	now	it	is	smaller.	But	it	still	looks	good,
since	reducing	the	size	of	images	doesn’t	have	that	much	bad	effect	on	them.

Let’s	resize	the	small	image	back	to	the	original	size.	While	Photoshop	did	a	relatively	good	job	at
producing	the	new	image	from	the	very	little	data	it	has.	It	still	doesn’t	look	as	good	as	the	original
image.



Here	is	a	comparison	between	the	original	picture	and	the	resized	one:-

The	example	I	gave	here	is	a	bit	of	an	extreme	case.	But	that’s	to	give	you	a	good	idea	on	how	image
resizing	works.

Summary
Resizing	images	is	useful	for	uploading	images	online	and	to	save	storage	space.
Resizing	images	in	Photoshop	is	done	using	the	Image	Resize	Dialog.
By	default,	Photoshop	retain	the	Aspect	Ratio	of	the	images	it	resizes,	but	you	can	resize



images	however	you	want.
Resizing	the	canvas	is	a	good	way	to	add	more	drawing	space	to	the	picture.	Which	you

could	use	to	draw	new	things	or	to	add	pictures	from	other	Photoshop	files.
It	is	not	hard	to	add	Text	to	pictures.	Though	there	are	much	more	details	to	that	than	I

explained	here.
The	Image	resize	in	all	the	versions	of	Photoshop	gives	you	a	great	variety	of	options	for

resizing	images.	Including	selecting	the	unit	of	the	resizing	and	the	way	(Or	the	algorithm,	if
you	want	to	be	technical)	the	resizing	is	done.
You	can	adjust	various	things	in	the	Resize	Canvas	dialog.	Including	the	direction	into	which

Photoshop	will	add	the	new	pixels.

All	About	Photoshop	type	tools

Photoshop	Type	Tools
There	are	4	Type	Tools	in	Photoshop,	each	of	them	adds	text	to	pictures	in	a	different	way:-

The	Horizontal	Type	Tool	 	Adds	a	horizontal	text	to	the	picture.	This	is	the	most
commonly	used	type	tool
The	Vertical	Type	Tool	 	Adds	a	vertical	text	instead	of	a	horizontal	one.	Similar	to	what

you	see	in	traditional	Japanese	text
Horizontal	Type	Mask	Tool	 	Makes	you	create	a	selection	from	a	horizontal	text	you

type.

Vertical	Type	Mask	Tool	 	Makes	you	create	a	selection	from	a	vertical	text	you	type.

Adding	text	Photoshop	using	the	Horizontal	Type	Tool
If	you	read	the	resizing	pictures	chapter	in	Photoshop.	You	pretty	much	won’t	have	to	read	this
section,	as	I	will	explain	again	how	to	add	horizontal	text	to	pictures	in	Photoshop.



Right	now,	we	are	going	to	add	some	text	to	the	following	elephant	picture.	To	do	that,	follow	these
steps:-

Select	the	Horizontal	Text	Tool	 	from	the	tools	panel
Click	on	the	picture	where	you	want	the	text	to	start.	A	blinking	line	similar	to	what	you	see	in

Microsoft	word	will	appear.
Type	the	text	you	want,	press	Enter	to	start	a	new	line	of	the	text,	if	you	want
Once	you	are	done	entering	the	text.	Click	the	✓	icon	on	the	text	tool	options.	If	you	changed

your	mind	and	no	longer	want	to	enter	the	text.	Then	press	the	⍉	icon	instead.	(You	could
always	press	the	Escape/Esc	key	at	the	corner	of	your	keyboard	to	cancel	the	operation	as	well)

Here	is	my	elephant	picture	after	I	added	some	text	to	it:-

Entering	a	vertical	text	using	the	Vertical	Type	Tool
Adding	a	vertical	text	to	pictures	is	the	same	as	adding	a	horizontal	one.	You	just	use	a	difference
tool	to	do	that.	Which	is	the	Vertical	Text	Tool	 ,	here	are	the	steps	of	how	to	do	that:-

Select	the	Vertical	Text	Tool	from	the	tools	panel.	To	access	the	tool,	click	and	hold	the
mouse	button	over	the	Horizontal	Text	Tool	and	Photoshop	will	show	you	the	other	available
text	tools.



The	rest	of	Photoshop	type	tools	can	be	accessed	by	clicking	&	holding	the	mouse	button	over
the	Horizontal	Text	Tool	in	the	tools	panel

Again,	click	where	you	want	the	text	to	start.	Because	the	text	we	are	creating	is	vertical,	we
click	where	we	want	the	top	of	the	text	to	be.	I	chose	to	click	on	the	upper-left	corner	of	the
following	picture:-

I	clicked	on	the	picture.	I	got	the	same	blinking	line	that	prompts	me	to	enter	the	text.	Then	I
entered	the	text.	Then	I	clicked	the	✓	icon	on	the	Type	Tool	options.
Here	is	the	picture	after	I	added	“Here	we	go”	to	it:-

Note:-	Don’t	worry	if	you	didn’t	get	the	exact	results	as	me.	I	kept	changing	the	text	color	and	font

between	the	examples	in	order	to	make	them	clearer	for	you	to	see.



Creating	text	selections	using	the	Horizontal	Type	Mask
Tool	and	vertical	Type	Mask	Tool:
The	Horizontal	Type	Mask	Tool	 ,	and	its	vertical	equivalent,	the	Vertical	Type	Mask	Tool	

	are	used	to	create	text	selections,	which	you	could	work	on	just	like	any	selection.
I	am	going	to	add	a	text	selection	using	the	Horizontal	Type	Mask	Tool	to	this	picture;	you	could
follow	the	same	steps	using	the	Vertical	Type	Horizontal	Tool	as	well.	
To	create	the	selection,	follow	these	steps:-

Select	the	Horizontal	Type	Mask	Tool	 	or	Vertical	Type	Mask	Tool	 	from	the	tools
panel.
Click	where	you	want	the	selection	to	start.	The	picture	will	turn	red,	meaning	that	we	are	in

mask	mode	right	now.

Enter	the	text	you	want.	Just	like	we	did	in	the	other	text	tool.



Once	you	are	done	entering	the	text.	Click	the	✓	iron	on	the	text	tool	options.	If	you	changed
your	mind	and	no	longer	want	to	enter	the	text.	Then	press	the	⍉	icon	instead.	Since	I	am
satisfied	with	the	text.	I	clicked	on	the	✓	icon.
The	text	you	entered	will	turn	into	selection.	Which	you	can	use	just	like	any	selection	in

Photoshop

I	painted	the	text	I	made	with	a	soft	brush
right	here:-

	Candy	Tip:-	You	can	turn	any	text	into	selection	the	same	way	you	do	with	any	layer.	Which
is	by	hovering	the	mouse	button	over	the	layer	thumbnail	in	the	layers	panel,	holding	the	Control
button	(Command	in	Mac).	And	the	cursor	will	have	a	selection	mark	on	it.	Then	click	on	the
thumbnail.



Photoshop	Type	Tools	options
Photoshop	Type	Tools	has	several	options.	For	the	most	part,	these	options	are	so	similar	to	the	ones
in	Microsoft	Word.	Like	changing	the	color	or	font.	Plus	some	new	ones	like	the	anti-aliasing
(smoothing)	method.	The	following	picture	explains	the	text	tool	options	in	details.	A	detailed
explanation	to	them	is	also	available	below:-

Changing	text	font

The	font	menu	allows	you	to	change	the	font	of	the	text.	There	are	a	lot	of	fonts	that	comes	with
Photoshop.	And	if	those	are	not	enough,	you	can	get	your	own	fonts	online	and	add	them	as	well.
Something	I	will	explain	to	you	later	in	this	chapter



Changing	text	style

The	font	style	menu	allows	you	to	change	whether	the	text	is	regular	(normal),	bold	or	italic.
Depending	on	the	font	you	selected,	some	additional	styles	will	appear	to	you.	And	some	fonts	have
no	styles	at	all

Changing	Font	Size

Font	size	is	self-explanatory.	It	allows	you	to	change	the	text	size	to	whatever	you	want.	The	biggest
font	size	you	can	choose	from	the	drop-down	menu	is	72.	But	you	can	enter	any	value	you	want	in
there.	As	you	can	see	in	the	picture	above~



	Candy	Tip:-	You	can	change	the	font	size	quickly	by	holding
your	mouse	over	the	text	size	icon	and	drag	the	mouse	left	or	right

Text	Anti-Aliasing	Settings

Next	comes	the	anti-aliasing	setting.	If	you	are	familiar	with	this	term	“Anti-Aliasing”,	you	won’t

have	any	problem	understanding	this	options.	But	if	you	are	not,	don’t	worry,	as	I	will	explain	the

term	right	away:-

What	is	anti-aliasing?
Anti-aliasing	refers	to	the	process	of	smoothing	the	lines	formed	by	pixels.	By	adding	some	semi-
transparent	pixels	here	and	there.
Computers	draw	lines	by	lining	up	pixels	side	by	side	to	create	them.	When	the	resolution	is	low,	or
when	the	text	is	small	to	a	certain	degree.	The	pixels	tend	to	look	like	a	staircase.	And	the	line	will
appear	choppy.	Just	like	this:-



Like	I	said,	anti-aliasing	smooths	the	pixels	by	adding	a	few	semi-transparent	ones	here	and	there.
With	anti-aliasing	is	enabled,	the	pixels	of	the	character	above	will	look	like	this:-

Anti-aliasing	is	usually	used	with	small	fonts	or	low-resolution	pictures.	If	the	picture	you	are
working	on	has	a	high-resolution.	Then	anti-aliasing	won’t	be	of	much	of	use	to	you.	Here	is	a	high-
resolution	picture	with	anti-aliasing	disabled.	Do	you	see	the	aliasing	(The	staircase	effect)?	It	is
there,	but	it	is	too	small	to	be	visible



And	to	repeat	what	I	said	again,	if	the	text	is	so	big,	or	the	resolution	of	your	screen	is	too	high.	Anti-
aliasing	won’t	matter	that	much	for	you.	Anti-aliasing	is	used	when	you	have	a	small	font	size	or	low
screen	resolution.	Here	is	an	aliased	&	anti-aliased	characters	arranged	side-by-side:-

Now	you	know	what	anti-aliasing	is.	You	can	pretty	much	understand	what	the	Anti-Aliasing	method
of	the	text	tool	does.	Setting	the	option	to	none	use	no	anti-aliasing	at	all.	Setting	it	to	the	other	ones
produces	different	effects.

Text	Align

Text	Align	aligns	the	text	to	either	the	left,	which	is	the	default,	to	the	middle,	or	to	the	right.	The
same	way	it	is	done	in	Microsoft	Word.



Text	Color

Another	self-explanatory	option,	it	allows	you	to	change	the	text	color.	After	clicking	on	the	color

icon.	The	color	picker	will	appear,	where	you	can	choose	the	font	color	you	want.

Creating	a	Warped	Text

The	Warped	Text	option	for	the	text	tool	allows	you	to	create	twisted	or	warped	text.	Once	you	click

on	this	option.	The	Warp	Text	dialog	appears.	Offering	you	various	options	to	do	so:-



Let’s	take	a	look	at	each	of	these	options	one	by	one:-
Style:-	The	style	options	shows	you	the	various	ways	to	wrap	the	text.	It	can	be	turned	into	a	wave,	an
arc,	a	fish	or	many	of	other	options

The	horizontal	or	vertical	set	whatever	the	effect,	is	done	on	the	text	vertically	or	horizontally.	This
makes	sense	depending	on	the	text	orientation.	Here	is	how	it	looks	like	on	horizontal	text:-

And	here	is	how	it	looks	like	on	Vertical	text:-



The	bend	option	determines	how	much	the	text	is	affected.	For	example,	if	you	chose	the	arc	style	for
the	text.	Then	the	bend	option	determines	how	much	the	text	is	arced.	Negative	values	produce	a
mirrored	shape	of	their	positive	equivalent:-

Vertical	Or	Horizontal	Distortion
These	two	options	squash	the	text	in	one	direction.	And	expand	it	on	the	other.	For	example,
Horizontal	Distortion	Squash	the	text	from	the	left	or	right	and	expand	it	on	the	other	side.	Depending
on	the	value	of	distortion,	like	this:-

Here	is	how	it	looks	like	for	Vertical	Distortion:-



Candy	Tip:-	The	best	way	to	understand	how	warped	text	options	work	is	to	play	with	them	for	some
time~

Displaying	and	hiding	the	character	&	paragraph	panels

This	last	option	displays	or	hides	the	Character	&	Paragraph	panels.	Which	are	two	separate	panels

that	are	grouped	together	in	default.	Here	is	how	the	panels	look	like	(as	I	said,	they	are	grouped	in

one	panel	by	default):-

The	Character/Paragraph	panel,	With	the	Paragraph	panel	options	shown	in	this	picture



The	Character	panel

These	two	panels	will	be	explained	in	detail	later	in	this	chapter.	Many	of	the	options	in	these	two
panels	are	the	same	as	the	ones	we	explained	above.

	Candy	Tip:-	You	can	also	display	the	Character	Panel	by	selecting	Window->Character.
	And	the	Paragraph	Panel	by	selecting	Window->Paragraph	from	the	main	menu.

More	about	Photoshop	Type	Tools
Like	every	time.	The	chapter	is	officially	done.	And	we	are	going	through	additional	features	that
have	to	do	with	Photoshop	Type	tools.	If	you	don’t	feel	like	reading	this	right	now,	feel	free	to	jump
to	the	examples	section	at	the	end	of	this	chapter

Text	layers

This	document	contains	many	text	layer.	The	name	of	the	text	layer	is	usually	the	same	as	the	content	of	the	text.	The	icon	of	the	layer
depends	on	whether	the	text	in	the	layer	is	warped	or	not.

You	may	have	noticed	that	each	text	you	type	gets	to	have	its	own	layer.	And	these	layers	look
different	from	the	other	layers,	these	are	text	layers,	which	are	different	type	of	layers	than	the	ones
you	worked	on	so	far.	Text	layers	can’t	be	used	for	painting	unless	you	convert	them	into	normal
layers.



Converting	text	into	a	raster	layer
As	we	just	stated.	You	can’t	draw	on	text	layer	until	you	convert	it	to	normal	layer	(Also	called	raster
layer).	To	do	that,	you	simply	need	to	start	painting	on	it	using	the	brush	tool	and	Photoshop	will
offer	to	convert	it	to	you.	Here	is	how:-

Select	the	text	layer	you	want	to	paint	on	in	the	layers	panel

Select	the	brush	tool	and	click	anywhere	on	the	canvas.	Photoshop	will	tell	you	that	the	layer
needs	to	be	rasterized	before	you	can	paint	on,	click	on	the	OK	button	to	do	rasterize	it

The	layer	will	be	converted	into	a	normal	layer.	Which	you	can	work	on	just	like	any	other
layer



Here	is	the	text	layer	after	it	has	been	rasterized.	I	locked	its	pixels.	Then	I	made	one	purple
stroke	with	the	brush	tool.

Formatting	part	of	a	text
So	far,	every	time	we	worked	with	the	type	options.	We	modified	the	whole	text.	It	is	also	possible	to
select	part	of	the	text.	And	modify	the	attributes	of	the	selected	part	alone.	Here	is	how	to	do	that:-

Select	the	Type	Tool	 	from	the	tools	panel
Hover	your	text	over	the	beginning	of	the	part	of	the	text	you	want	to	edit.	And	then	click	and

drag	the	cursor	until	you	select	all	the	text	you	want.	Just	like	you	do	in	Microsoft	word.	Here	is
my	text	after	I	selected	part	of	it:-

Edit	the	text	attributes	however	you	want.	Only	the	text	you	selected	will	be	affected	by	the
changes.	Here	I	changed	the	color	of	the	selected	text	to	blue.

After	you	are	done.	Click	on	the	✓	icon	on	the	Type	Tool	Options.

You	can	modify	part	of	the	text	however	you	want.	You	can	set	it	to	bold,	change	its	size.	Or
do	virtually	anything	you	want.

Explaining	the	Character	Panel
The	character	panel,	as	well	as	the	Paragraph	panel,	allows	you	to	edit	many	attributes	of	the	text.	Just
like	the	Type	Tool	Options	we	explained	above.	Except	that	it	gives	you	even	more	options	to	do	so.



The	following	infographic	explain	it	in	details.	Note	that	I	cut	down	on	the	details	on	the	ones	we
already	seen:-

Photoshop	Character
Panel

Text	Font:-	Changes	the	text	font,	this	option	works	similar	to	its	equivalent	in	the	Type	Tool
options.

Font	Size:-	Changes	the	font	size,	this	options	also	works	the	same	way	as	the	one	in	the	Type	Tool
options.



Text	Style:-	Again,	this	option	works	the	same	way	we	have	seen	before.	It	changes	the	text	style,
from	either	regular,	bold	or	italic.

Changing	the	space	between	characters:-	

As	the	name	suggests.	This	option	allows	you	to	change	the	space	between	characters.	You	can	create
a	text	with	a	lot	of	space	between	characters.	Or	very	little	space	between	them.	You	can	enter	any
value	you	want	in	this	field.	Or	simply	choose	from	the	drop-down	menu.



The	space	between	characters	in	action

Change	the	space	between	lines:-	

Similar	to	how	you	can	change	the	space	between	characters.	You	can	also	change	the	space	between
the	different	lines	in	your	text.	This	option	has	no	effect	if	your	text	consists	of	only	one	line.

Characters	kerning:-	



According	to	Wikipedia.	Kerning	(less	commonly	mortising)	is	the	process	of	adjusting	the	spacing
between	characters	in	a	proportional	font,	usually	to	achieve	a	visually	pleasing	result.
This	option	allows	you	to	choose	the	characters	kerning	method,	or	you	can	set	it	so	that	there	is	not
kerning	at	all.

This	is	how	kerning	works	in	general.	Picture	Credit:-	Wikipedia

Vertical	&	horizontal	scale:-	
Allows	you	to	scale(or	stretch)	the	text	either	horizontally	or	vertically.

http://en.wikipedia.org/wiki/Kerning


The	baseline	shift:-	

Determines	how	much	the	characters	are	above	or	below	the	line	of	the	text	(the	baseline).	You	can
adjust	each	character	separately	this	way	to	create	some	nice	effects.

Change	the	text
color:-	

As	the	name	suggest,	this	option	allows	you	to	change	the	text	color.

Change	the	text	style:-	



This	range	of	option	works	in	a	similar	fashion	to	the	ones	you	have	seen	in	the	Type	Tool	Options,
except	that	it	works	whether	the	font	supports	them	or	not.	And	they	offer	you	some	additional
styles	to	format	the	text.	Like	the	ones	you	could	see	in	the	picture	below:-

Open	Type	Features

These	options	allow	you	to	substitute	some	characters	in	a	certain	way,	to	make	them	look	different
(or	more	stylish?).	For	this	feature	to	work,	the	font	must	be	an	Open	Type	font,	which	are	the	fonts
that	have	the 	icon	beside	them	in	Photoshop	fonts	menu.	And	it	must	support	the	certain	feature



among	these	options.
Standard	Ligature:-	Format	the	certain	groups	of	characters.	Like	like	fi,	fl,	ff,	ffi,	and	ffl.	To
connect	differently

					

Contextual	Alternative:-	Adds	some	serifs	and	lines	to	the	text	to	make	it	look	more	like
handwriting.

Discretionary	Ligature:-	Makes	the	character	pairs	ct,	st
and	ft	looks	like	this:-

With	all	honesty,	none	of	the	fonts	I	have	support	the	pair	ft,	so	I	kept	it	at	that.



Swash:-	Makes	certain	characters	more	stylish.
Like	this:-

Stylistic	Alternative:-	Changes	the	look	of
some	characters	to	make	them	look	more	stylized,	the	characters	styled	that	way	can	look	weird

Ordinal:-	Stylizes	characters	like	1st,	2nd	and	3rd:-

Fractions:-	Stylizes	fractions:-



Anti-aliasing	method:-	Allows	you	to	choose	the	anti-aliasing	method.	Anti-aliasing	has	been
explained	earlier	in	this	chapter.

The	text	language:-	This	option	doesn’t	change	the	look	of	the	text	at	all.	It	is	there	if	you	want	to
use	the	spell-checker	of	Photoshop.	For	example,	if	you	chose	French	from	this	menu,	then
Photoshop	will	use	its	French	dictionary	to	look	for	mistyped	words.

Reset	characters
You	can	reset	all	the	changes	you	have	made	on	your	text	by	selecting	“Reset	Characters”	from	the
Character	Panel	menu.	To	do	that,	follow	these	steps:-

Click	on	the	arrow	at	the	corner	of	the	characters	panel.	A	drop	down	menu	will	appear



Select	“Reset	Characters”	from	that	menu.

Explaining	the	Paragraph	Panel
The	paragraph	Panel	is	much	simpler	than	the	character	panel.	And	it	contains	less	options.	Many	of
them	are	simple	and	self-explanatory.	In	the	paragraph	options	examples,	I	used	few	paragraphs	of
Wikipedia’s	Cat	article.	To	show	you	how	these	options	work.	Here	is	the	simple	explanation	for	the
panel.	We	will	cover	each	of	those	options	in	turn:-



Photoshop	Paragraph
Panel

Text	Align:-	Works	the	same	way	we	have	seen	so	far.	Text	align	allows	you	to	align	the	text	to	the
left,	right	or	at	the	middle.

Justifying	Text::-	To	avoid	going	through	the	difference	between	Align	&	Justify.	Let’s	say	that	this
option	gives	you	the	options	to	align	the	last	line	of	the	paragraph.	To	the	left,	at	the	middle.	Or	to	the
right.	There	is	also	the	option	to	justify	the	whole	paragraph.	Meaning	that	Photoshop	will	add	space
between	the	words,	so	that	all	the	lines	start	&end	at	the	same	point



Paragraph	indentation:-	These	two	options	allows	you	to	add	an
indent.	Or	a	space	you	could	say.	To	the	left	or	the	right	of	the	paragraph.

Indent	the	first	line:-	This	option	allows	you	to	specify	the	indentation(the	space	to	the	left	or	right)
for	the	first	line	of	the	text,	while	keeping	the	rest	of	the	text	intact.
The	space	before	and	after	the	paragraph:-	These	two	options	allows	you	to	specify	the	space
before	and	after	a	certain	paragraph



Hyphenate:-	This	option	specify	whether	the	Photoshop	will	split	the	words	that	come	at	the	end	of
the	line	into	halves.	And	add	a	hyphen	“-“	at	the	end	of	the	said	line.	Or	simply	start	the	word	in	the
next	line.	Hyphenation	is	a	common	practice	in	English	writing.

	Note:-	You	could	select	a	certain	paragraph	or	part	of	the	text.	And	apply	the	above	options
to	it	separately.	This	is	useful	in	case	you	want	a	certain	paragraphs	or	part	of	the	text	to	be	formatted
in	a	certain	way.
For	more	information	about	Fonts	in	Photoshop,	check	out	this	page	of	Adobe’s	website~

	Candy	Tip:-	Similar	to	what	we	have	seen	in	the	type	tool	options.	You	could	click	on	any	of
the	options	in	the	character	or	paragraph	panel	and	drag	your	cursor	sideway	to	increase	or	decrease
the	value	of	the	corresponded	option.	This	can	save	you	some	time	every	now	and	then.

How	to	download	and	add	fonts	to	Photoshop
In	addition	to	the	good	amount	of	fonts	that	Photoshop	comes	with,	you	could	download	tons	of	fonts
from	the	Internet.	Many	of	these	fonts	are	free.	And	some	of	them	are	only	free	for	non-commercial
use,	and	some	others	have	to	be	bought	before	you	could	use	them
In	this	part,	we	are	going	to	download	and	install	a	new	font	in	Photoshop,	and	at	the	end	of	the
chapter,	I	have	made	a	list	of	sites	that	allows	you	to	download	fonts	for	free

Downloading	the	font
In	this	example,	we	are	going	to	download	a	font	from	DaFont.com	and	add	it	to	Photoshop.	The	font
I	chose	for	this	example	is	called	Inked	God.	Which	I	hope	you	find	it	fancy	and	worth	adding	it	to

http://helpx.adobe.com/photoshop/using/fonts.html


your	fonts	collection.

Go	to	the	following	URL,	where	you	could	find	the	Inked	God
font:-	http://www.dafont.com/inked-god.font
From	what	you	could	see.	Inked	God	is	free	for	non-commercial	use	only,	to	use	it

for	commercial	uses.	You	will	have	to	contact	the	author	of	the	font.	If	you	looked	at	the	bottom
of	the	page.	You	will	see	how	each	of	the	characters	look	like.

Download	the	font	by	clicking	the	gray	download	at	the	right	of	the	screen	(and	donate	to	the
author	in	case	you	really	liked	it)

After	the	file	is	downloaded.	Unpack	the	zip	file	where	the	file	has	been	downloaded	to	get	the	font

file	inside	of	it.	For	instructions	on	how	to	unpack	Zip	files,	check	out	this	useful	post

Installing	the	font	on	your	computer
Because	Adobe	already	has	an	extensive	instructions	on	how	to	add	fonts	to	your	computer,	I	won’t
repeat	what	they	have	in	that	page.	But	I	will	cover	the	simple	way	to	install	fonts	on	Mac	OS	X	below.

To	install	a	font	in	Mac	OS	X:-
Installing	fonts	in	Mac	OS	X,	all	you	have	to	do	is	to	double	click	the	font	you	downloaded,

and	Mac	will	open	the	Font	for	you.

http://www.dafont.com/inked-god.font
http://www.adobe.com/products/type/install-instructions.html


Just	Click	on	“Install	Font”	at	the	corner	of	the	window.	And	wait	until	the	fonts	get	installed.
After	the	font	gets	installed,	restart	Photoshop.	And	you	will	find	the	font	you	installed	in	the

fonts	menu

Aligning	Text	To	Path.
Starting	from	Photoshop	CS.	Adobe	has	added	a	nice	feature	to	the	type	tool	in	Photoshop.	Which	is
the	ability	to	make	your	text	follows	any	path	you	made	with	the	pen	tool.	This	is	a	very	nice	way	to
create	a	wide	variety	of	designs,	here	is	how	to	do	that:-

First,	create	a	path	using	the	Pen	tool.	It	could	be	of	any	shape	you	want.	Here,	I	created	a
simple	arc.	Which	I	want	my	text	to	follow.

Select	the	Horizontal	Type	Tool	 	from	the	tools	panel.
Move	the	cursors	toward	the	path	you	created	in	the	first	step	(Where	you	want	your	text	to

start).	When	the	cursor	become	like	this	 .	Click	on	the	path.	And	the	text	will	be	ready	to	be
typed.	Here	is	how	my	screen	looked	like	before	I	typed	my	text:-



Now	type	the	text	you	want.	You	will	see	the	text	follow	the	path	you	clicked	on.	Here	is	how
my	text	looked	like:-

After	you	are	done	entering	the	text.	Click	on	the	✓	on	the	type	tools	options.	And	we	will	be
done.
To	move	the	text	you	created.	Select	the	Path	Selection	Tool	from	the	tools	panel,	then	click

and	drag	the	text.	And	the	text	will	move	along	with	your	cursor.	Here	is	how	I	moved	my	text	a
little	to	the	right:-

Examples
Making	a	better	Internet	memes.
In	last	chapter,	we	have	added	simple	text	to	our	Internet	meme	using	the	horizontal	text	tool.	And	we
didn’t	bother	to	resize	our	text	or	change	the	font,	because	that	was	outside	the	scope	of	the	chapter.
Now	we	are	aware	of	many	of	the	type	tool	options.	We	can	now	create	a	better	meme,	with	more
suitable	text	sizes	and	fonts.



Colored	text	+	Blending	Modes
Like	many	things	in	Photoshop,	you	could	change	blending	modes	of	the	Text	layer	however	you
want.	Which	is	a	nice	way	to	create	simple	but	good	looking	effects.	Like	how	I	did	with	the	text	in
this	picture:-

Creating	A	Simple	Logo
Fonts	are	a	nice	shortcut	in	case	you	want	to	create	a	simple	logo	and	didn’t	know	how	to	go	about	it.
Seeing	the	vast	amount	of	available	fonts	on	the	Internet.	I	created	a	simple	logo	for	an	imaginary
toys	store	using	the	font	“Patterns	&	Dots”,	which	I	found	online.	Of	course,	we	could	make	this	font
looks	even	better	by	adding	more	to	the	design:-

http://www.dafont.com/patterns-and-dots.font


List	of	sites	to	download
fonts	from:-

http://www.dafont.com/
Adobe	Fonts	Finder	
http://www.1001freefonts.com/
http://www.fontsquirrel.com/fonts/list/popular
http://www.urbanfonts.com/free-fonts.htm
http://fontzone.net/
http://www.fontspace.com/

Summary
There	are	4	Photoshop	Type	Tools,	which	allow	you	to	enter	horizontal	or	vertical	text.	Or	to

create	a	selection	from	the	text	you	type
The	Type	tool	options	allow	you	to	edit	the	text	in	multiple	of	ways.	Like	changing	the	font

size	or	color.	Or	the	font	itself.
You	could	edit	the	properties	of	the	whole	text.	Or	just	select	the	part	of	the	text	you	want	to

edit
The	type	tool	also	allows	you	to	create	a	warped	text,	which	is	a	nice	way	to	create	many

effects,	like	wave	or	flag.
Anti-aliasing	is	a	method	of	smoothing	text	so	that	it	won’t	look	so	pixelated.	It	is	particularly

useful	when	you	are	dealing	with	small	fonts,	or	low-resolution	screens.
Text	layer	is	another	type	of	layers	in	Photoshop,	as	its	name	suggests.	It	contains	some	text.

Which	you	could	to	edit	the	at	any	time
Text	layers	can	be	converted	into	raster	layers,	which	could	then	be	edited	just	like	any	other

layer	in	Photoshop
The	character	panel	offers	a	variety	of	ways	to	edit	your	text.	Including	the	ability	to	make	the

text	bold	or	italic,	even	if	the	font	doesn’t	support	that.
The	paragraph	panel	deals	with	formatting	paragraphs	in	details,	like	aligning	or	justifying

the	text.	And	setting	all	the	kinds	of	spaces	and	indentations.
Starting	from	Photoshop	CS.	You	could	make	text	follow	a	certain	path	you	drew	by	just

clicking	on	the	path	using	the	Type	Tool.
There	are	tons	of	fonts	that	could	be	downloaded	and	use	from	the	Internet

http://www.dafont.com/
http://www.adobe.com/type/fontfinder/
http://www.1001freefonts.com/
http://www.fontsquirrel.com/fonts/list/popular
http://www.urbanfonts.com/free-fonts.htm
http://fontzone.net/
http://www.fontspace.com/


Fonts	are	a	great	way	to	create	logo	or	Internet	memes

Photoshop	Photo	Manipulation	tools	Part	I:-	Clone
Stamp	Tool,	Healing	Brush	Tool	&	Spot	Healing

Brush	Tool

Because	there	are	many	Photoshop	manipulation	tools	in	Photoshop,	and	because	I	want	to	keep	the
explanation	more	focused	and	enjoyable	to	read,	I	decided	to	break	up	this	chapter	into	two	parts.	And
this	is	part	I
I	believe	this	is	going	to	be	one	of	the	most	amusing	chapters	in	this	book,	as	it	discusses	some	of	the
most	interesting	tools	in	Photoshop,	and	ones	that	are	among	the	most	useful.	As	they	allow	you	to	do
many	funny	things.	Like	adding	or	removing	things	to	and	from	a	pictures,	or	to	fix	many	problems
that	are	found	in	them.

Photoshop	Photo	manipulation	tools
There	are	6	Photo	Manipulation	tools	I	plan	to	cover,	and	in	this	chapter,	we	are	going	to	discuss	3	of
them.	The	tools	we	are	discussing	here	are:-

The	Clone	Stamp	Tool	
The	Healing	Brush	Tool	
The	Spot	Healing	Brush	Tool	

First	look	at	the	Stamp	tool	
The	Clone	Stamp	Tool	does	one	simple	&	useful	thing.	It	allows	you	to	copy	pixels	from	anywhere	in
the	picture,	or	from	another	picture	to	the	area	you	are	painting	on
If	you	selected	the	Clone	Stamp	Tool	and	begin	painting	with	it	right	away,	you	will	get	the	following
message:-



That	message	tells	you	that	you	have	to	define	a	source	point,	which	is	the	place	from
which	Photoshop	will	copy	pixels	to	where	you	are	painting
To	do	that,	simply	hold	down	alt/option	button	and	hover	your	mouse	over	your	picture,	the
cursor	will	then	turn	into	a	reticle	 	,	simply	click	with	your	left	mouse	button	and	you	will	be	done
setting	the	source.
Now	you	can	paint	anywhere	with	the	tool	and	Photoshop	will	copy	the	pixels	starting	from	the	point
you	clicked	on	in	the	last	step.

How	can	copying	pixels	from	part	of	the	picture	into
another	benefit	me	at	all?
There	are	innumerable	ways	this	can	be	useful.	It	allows	you	to	add	or	remove	things	from	pictures
without	much	efforts.	For	example,	like	how	I	removed	the	referee	from	the	following	picture:-

Photoshop	Photo	Manipulation	tools	like
the	Clone	Stamp	Tool	makes	it	easy	to	do	things	like	removing	the	referee	from	the	match

Then	I	added	some	flowers	the	same	way:-

Here	is	the	picture	where	I	got	the
flowers	from:-



The	Clone	Stamp	Tool	in	action
Right	now,	I	am	going	to	show	you	how	I	removed	the	referee	from	the	match.	If	the	referee	was	not
standing	there,	you	would	be	able	to	see	the	field	grass	that	is	behind	him.	So	to	remove	him,	all	you
have	to	do	is	to	copy	some	grass	from	the	other	parts	of	the	picture	over	him.	Here	is	how	to	do	that:-

First,	select	the	Clone	Stamp	Tool	 	from	the	tools	panel
Hover	your	mouse	where	you	want	to	copy	pixels	from,	which	is	the	grass	that’s	near	the

referee.	The	red	circle	in	the	following	picture	is	the	sampling	point	I	chose:-

Before	you	start	painting.	I	advice	you	to	make	the	tip	of	the	Clone	Stamp	Tool	soft,	which
could	be	done	by	right-clicking	on	the	canvas.	And	then	move	the	Hardness	slider	to	the	left,
just	like	we	have	done	with	the	brush	tool	in	the	past



Now	hover	your	mouse	over	the	referee.	And	Photoshop	will	interactively	shows	you	how
the	part	below	the	cursor	will	look	like	after	you	make	your	stroke:-

Now	begin	painting	over	the	referee.	You	will	be	able	to	remove	a	good	part	of	him,
depending	on	the	sample	point	you	chose.	Keep	painting	until	some	of	the	unwanted	pixels	start
to	creep	in.	Which	mean	it	is	time	to	choose	another	sample	point.	Here	is	how	things	looked
liked	from	my	side	(In	case	you	made	a	mistake,	you	could	choose	Edit->Step	Backward	to
undo	the	last	stroke	you	made):-



It	is	time	to	select	a	new	sample	point,	it	is	totally	okay	to	select	the	same	sample	point	again,
since	we	simply	want	to	paint	the	same	grass	over	the	referee	over	and	over.	Keep	repeating
what	we	did	until	you	get	rid	of	most	of	the	referee.	Here	is	how	I	got	rid	of	most	of	him.	I	had
to	change	the	sampling	point	many	times.	Especially	on	the	grass	areas	around	his	feet	&	head.
Which	look	different	than	the	grass	around	his	waist.

Now	the	referee	is	no	longer	here,	we	need	to	repaint	the	white	lines	that	were	hidden	behind
his	head	and	feet.	This	is	done	same	way	as	we	painted	the	grass.	Here	is	the	sample	point	I
chose	to	do	that,	which	is	one	of	many	you	could	choose	from	in	this	example:-



Hover	your	mouse	over	the	missing	white	line.	And	the	preview	feature	of	the	Clone	Stamp
Tool	will	help	you	make	the	correct	stroke,	like	this:-

Finish	painting	the	white	line,	then	do	the	same	with	the	second	white	line.	And	you	will	end
up	with	a	clean	picture	with	no	referee	in	it.



If	you	felt	that	the	repetitive	painting	over	the	referral	has	made	it	obvious	that	the	picture	has
been	Photoshopped.	Simply	do	a	little	more	resampling	and	painting	over	new	grass	until	the
area	feels	more	natural
Here	is	the	final	picture	without	the	referee.

The	Healing	Brush	Tool
The	Healing	Brush	Tool	 	works	the	same	way	as	the	Clone	Stamp	Tool	 .	In	that	you	specify	a
sampling	point.	And	then	copy	pixels	from	the	area	you	sampled	from	to	remove	or	add	things	to
your	picture.	But	it	comes	with	one	little	difference,	is	that	the	Healing	Brush	Tool	tries	to	match	the
lighting	of	the	area	you	are	painting	on.	For	example,	if	you	want	to	copy	some	flowers	to	the
playing	field.	And	the	flowers	Photo	has	a	different	lighting	level	than	the	playing	field.	Then	using
the	Healing	Brush	Tool	can	bring	you	much	better	results.
To	illustrate	my	point,	here	is	the	field	picture	after	I	added	some	flowers	on	it.	See	how	the	flowers
got	a	bit	green	to	match	the	field	illumination:-



Though,	with	all	honesty,	the	flowers	were	greener	than	necessary	there.	And	more	adjustment	needed
to	be	done	on	them

Note:-	To	access	the	Healing	Brush	Tool.	Click	and	hold	your	mouse	over	the	Spot	Healing	Brush
Tool.	And	Photoshop	will	show	you	the	rest	of	the	tools	under	it.	Just	like	you	did	with	the	selection
tools	and	pen	tools

Accessing	Healing	Brush	Tool	from	the	Tools	Panel

The	Spot	Healing	Brush	Tool
As	its	name	says,	the	Spot	healing	brush	Tool	 	heals	and	remove	Spot	problems	in	your	images,
like	skin	blemishes,	dirty	or	unwanted	spots.	This	works	similar	to	cleaning	the	table	you	spilled
some	coffee	on.	The	good	thing	about	the	Spot	Healing	Brush	Tool	is	that	it	is	smart	enough	to	match
the	texture	and	lighting	of	the	area	you	are	healing.
Using	the	Spot	Healing	Brush	Tool	is	simple;	all	you	have	to	do	is	to	select	the	tool,	then	paint	over
the	part	you	don’t	want.	Along	with	some	of	the	area	around	it,	and	it	will	do	the	job	for	you.
To	get	the	best	results	from	the	tool,	make	sure	that	the	part	you	don’t	want	is	at	the	middle	of	the	area
you	are	painting.
In	the	following	picture,	I	was	able	to	remove	that	blemish	from	the	man’s	neck	with	the	healing
brush.	And	it	is	as	if	I	erased	it,	while	you	could	do	the	same	thing	with	the	Clone	Stamp	tool.	The
easiness	and	quickness	of	the	Spot	Healing	Brush	Tool	makes	it	more	ideal	for	things	like	that:-

Blemishes	like	that	in	the	picture	can	be	easily
removed	using	the	Spot	Healing	Brush	Tool



As	long	the	things	you	want	to	hide	from	the	picture	is	at	the	middle	of	the	area	you	are	painting,	the
Spot	Healing	Brush	Tool	will	do	a	very	good	job	removing	that	part	for	you.
Back	to	our	game	example,	I	was	able	to	remove	one	of	the	players	easily	the	same	way.	And	it	did	a
very	good	job	at	that.	All	is	left	was	to	redraw	the	white	lines	of	the	field,	just	like	we	did	before:-

The	player	has	been	removed	quickly	and
easily	using	the	Spot	Healing	Brush	Tool

The	Align	option	in	Clone	Stamp	Tool	And	Healing	Brush
Tool.

This	option	determines	whether
the	Clone	Stamp	Tool	or	the	Healing	Brush	tool	will	copy	pixels	starting	from	the	same	sampling
point	every	time	you	paint	(when	it	is	unchecked).	Or	if	it	will	copy	the	pixels	from	a	point	that	is	the
same	distance	away	from	your	cursor	(when	it	is	checked).
To	illustrate	this	confusing	difference,	take	a	look	at	the	following	colored	rectangles.	First,	I	will
sample	the	white	point	pointed	here,	while	making	sure	the	Aligned	option	is	unchecked:-

Then	I	will	begin	painting	at	the	left	of	the	rectangle,	and	the	Clone	Stamp	Tool	(Or	the
healing	brush,	whatever	you	are	using)	will	copy	the	pixels	for	me.	So	far,	nothing	is	different.



Now	let’s	start	painting	again	on	the	area	above,	here	is	what	I	got:-

As	you	can	see,	the	point	Photoshop	copies	the	pixels	from	the	same	sample	point	in	both
cases.	And	it	will	still	do	the	same	as	long	as	the	Aligned	option	is	unchecked:-

Now	let’s	redo	all	these	steps,	but	with	the	aligned	option	checked	this	time.	I	sampled	the



same	point	and	started	painting	on	the	bottom	of	the	picture:-

And	then,	I	painted	again	&	again	on	the	area	above:-

See!	The	point	Photoshop	copies	pixels	from	changed	to	match	the	distance	between	the	first
area	you	painted	on	and	the	sample	point.	You	can	keep	painting	until	you	have	the	colored
rectangles	all	copied	on	the	left.	Determining	whether	to	check	or	uncheck	the	Align	option
depending	on	what	makes	it	easier	to	you	to	achieve	the	results	you	want.

Examples:-
Changing	the	face	of	someday
I	took	a	girl	face	from	another	picture	and	copied	it	on	the	body	of	another ’s.	Which	it	looked	almost
perfect.	Doing	some	more	rotating	and	resizing	of	the	new	face	can	make	it	look	even	more	realistic



than	what	it	is	now.

Artificial	Sunset
Take	a	look	at	the	following	scenery.	Isn’t	that	beautiful?

I	bet	it	would	look	fairly	nice	at	sunset.	So	let’s	bring	out
a	sunset	picture,	like	this	one:-



And	using	the	Clone	Stamp	Tool	with	a	soft	brush	tip.	I	painted	a	new	sky	over	the	original	one.	I	did
some	erasing	to	erase	some	of	the	pixels	that	covered	the	trees	by	mistake

To	make	the	scene	look	more	realistic,	in	a	new	layer,	I	painted	orange	over	the	rest	of	the	picture,
then	changed	the	layer ’s	blending	mode	to	Hard	Light.	And	then	decreased	the	opacity	until	I	was
satisfied	with	the	results.	Here	is	the	final	picture:-

The	New	man	at	the	meeting



Using	the	Healing	Brush	Tool.	I	added	a	new	man	to	the	meeting	below.	I	used	the	Healing	Brush	tool
because	it	saved	me	the	trouble	of	trying	the	fit	the	man	illumination	in	the	new	picture.	While	I	still
need	to	make	sure	the	man	fits	more	in	the	picture	using	the	Brush	Tool.	The	amount	of	work	needed
for	that	is	much	less	than	in	case	I	used	the	Clone	Stamp	Tool

Removing	cat	eyes
Using	the	Spot	Healing	Brush	Tool,	you	could	remove	the	eye	of	a	cat	using	very	few	strokes.	Don’t
get	me	wrong;	the	purpose	of	doing	that	is	not	to	create	an	ugly	picture,	but	rather	to	draw	your	own.
Which	is	a	great	practice	in	case	you	are	a	digital	artist:-

Pulling	out	a	Photoshop	Scam
This	is	a	fictional	scam	I	made	up	to	show	you	how	much	you	could	do	with	the	tools	explained	in
this	chapter.	I	made	the	house	in	the	picture	below	look	much	better	by	adding	fields	and	a	luxury	car
besides	it.	Making	it	looks	much	better	than	it	is	in	reality.	Unfortunately,	such	practices	actually	exist
in	this	world.



Restoring	an	old	Photo
Photoshop	Photo	Manipulation	Tools	are	not	just	limited	to	playing	with	pictures.	But	they	can	also
do	a	lot	of	restoring	the	details	of	old	Photos.	Like	removing	all	the	cracks	in	the	following	picture
(Picture	credit:-	Wikipedia).

Summary
In	this	chapter,	we	focused	on	3	Photo	manipulation	tools.	The	Clone	Stamp	Tool,	The

Healing	Brush	Tool,	and	the	Spot	Healing	Brush	Tool
The	Clone	Stamp	Tool	copies	pixels	from	the	sample	point	to	the	area	you	choose.	It	does

that	the	same	way	you	would	do	it	with	selection	tools	and	Copy	&	Paste,	except	that	it	is	more
convenient.
The	Healing	Brush	Tool	works	the	same	way	as	the	Clone	Stamp	Tool,	it	also	tries	to	match

the	illumination	of	the	target	area	to	make	the	object	you	are	copying	fit	with	the	picture,
which	is	so	useful	in	many	situations.
The	Align	option	of	the	Clone	Stamp	Tool	and	the	Healing	Brush	Tool	determines	whether

Photoshop	will	copy	pixels	from	the	same	point	every	time	you	paint.	Or	move	the	sample
point	so	that	it	is	aligned	with	the	first	point	you	clicked	on	when	you	started	copying.
The	Spot	Healing	Brush	Tool	is	a	nice	way	to	remove	things	you	don’t	want	from	the	picture.

Like	blemishes	or	even	whole	objects	like	players	in	the	field.

http://commons.wikimedia.org/wiki/File:Portrait_restoration,_before_and_after.jpg


Photoshop	Photo	Manipulation	Tools	Part	II:	Patch
Tool,	Content-Aware	Move	Tool,	And	Content-

Aware	Fill

In	this	chapter,	we	will	continue	focusing	on	Photoshop	photo	manipulation	tool.	The	three

tools	we	are	discussing	here	are	The	Patch	Tool	 	,	the	Content-Aware	Move	tool	 	and	Content-
Aware	Fill	option	(which	has	no	icon).	If	you	understood	how	the	Spot	Healing	Brush	Tool	in	part	I,
you	already	have	a	very	good	foundation	on	what	content-aware	tools	do.

What	is	Content-Aware?
Content-aware	is	a	feature	Adobe	introduced	in	Photoshop	starting	from	Photoshop	CS5.	This	feature
basically	removes	a	certain	part	of	a	picture	by	analyzing	its	surrounding	area.	Without	you	having	to
do	much	work	at	all.	We	have	seen	a	little	example	of	how	this	work	in	the	last	chapter,	when	we
removed	a	big	blemish	from	a	man’s	neck	using	the	Spot	Healing	Brush	Tool.	The	three	tools	we	are
discussion	here	all	work	the	same	way.	But	each	of	them	is	slightly	different.

The	Patch	Tool	
The	Patch	Tool	 	allows	you	to	select	a	part	of	the	picture	you	don’t	want.	And	then	replace	it	by
one	you	do.	To	illustrate	the	point,	take	a	look	at	the	following	picture.	Where	we	have	a	little	girl
sitting	between	flowers.



Assume	we	want	to	remove	the	girl.	All	we	have	to	do	is	use	the	Patch	tool	to	select	the	girl,	then
drag	the	selection	into	the	grass	and	flowers	around	her.	Here	is	how	to	do	that:-

Select	the	Patch	Tool	 	from	the	tools	Panel.	If	you	can’t	see	the	Patch	tool.	Simply	click
and	hold	on	the	Healing	Brush	Tool	or	the	Spot	Healing	Brush	Tool	and	Photoshop	will	display
the	rest	of	the	tools	below	it

Click	and	drag	your	mouse	to	select	the	girl	on	the	picture,	here	is	how	my	selection	looked
like:-

In	the	Patch	Tool	Options,	make	sure	that	Source	option	is	selected	instead	of	destination.



This	option	determines	whether	Photoshop	will	replace	the	source	(which	is	the	girl	here),	with
the	destination	(The	grass	around	her).	Or	if	it	will	replace	the	destination	(the	grass)	with	the
source	(the	girl).	If	you	chose	destination	here,	Photoshop	will	create	a	replica	of	the	girl.
Choosing	source	or	destination	is	just	a	convenient	way	Photoshop	offers	to	you	to	make	your
workflow	much	smoother.	As	it	is	possible	do	anything	you	want	by	knowing	one	of	them.

Now	click	on	the	girl	selection,	and	drag	it	to	the	grass	section,	while	you	are	doing	that,
Photoshop	will	show	you	a	preview	of	how	the	picture	will	look	like	after	you	release	your
hand	off	the	mouse	button.	Here	is	how	the	preview	looked	like	to	me:-

Now	release	the	mouse	button,	and	wait	until	Photoshop	do	all	the	work	of	patching	the
picture.	Here	is	the	final	picture	I	got:-



The	source	and	destination	options

The	source	and	destination	options	of	the	Patch	Tool	 	determine	whether	you	want	to	replace	the

source	with	the	destination	or	vice	versa.	As	I	stated	in	the	above,	if	we	followed	the	same	steps	as	we

did	above.	But	instead	of	selecting	destination	instead	of	source,	Photoshop	will	remove	the	grass	on

the	destination,	and	replace	it	with	the	girl,	creating	something	that	looks	like	this:-

The	Content-Aware	Move	Tool	
The	Patch	Tool	 	did	a	very	good	job	at	removing	the	girl	in	the	last	example.	But	instead	of
removing	the	girl	altogether,	we	just	wanted	to	move	her	a	little	to	the	left	or	to	the	right.	The
Content-Aware	Move	Tool	does	just	that.	And	the	steps	to	use	it	is	the	same	as	the	Patch	Tool	above:-

Select	the	Content-Aware	Move	Tool	 	from	the	tools	panel
Just	like	we	did	with	the	Patch	Tool	 ,	select	the	girl	by	dragging	your	mouse	cursor

around	her.



.

Drag	the	girl	you	where	you	want	to.	And	Photoshop	will	show	you	a	preview	of	how	the	girl
will	look	like	after	you	release	the	mouse	button.	This	is	how	things	looked	like	to	me:-

Release	the	mouse	button,	and	wait	for	Photoshop	to	finish	working	on	the	picture.	After	that,
the	girl	will	be	on	the	new	spot	you	chose	for	her:-

You	may	have	noticed	that	Photoshop	removed	the	flowers	from	where	the	girl	was.	This	is



totally	fine.	While	the	Content-Aware	tools	in	Photoshop	did	indeed	a	great	job	at	moving	the
girl	to	her	new	spot.	The	content-aware	technology	is	not	%100	perfect,	you	will	encounter
many	situations	like	that	in	your	Photoshop	life.	Which	is	why	I	don’t	try	to	use	pictures	that
produces	perfect	results.	You	have	some	of	what	you	can	do:-

Try	to	do	the	same	things	using	another	tool	or	technique.
Copy	the	flowers	again	using	the	Patch	Tool	or	the	Clone	Stamp	Tool,	like	I	did	here:-

Content-Aware	Fill
Introduced	in	Photoshop	CS5,	Content-Aware	Fill	allows	you	to	eliminate	any	element	you	don’t	want
in	a	picture,	just	like	we	did	using	the	Patch	Tool	and	the	Spot	Healing	Brush	Tool.	In	additional	to
that,	it	can	also	be	used	to	“extend”	a	picture	that	has	missing	parts.	Just	how	we	filled	in	the	mountain
and	the	sea	in	the	following	picture:-



Using	Content-Aware	Fill
To	use	the	Content-Aware	Fill,	all	you	have	to	do	is	to	select	the	part	you	don’t	want	in	your	picture,
using	any	of	Photoshop	Selection	Tools.	And	then	select	Edit->Fill	from	the	main	menu.	Let’s	do	that
now~
Suppose	we	don’t	want	the	towel	in	the	following	picture.	So	let’s	use	Content-Aware	Fill	to	remove
it:-

I	used	the	Lasso	Tool	 	to	select	the	towel	and	the	area	around	it.	But	you	can	use	any	of	the



other	selection	tools	if	you	like.	Like	the	Pen	Tool:-

Select	Edit->Fill	from	the	main	menu,	and	the	Fill	dialog	appears

	

Select	Content-Aware	from	the	Use	menu.	Then	click	OK.	And	now	it	is	Photoshop’s	turn	to
do	its	magic



Et	voilà.	The	towel	is	gone.	Without	having	to	do	much	work	on	our	part.	This	is	one	of	the
reasons	I	think	mathematics	is	nice~

Using	Content-Aware	fill	to	extend	a	picture
Extending	a	partial	picture	by	filling	in	the	missing	pixels	is	my	favorite	Content-Aware	fill	trick.	IN
this	section,	we	are	going	to	fill	the	rest	of	the	sea	and	the	mountain	behind	it	using	the	Content-Aware
fill.



Select	the	area	you	want	to	Photoshop	to	fill	with	pixels.	Which	is	the	white	area	that	has	no
pixels.	To	do	that,	I	selected	the	pixels	of	the	sea	layer,	then	inverted	the	selection	by	selecting
Select->Inverse	from	the	main	menu

To	fill	the	selected	pixels,	select	Edit	->	Fill	from	the	main	menu,	and	the	Fill	dialog	appears



Select	Content-Aware	from	the	Use	menu.	Then	click	OK.

After	Photoshop	finish	filling	the	picture,	you	will	end	up	with	the	full	sea	&	mountains
picture	you	see	here:-



Content-Aware	tools	VS	Spot	Healing	Brush	Tool
The	Spot	Healing	Brush	Tool	and	the	Content-Aware	tools	we	discussed	here	are	so	similar.	You	may
be	wondering	when	to	use	any	of	these	tools,	and	you	probably	know	my	answer:-	“Use	whatever	you
think	is	best	for	the	job”.
In	a	complex	and	vast	program	like	Photoshop,	there	is	usually	more	than	a	single	way	to	do	a	certain
thing.	One	way	to	go	about	it	is	to	use	the	Spot	Healing	Brush	Tool	to	remove	small	spots	from
pictures,	like	blemishes	and	pimples.	And	the	other	Content-Aware	tools	to	remove	and	fill	bigger
parts	your	pictures.	Or	you	could	also	ignore	the	Spot	Healing	Brush	Tool	all	together	and	use	the
Content-Aware	Tools	we	discussed	here,	this	is	all	up	to	you	to	decide.
It	is	worth	it	to	note	that	there	are	times	when	the	Content-Aware	Tools	will	fail	to	do	the	job.	In	which
case	doing	it	using	the	older	tools	like	the	Clone	Stamp	Tool	is	much	better.	Like	how	they	failed	to
fully	match	the	tiles	pattern	after	removing	the	cat:-

Examples
Moving	a	cat	around
Let’s	play	with	the	following	cat:-



We	could	remove	the	whole	cat	altogether	using	the	Patch	Tool	 :-

Or	we	could	move	her	to	another	place	using	the	Content-Aware	Move	Tool	 :-

Removing	the	mountains
Content-Aware	Fill	can	be	used	to	remove	a	while	range	of	mountains	from	the	sea	picture.	Though
the	selection	was	a	little	bit	tricky:-



Removing	Blemishes
Content-Aware	Fill	can	be	used	to	remove	a	large	amount	of	Blemishes,	like	how	I	did	with	the
following	forehead.	To	do	that,	I	had	to	use	the	Content-Aware	fill	multiple	of	times	on	the	picture.
Which	makes	me	wonder	if	I	should	have	used	the	Healing	Brush	Tool	is	better	for	that:-

Summary
Content-Aware	Tools	use	mathematics	to	fill	the	missing	details	of	pictures.	Without	you

having	to	do	much.
The	Patch	Tool	 	patches	a	certain	area	you	select	using	the	pixels	of	another	area.
You	could	replace	the	destination	with	the	source	and	vice	versa	from	the	Patch	Tool	options.



The	Content-Aware	Move	Tool	works	the	same	way	as	the	Patch	Tool.	Except	that	it	moves
the	object	to	somewhere	else	in	the	picture	instead	of	removing	it.	And	it	uses	Content-Aware	to
seamlessly	remove	any	trace	of	the	moved	object,	and	to	integrate	that	object	into	the	new	place
you	move	it	to
The	Content-Aware	Fill	is	similar	to	the	Patch	Tool.	But	it	can	do	more,	like	filling	a	missing

part	of	a	picture	so	easily.
Usually,	you	use	the	tool	you	think	is	the	best	for	the	job.	The	Spot	Healing	Brush	Tool	can

be	used	to	remove	small	spots	from	pictures,	like	blemishes	or	freckles.	While	the	other
Content-Aware	Tools	can	be	used	to	remove	bigger	parts.

Photoshop	Blur	Tool,	Sharpen	Tool	and	the
Smudge	Tool

In	this	chapter,	We	are	going	to	discuss	3	more	tools,	which	are	the	Blur	Tool	 ,	The	Sharpen	Tool	

	and	The	Smudge	Tool	 	.
The	blur	tool	decreases	the	focus	of	part	of	the	picture,	the	sharpen	tool	does	the	opposite,	it	increase
the	focus	of	a	certain	area,	or	sharpen	it	in	other	words,	while	the	smudge	Tool	smears	the	picture,
similar	to	what	you	could	to	paints	with	your	finger.	Which	is	why	is	has	a	finger	icon

The	Blur	Tool	
The	blur	tool	 	decreases	the	focus	of	the	part	of	the	picture	you	paint	on.	This	is	useful	to	integrate
a	new	object	into	the	picture,	or	to	remove	very	small	blemishes	from	someone’s	face.
Bigger	blemishes	should	be	removed	by	using	the	Spot	Healing	Brush	Tool	 ,	or	any	similar	tool
to	it.
To	illustrate	how	the	Blur	tool	works,	take	a	look	at	the	line	on	the	picture	on	the	left.	See	how	sharp
it	is.	And	compare	it	to	the	same	line	on	the	right.	And	notice	see	how	blurred	and	unfocused	it	looks
like.	This	is	because	I	blurred	it	using	the	blur	tool.



Using	the	Blur	Tool	is	so	straightforward;	all	you	have	to	do	is	to	select	the	tool,	and	then	paint	on	the
picture	with	it,	just	like	we	do	with	the	brush	tool.

I	am	going	to	show	you	two	examples	for	the	Blur	Tool,	one	that	works,	and	one	that	doesn’t	work
that	well.
Take	a	look	at	the	following	girl	picture:-

If	you	looked	carefully,	you	will	see	a	little	blemish	on	the	girl	face,	this	blemish	can	be	removed
easily	with	the	Blur	Tool.



To	remove	the	blemish,	do	the	following:-
Select	the	Blur	Tool	 	from	the	Tools	Panel
Adjust	the	brush	size	of	the	tool,	mine	looked	like	that:-

Now	click	and	drag	the	mouse	a	little	over	the	small	blemish,	then	release	the	button.	Do	that
about	10	times,	and	the	blur	tool	will	blend	the	area	with	the	blemish	with	its	surroundings.
Causing	the	blemish	to	disappear



Now	let’s	work	on	the	example	that	doesn’t	exactly	work.	We	will	try	to	remove	the	bigger
blemish	in	the	middle	of	the	girl’s	face:-

Select	the	Blur	Tool	 	from	the	Tools	Panel.	And	start	making	strokes	on	that	spot.	No
matter	how	much	you	stroke	the	area,	the	blemish	won’t	go.	The	reason	for	that	is	because	the
Blur	Tool	is	not	made	for	making	very	strong	blur	like	the	one	needed	to	remove	the	blemish.
Making	it	unsuitable	for	the	job.	So	if	you	want	to	remove	that	blemish,	you	will	have	to	do	one
of	the	following:-

Using	another	tool,	like	the	Spot	Healing	Brush	Tool	or	the	Patch	Tool.
Use	a	more	powerful	blurring	technique,	like	the	Gaussian	Blur	Filter.	Which	we	will

talk	about	when	we	get	to	talk	about	filters	later	in	this	book

Integrating	a	new	object	into	a	picture	using	the	Blur	Tool
Here	a	girl	I	pasted	onto	the	field	picture:-



And	for	many	reasons,	the	girl	stands	out	in	the	picture,	causing	her	to	appear	unnatural.	And	it	is
obvious	that	she	didn’t	belong	to	the	picture	in	the	first	place.	One	of	the	few	things	that	could	be	done
to	integrate	her	with	the	picture	is	to	blur	the	edges	or	the	girl	using	the	Blur	Tool.	Because	if	you
looked	closely,	you	will	see	that	the	edges	of	the	girls	are	so	sharp.	Which	is	part	of	what	made	her
stand	out	in	the	first	place:-

After	going	through	the	edges	with	the	Blur	Tool,	the
edges	seem	a	bit	smoother	now:-

Here	is	the	picture	after	I	zoomed	out.	Notice	how	I	applied	more	blur	on	her	feet	to	makes	them	look



like	they	sink	into	the	grass

Another	thing	you	could	do	to	integrate	the	girl	more	into	the	picture	is	to	match	her	lighting	with	the
picture.	So	on	a	different	layer,	I	painted	some	green	over	the	girl	using	a	soft	brush.	Then	I	changed
the	Blending	mode	to	Soft	Light	and	decreased	the	layer ’s	flow/opacity	until	I	was	satisfied	with	the
results.	Here	are	the	final	image	I	got:-

The	Sharpen	Tool	
The	Sharpen	Tool	 	does	exactly	the	opposite	of	the	Blur	Tool	 .	It	sharpens	the	edges	of	the
pixels	you	paint	on.	Which	is	a	good	way	to	make	certain	parts	of	the	picture	stand	out.	Or	to	remove
some	Blur	that	may	exist	in	the	picture.
To	illustrate	how	the	Sharpen	Tool	works,	we	are	going	to	sharpen	some	parts	of	the	fur	in	the
following	Panda.	To	make	these	parts	of	the	fur	stands	out	more:-



To	do	that,	select	the	Sharpen	Tool	 	from	the	Tools	Panel,	and	then	start	painting	with	the	tool.
After	a	few	strokes,	the	details	of	the	Panda	face	start	to	stand	out	more.

Don’t	overdo	it	with	the	Sharpen	Tool
With	the	Sharpen	Tool	 .	It	is	certainly	a	pleasure	to	see	the	details	of	the	picture	appears	in	front	of
you.	This	is	one	of	the	reasons	Photoshop	Beginners	tend	to	overdo	using	the	tool	trying	to	get	better
results.	And	end	up	destroying	their	photo.	When	editing	pictures	using	Photoshop.	You	have	to
remember	that	in	Photo-editing,	sometimes	less	is	more.	So	choosing	to	sharpen	a	little	bit	less	is
usually	better	than	ending	up	with	a	distorted	picture.	Like	how	the	following	Panda	picture	was
sharpened	to	death:-

http://michellekanephotography.com/2012/01/31/sometimes-less-is-more-when-editing-photos-by-linda-gentry/


One	great	alternative	for	the	Sharpen	Tool	is	the	Unsharp	Mask	filter,	which	is	explained	in	the	filters
chapter

The	strength	option	of	the	Blur	Tool	&	The	Sharpen	Tool

The	strength	option,	which	exists	for	both	the	Blur	Tool	&	The	Sharpen	Tool,	allows	you	to	adjust
how	powerful	the	effect	of	the	tool.	Sometimes,	the	effect	of	each	stroke	from	the	tool	is	not	enough,
so	you	need	to	increase	the	strength	of	the	tool	to	get	faster	results.	Likewise,	sometimes	the	strength
of	the	tool	is	a	bit	too	much,	where	you	need	to	decrease	the	power	of	the	tool	to	get	the	exact	effect
you	want
Take	a	look	at	the	following	Deer	picture:-

I	sharpened	the	back	of	the	Deer	so	sharply	by	setting	the	strength	of	the	Sharpen	Tool	to	%100.	It
took	me	3	strokes	only	to	sharpen	his	back	that	way:-



Then	I	redid	the	sharpening	again,	but	this	time,	the	strength	of	the	Sharpen	tool	was	set	to	%25.	So	it
took	me	12	strokes	to	get	the	same	amount	of	sharpening:-

Generally	speaking,	you	could	achieve	everything	you	want	by	keeping	the	strength	of	the	Blur	Tool
or	Sharpen	Tool	so	low,	though	that	will	require	you	to	do	much	more	clicking	to	achieve	the	same
result,	which	could	lower	your	productivity	to	some	degree.

The	Smudge	Tool	
The	Smudge	Tool	 	is	intended	to	use	for	painting,	it	aims	at	simulating	the	process	of	smudging
the	colors	with	your	finger.	Similar	to	how	painters	do	in	traditional	drawing.	But	the	tool	can	still	be
used	to	do	some	minor	editing	as	well
I	was	able	to	make	the	Panda	eyes	bigger	using	the	Smudge	tool	here.	If	you	looked	carefully,	you
will	notice	that	the	edges	of	the	eyes	became	somewhat	distorted.	Which	could	be	fixed	to	some
degree	by	the	sharpening	it	using	the	Sharpen	Tool:-



The	Strength	Of	The	Smudge	Tool

Just	like	the	Blur	Tool	&	The	Sharpen	Tool.	The	Smudge	Tool	has	a	strength	option	that	determines
how	powerful	your	strokes	will	move	the	picture	pixels.	The	more	powerful	the	strength,	the	more
pixels	will	move	by	your	strokes.	Here	is	how	this	option	works	in	general:-

Notice	how	the	Smudge	Tool	at	%100	strength	moves	all	the	pixels	that	are	below	the	cursor.

Warning:-	Be	careful	about	using	the	Smudge	Tool	with	huge	brush	tip,	as	doing	so	may	cause
Photoshop	to	do	lengthily	calculations.	Rendering	it	useless	until	these	operations	end.	Or	until	you
force	quit	the	program

Finger	painting

A	nifty	feature	of	the	Smudge	tool	is	the	Finger	Painting	check	box.	When	this	option	is	checked,	the
smudge	tool	adds	a	little	stroke	to	the	picture,	which	is	fairly	useful	in	case	you	want	to	use	the	tool
for	painting	and	color	blending.
I	added	a	few	red	strokes	on	the	Panda	head	using	the	Finger	Paint	option.



And	after	working	on	it	a	little	bit,	I	ended	up	making	the	following	hat:-

Note:-	The	Liquify	filter	provides	a	much	easier	way	to	manipulate	pictures	than	the	Smudge
Tool.	The	Liquify	filter	will	be	explained	in	the	filters	chapter

Summary
The	Blur	Tool	smooths	the	pixels	you	paint	one,	making	them	look	misty	or	less	focused
The	Sharpen	Tool	does	exactly	the	opposite	of	the	Blur	Tool.	It	increases	the	sharpness	of	the

pixels	by	increasing	the	contrast	between	them
Overusing	the	Blur	Tool	or	the	Sharpen	Tool	can	lead	to	less	than	ideal	results.	So	be	careful

about	using	them,	and	always	remember	that	less	is	more	when	it	come	to	photo-editing
The	strength	option	of	the	Blur	Tool	&	Sharpen	Tool	determines	how	much	blurring

or	sharpening	happens	with	each	stroke	you	make.	This	is	useful	way	to	apply	effects	precisely
on	your	pictures



The	Smudge	Tool	simulates	smudging	&	mixing	colors	with	your	finger,	and	it	is	a	very
useful	tool	to	use	for	digital	painting
The	strength	option	of	the	Smudge	Tool	determines	how	much	and	how	far	pixels	are	moved

with	each	stroke
Fingerprint	option	of	the	Smudge	Tool	applies	a	little	color	alongside	your	stroke,	which	is	a

good	why	to	mix	multiple	colors	together

Examples
Blur	the	surroundings	of	an	object
The	Blur	Tool	can	be	used	to	blur	the	surrounding	of	the	object	you	want	to	be	the	center	of	focus.
That	way,	the	viewers	of	the	picture	will	tend	to	focus	on	it	when	they	look	at	it	(A	similar	&	better
example	to	this	will	be	introduced	in	the	filters	chapter):-

Emphasizing	the	details	of	a	picture
The	Sharpen	tool	is	a	very	good	way	to	emphasize	the	details	of	a	pictures.	As	I	have	done	with	the
following	dog	picture

Creating	a	logo
The	Smudge	Tool,	along	with	the	fingerprint	option,	can	be	used	to	create	a	simple	logo.	Like	the	one
I	created	for	the	fictional	company	“Fire”:-



Photoshop	Dodge	Tool,	Burn	Tool,	And	the
Sponge	Tool

The	Dodge	Tool	
The	Dodge	Tool	is	used	to	lighten	a	part	of	the	picture,	which	makes	it	very	good	way	to	lighten	a
picture	or	parts	of	it,	like	how	we	are	going	to	see	now
Take	a	look	at	the	following	flowers	picture,	notice	how	the	flowers	is	kind	of	dark:-



Using	the	default	settings	of	the	Dodge	Tool.	You	could	lighten	the	picture	a	little	bit	more.	By
making	a	few	dabs	with	the	Dodge	tool,	and	causing	the	flowers	to	look	much	better:-

The	Range	option	of	the	Dodge	Tool:-



The	Range	option	of	the	Dodge	Tool	determines	the	range	of	values	(or	colors)	that	get	affected	by

your	strokes.	If	you	selected	Shadows,	then	mostly	the	dark	areas	will	be	lightened.	If	you	selected

Highlights,	then	the	bright	area	will	be	affected	the	most	by	your	strokes.	Midtones	affects	the	values

in	between.

Take	a	look	at	our	flowers	picture;	I	applied	similar	strokes	on	the	picture	using	each	of	the	range
options.	Notice	how	when	I	applied	the	strokes	using	Shadows.	The	midtones	and	highlights	areas	got
barely	affected,	making	them	a	good	way	to	remove	shadows	from	a	dark	picture.	While	the
Highlights	affected	the	bright	areas,	causing	them	to	become	even	brighter

The	Shadows	Range	option	is	certainly	useful	at	shedding	some	light	on	a	dark	picture,	the	this	one:-

	
The	Exposure	setting	of	the	Dodge	Tool:-
The	Exposure	setting	of	the	Dodge	Tool	is	similar	to	the	Strength	option	of	the	Blur	Tool	&	the
Sharpen	Tool.	The	more	the	exposure	is,	the	more	powerful	the	affect	of	each	strokes	you	make	will
be.	Using	low	exposure	is	a	good	way	to	apply	precise	effect	on	pictures.	While	high	level	of
exposure	can	help	you	apply	a	powerful	effect	to	the	picture,	something	you	may	want	to	avoid	doing
most	of	the	time.
In	short,	high	Exposure	level	is	a	way	to	achieve	a	bigger	effect	using	less	strokes.	Take	a	look	at	the



following	cat	picture,	I	applied	two	strokes	using	%25	exposure,	%50	exposure	and	%100	exposure
respectively.	Notice	how	the	effect	gets	stronger	with	the	higher	exposure	level:-

The	Burn	Tool	
Remember	when	we	discussed	Blending	modes	of	the	Brush	Tool.	And	how	I	describe	the	Color
Burn	blending	as	the	mode	that	burns	the	colors	of	the	picture?	The	Burn	Tool	 	does	exactly	that,	it
darkens	a	certain	area	of	the	picture;	which	is	the	opposite	of	what	the	Dodge	Tool	does
The	Burn	Tool	is	useful	for	darkening	bright	areas	of	pictures,	or	to	correct	the	illumination	in	them.
Just	like	how	I	toned	down	the	illumination	of	the	following	room	a	little	bit	(the	effect	is	too	slight
here,	but	it	is	obvious	more	on	the	lower	part	of	the	picture):-

The	Burn	Tool	is	also	a	good	way	to	emphasize	the	dark	area	of	faces,	like	the	eyebrows	and	the
eyelashes.	It	gives	you	the	same	feeling	as	applying	mascara	to	the	eyes	(Again,	the	effect	is	not	easy
to	see,	but	notice	how	the	mascara	became	a	bit	thickened	around	the	girl’s	eyes	:)

Range	of	the	Burn	Tool



The	Burn	Tool	has	the	same	range	option	of	the	Dodge	Tool.	Which	allows	you	to	specify	the	values
or	tones	that	gets	affected	mostly	by	your	strokes,	be	it	the	dark	areas	(Shadows),	the	bright	areas
(Highlights)	or	the	areas	in-between	(Midtones).	Choosing	the	most	suitable	range	can	insure	you	get
the	best	results	possible.
Darkening	the	mascara	using	the	Burn	Tool	while	setting	the	range	to	Shadows	produced	better
results	than	when	did	it	with	mid	tones:-

Now	take	a	look	at	the	earth	picture,	the	picture	in	the	upper	left	corner	is	the	original	one.	While	the
other	three	have	been	painted	with	the	burn	tool	using	the	Shadows,	Midtones	and	Highlights
respectively,	notice	how	in	the	Highlights	picture,	the	bright	areas	of	the	picture	got	dimmed,	while	in
the	Shadows	one,	the	dark	areas	got	darker:-



The	exposure	option	of	the	Burn	Tool
Similar	to	the	exposure	of	the	Dodge	Tool,	the	exposure	setting	of	the	Burn	tool	allows	you	to	burn
the	image	more	or	less	with	each	stroke,	depending	on	the	exposure	value	you	choose
In	the	following	picture,	I	made	5	strokes	in	the	area	marked	by	the	white	rectangle,	using	exposure
levels	%25,	%50	and	%100	respectively.	And	I	got	a	more	powerful	effect	each	time	the	exposure	was
higher:-



The	Sponge	Tool	
The	Sponge	Tool	adds	or	takes	color	from	the	picture.	In	other	words,	it	saturates	or	desaturates	the
picture	colors.	It	can	be	used	to	enhance	the	colors	your	pictures,	or	to	lessen	them	in	case	they	were	a
bit	much	colors	in	a	certain	area.
The	Sponge	Tool	desaturates	the	colors	of	the	pictures	by	default.	And	if	you	overdid	it,	you	will	end
up	turning	the	colors	of	part	of	the	picture	into	grayscale,	just	like	this:-



But	you	can	change	the	mode	of	the	tool	to	make	it	adds	colors	to	the	picture	instead	of	taking	it	away,
using	the	mode	option.

Here	is	how	I	added	colors	to	the	electric	car	instead	of	taking	it	away,	overdoing	it	can	produce
some	interesting	results:-



The	Flow	Option	of	the	Sponge	Tool
The	flow	option	of	the	Sponge	Tool	work	the	same	way	the	flow,	strength	or	exposure	settings	of	the
other	Photoshop	tools.	It	determines	how	much	your	strokes	affect	your	picture.	In	other	words,	it
determines	how	much	your	strokes	saturates	or	desaturates	the	area	you	paint	on.
I	applied	one	thorough	stroke	using	the	Sponge	tool	with	the	Flow	option	set	to	%50	and	%100
respectively.	See	how	the	color	of	the	car	become	more	saturated	with	each	flow	value:-



Summary
The	Dodge	Tool	lighten	part	of	the	picture,	and	it	can	be	used	to	enhance	the	illumination	of

the	a	specific	object	or	whiten	it
The	Burn	Tool	does	exactly	the	opposite	of	the	Dodge	Tool.	It	darkens	or	“Burn”	the	part	of

the	picture	you	paint	on.	Which	can	be	used	for	both	enhancing	the	look	of	pictures,	or	to	create
certain	effects.
The	Exposure	setting	of	the	Burn	tool	&	the	Dodge	Tool	works	the	same	way	the	Flow

setting	of	the	Brush	Tool.	It	determines	how	each	stroke	affects	the	picture.	Having	more
exposure	means	that	you	can	achieve	more	by	going	fewer	clicks.	But	you	have	to	be	careful
about	doing	that.
The	range	option	of	the	Dodge	Tool	&	The	Burn	Tool	determines	which	are	the	values	that

get	affected	by	the	tool	the	most.	Shadows	make	the	tool	works	mostly	on	the	dark	areas	of	the
picture,	while	Highlights	makes	them	work	on	the	bright	ones.	And	Midtones	makes	them	work
on	the	area	in-between	the	most.
The	Sponge	Tool	increases	or	decreases	the	color	of	the	picture,	or	in	other	words,	it

saturates	or	desaturates	the	area	you	paint	on,	depending	on	the	tool	mode.
The	Flow	options	of	the	Sponge	Tool	works	the	same	way	as	the	Exposure	of	the	Sponge

Tool	or	Burn	Tool.	It	determines	how	much	effect	the	Sponge	Tool	has	on	the	picture.

Examples



Enhancing	the	eye	looks
Take	a	look	at	the	following	beautiful	eye:-

Using	the	Dodge	Tool,	you	can	whiten	the	eye	to	make	it	look	better,	but	make	sure	you	don’t	overdo
it:-

Then	you	could	burn	the	eye	lashes	a	little	bit,	to	make	the	mascara	on	the	eyes	look	better:-



Painting	lights	on	a	car
The	following	Mercedes	has	its	lights	off,	but	we	can	turn	them	on	using	the	Dodge	tool

First,	we	carefully	make	a	few	strokes	using	the	Dodge	tool;	the	lights	are	starting	to	come	into	life

Then	with	a	soft	white	brush,	I	dapped	around	the	lights	to	make	them	look	more	realistic:-

Burning	the	face	with	the	Burn	Tool
The	Burn	Tool	can	literally	burn	the	human	faces.	Just	like	how	I	did	to	the	face	of	the	girl	below,



overdoing	it	can	produce	some	ugly	results.	So	I	stopped	after	few	dabs	of	the	tool.

Saturating	a	part	of	the	picture
Using	the	Sponge	Tool,	you	could	saturate	all	but	a	certain	part	of	your	picture.	Which	is	a	good	way
to	create	an	effect	or	draw	the	viewer	attention	to	a	certain	object	in	the	picture,	just	like	I	did	with	the
following	house,	which	has	been	saturated	in	order	to	make	it	stand	out	more:-



Photoshop	Shape	Tools

This	chapter	is	relatively	easy	compared	to	the	previous	ones.	In	this	chapter,	we	are	going	to	discuss
the	Photoshop	Shape	tools,	which	are	more	straightforward	to	learn.	Think	of	this	chapter	as	a
breather	after	the	last	few	ones.
Despite	their	simplicity,	The	Shape	Tools’	importance	can’t	be	underestimated.	Especially	for	those
who	plan	to	use	Photoshop	for	graphics	design.

Photoshop	Shapes	Tools
There	are	5	Shape	Tools	in	Photoshop,	besides	the	Custom	Shape	Tool,	which	allows	you	to	choose
from	tons	of	shapes	to	add	to	your	designs,	these	tools	are:-

Rectangle	Tool	
Rounded	Rectangle	Tool	
Ellipse	Tool	
Polygon	Tool	
Line	Tool	
Custom	Shape	Tool	

I	will	talk	about	the	Custom	Shape	Tool	in	details	in	the	next	chapter.	For	now,	let’s	focus	on	covering
the	other	ones

The	Rectangle	Tool	



The	Rectangle	Tool	allows	you	to	draw	a	rectangle	(obviously),	to	do	that,	just	do	the	following:-

Select	the	Rectangle	Tool	 	from	the	Tools	Panel
For	more	options,	click	on	the	gear	button	for	the	available	options	for	creating	the

rectangle.

All	the	gears	options	are	explained	in	this	infographic:-

The	“From	Corner”	checkbox	will	be
explained	shortly.	If	you	are	not	familiar	with	Aspect	Ratio,	then	I	highly	recommend	that	you	read
the	Cropping	chapter	(Cropping	Images	in	Photoshop	using	the	Crop	Tool	And	Rectangle	Marquee
Tool,	and	An	Introduction	to	aspect	ratio)

After	you	specify	the	rectangle	options,	click	drag	the	mouse	to	draw	the	rectangle:-

If	you	want	the	rectangle	to	have	a	certain	dimensions,	you	can	adjust	its	Weight	&	Height
from	the	Rectangle	Tool	options,	this	will	only	work	if	you	drew	the	rectangle	as	a	Photoshop
Shape,	something	you	will	have	to	specify	before	you	draw	the	rectangle:-

You	can	specify	whatever	height	or	width	you	want.	Even	after	you	drew	the	rectangle

To	be	able	to	change	the	width	&	height	of	the	rectangle	after	you	draw	it.	The	shape	must	be	created	in	the	shape	mode.
All	the	Shape,	Path	&	Pixel	modes	will	be	explained	later	in	this	chapter



Here	is	the	rectangle	after	I	changed	its	height	to	100:-

Another	way	to	draw
rectangles	using	the	Rectangle	Tool

Select	the	Rectangle	Tool	 	from	the	tools	panel
Click	anywhere	in	the	canvas,	just	make	sure	you	don’t	drag	your	mouse	at	all,	and

Photoshop	will	display	the	Create	Rectangle	dialog:-

Enter	the	width	&	height	you	want	of	the	rectangle,	if	you	kept	the	“From	Center”	option
unchecked,	then	the	top	left	corner	of	the	new	rectangle	will	be	at	point	you	clicked	on
to	display	the	dialog.	If	you	checked	it.	Then	the	rectangle	will	be	created	so	that	point	will	be
the	center	of	the	new	rectangle.	If	what	I	just	said	felt	confusing	to	you,	then	I	highly	suggest
you	try	to	draw	the	rectangle	twice,	once	when	“From	Center”	is	checked,	and	again	when	it	is
unchecked.
Click	on	the	OK	button,	and	Photoshop	will	draw	the	new	rectangle	(or	square)	for	you



The	Rounded	Rectangle	Tool	
The	rounded	rectangle	shape	 	looks	much	cooler	than	the	boring	rectangle.	And	it	works	the	same
way	as	the	normal	rectangle,	except	that	you	get	to	specify	the	radius	of	the	corners,	or	in	other
words,	how	much	the	corners	are	rounded.
Just	like	the	rectangle	shape.	You	can	draw	the	Rounded	rectangle	in	two	ways.	Interactively	or	using
the	dialog

To	draw	a	rounded	rectangles	interactively,	follow	these	steps:-
Select	the	Rounded	Rectangle	Tool	 	from	the	Tools	Panel
In	the	Radius	option.	Enter	the	radius	of	the	corners	of	the	rectangle,	the	more	radius	the

rectangle	has,	the	more	rounded	the	rectangle	will	be.	See	the	picture	below	for	some	examples

Just	like	we	did	with	the	Rectangle
Tool.	Click	on	the	gear	to	specify	the	aspect	ratio	options,	the	options	for	the	Rounded
Rectangle	Tool	is	the	same	as	the	ones	we	discussed	when	we	talked	about	the	Rectangle	Tool.

Click	and	drag	on	the	canvas	to	draw	the	rounded	rectangle.	Once	you	are	satisfied	with	the
rectangle,	release	the	mouse	button.

Drawing	a	rounded
rectangle	using	the	dialog



Drawing	a	rounded	rectangle	using	the	dialog	also	works	the	same	as	drawing	it	using	the	Rectangle
Tool.	In	addition	to	being	able	to	specify	the	radius	of	the	corners	in	the	dialog.

Select	the	Rounded	Rectangle	Tool	 	from	the	Tools	Panel
Click	on	the	canvas	where	you	want	the	rectangle	to	be	drawn
Photoshop	Will	display	the	Create	Rounded	Rectangle	dialog

Enter	the	width	&	height	of	the	rectangle.	And	choose	if	you	want	the	rectangle	to	be	created
from	the	center
Then	enter	how	much	rounded	each	of	the	rectangle	corners	are.	The	nice	thing	about

creating	the	rounded	rectangle	from	the	dialog	is	that	you	could	specify	how	much	each	of	the
4	corners	is	rounded.	And	you	could	enter	a	different	value	for	each	of	them.	Using	that	I	was
able	to	create	a	bizarre	looking	rounded	rectangle,	whose	corners	are	all	rounded	differently

The	Ellipse	Tool	
The	Ellipse	Tool,	which	is	obviously	used	to	create	Ellipses.	Also	works	exactly	like	the	Rectangle
Tool.	In	that	it	allows	you	to	create	ellipses	by	specifying	its	width	&	height,	or	by	clicking	&
dragging	using	the	mouse	cursor
If	the	idea	of	ellipses	having	width	&	height	is	confusing	to	you,	here	is	how	these	dimensions	are
measured:-



To	create	an	ellipse
interactively,	follow	these	steps:-

Select	the	ellipse	tool	 	from	the	Tools	Panels
Just	like	we	did	with	the	Rectangle	Tool	and	the	Rounded	Rectangle	Tools.	Click	on	the	gear

to	show	the	aspect	ratio	options	of	the	rectangle.	The	only	different	in	the	settings	is	that	you	get
the	option	to	draw	a	“Circle”	option	instead	of	“Square”.

Click	and	drag	the	mouse	cursor.	And	Photoshop	will	draw	the	ellipse	for	you.
When	you	are	done,	release	the	mouse	button,	and	you	will	be	done

To	create	an	ellipse	using	the
dialog,	follow	these	steps:-

Select	the	Ellipse	Tool	 	from	the	Tools	Panel
Click	on	the	canvas	where	you	want	the	ellipse	to	be	drawn,	and	Photoshop	will	display	the

Create	Ellipse	dialog	box



Enter	the	width	&	height	you	want	for	the	ellipse.	And	choose	if	you	want	the	ellipse	to	be
created	from	the	center	or	not,	then	press	on	the	OK	button.
Photoshop	will	then	draw	the	ellipse	for	you,	I	drew	a	600	X	200	ellipse	right	here:-

Polygon	Tool	
Unlike	the	shapes	we	have	been	creating	until	now,	the	Polygon	Tool	offers	a	wider	variety	of
options.	Which	is	why	we	will	take	our	time	exploring	its	options.

To	draw	a	polygon	using	the	Polygon	Tool	interactively,
follow	these	steps:-

Select	the	Polygon	Tool	 	from	the	tools	panel
From	the	Polygon	Tool	options.	Type	the	number	of	the	sides	the	polygon	will	have.

For	the	rest	of	the	chapter,	I	will	stick	with	5	sides	polygons.	But	you	can	draw	a	triangle,
square,	pentagon,	and	polygons	with	any	number	of	sides	you	want.



Click	on	the	gear	button	to	specify
how	the	polygon	will	looks	like.

The	options	you	can	specify	are:-

Radius

The	radius	of	a	polygon	is	the	distance	between	the	center	point	and	one	of	its	head.	Specifying	the

radius	means	that	you	won’t	get	to	interactively	decide	on	the	size	of	the	polygon.	But	will	be	able	to

rotate	it	while	you	are	drawing	it.



Smooth	Corners

This	checkbox	allows	you	to	create	a	polygon	with	rounded	corners,	if	your	polygon	has	5	or	more
sides,	the	polygon	will	looks	a	little	bit	like	a	circle

Star



The	Star	check	box	creates	a	star	instead	of	a	polygon.	With	the	same	number	of	heads	as	the	number

of	sides	you	specified

Intent	Sides	By

This	option	determines	how	much	the	sides	of	the	polygon	(which	is	a	star	now)	are	indented

Smooth	Indents



Smooth	Indents	smooth	the	indented	corners.	Just	like	the	Smooth	Corners	option	smooths	the	heads

of	the	polygons

Note	that	stars	can	have	either	smooth	heads,	smooth	indentations,	or	both:-

After	you	adjust	the	option	to	match	what	you	want,	here	comes	the	easy	step,	click	and	drag
the	mouse	on	your	canvas.	And	notice	how	polygons	are	always	drawn	from	the	center.

To	Draw	a	polygon	using	the	dialog
Select	the	Polygon	Tool	from	the	tools	panel.
Click	anywhere	on	the	canvas,	and	Photoshop	will	display	the	Create	Polygon	dialog



A	good	thing	about	using	the	dialog	to	create	polygons	is	that	you	get	to	type	the	desired
Width	&	Height,	which	allows	you	to	create	all	sorts	of	squashed	polygons.	Like	these	in	the
picture:-

The	number	of	the	sides	of	the	polygon	allows	you	to	specify	the	number	of	sides	the
polygon	has.
The	Star	options	allows	you	to	create	a	star	instead	of	a	polygon
Indent	sides	is	available	only	when	you	check	the	Star	checkbox.	It	specify	how	much	the	star

heads	are	indented
Smooth	indents	will	create	curved	indents	instead	of	the	sharp	ones	that	are	typical	of	a	star

Candy	Tip:-	The	polygon	tool	can	be	used	to	draw	perspective	as	well,	The	way	to	do	that
is	explained	in	my	blog	post	Drawing	Perspective	in	Photoshop	&	Illustrator,	A	simple	how	to

The	line	Tool	
The	Line	tool	is	very	simple	at	heart,	it	allows	you	to	draw	lines	while	specifying	its	width	(or	weight
as	Photoshop	calls	it).	As	well	as	whether	each	of	the	line	ends	with	an	arrow,	and	how	the	arrows
look	like.

http://sweetmonia.com/Sweet-Drawing-Blog/drawing-perspective-in-photoshop-illustrator-a-simple-how-to/


Unlike	the	rest	of	the	Shape	tool,	you	can	only	draw	lines	interactively.	There	is	no	other	way	to	draw
a	line	using	the	Line	Tool	in	Photoshop.

To	draw	a	line	using	the	Line	Tool,	follow	these	steps:-
Select	the	Line	Tool	 	from	the	Tools	Panel
From	the	Line	Tool	options,	enter	the	weight	of	the	line	(or	how	thick	the	line	is):-

Now,	click	on	the	gear	button	on	the	Line	Tool	options	to	see	the	available	options	for	the
tool.	We	will	take	a	look	at	each	of	them	one	by	one.

Start	&	End

Checkboxes

The	Start	&	End	check	boxes	determines	whether	there	is	doing	to	be	an	arrow	at	the	start	or
the	end	of	the	line,	respectively,	you	have	arrows	on	either	sides,	neither	side,	or	only	one	side:-



Arrows	Width

The	Width	option	determines	how	wide	the	arrows	are	in	relation	with	the	line	weight.	If	you
set	this	value	to	%500,	it	means	that	the	arrowhead	will	be	5	times	the	width	of	your	line.	Here
is	how	a	line	with	a	20	px	weight	will	look	like	with	different	values	of	this	options,	notice	how
the	width	of	the	first	arrows	is	the	same	as	the	line	itself.

Arrows	Length



The	length	option	determines	how	long	the	arrowhead	is	compared	to	the	weight	of	the	line.
If	the	length	is	set	to	%100	and	the	line	Weight	is	20	pixels.	Then	the	length	of	each	of	the
arrowheads	will	be	20	pixels.	If	the	length	is	set	to	%500	and	the	line	weight	is	20	pixels,	then
the	length	of	each	of	the	arrow	heads	will	be	100	pixels,	and	so	on.

Arrows	Concavity
The	last	option,	the	concavity,	determines	how	much	concave	the	arrowheads	are	compared

to	the	weight	of	the	line.	If	the	line	weight	is	20	pixels.	And	the	Concavity	is	%20,	and	then	each
of	the	arrowheads	will	go	back	(or	be	concave)	by	4	pixels.	If	the	concavity	is	%50,	then	each
of	the	arrow	heads	will	go	back	by	10	pixels,	and	so	on



More	about	the
Photoshop	Shape	Tools
As	usual,	this	chapter	is	officially	done.	But	we	will	still	take	a	look	at	the	wider	range	of	options	of
the	shape	tools.	If	you	don’t	feel	like	going	through	that	right	now,	you	can	skip	to	the	examples
section	for	now~

Exploring	the	3	different	modes	of	shapes	tools:-	Shape,
Path	And	Pixels

In	the	option	bar,	you

could	specify	one	of	3	modes	for	the	shape	you	are	creating.	The	3	available	modes	are:-

The	Shape	Mode
Shapes	created	using	the	shape	mode	are	contained	in	a	special	kind	of	layers,	called	Shape	Layer.
The	main	advantage	of	shapes	layers	is	that	they	contain	vector	graphics	shapes.	Meaning	that	you	can
resize	the	shapes	in	the	layer	however	you	want	without	losing	any	of	the	quality	of	the	shape.
Because	the	shapes	are	redrawn	every	time	you	resize	them	using	mathematical	equations

The	Path	Mode
The	Path	mode	create	a	path	of	the	shape	you	are	drawing,	be	it	a	square,	rectangle	or	any	other
shape.	The	path	can	be	treated	just	like	any	path	you	create	in	Photoshop.	And	whenever	you	want,	you
can	change	the	shape	mode	into	a	pixel	mode,	turn	it	into	selection,	or	turn	it	into	a	mask	for	the
current	layer.

The	Pixel	Mode
The	easiest	to	understand	among	the	3	types,	the	pixel	shape	you	create	in	this	mode	is	added	to	the
current	layer	pixels.	And	it	is	treated	the	same	way	as	any	pixel	you	painted	using	the	brush	tool,	or
any	other	tool.
In	another	word,	there	is	no	difference	between	say,	rectangles	you	create	with	the	shape	tools	this



way,	or	the	one	you	create	by	making	a	rectangular	or	elliptical	selection	and	then	filling	it	with
pixels	using	the	brush	tool.
Let’s	talk	a	look	on	the	options	of	each	of	these	3	modes:-

The	Shape	Mode	Options
The	Shape	Mode	shapes	works	the	same	way	any	vector	graphics	program	works.	If	you	have	any
experience	working	on	a	vector	graphics,	then	these	options	will	look	familiar	to	you.	You	can	set
these	options	before	you	draw	your	shape,	or	after	you	draw	it	by	selecting	the	shape	layer	of	the
shape	then	changing	the	options	you	want.

Shape	Layer	in	the	Layers	panel

Fill	Color

Determines	the	fill	of	the	shape,

you	can	choose	any	color	you	like	from	the	colors	palette.	You	can	also	make	the	shape	so	that	it	has

no	fill	at	all



Stroke	Color

Allows	you	to	specify	the	color	of

the	shape	stroke	(or	border,	as	you	may	call	it).	The	options	here	are	exactly	the	same	as	the	ones

available	for	the	Fill	Color	option.	You	can	choose	a	certain	color	for	the	stroke,	make	the	shape	has

no	stroke	at	all,	make	the	shape	stroke	color	to	be	a	gradient	or	a	pattern.



Stroke	Width

This	option	determines	how	thick

the	shape	stroke	is.	Setting	this	to	0	means	that	the	shape	stroke	at	all

Shape	Stroke	Types

Shape	strokes	don’t	have	to

be	continuous	stream	of	pixel.	As	this	option	allows	you	to	choose	from	many	types	of	stroke	types,

from	dashes	to	strokes.	It	also	allows	you	to	create	your	own	stroke	types	as	well:-



Shape
Width

Determines	the	shape	width.

Shape	Height

Determines	the	shape	height.

Link	Shape	Width	&	Height

When	this	option	is	toggled	on.	Photoshop	will	link	the	Width	&	Height	so	that	the	shape	aspect	ratio

will	stay	the	same.	Meaning	that	when	you	type	a	new	value	for	the	width,	Photoshop	will

automatically	change	the	height	so	that	shape	will	preserve	the	same	aspect	ratio	it	has.

For	more	information	about	Aspect	Ratio,	refer	to	the	chapter	“Cropping	Images	in	Photoshop	using
the	Crop	Tool	And	Rectangle	Marquee	Tool,	and	An	Introduction	to	aspect	ratio”.



Converting	shape	layer	into	normal	layer
Shape	layers	are	nice	and	all,	but	sometimes	you	may	want	to	convert	them	to	pixel	layers	so	you
could	paint	directly	on	them,	or	to	apply	a	filter	that	doesn’t	support	vector	graphics.	To	do	that,
follow	these	steps:-

In	the	layers	panel,	select	the	shape	layer	you	want	to	convert	into	a	normal	layer.

Select	the	brush	tool	 	from	the	Tools	Panel
Now	click	anywhere	on	the	canvas,	and	Photoshop	will	ask	you	whether	you	want	to	convert

the	shape	layer	into	a	normal	layer	(Normal	layers	are	also	known	as	raster	layers	or	pixel
layers	as	well)

Click	on	the	OK	button,	and	Photoshop	will	turn	the	shape	layer	into	a	normal	one.



The	Path	Mode	Options

The	Path	Mode	options	are	much	simpler	than	the	ones	in	the	Shape	Mode.	There	are	only	3	options

you	have	to	be	aware	of,	which	they	are:-

Selection	(Or	Make	Selections)

	

This	option	will	turn	the	shape	path	into	a	selection,	which	you	could	manipulate	just	like	any	other

selection	in	Photoshop.	For	more	about	Photoshop	Selection	Tools,	Refer	back	to	the

chapter	“Photoshop	selection	tools	In-Depth”

Mask	(Or	Make	Mask)

This	option	adds	a	layer	mask	to	the	current	layer.	If	you	don’t	know	what	a	layer	Mask	Is,	I	suggest

you	check	out	the	Layers	Chapters.	But	in	short,	Layer	Mask	is	a	way	to	hide	or	conceal	some	of	the



pixels	in	a	given	layer,	but	without	actually	deleting	them.	This	means	that	by	modifying	the	mask,

you	can	determine	which	pixels	are	visible	in	a	given	layer	and	which	are	not.

Shape	(Or	Make	Shape)

This	option	will	turn	the	Path	Shape	into	a	Shape	layer,	which	is	the	same	as	the	shapes	created	with

the	shape	mode.	When	you	use	that	option,	Photoshop	will	add	a	new	layer	that	contains	the	newly

created	shape.

Summary
There	are	6	Photoshop	Shape	Tools.	The	Rectangle	Tool,	the	Rounded	Rectangle	tool,	the

Ellipse	Tool,	the	Polygon	tool,	the	Line	Tool,	and	the	Custom	Shape	Tool.
The	Rectangle	Tool	and	the	Rounded	Rectangle	Tools	both	do	the	same	things,	but	the

Rounded	Rectangle	can	draw	rectangles	with	rounded	corner
You	could	specify	the	aspect	ratio	options	for	almost	all	the	shapes	you	draw	by	clicking	on

the	gear	icon	before	you	draw	the	shape
The	ellipse	is	drawn	the	same	way	you	draw	rectangles,	the	width	&	height	of	the	ellipse	is

measured	by	the	length	its	axis
The	Polygon	Tool	offers	more	options	than	any	of	the	other	Photoshop	shape	tools,	it	allows

you	to	draw	a	star	instead	of	polygon,	which	you	could	also	customize	in	any	ways.
Using	the	star	option	of	the	Polygon	Tool	can	help	you	draw	in	perspective	in	Photoshop

easily
The	line	tool	draws	all	kind	of	thin	and	thick	lines.	You	could	also	specify	if	the	line	has

arrows	on	either	side	of	it
The	line	tool	arrows	can	be	customized	in	more	than	a	way	in	relation	with	the	weight	or

width	of	the	line

Examples
Creating	an	iPhone-like	Icon
The	Rounded	Rectangle	Shape	Tool	is	one	of	many	ways	you	could	use	to	create	an	iPhone-like	icon.
While	you	don’t	really	create	it	that	way	when	you	develop	applications	for	the	iPhone.	Icons
that	looks	like	that	can	make	websites	look	more	modern	and	cool:-



Drawing	in	Perspective	using	the	Polygon	Tool
This	example	is	out	of	the	scope	of	this	chapter.	But	it	is	worth	mentioning	for	those	who	plan	to
use	Photoshop	for	drawing.	The	Polygon	Tool,	along	with	the	Star	Option,	can	be	used	to	quickly
draw	a	vanishing	point	and	all	of	the	lines	that	come	out	of	it,	which	can	then	be	used	as	drawing
guidelines.	This	trick	can	be	used	to	draw	in	One,	two	or	three	points	perspective.	The	whole	trick
is	explained	in	full	details	in	my	blog	post	Drawing	Perspective	in	Photoshop	&	Illustrator,	A	simple
how	to~

Using	the	shapes	tools	to	create	simple	drawings.
Since	all	the	kinds	of	shapes	exist	everywhere	around	as.	They	can	be	used	to	draw	tons	of	things,	and
without	having	much	of	drawing	skills,	and	if	you	made	these	shapes	in	the	Shape	Mode,	you	will	be
able	to	resize	them	however	you	want,	without	affecting	their	quality.
If	you	are	really	interested	in	drawing	that	way,	then	I	highly	advice	you	to	learn	a	Vector	Graphics
program	like	Adobe	Illustrator,	which	was	designed	specifically	for	that.	And	it	contains	much	more
tools	for	that	than	Photoshop.

An	Envelope	using	lines

http://sweetmonia.com/Sweet-Drawing-Blog/drawing-perspective-in-photoshop-illustrator-a-simple-how-to/


A	mobile	using	ellipses	and	rounded
rectangles,	with	some	texts	here	and	there

A	coffee	cup	made	entirely	from	ellipses	and	half	ellipses

Photoshop	Custom	Shape	Tool



Custom	Shape	Tool	is	similar	to	the	other	shape	tools	we	have	seen	in	the	last	chapter,	except	that
instead	of	limiting	you	to	draw	basic	shapes	like	lines,	rectangles	or	circles.	The	Custom	Shape	Tool
allows	you	to	draw	from	a	wider	variety	of	shapes.	And	technically	speaking,	there	is	no	limit	to	what
shapes	you	can	draw	using	this	tool.
Here	are	some	of	the	shapes	you	could	draw	with	the	tool:-

And	here	are	all	the	shapes	that	are	available	to	you	out	of	the	box	(to	see	all	these	shapes,	you	have	to
tell	Photoshop	to	load	them	for	you	first,	I	will	explain	how	to	do	that	later	in	this	chapter):-

Besides	these	shapes,	you	can	download	more	shapes	from	the	Internet,	or	create	your	own,
the	possibilities	of	the	shapes	are	endless



Drawing	a	shape	using	the	Custom	Shape	Tool
Creating	custom	shapes	is	easy,	and	it	is	not	that	different	from	using	the	other	shape	tools.	To	draw	a
custom	shape	in	Photoshop,	follow	these	steps:-

Select	the	Custom	Shape	Tool	 	from	the	Tools	panel
From	the	Custom	Shape	Tool	options,	click	on	the	shape	option

Photoshop	will	display	all	the	shapes	that	are	loaded	for	you	to	choose	from.	The	shapes	you
will	see	depend	on	how	many	shapes	you	told	Photoshop	to	load,	and	how	many	you	have
downloaded	and	added	from	the	Internet
Select	the	shape	you	want	to	draw,	I	selected	the	heart	shape	in	this	example:-

Adjust	any	setting	you	want,	like	the	fill,	the	line	width,	shape	color	or	the	aspect	ratio.	All
these	options	work	the	same	way	I	explained	in	the	shapes	chapter.	If	you	find	the	term	Aspect-
Ratio	confusing,	refer	to	the	Resizing	Photos	chapter,	which	explains	the	concept	in	details.
Now	click	and	drag	the	mouse	cursor	over	the	canvas,	and	Photoshop	will	draw	the	shape	for

you:-

Since	Custom	shape	Tool	have	the	exact	options	as	the	regular	shape

tools	we	explained	in	the	previous	chapter,	I	will	avoid	explaining	them	again,	to	know	more	about



these	options,	refer	to	the	Shape	Tools	chapter	for	an	in-depth	explanation	about	them.

Loading	new	shape	groups	into	Photoshop
By	default,	the	Custom	shape	tool	doesn’t	show	you	all	the	shapes	you	have	seen	above.	If	you	just
installed	Photoshop,	you	will	only	see	the	following	shapes	in	the	Shapes	Panel:-

To	be	able	to	see	the	rest	of	the	shapes,	you	will	need	to	tell	Photoshop	to	load	them	first,	And	this	is
what	we	are	going	to	do	next.

To	load	a	new	shape	group,	follow	these	steps:-
Select	the	Custom	Shape	Tool	 	from	the	Tools	panel
From	the	Custom	Shape	Tool	options,	click	on	the	shape	option

From	the	upper-	right	corner	of	the	shape	panel,	click	on	the	small	gear	icon.

From	the	menu,	select	the	shapes	group	you	want	to	load.	Selecting	the	“All”	option	will	load
all	the	shapes	groups,	which	is	what	I	am	going	to	choose



Photoshop	will	ask	you	whether	you	want	to	replace	the	currently	loaded	shapes	with	the	one
you	selected.	Selecting	append	will	add	the	shapes	in	the	group	you	selected	to	the	shapes	panel,
while	keeping	all	the	shapes	that	are	already	there.	And	selecting	OK	will	cause	Photoshop	to
remove	all	the	loaded	shapes,	and	replace	them	with	the	ones	you	are	loading

Now	open	the	shapes	panel	again,	et	voilà,	all	the	shapes	are	here,	ready	for	you	to	use	them:-



Downloading	and	Loading	new	shapes	from	the	Internet
Besides	the	various	shapes	available	in	Photoshop	out	of	the	box.	You	can	download	any	number	of
shapes	from	the	Internet;	similar	to	how	you	can	download	brushes,	patterns	&	filters.
To	show	you	how	to	add	shapes	into	Photoshop,	we	are	going	to	download	and	add	the	“Animal
Costum	Shape	Package”	from	Brusheezy.	Which	contains	6	very	beautiful	and	well-made	animal
shapes,	free	for	you	to	use,	as	long	you	didn’t	use	them	in	a	Tattoo,	according	to	the	creator.

To	download	the	Animal	Costum	Shape	Package,	follow	these	steps:-

Go	to	the	“Animal	Costum	Shape	Package”	page	in
Brusheezy:-	http://www.brusheezy.com/shapes/32561-animal-costum-shape-pack-inspired-by-
nature

http://www.brusheezy.com/
http://www.brusheezy.com/
http://www.brusheezy.com/shapes/32561-animal-costum-shape-pack-inspired-by-nature


Click	on	the	download	button	to	download	the	shapes	file
Go	where	you	saved	the	compressed	file,	and	uncompress	the	zip	file.	For	detailed	steps	on

how	to	uncompress	zip	or	rar	files	for	all	the	major	operating	systems	(Windows,	Linux	&
Mac	OS	X),	check	out	this	link.
After	you	uncompress	the	file,	you	will	end	up	with	the	following	csh	file:-

All	that’s	left	if	to	tell	Photoshop	to	load	the	shapes	in	the	file	so	that	you	could	start	using	them.

To	load	the	CSH	file	that	contains	the	shape	into
Photoshop:-

Select	the	Custom	Shapes	Tool		 	from	the	Tools	Panel
From	the	Custom	Shape	Tool	options.	Click	on	the	shape	option

From	the	upper-	right	corner	of	the	shape	panel.	Click	on	the	small	gear	icon.

http://www.computerhope.com/issues/ch000506.htm


From	the	drop-down	menu,	select	the	load	shapes	option

The	open	dialog	appear	(whose	look	depends	on	your	operating	system),	locate	the	file	you
downloaded	and	then	double-click	on	it
And	Photoshop	will	load	the	new	shapes	for	you.

Now	you	can	use	the	new	shapes	just	like	any	of	the	other	ones:-



Create	New	Shape	From	Scratch
In	case	the	shape	you	want	is	not	available	on	the	web,	or	if	you	felt	like	being	creative	and	wanted	to
create	a	unique	shape.	Photoshop	allows	you	to	create	your	own	shapes.
Virtually	speaking,	anything	you	can	draw	with	the	pen	tool	can	be	turned	into	a	shape,	if	you	are	not
familiar	with	the	pen	tool,	then	I	highly	suggest	that	you	read	the	pen	tool	chapter	before	proceeding.
We	will	create	the	following	thunder	shape,	which	is	not	just	easy	to	draw,	but	still	represents
something	we	all	know:-

To	create	the	thunder	shape,	follow	these	steps:-
Select	the	Pen	Tool	 	from	the	tools	panel
From	the	Pen	Tool	options,	make	sure	you	select	the	shape	option	instead	of	the	path.	Doing

so	will	ensure	that	the	pen	tool	will	create	a	shape	instead	of	a	path,	which	is	exactly	what	we
want	to	do



Now	draw	the	thunder	shape,	to	make	it	easier	to	create	straight	lines	that	are	45	degree	from
each	other,	hold	down	the	Shift	key	while	you	are	clicking	with	the	pen	tool:-

After	you	are	done	drawing	the	shape.	Select	it	using	either	the	Direct	Selection	Tool	 	or
the	Path	Selection	Tool	 :-

Select	Edit	->	Define	Custom	Shape	from	the	main	menu



In	the	Shape	Name	Dialog,	enter	the	name	you	want	to	give	to	the	shape,	then	press	OK

And	the	new	shape	will	be	available	to	you	in	the	Shapes	panel



And	now	you	can	use	your	new	shape	however	you	want	now:-

Sites	where	you	can	download	Custom	Shapes	from
Brusheezy
Shapes4Free
InspirationFeed
Photoshop.cc
DeviantArt

Summary
Photoshop	Custom	Shape	Tool	allows	you	draw	a	variety	of	shapes,	unlike	the	regular	shape

tools
Custom	Shape	Tool	options	are	exactly	the	same	as	the	regular	shape	tools
Photoshop	comes	with	a	lot	of	shapes	out	of	the	box,	but	to	be	able	to	see	&	use	them.	You

http://www.brusheezy.com/shapes
http://www.shapes4free.com/
http://inspirationfeed.com/freebies/2500-free-custom-photoshop-shapes/
http://photoshop.cc/custom-shapes
http://www.deviantart.com/browse/all/resources/applications/customshape/?order=9


will	have	to	tell	it	to	load	them	for	you.
Besides	the	shapes	that	come	with	Photoshop,	you	can	download	many	shapes	from	the

Internet;	many	of	these	shapes	are	completely	free.
If	the	shape	you	want	doesn’t	exist,	or	you	couldn’t	find	it.	You	can	create	it	from	scratch.

Any	shape	you	can	draw	using	the	Pen	Tool	can	be	made	into	a	custom	shape

Examples
Creating	A	Simple	Greeting	card
Using	multiple	shapes,	especially	the	frame	shapes,	you	could	create	a	simple	greeting	card	or	a
signature,	and	the	better	you	arrange	the	shapes,	the	better	the	card	will	look:-

Embedding	shapes	into	text:-
One	of	the	common	uses	for	shapes	is	to	insert	them	inside	a	text,	which	can	make	a	good	example	of
logo	creation.	I	made	up	a	simple	logo	for	an	imaginary	Anti-Virus	called	“Protector	Anti-Virus”,	but
instead	of	having	an	O	in	Protector.	I	placed	two	shield	shapes,	one	inside	the	other.
To	make	the	logo	looks	the	best	way	possible.	I	played	a	little	bit	with	the	space	between	the
characters	in	the	Character	Panel	until	I	felt	like	it	was	perfect:-

	

Photoshop	Blending	Options



Layer	Style	or	Blending	Options,	like	they	are	also	called,	is	one	of	my	favorite	features	in
Photoshop.	And	I	rarely	ever	do	any	kind	of	design	without	playing	around	with	them
Blending	options	is	a	way	to	add	some	effects	to	the	contents	layers.	Many	of	the	options	in	the	dialog
are	straight	forward,	and	delving	into	them	can	provide	you	a	way	to	create	a	lot	of	nice	effects
To	access	the	Layers	Styles	dialog,	right-click	on	the	layer	you	want	to	apply	Layer	Styles	on,	and	the
choose	“Blending	Options”	from	the	contextual	menu

Here	are	all	the	Layer	Styles	available	in	Photoshop,	we	will	take	a	look	at	each	of	these	styles	one	by
one:-

Bevel	&	Emboss
Contour
Texture
Stroke
Inner	Shadow
Inner	Flow
Satin
Color	Overlay
Gradient	Overlay
Pattern	Overlay



Outer	Glow
Drop	Shadow

Each	one	of	these	Layer	Styles	has	many	options,	And	the	number	of	options	may	feel	a	little	bit
overwhelming	to	learn	at	first,	Except	that	many	of	these	options	are	similar,	too	the	degree	that	if
you	learned	one	of	them,	all	the	options	similar	to	that	one	will	be	easy.
I	am	aware	that	this	chapter	is	quite	repetitive,	but	I	thought	it	is	better	to	make	it	this	than	to	make	it
short	but	hard	to	understand,	so	feel	free	to	skip	the	parts	that	are	explained	over	and	over
If	you	are	using	an	older	version	if	Photoshop,	chances	that	the	options	in	the	layer	style	dialog	are
going	to	be	in	a	different	order,	but	you	can	still	follow	this	chapter	without	any	problem

Now	let’s	start	looking	at	each	section	in	the	Blending	Options	dialog:-

Style

This	is	where	you	get	to	choose	from	the	many	premade	Layer	Styles	that	ships	with	Photoshop,	plus
any	Layer	Styles	you	created	or	downloaded	from	the	web.
Even	if	you	have	Photoshop	just	installed,	you	are	going	to	have	a	quite	few	layer	styles	shown	in
there:-

And	it	is	fairly	fun	to	check	out	these	styles	to	see	how	each	of	them	looks	like:-



You	can	also	see	these	styles	from	the	Styles	panel,	if	you	don’t	have	the	Styles	panel	open,	you	can
show	it	by	selecting	Window->Styles	from	the	main	menu

Anything	that	can	be	done	from	the	Styles	part	of	the	Layer	Style	dialog	can	be	done	from	the	Styles
panel,	including	loading	new	styles	~



Default

Default	is	not	a	Layer	Style	on	its	own,	but	it	contains	many	options	that	affects	all	the	layer	styles	we
are	going	to	learn	in	this	chapter
Because	many	of	these	options	are	not	usually	used,	and	for	the	sake	of	keeping	this	book	simple,
many	of	these	options	won’t	be	covered	in	this	edition

The	first	option,	the	Blend	Mode,	change	the	layer ’s	Blend	Mode,	there	is	no	difference	between
changing	Blend	Mode	from	here,	or	by	doing	so	in	the	Layers	panel

The	opacity	changes	the	layer	opacity,	and	again,	it	works	exactly	the	same	as	the	Opacity	in	the



Layers	panel

Fill	Opacity	changes	the	layer	fill,	and	once	again,	this	is	the	same	as	the	fill	slider	in	the	Layers	panel

Bevel	&	Emboss
Bevel	And	Emboss	allows	you	to	add	a	3D	effect	to	the	content	of	your	layer,	even	without
understanding	any	of	the	options	of	this	layer	style,	you	can	make	some	very	nice	looking	shapes	&
characters:-

Let’s	take	a	look	at	each	of	the	Bevel	&	Emboss
options:-



Style
Style	menu	options	determines	from	where	the	bevel	comes	from:-

Outer	bevel	comes	from	“below”	the	shape,	and	Inner	Bevel	comes	from	“above”	it,	this	is	how	each
of	these	two	look	like:-

If	the	difference	between	the	two	bevels	are	not
clear,	then	zooming-into	the	two	characters	can	make	things	easier,	for	that	reason,	most	of	the	bevel
examples	are	going	to	be	zoomed	in:-



You	can	probably	see	now	why	I	said	that	Outer
bevel	gets	from	“below”	the	shape,	and	inner	bevel	get	from	“above”	it.
And	Emboss	applies	the	bevel	in	both	the	inside	and	outside	the	shape:-

Pillow	Emboss	is	the	same	as	emboss	in	that	it
applies	the	bevel	on	both	the	inside	and	the	outside.	Except	that	it	does	it	in	the	opposite	direction
(look	at	where	the	shades	are	to	see	what	I	mean):-

The	Stroke	Emboss	works	only	when	the	“Stroke”
Layer	Style	is	activated.	The	stroke	Layer	Style	adds	a	stroke/border	around	the	text.	And	when	you
apply	a	Stroke	Emboss	to	a	text	with	such	border.	Parts	if	the	stroke	becomes	a	bit	shiny,	which	gives
it	a	nice	3D	look:-

To	explain	the	rest	of	the	options,	I	will	stick	with	the	Inner	Bevel,	but	the	rest	of	the	options	work	the
same	way	across	all	the	types	of	bevel.

Technique
The	technique	menu	allows	you	to	choose	the	way	the	bevel	is	applied.



Smooth	allow	you	to	create	a	smooth	transition	of	the	bevel,	while	Chisel	Hard	creates	a	blunt
looking	effect

While	the	Chisel	Soft	is	the	same	as	the	Chisel
Hard,	except	that	it	adds	a	little	texture	to	the	bevel:-

Depth



The	Bevel	depth	determines	how	much	deep	the	Bevel	is,	it	doesn’t	really	make	the	Bevel	bigger	or
smaller.	It	just	change	the	contrast	of	the	bevel	colors	to	make	the	bevel	looks	deeper	or	shallower

Direction
Determines	whether	the	bevel	is	pointing	upward	or	downward

Depending	on	if	you	are	creating	a	signboard,	or	want	some	text	to	look	like	it	has	been	chiseled	on	a
wall,	this	option	can	help	you	achieve	what	you	want



Size

The	bevel	size	determines	how	big	or	small	the	bevel	is:-

Soften



The	Soften	option	smooth	the	bevel,	and	it	works	whether	the	bevel	technique	is	Smooth,	Chisel	Hard,
or	Chisel	Soft
Here	is	how	the	Soften	option	works	when	bevel	is	set	to	Chisel	Hard:-

Angle	&	Altitude
Angle	&	Altitude	determines	where	the	light	is	coming	from,	this	allows	you	to	create	many	kinds	of
bevels,	depending	on	how	far	or	close	the	light	source	is,	while	the	Angle	option	is	easy	to
understand,	as	it	allows	you	to	select	the	bevel	direction.	The	Altitude	option	is	better	understood	by
experimenting	with	it.
Here	is	how	the	tip	of	the	N	looks	like	with	a	various	values	of	Angle	&	Altitude:-



Use	Global	Light

The	“Use	Global	Light”	option	allows	you	to	create	multiple	shapes	with	the	same	angle	&	altitude
values,	for	all	the	shapes/layers	that	have	the	“Use	Global	Light”	checked,	the	Angle	&	Altitude	of	the
light	will	be	unified.	And	if	you	changed	the	Angle	or	Altitude	for	one	of	these	shapes,	it	will	change
for	all	the	other	shapes	as	well.
And	According	to	Adobe:-	This	setting	allows	you	to	set	one	“master”	lighting	angle	that	is	then
available	in	all	the	layer	effects	that	use	shading:	Drop	Shadow,	Inner	Shadow,	and	Bevel	and	Emboss.
In	any	of	these	effects,	if	Use	Global	Light	is	selected	and	you	set	a	lighting	angle,	that	angle	becomes
the	global	lighting	angle.	Any	other	effect	that	has	Use	Global	Light	selected	automatically	inherits
the	same	angle	setting.	If	Use	Global	Light	is	deselected,	the	lighting	angle	you	set	is	“local”	and
applies	only	to	that	effect.	You	can	also	set	the	global	lighting	angle	by	choosing	Layer	Style	>
Global	Light.



From	now	on,	be	ready	to	see	this	option	in	more	than	one	place	in	the	Layer	Styles	dialog

Gloss	Contour

The	Gloss	Contour	option	allows	you	to	define	the	edge	of	the	bevel.	Using	this	option,	you	could
make	your	shape	look	metallic	or	plastic	depending	on	the	curve	you	choose.
There	are	10	curve	that	are	available	for	you	to	use	by	default:-

You	could	also	create	your	own	curve	by	clicking	on	the	curve	icon	itself:-

Which	opens	the	Contour	Editor	dialog,	which	allows	you	to	edit
the	curve	however	you	want:-



Here	is	the	tip	of	the	N	after	I	applied	9	different	curves	to	it.	The	3	curves	in	the	last	row	were	created
using	the	Contour	Editor:-

Highlight	Mode



Highlight	Mode	allows	you	to	choose	the	blending	mode	of	the	highlights	the	effects	you	will	get
depend	on	both	the	shape	and	highlight	colors,	this	option	is	a	good	way	to	get	some	weird	or
glamorous	effects	on	your	shapes
The	9	examples	below	may	not	be	enough	to	illustrate	all	the	uses	of	this	option,	but	it	gives	you	an
idea	on	how	it	works:-

Highlight	Color
Besides	the	highlight	Blend	Mode,	you	can	also	choose	the	highlight	color	using	this	option,	which	is
White	by	default;



Here	are	a	few	tests	I	made	using	different	highlight	colors:-

Highlight	Opacity

The	opacity	option	allows	you	to	change	the	opacity	of	the	highlight,	to	the	point	that	you	could	hide
the	highlight	altogether:-



And	you	can
also	increase	the	default	opacity	from	%75	to	%100	as	well:-

Shadow	Mode
The	Shadow	Mode	changes	the	blending	mode	of	the	bevel	Shade.	It	works	the	same	way	as	the
Highlight	Blending	Mode,	in	that	you	could	get	very	difference	results	depending	on	the	colors	of	the
shape	&	the	shadow



Here	is	how	the	Shadow	Blending	mode	works,	some	of	the	modes	barely	make	difference	with	the
colors	we	have	and	some	of	the	modes,	like	dissolve,	can	only	be	seen	by	looking	so	closely	on	the
shadow:-

Shadow	Color
You	can	change	the	Shadow	Color	by	clicking	on	the	Shadow	Color	button:-



Because	the	default	Blending	Mode	for	the	shadows	is	Multiply,	some	colors	won’t	appear	clearly.	So
I	changed	the	blending	mode	to	normal	in	the	following	examples	to	make	the	colors	appear	more
obvious:-

Shadow	Opacity



You	can	also	change	the	opacity	of	the	shadow,	which	is	%75	by	default,	to	any	percent	you	want:-

Default	Settings	Options



The	last	two	options	“Make	Default”	&	“Restore	To	Default”,	allows	you	to	change	the	default
options	to	the	ones	you	currently	have.
By	clicking	the	“Make	Default”	button,	the	current	options	you	have	are	going	to	be	the	starting	point
the	next	time	you	apply	Bevel	&	Emboss.	This	is	useful	in	case	you	use	certain	values	all	the	time.	J
The	“Restore	To	Default”	resets	all	the	values	in	the	dialog	to	the	default/starting	values.
These	two	buttons	are	available	in	all	the	Layer	Style	section.	And	they	work	the	same	way	in	all	of
them.	Because	of	that,	I	will	refrain	from	explaining	them	in	the	upcoming	sections	to	avoid	making
this	chapter	more	repetitive	than	it	is	J

Contour

Contour	options,	as	its	name	suggests,	controls	the
contour	of	the	bevel.	Unlike	the	Gloss	Contour	option,	which	I	explained	just	now,	this	option	affects
the	edge	of	the	bevel	only,	instead	of	the	whole	shape.

Contour
The	contour	option	allows	you	to	choose	the	curve	of	the	contour.	This	is	one	of	my	favorite	Bevel
options

Here	are	a	couple	of	examples	of	using	the	contour	option	using	different	curves,	notice	how	the
option	affects	only	the	edge	of	the	bevel,	and	not	the	whole	shape:-

And	 just	like	we	did	with	the	Gloss
Contour	option,	you	can	click	on	the	curve	itself	and	create	your	own	curve	using	the	Contour	Editor.

Contour	Range



The	range	option,	which	has	a	confusing	name,	determines	the	percent	of	the	edge	of	the	bevel	will	be
affected	by	the	Contour	curve.
In	other	words,	if	you	set	the	Range	to	%100,	the	Contour	curve	will	be	applied	to	the	entire	bevel
edge.
If	you	set	it	to	%50	the	Contour	curve	will	be	applied	to	the	upper	%50	of	the	bevel	edge.	And	setting
the	range	to	%0	will	apply	it	only	the	very	upper	edge	of	the	bevel,	here	is	how	it	looks	like	for	the
default	contour:-

Texture

The	texture	options	apply	a	texture	on	the	beveled	shape,	using	any	of	the	patterns	you	have	in	your
Photoshop	installation.

Pattern

The	pattern	option	allows	you	to	choose	the	pattern	you	want	to	apply	to	the	shape	from	among	many
textures	to	apply	on	your	beveled	shape:-



Scale
Determines	how	big	or	scaled	the	pattern	is:-

Applying	the	same	pattern	with	different	scale	can	produce	different	results:-

Depth

The	depth	increases	the	contrast	of	the	pattern	colors	to	give	you
the	impression	that	the	“bumps”	of	the	pattern	are	deeper	or	shallower
And	it	does	a	very	good	job	at	that:-



Invert
And	the	invert	option	inverts	the	colors	of	the	texture

And	doing	this	can	lead	you	to	totally	different	patterns	than	what	we	have	seen:-

Link	With	Layer

The	“Link	With	Layer”	option	determines	whether	the	pattern	will	move	along	the	shape/layer	when
you	move	it.	If	you	unchecked	this	option,	the	pattern	is	going	to	change	every	time	you	move	the
contents	of	your	layer.	As	if	the	layer	is	acting	like	a	mask	for	the	underlying	pattern.	To	see	what	I
mean,	try	to	apply	a	texture	on	a	certain	layer	with	the	“Link	With	Layer”	unchecked,	and	then	move
the	layer	contents	using	the	Move	Tool	to	see	what	happen

Stroke



Despite	its	many	options,	the	Stroke	Layer	Style	is	one	of	the	simplest	sections	in	the	layer	style,	if
you	have	a	good	idea	on	how	to	use	Photoshop	Shape	Tool,	you	won’t	have	a	hard	time
understanding	most	of	the	options	here.
The	Stroke	Layer	Style	does	a	simple	thing,	it	applies	a	Stroke/Border	on	the	edge	of	your	shape:-

Size
Stroke	Size	option	allows	you	to	specify	the	size	of	the	stroke/border

The	bigger	the	Stroke	Size	you	specify,	the	bigger	the	stroke/border	will	be:-

Position
Stroke	Position	determines	whether	the	stroke	will	be	applied	outside	of	the	shape,	inside	of	it,	or	in-
between	(Center).



Depending	on	which	position	you	choose,	the	shape	size	can	change.	“Inside”	doesn’t	change	the	size
of	the	shape,	because	it	applies	the	stroke	inside	the	shape.	Center	increases	the	shape	size	by	half	the
stroke	size.	And	Outside	increases	the	shape	size	by	the	full	stroke	size.
Here	is	how	this	works	out:-

Let’s	take	a	closer	look	at	the	shapes	to	see	how	the
circle	have	different	sizes	with	each	option:-

Blend
Mode
Stroke	Blend	Mode	allows	you	to	choose	the	stroke	Blend	Mode,	which	is	Normal	by	default.	Here	is
how	the	Blending	Mode	looks	like	after	I	changed	the	stroke	color	to	Red	and	added	a	background	so
you	could	see	how	the	stroke	looks	like	with	each	Blending	Mode:-



Stroke	Opacity
Stroke	Opacity	changes	the	transparency	of	the	stroke,	similar	to	how	the	Layer	opacity	works

Stroke	Fill
The	stroke	Fill	Type	allows	you	to	determine	how	the	stroke	is	filled

The	default	option,	which	is	the	Color	fill,	allows	you	to



choose	a	solid	color	for	the	stroke,	like	this:-

Choosing	the	“Gradient”	option	fills	the	stroke	with	a	gradient	instead	of	a	solid	color,	once	you
choose	“Gradient”	from	the	Fill	Type	menu,	you	will	see	additional	options,	these	options	help	you
set	the	gradient	option	you	want	to	have

Gradient	Colors
The	Gradient	Colors	option	allows	you	to	choose	the	gradient	colors

There	are	many	gradients	available	with	Photoshop:-

And	clicking	on	the	gradient	itself,	instead	of	the	arrow	besides	of	it	opens	the	Gradient	Editor,	where
you	can	create	or	edit	gradients	to	suit	your	needs:-

Here	is	how	the	Gradient	Editor	looks	like:-



Reverse
Image9386.PNG

The	Reverse	checkbox	allows	you	to	reverse	the	direction	of	the	gradient.	For	example,	if	the
gradient	you	set	originally	comes	from	left	to	right,	it	will	come	from	right	to	left	after	checking
“Inverse”
Here	are	a	few	linear	gradients	that	are	applied	to	the	stroke	of	our	circle.	With	and	without	the
Reverse	checkbox	checked:-

Image9394.PNG

Gradient	Style
Image9401.PNG

Gradient	Style	allows	you	to	choose	the	type	of	the	gradient,	which	is	Linear	by	default.	Linear
gradient	is	the	type	of	gradient	where	the	colors	gradually	change	from	one	direction	to	another,	like,



from	left	to	right,	or	from	up	to	down	and	so	on.	We	will	take	a	detailed	look	at	each	of	these	types
Here	are	all	the	gradient	styles	we	have,	I	made	the	stroke	so	big	so	that	you	could	see	the	gradients
much	better:-
Image9411.PNG

Note:-	Don’t	worry	if	you	couldn’t	understand	all	the	gradient	types	right	away.	Many	of	these
types	will	be	re-explained	when	we	get	to	the	Gradient	Layer	Style

Gradient	Angle
Image9418.PNG

Gradient	Angle	allows	you	to	choose	the	direction	of	the	gradient,	which	is	from	left	to	right	by
default
In	a	way,	this	option	makes	the	Reverse	option	kind	of	useless	J
Here	are	the	black-to-white	gradient	on	the	circle,	with	different	directions	of	the	gradient	applied
using	Linear	gradient	style:-
Image9425.PNG

The	Angle	Option	doesn’t	have	much	effect	over
the	Radial	Gradient.



Here	is	how	it	looks	with	the	Angle	Gradient:-
Image9433.PNG

And	the	Reflected	Gradient:-
Image9442.PNG

And	Diamond:-
Image9451.PNG

The	Angle	option	has	no	effect	on	the	Shape	Burst
gradient	style

Scale
Image9462.PNG

The	last	option,	which	is	the	scale,	determines	how	much	fast	the	graduation	from	the	first	to	the
second	color	will	be.	In	other	words,	it	determines	how	much	“big”	the	graduation	is
To	better	understand	how	the	Scale	Option	works,	take	a	look	at	the	3	examples	below,	notice	how
when	the	scale	value	is	as	low	as	10,	the	gradient	happen	very	quickly,	but	when	the	scale	is	150,	the
scale	becomes	much	smoother:-



Image9475.PNG

Stroke	Pattern
Image9482.PNG

Stroke	Pattern	applies	a	pattern	on	the	stroke	instead	of	a	solid	color	or	a	gradient.	The	pattern
options	are	very	similar	to	the	bevel	pattern.

Image9491.PNG

Pattern
Image9498.PNG

The	Stroke	Pattern	option	allows	you	to	choose	the	pattern	you	want	to	apply
There	are	many	patterns	to	choose	from,	and	more	could	be	downloaded	from	the	Internet	by	the
way:-



Image9506.PNG

Scale
Image9513.PNG

The	Pattern	scale	determines	how	big	or	small	the	pattern	is,	here	is	how	the	same	pattern	looks	on
different	scales;	I	have	changed	the	size	of	the	stroke	in	each	of	the	circles	to	make	the	pattern	more
visible:-

Image9520.PNG

Link	With	Layer
Image9528.PNG

The	“Link	With	Layer”	option	determines	whether	the	pattern	you	applied	will	move	along	with	the
shape	in	case	you	moved	it	using	the	Move	Tool	or	any	other	moving	tool	or	not.	If	this	option	is
unchecked,	and	then	you	moved	the	contents	of	the	layer,	the	pattern	is	going	to	change	depending
where	you	place	your	shape.

Inner	Shadow
Inner	Shadow	applies	a	shadow	on	the	inside	of	the	shape,	as	appose	to	the	outside	of	it.	Which	is	what
the	“Drop	Shadow”	Layer	Style	does.



Image9536.PNG

Here	are	the	Inner	Shadow	Options;	You	can
probably	guess	what	many	of	these	options	do	by	now:-
Image9545.PNG

Blend	Mode
Image9556.PNG

Blend	Mode	determines	the	Blending	Mode	of	the	shadow;	the	final	result	you	will	get	depends	on
both	the	color	of	the	shadow	and	the	color	of	the	shape



Image9568.PNG

Nothing	much,	right?
You	are	going	to	get	much	better	results	if	the	shape	fill	is	a	pattern	or	the	color	of	the	shadow	is	not
black,	for	the	sake	of	visibility,	I	have	also	increased	the	size	of	the	inner	shadow:-
Image9575.PNG

Shadow	Color
Image9583.PNG

You	can	change	the	color	of	the	Shadow	by	clicking	on	the	color	icon,	to	make	the	colors	more
visible,	I	changed	the	Blend	Mode	of	the	shade	to	“Normal”:-

Image9590.PNG

Shadow	Opacity
The	opacity	option	determines	how	transparent	the	inner	shadow	is.



Image9598.PNG

You	probably	noticed	by	now	how	the	opacity	option	works	the	same	way	across	all	the	Layer	Styles
Image9605.PNG

Angle
Image9613.PNG

The	Angle	option	determines	where	the	direction	the	shadow	is	facing,	this	is	another	option	that
works	the	same	way	across	many	Layer	Styles

Image9621.PNG

Distance



Image9629.PNG

This	option	is	kind	of	confusing;	so	don’t	worry	if	you	couldn’t	understand	what	it	does	at	first
The	Distance	determines	how	much	the	shade	“travels”	inside	of	the	shape.	This	option	works	along
the	Angle	option,	which	we	will	get	to	shortly.
You	could	also	say	that	this	option	moves	the	exposed	area	(The	area	that	are	not	covered	by	the
shadow)	to	the	direction	specified	by	the	Angle	option

Image9638.PNG

Choke
Image9649.PNG

The	Choke	option	determines	how	gradual	or	smooth	the	edges	of	the	shadows	are.	The	amount	of
smoothness	you	could	get	from	this	option	also	depends	on	the	size	of	the	Shadow	(which	we	will
explained	next).
Here	are	what	different	Choke	values	do	when	the	size	of	the	Shadow	is	15,	bigger	sizes	for	the
shadow	can	easily	produce	smoother	graduation	for	low	Choke	values:-



Image9661.PNG

Size
Image9668.PNG

The	Size	determines	the	amount	the	shape	gets	covered	by	the	shadow.	This	option	works	along	with
the	Distance	option	to	determine	the	area	that	are	not	covered	with	Shadow.
The	Size	option	also	works	along	the	Choke	option	to	determine	how	much	space	the	Choke	option
has	for	smoothing	the	shadow
Image9676.PNG

As	I	said,	the	Size	&	Distance	options	work
together,	here	is	how	the	Distance	option	like	when	the	shadow	size	is	set	to	50:-
Image9683.PNG



Contour
Image9691.PNG

The	Inner	Shadow	Contour	allows	you	to	specify	the	look	of	the	shadow	using	different	curves.
Bear	in	mind	that	for	this	to	work,	the	Choke	option	should	have	a	value	that	is	less	than	100,	and
preferably	below	50
Image9698.PNG

Just	like	we	did	with	the	curves	before,	clicking	on
the	curve	itself	opens	the	Contour	Editor	dialog,	where	you	could	edit	or	create	your	own	curves

Noise
Image9707.PNG

The	noise	option	adds	some	noise	to	the	shadow,	so	you	will	get	a	noisy	shadow	once	you	set	the
value	of	this	option	above	0	J



Image9715.PNG

In	case	you	can’t	get	see	the	difference	between	the
noise	values,	here	are	a	close-up	look	on	how	they	strokes	look	like:-
48812.jpg

Inner
Glow
Inner	Glow	adds	a	glow	to	the	inner	edges	of	the	shape,	similar	to	how	the	Inner	Shadow	adds	a
shadow	to	it
Image9732.PNG

Various	options	are	available	to	help	you	adjust	the
glow	however	you	want,	and	I	bet	many	of	these	options	are	obvious	to	you	now,	like	Choke
Image9743.PNG



Blend	Mode
Image9755.PNG

The	first	option,	Blend	Mode,	determines	how	the	blend	mode	used	to	apply	the	glow	color	on	the
shape,	the	results	you	could	get	from	this	option	depends	on	both	the	glow	and	the	shape	colors
Here	are	some	examples	Inner	Glow	with	different	Blend	Modes:-

48827.jpg

Opacity
Image9770.PNG

Opacity	determines	how	the	glow	is	transparent;	setting	this	option
to	%0	means	that	there	won’t	be	glow	at	all



48835.jpg

Noise
Image9785.PNG

Noise	adds	noise	or	static	to	the	glow,	this	option	is	0	by	default
48844.jpg

Glow
Color



Image9800.PNG

For	settings	the	glow	color,	you	have	two	options,	you	can	either	chose	a	certain	color	for	the	glow,
or	to	apply	a	gradient
Choosing	a	color	allows	you	to	choose	a	color	using	the	color	picker,	this	is	the	simplest	way	for
settings	the	glow	color
Image9808.PNG

Gradient	Glow
Image9816.PNG

Gradient	allows	you	to	select	(or	create)	a	gradient	instead	of	a
single	color,	applying	a	gradient	instead	of	a	color	can	change	the	color	of	the	entire	shape.	But	it	can
lead	to	some	interesting	effects:-



48856.jpg

Technique
Image9839.PNG

Technique	specify	how	the	glow	is	created,	“Softer”	makes	the
glow	soft,	and	with	that	option,	the	glow	doesn’t	follows	the	contour	of	the	shape	precisely,	while
“Precise”	does	the	opposite,	it	follows	the	contour	of	the	shape,	even	if	that	mean	the	glow	will	be
hard

48863.jpg

Source



Image9860.PNG

The	Source	option	determines	where	the	glow	starts	from,	Edge	means	the	glow	will	start	from	the
edges	of	the	shape	and	continue	inward.	Center	means	the	glow	will	start	from	the	center	of	the	shape
and	continue	outward
This	option	will	be	easier	to	understand	once	I	explain	the	Size	option,	so	don’t	worry	if	you	didn’t
get	what	this	option	does	right	away:-

Image9868.PNG

	Choke
Image9875.PNG

Choke	specify	how	gradient	or	smooth	the	glow	will	be,	this	option	is	%0	by	default,	meaning	that	the
glow	will	be	as	much	smooth	as	possible.	Setting	Choke	to	%100	will	make	the	glow	very	sharp



48875.jpg

Size
Image9890.PNG

Size	determines	the	glow	size,	the	bigger	the	size,	the	more	parts	of	the	shape	will	be	covered	by	the
glow
48883.jpg

It	is	worth	to	demonstrate	how	different	sizes	look	when	the	glow	“Technique”	is	set	to	“Precise”
instead	of	“Softer”:-



48894.jpg

Let’s	visit	the
Source	option	again,	it	is	easier	to	see	what	this	option	does	when	we	play	with	it	along	the	glow
size:-
48902.jpg

Contour



Image9923.PNG

The	Contour	option	let’s	you	make	the	glow	follow	a	certain	curve,	just	like	we	have	seen	with	many
Layer	Styles
Here	are	various	glows,	with	the	Source	set	to	both	“Center”	&	“Edge”.	Note	that	for	this	option	to
work,	the	Choke	value	must	not	be	set	to	%100,	and	it	is	preferable	for	it	to	be	less	than	%50:-
48909.jpg

Just	like	we	saw	with	the	other
Layer	Styles,	clicking	on	the	curve	itself	opens	the	“Contour	Editor”,	where	you	can	edit	or	create
your	own	curves

Range



Image9946.PNG

The	Range	option	determines	how	fast	the	color	transitions	of	the	contour	will	be.	In	other	words,
low	value	of	Range	means	that	the	color	changes	of	the	Contour	will	be	abrupt,	high	value	of	range
makes	the	contour	very	smooth.
48917.jpg

Jitter



Image9961.PNG

The	Jitter	option	works	only	if	you	have	a	gradient	applied	to	the	glow	color	instead	of	a	single
color.	This	option	determines	how	much	noisy	the	color	transition	of	the	gradient.	Setting	this	option
to	a	low	value	means	that	there	won’t	be	much	noise
48927.jpg

Satin
The	Satin	Layer	Style	is	the	hardest	to	grasp,	despite	being	so	simple	in	reality,	this	Layer	Style
creates	a	duplicate	of	your	shape,	and	then	applies	it	on	the	inside	of	the	shape.	Which	is	useful	in
creating	a	various	effects,	like	Chrome	or	metallic	effects
Because	of	the	randomness	of	the	results	you	will	get	from	this	layer	style,	it	is	kind	of	hard	to
demonstrate	what	it	does	using	pictures,	but	I	will	try	nevertheless.	The	best	way	to	understand	what	it
does	is	by	playing	with	it.
All	the	following	shapes	have	the	Satin	Layer	Style	enabled,	but	with	different	settings	for	the
“Distance”	option.	You	will	notice	how	a	distorted	copies	of	the	shape	itself	is	used	to	create	the	Satin
effect.	And	in	case	of	the	Text	at	the	bottom,	a	distorted	copy	of	the	word	“Text”	is	placed	inside.



Image9976.PNG

You	are	probably	wondering	now,	“What	is	this	layer	style	used	for?”.	The	best	way	to	think	about	it
is	to	consider	the	Satin	Layer	Style	as	a	way	to	create	an	effect.	And	to	not	concern	yourself	trying	to
fully	understand	how	it	works.
Fortunately,	there	are	not	many	options	for	the	Satin	Layer	Style,	and	almost	all	of	these	are	self-
explanatory
Image9983.PNG

Color
Image9991.PNG

The	color	option	is	change	the	color	of	the	inner	shapes	that	Satin	create	inside	your	original	shape.
To	make	the	results	of	this	option	appears	more	visible,	I	changed	the	Blend	Mode	of	Satin	from	the
default	mode	(Multiply)	to	Normal



Image10000.PNG

Blend	Mode
Image10008.PNG

Blend	Mode	of	Satin	changes	the	Blend	Mode	of	the	inner	Satin	shapes,	like	with	every	Layer	Style,
the	final	result	you	are	getting	depends	mainly	on	the	colors	of	the	Satin	and	the	color	of	the	original
shape
Here	are	how	red	Satin	looks	like	under	different	blend	modes:-

Image10017.PNG

Opacity
Image10028.PNG

Opacity	determines	the	transparency	of	the	inner	satin	shape,	exactly	like	you	have	guessed	J



Image10040.PNG

Angle
Image10047.PNG

Satin	Angle	is	where	it	gets	confusing	a	little	bit,	to	simplify	the	idea,	think	of	it	as	a	way	to	rotate	the
internal	shape(s)	created	using	Satin

Image10056.PNG

Distance
Image10063.PNG

Distance	is	another	confusing	option,	it	kind	of	specify	how	the	shapes	created	by	Satin	are	merged
with	each	other.
For	example,	take	a	look	on	how	the	different	values	of	distance	do	to	the	rounded	rectangle	Satin:-



Image10071.PNG

Similar	effects	happen	when	you	experiment	with
the	circle	instead	of	the	rounded	rectangle:-

Image10078.PNG

Size
Image10085.PNG

The	size	blurs	the	borders	of	the	inner	Satin	shapes,	it	kind	of	reminds	me	of	the	Gaussian	Blur	filter,
which	we	will	get	to	when	we	start	working	with	Photoshop	filters.
This	is	the	last	confusing	Satin	option	we	are	going	to	see,	fortunately~



Image10093.PNG

Contour
Image10101.PNG

Contour	change	and	control	the	contour	of	the	Satin	shapes,	for	this	option	to	work,	the	Size
parameter	has	to	be	larger	than	0
Here	are	how	the	rounded	rectangle	looks	like	using	different	contours,	with	the	size	value	set	to	20:-
Image10110.PNG

Interestingly,	here	are	how	these	same	contours
look	like	when	the	size	parameter	is	set	to	100:-



Image10121.PNG

Invert
Image10133.PNG

Invert	changes	the	invert	the	shape	and	the	satin	colors,	the	shape	color	becomes	the	satin	color	and
vice	versa
Image10140.PNG

Color	Overlay
Color	Overlay	is	probably	the	easiest	and	the	simplest	Layer	Style.	It	applies	a	certain	color	over
your	shape,	it	produces	the	same	result	as	creating	an	identical	layer	above	your	shape,	then	changing
the	color	of	the	new	shape,	and	apply	a	certain	opacity	and	Blend	Mode	to	that	layer,	you	can	always
get	back	how	your	shape	used	to	look	like	by	hiding	that	layer.
Color	Overlay	foes	just	that,	except	that	Color	Overlay	is	an	easier	&	cleaner	way	to	do	that



Here	is	what	happened	to	the	red	square	below	after	I	applied	Color	Overlay	using	Pink	as	the	overlay
color,	and	Hard	Light	as	Blend	Mode:-
Image10148.PNG

There	are	3	options	for	Color	Overlay;	all	of	them
should	be	easy	for	you	right	now,	as	they	work	identically	to	many	of	the	similar	options	we	have
seen	so	far

Image10155.PNG

Color
Image10163.PNG

The	color	option	allows	you	to	choose	the	color	to	apply	the	overly	with,	unless	you	set	the	opacity
parameter	to	a	value	that	is	less	than	%100,	this	color	you	choose	will	be	the	dominant	color	for	the
shape	especially	when	the	Blend	Mode	is	Normal
Here	is	how	our	red	square	looks	like	using	different	colors,	because	the	Blend	Mode	is	set	to
“Normal”,	and	the	opacity	is	%100,	all	the	colors	I	chose	dominated	over	red:-

Image10170.PNG

Blend	Mode
Image10178.PNG

Blend	Mode	determines	the	blending	mode	of	the	color	you
chose,	this	is	where	your	color	choice	can	produce	a	different	result	than	merely	changing	the	shape
color
The	following	Squares	are	the	same	as	the	ones	we	saw	just	now,	except	that	the	Blend	Mode	was
changed	from	“Normal”	to	“Color”,	the	difference	between	these	examples	and	the	previous	ones	is
easy	to	spot



Image10186.PNG

Opacity
Image10194.PNG

Opacity	changes	the	opacity	of	the	Overlay	color,	lowering	this
value	will	make	the	original	shape	color	appears	through
Here	are	the	3	squares	after	changing	the	Blend	Mode	to	“Normal”,	and	decreasing	the	opacity	of	the
Overlay	color	a	bit	by	bit:-
Image10203.PNG

Is	the	Color	Overlay	Layer	Style	Useless?
In	case	you	are	thinking	of	that,	think	again,	while	you	may	not	use	the	Color	overlay	in	the	simple
way	we	have	been	using	just	now.	Color	overlay	really	shines	when	the	original	shape	is	more
complicated	than	a	solid	color,	like	a	pattern	of	a	picture,	like	the	textured	square	we	have	here:-



Image10214.PNG

Gradient	Overlay
Gradient	Overlay	is	exactly	the	same	as	Color	Overlay,	but	instead	of	overlaying	a	single	color	over
your	shape,	it	will	overlay	a	gradient	instead.
Image10226.PNG

Just	like	the	case	with	Color	Overlay,	applying
Gradient	Overlay	with	%100	opacity	and	using	Normal	Blend	Mode	will	completely	cover	the
original	shape	color(s).	If	this	is	the	result	you	are	looking	for,	then	this	is	fine.	But	much	more	can
be	achieved	by	playing	with	these	two	settings
Gradient	Overlay	options	are	almost	identical	to	the	ones	we	have	seen	when	I	covered	the	Stroke
Layer	Style,	which	is	why	we	are	going	to	go	through	some	of	these	more	quickly	than	we	have	done
so	far



Image10233.PNG

Blend	Mode
Image10241.PNG

Blend	Mode	determines	the	blend	mode	that’s	applied	on	the	original	shape	color(s)

Opacity
Image10248.PNG

Opacity	changes	the	opacity	of	the	whole	Gradient	Overlay,	this	is	a	nice	way	to	mix	the	gradient	with
the	colors	of	the	original	shape

Image10256.PNG

Gradient
Image10263.PNG

Gradient	allows	you	to	choose	the	colors	of	the	gradient,	which	are	black	to	white	by	default.	The
reverse	checkbox	change	that	to	from	White	to	black	in	this	case
Clicking	on	the	little	arrows	allows	you	to	choose	another	gradient,	and	clicking	on	the	gradient	itself
instead	of	the	little	arrows	will	open	Gradient	Editor,	where	you	can	create	your	own	gradients



Style
Image10279.PNG

Style	allows	you	to	choose	the	gradient	type,	which	is	Linear	by
default,	many	other	types	of	gradients	are	available	here,	and	it	is	worth	it	to	take	another	look	at
them	again

Image10287.PNG

Angle
Image10296.PNG

Angle	determines	the	angle	of	the	gradient,	for	all	the	examples	of	the	gradients	above,	the	Angle	was
º90
The	effects	of	the	pattern	Angle	depend	on	the	gradient	itself,	it	is	an	easy	option	to	perceive	once	you
know	how	the	whole	thing	works.	Note	that	this	option	has	no	effect	on	the	Radial	gradient	style



Image10307.PNG

Image10321.PNG

Image10328.PNG

Image10336.PNG

Scale
Image10343.PNG



The	Scale	option	works	the	same	way	as	the	Choke	&	Range	options	we	have	seen	before.	The	less
scale	value	you	have,	the	more	abrupt	or	quick	the	gradient	occurs,	and	the	more	Scale	value,	the
more	smooth	&	slow	the	gradient	will	be.
The	scale	option	has	no	effect	on	the	Angle	gradient
Let’s	take	a	look	on	how	the	scale	parameter	affects	the	various	gradient	styles:-
Image10351.PNG

Image10358.PNG

Image10366.PNG

Image10373.PNG

Now	we	have	taken	a	look	on	how	the	gradient	layer
style	works,	let’s	take	a	look	at	some	useful	ways	we	could	use	the	Gradient	Overlay,	which	is	much



more	powerful	than	the	simple	Color	Overlay
Image10381.PNG

Pattern	Overlay
Image10393.PNG

Pattern	Overlay	works	similarly	to	Color	Overlay
and	Gradient	Overlay	Layer	Style,	except	that	it	overlays	a	pattern	instead	of	a	single	color	or	a
gradient.
Here	are	the	Pattern	Overlay	options,	which	we	are	going	to	take	a	look	at	them	one	by	one:-

Image10405.PNG

Blend	Mode
Image10418.PNG



Blend	Mode	determines	how	the	Pattern	Overlay	will	be	applied	on	the	original	shape,	here	is	how	the
default	pattern	is	applied	on	a	red	square	using	different	Blend	Modes

Image10425.PNG

Opacity
Image10433.PNG

Opacity	determines	how	much	transparent	the	Gradient	Overlay	is.
Let’s	take	a	look	on	how	the	opacity	works	with	different	Blend	Modes:-



Image10440.PNG

Pattern
Image10449.PNG

You	can	choose	the	pattern	you	want	to	apply	from	the	Pattern	option,	there	are	few	patterns	that
comes	with	Photoshop	out	of	the	box,	but	you	can	download	as	much	patterns	you	want	from	the	web
J



Image10456.PNG

Scale
Image10464.PNG

Scale	changes	the	size	of	the	pattern;	you	can	have	a	very	big	or	a	very	small	pattern	using	this	option

Image10471.PNG

Link	With	Layer
“Link	With	Layer”	works	the	same	way	as	the	other	“Link	With	Layer”	checkboxes	we	have	seen	so
far.	If	you	unchecked	this	option,	then	you	moved	the	shapes	in	the	layer	you	have	the	Pattern	overlay
applied	on,	the	pattern	will	change	depending	on	the	new	location	of	the	shapes.
And	if	you	have	this	option	checked,	the	pattern	will	move	alongside	the	layer	contents,	and	will	stay
the	same	no	matter	where	you	place	the	layer	contents

Outer	Glow
Outer	glow	is	identical	to	Inner	Glow,	except	that	the	glow	is	created	on	the	outer	edges	of	the	shape,
rather	than	the	inner	edges:-
Image10480.PNG

There	are	a	lot	of	similarities	between	the	Inner
Glow	&	Outer	Glow	options,	so	if	the	Inner	Glow	options	were	clear	to	you,	then	the	case	will	be	the



same	with	Outer	Glow	options
Image10490.PNG

Blend	Mode
Image10501.PNG

The	first	Outer	Glow	option,	Blend	Modes,	specifies	the	Blend	Mode	that	will	be	applied	on	anything
that	comes	below	the	glow.	Sometimes	the	default	Blend	Mode,	Screen,	will	cause	the	glow	to	not
appear	in	case	you	have	your	shape	on	a	light	background.
So	if	you	only	want	to	have	a	glow	around	your	shape,	no	matter	what	is	behind	of	it,	setting	the
Blend	Mode	to	normal	is	the	best	things	to	do



Image10513.PNG

	Opacity
Image10520.PNG

Opacity	determines	how	transparent	the	glow	is,	I	apologize	if	you
felt	bored	hearing	this	over	and	over	from	me	J



Image10529.PNG

Noise
Image10536.PNG

Noise	adds	some	noise	to	the	glow:-

Outer	Glow	Color

Image10544.PNG

There	are	two	ways	to	specify	the	glow	color,	you	can	either	specify	a	single	color	for	the	glow,	or
choose	a	pattern.

Single	Glow	Color



Image10551.PNG

The	first	option,	which	is	to	specify	a	single	color,	allows	you	to	choose	one	color	for	the	glow,	as
opposed	to	the	pattern	option,	which	allows	you	include	more	colors

Image10560.PNG

Gradient
Image10567.PNG

The	second	option	allows	you	to	choose	a	gradient	instead	of	a	single	color,	which	is	kind	of	cool,
patterns	glows	tend	to	have	harder	edges	compared	their	single	color	equivalent.



Image10575.PNG

Technique
Image10585.PNG

Technique	drop-down	menu	works	the	same	way	as	the	one	we	have	seen	in	Inner	Glow,	it	determines
whether	the	glow	will	follow	the	edges	of	the	shape	(Precise),	or	be	smooth	but	doesn’t	follow	the
edges	quite	precisely
Image10596.PNG

Spread



Image10608.PNG

Spread	works	along	with	the	Size	option	to	produce	different	results,	and	in	general,	it	determines
how	smooth	or	hard	the	glow	is,	low	Spread	value	will	create	a	smooth	glow,	and	a	high	value	will
create	a	hard	one,	very	high	value	can	produce	an	oversized	&	ugly	glow,	how	low	or	high	the	spread
value	should	be	depends	on	the	size	value	of	the	glow

Image10615.PNG

Size
Image10623.PNG

Size	determines	the	glow	size,	depending	on	the	Glow	Spread	value,	you	will	get	different	results,
which	are	all	shown	in	the	infographic	below



Image10630.PNG

Contour
Image10638.PNG

Contour	allows	you	to	define	how	the	glow	looks	like,	instead	of	having	a	glow	that	starts	at	the	edge
of	the	shape	and	then	fades	out	near	the	edge,	contour	allows	you	to	control	where	&	how	the	glow
starts	or	ends.	The	contour	size	is	affected	by	the	glow	size	and	the	spread	values	as	well



Image10645.PNG

Range
Image10653.PNG

Range	determines	the	percent	of	the	glow	in	which	contour	transition	occurs,	the	lower	the	range	is,
and	the	tighter	the	contour	will	occurs.	Having	range	set	to	%100	gives	the	whole	glow	area	for	the
contour	transition;	And	in	that	case,	you	won’t	be	able	to	see	the	whole	contour,	as	part	of	it	will	be
hidden	behind	the	shape	itself,	as	you	can	see	in	the	second	picture	below~
Let’s	take	a	look	at	two	examples	to	see	how	this	option	works	with	Outer	Glow:-
Image10660.PNG



Image10668.PNG

Jitter
Image10678.PNG

Jitter	only	works	when	the	glow	colors	is	set	to	gradient,	as	you	most	likely	have	guessed,	it	creates	a
noisy	color	transition	instead	of	the	usual	smooth	one
Image10689.PNG

Drop	Shadow
Drop	Shadow	Layer	Style	creates	a	shadow	below	the	layer	contents,	which	makes	it	another	good
option	to	create	a	3D-like	shapes	&	effects.
Here	is	how	the	drop	shadow	works	on	a	little	square:-
Image10701.PNG

And	following	are	the	Drop	Shadow	options,
which	are	similar	to	the	Inner	Shadow’s:-



Image10708.PNG

Blending	Mode
Image10716.PNG

Blending	Mode	determines	the	blending	mode	of	the	shadow	you	are	going	to	create;	This	is	a	good
way	to	create	a	shadow	that	interacts	with	the	elements	that	are	below	it.

Color
Image10723.PNG

The	shadow	color	option	determines	the	color	of	the	dropped	shadow,	this	color	is	set	to	black	by
default.	But	you	can	change	it	to	any	color	you	want:-



Image10731.PNG

Opacity
Image10738.PNG

Opacity	determines	how	transparent	the	shadow	is:-

Image10746.PNG

Angle
Image10753.PNG

Determines	the	angle	of	the	shadow,	you	can	have	the	shade	cast	in	any	direction	you	want:-



Image10761.PNG

Use	Global	Light
Image10771.PNG

If	the	“Use	Global	Light”	option	is	checked,	then	the	shadow	in	that	layer	will	be	the	same	on	all	the
layers	that	has	this	option	checked,	and	the	direction	of	the	shadow	will	change	to	the	angle	of	last
layer	you	changed	its	angle	with	this	option	checked
In	other	words,	this	option	allows	you	to	unify	the	direction	of	the	shadow	across	multiple	layers.
Which	is	a	good	thing	in	case	you	are	using	the	layer	styles	to	create	scenes.

Distance
Image10782.PNG

The	distance	option	determines	the	distance	between	the	layer	shape	and	its	shadow:-



Image10794.PNG

Spread	&	Size
Image10801.PNG

The	spread	and	the	size	options	have	to	be	explained	together.	Because	they	are	so	related.	Let’s	start
with	the	size	option
The	Shadow	Size	determine	how	scattered	the	shadow	is,	the	more	size	the	shadow	has,	the	more
scattered	&	blurred	the	shadow	will	be:-
Image10809.PNG

To	make	the	resized	shadow	less	scattered,	you	can	increase	the	spread	of	the	shadow.	Here	are	the
same	shadows	we	just	saw,	but	with	the	spread	value	set	to	40	instead	of	0:-
Image10816.PNG

Setting	a	high	size	&	spread	values	allows	you	to	create	shadows	that	are	bigger	than	the	original
shape:-

Contour



Image10831.PNG

The	shadow	contour	is	similar	to	the	contour	option	in	the	other	Layer	Styles.	It	allows	you	to	create
shadows	that	follow	a	certain	curve,	the	high	points	in	the	curve	represent	black,	while	the	lowest
point	represent	white.
For	the	contour	option	to	work,	the	shadow	must	be	expanded	using	the	Size	&	Spread	options.
Here	are	some	ways	you	could	play	with	the	shadow	using	many	of	the	available	curves:-
Image10839.PNG

Image10846.PNG

If	you	did	not	like	any	of	the	available	curves,	you	could	draw	your	own	using	the	Contour	Editor

Noise
Image10878.PNG



The	noise	option	is	self-explanatory;	It	adds	noise	to	the	shadow	:)
Image10892.PNG

Layer	Knocks	Out	Drop	Shadow
Image10899.PNG

Now	comes	the	badly	named	“Layer	Knocks	Out	Drop	Shadow”,	this	option	determines	what	happen
when	you	reduce	the	transparency	of	the	layer	that	has	the	Drop	Shadow	applied	on.
To	make	things	clearer,	here	are	two	identical	layers,	with	two	identical	Layer	Style,	except	that	the
“Layer	Knocks	Out	Drop	Shadow”	is	checked	in	one	of	them,	and	unchecked	in	the	other.
Image10907.PNG

So	far,	there	is	no	difference	between	the	two,	but	after	changing	the	layer	fill	to	%10,	you	are	going
to	see	this:-
Image10914.PNG

As	you	saw,	when	the	option	was	unchecked,	you	were	able	to	see	the	rest	of	the	shadow	that	was



below	the	shape,	and	when	it	was	checked,	you	could	see	the	contents	of	the	layers	below	instead,
which	is	white	background	in	this	case.

Enabling	and	disabling	Layer	styles	from	the	Layers
Panel
One	of	the	nice	features	in	the	Layers	Panel	is	the	ability	to	turn	any	of	the	Layer	Styles	on	and	off,
and	it	works	the	exact	same	way	you	hide	and	show	layers:-
Image10922.PNG

Each	time	you	apply	a	layer	style	on	a	layer,	Photoshop	will	add	that	style	name	below	the	layer	you
applied	it	on	in	the	Layers	Panel,	and	clicking	on	the	eye	icon	besides	the	style	enables	and	disables	it.
Clicking	on	the	eye	icon	besides	the	“Effects”	text	on	the	very	top	disables	or	enables	all	the	Layer
Styles	applied	on	that	layer

Rasterizing	your	Layers	Styles
One	of	the	main	advantages	of	Layer	Styles	is	that	they	don’t	change	the	original	contents	of	your
layer,	this	means	you	can	disable	all	these	styles,	edit	or	change	them	however	you	want	without
affecting	the	original	contents	of	the	layer.
This	advantage	is	called	non-destructive	photo	editing,	which	is	a	very	important	concept	nowadays,
and	it	is	highly	recommended	that	you	edit	your	picture	using	such	technique	as	much	as	you	can.
But	sometimes	you	may	really	need	to	edit	the	pixels	of	the	styles	themselves,	using	any	of	Photoshop
tools,	like	the	Brush	Tool	or	filters,	and	to	be	able	to	edit	your	layer	styles	that	way,	you	will	need	to
rasterizing	them	first	(turn	them	into	pixels),	and	doing	so	is	pretty	simple,	here	is	how	to	do	that:-

Create	a	new	layer	from	the	layers	panel;	This	is	done	by	selecting	Layers	->	New	->	Layer
from	the	main	menu,	or	by	clicking	the	“New	Layer”	from	the	Layers	Panel



Image10929.PNG

Image10937.PNG

The	new	layer	will	be	created	and	it	will	appear	in	the	Layers	Panel:-
By	merging	the	new	layer	with	the	one	with	the	Layer	Styles,	all	the	styles	applied	to	the	original
layer	are	going	to	still	be	rasterized	and	ready	to	be	editing	like	anything	you	have	edited	so	far.

To	merge	the	two	layers,	do	the	following:-
Click	on	one	of	the	layers	in	the	Layers	Panel	to	select	it
Then	hold	the	Shift	button	and	select	the	other	layer,	the	layers	panel	will	look	like	that	after

you	make	the	second	selection:-

To	merge	the	two	layers,	select	Layer->Merge	Down	from	the	main	menu,	and	the	two	layers
will	be	merged

After	the	layer	style	is	rasterized,	you	will	be	able	to	edit	them	using	filters	or	any	other	Photoshop
tool,	here	is	how	I	blurred	the	whole	contents	of	a	rasterized	layer	style:-



Image10962.PNG

Saving	your	Layer	Styles
After	you	create	your	Layer	Style,	you	can	save	it	to	be	able	to	use	it	later,	this	is	done	from	the	Styles
Panel,	here	is	how	to	do	that:-

Make	sure	the	Layer	you	applied	the	Layer	Style	on	is	selected	in	the	Layers	Panel

Image10973.PNG

In	the	Styles	Menu,	click	on	the	arrow	on	the	top-right	of	the	panel:-

Image10985.PNG

Select	“New	Style”	from	the	menu:-



Image10992.PNG

The	“New	Style”	dialog	Appears
Type	the	name	of	the	new	style,	and	make	sure	the	“Include	Layer	Effects”	option	is	turned

on,	then	click	OK

Image11000.PNG

And	the	new	style	will	be	available	in	the	Styles	Panel	for	you	to	use	at	anytime~

Loading	more	Layer	Styles	into	Photoshop
The	Styles	Panel	gives	you	the	option	to	load	more	styles	groups	that	comes	with	Photoshop	with	a
few	clicks,	all	you	have	to	do	is	to	click	on	the	styles	group	name	you	want	to	load:-

Let’s	say	I	want	to	load	the	“Buttons”	styles	group,	so	I	select	that	option	from	the	menu
Photoshop	asks	you	whether	you	want	to	replace	the	currently	loaded	styles	with	the	ones	in



the	group	you	selected,	selecting	OK	will	do	just	that.	And	selecting	Append	will	simply	add	the
new	styles	into	the	Styles	Panel,	and	keep	the	ones	that	are	already	there,	this	is	what	I	chose:-

Image11015.PNG

Now	take	a	look	at	the	Styles	Panel	to	see	all	the	styles	in	the	“Buttons”	group	are	there:-

Image11022.PNG

Downloading	and	loading	new	Styles	from	the	Internet
As	I	said	earlier,	you	can	download	Layer	Styles	from	the	Internet,	and	then	load	them	into	Photoshop
to	use	in	your	own	designs.	There	are	millions	of	ways	to	create	Layer	Styles,	and	different	people
around	the	world	would	create	styles	you	wouldn’t	be	able	to	think	of	yourself.	Plus,	it	saves	a	lot	of
time	to	use	some	premade	designs.
There	are	many	sites	and	places	where	you	can	download	styles.	Brusheezy.com	is	one	of	them.
The	Style	we	are	going	to	download	and	load	is	called	the	“Style	Steel	Text”,	this	style	is	free	to	use
for	personal	&	commercial	use,	as	long	you	link	to	the	original	Layer	Style	and	credit	the	author.



Image11030.PNG

“Contributor’s	Des1Ussef/brusheezy.com.”

Note:-	It	is	a	good	idea	to	read	the	License	of	anything	you	download	from	the	Internet,
including	Photoshop	Brushes,	Patterns	&	layer,	so	that	you	won’t	get	into	legal	trouble,	no	matter
how	boring	this	may	seem.	For	one,	here	is	the	text	of	“Style	Steel	Text”	license:-
Image11037.PNG

To	download	and	load	“Style	Steel	Text”	into	Photoshop,	follow	these	instructions:-

Go	to	“Style	Steel	Text”	page	in	Brusheezy:-	http://www.brusheezy.com/styles/43653-style-
steel-text-by
Click	on	the	“Download”	button	to	download	the	Style:-

Image11045.PNG

After	the	file	finish	downloading,	unzip	the	file	to	be	able	to	see	its	contents,	for	a	great
instructions	on	how	to	do	that,	on	all	the	major	operating	systems,	visit	this	page:-
http://www.computerhope.com/issues/ch000506.htm

http://www.brusheezy.com/styles/43653-style-steel-text-by
http://www.computerhope.com/issues/ch000506.htm


Open	the	Style	Panel	menu,	and	choose	“Load	Styles”	from	the	menu:-

Locate	the	folder	where	you	extracted	the	zip	files	contents,	then	select	the	.asl	file,	which	is	called
“Steel	RGBY	By	Ussef	ps.asl”	in	this	case,	then	click	“Open”.
And	in	the	Styles	Panel,	you	will	find	4	new	Steel	styles	loaded	and	ready	for	you	to	use:-
Image11067.PNG

Summary
Layers	Styles	is	a	great	&	easy	way	to	create	a	effects,	and	there	is	not	painting	needed	to

create	them,	only	a	good	taste	and	some	experimenting
There	are	many	Layer	Styles	that	comes	with	Photoshop,	and	you	can	download	many	others

from	the	Internet
Many	of	the	options	in	the	Layer	Styles	are	the	same	that	some	of	them	can	be	accessed	from

the	Layers	panel,	like	the	fill,	opacity	and	blend	mode.
Bevel	allows	you	to	add	a	3D	effect	to	the	contents	of	your	shapes,	you	can	also	control	the

contour	&	add	some	texture	to	your	shape
Stroke	creates	a	border/stroke	around	your	shapes.	The	Stroke	can	have	a	single	color,

pattern,	or	a	gradient
Inner	Shadow	creates	a	shadow	inside	the	shape,	along	with	Bevel,	this	can	help	you	create	a

3D	effect	for	your	shapes.
Inner	Glow	is	similar	to	the	Inner	Shadow,	but	it	creates	a	glow	instead	of	a	shadow.
Satin	is	the	hardest	Layer	Style	to	grasp,	it	creates	duplicates	of	your	shape	and	applies	them

inside	your	shape,	it	also	distorts	these	shapes	and	creates	a	chrome-like	effect.	Experimenting
with	this	Layer	Style	is	the	best	way	to	understand	how	it	works



Color	Overlay	covers	your	shape	with	a	certain	color,	while	this	may	seem	useless,	it	gives
you	a	nice	way	to	change	the	color	of	your	shape	without	exiting	the	Layer	Style	dialog.	And
without	actually	changing	the	pixels	of	your	shape
Gradient	Overlay	works	the	same	way	as	Color	Overlay,	except	that	instead	of	covering	your

shape	with	a	layer,	it	covers	it	with	a	gradient	of	any	type	you	want
And	as	you	may	have	guessed,	Pattern	Overlay	covers	your	shape	with	a	pattern,	instead	of	a

color	or	a	gradient
Outer	Glow	creates	a	glow	outside	your	shape,	it	is	a	great	way	to	make	your	shape	glow,

and	you	can	use	it	to	draw	all	sorts	of	things,	from	a	light	bulb	to	a	laser	sword.
Drop	Shadow	creates	a	shadow	below	your	shape,	this	one	more	3D	effects	that	is	nice	to

have
You	can	turn	any	of	the	layer	styles	you	created	on	&	off	directly	from	the	Layers	Panel
It	takes	only	a	few	clicks	to	save	any	layer	style	you	created,	which	you	can	then	reuse	at	any

time	you	want
You	can	add	more	Layer	Styles	to	Photoshop,	by	either	telling	Photoshop	to	load	some	of	the

available	Layer	Styles	group,	or	by	downloading	them	from	the	Internet

Examples
Drawing	A	House
One	of	the	nice	things	about	the	layer	styles	is	the	ability	they	give	you	to	draw	things	from	scratch,
while	I	don’t	advice	you	to	fully	depend	on	them	for	that	if	you	are	into	digital	art.
The	Layer	Styles	that	has	been	used	the	most	are	Bevel	(along	with	texture),	Drop	Shadow	and
patterns,	tweaking	the	options	more	and	more	and	adding	more	shapes	can	make	the	following	house
look	even	better

Image11079.PNG

Creating	a	Logo
By	applying	Layer	Styles	on	text,	and	along	with	a	few	shape	tools,	you	can	create	some	simple	logo.



You	can	do	that	using	your	own	layer	styles,	or	a	layer	style	you	download	from	the	Internet.	The
same	techniques	used	for	creating	the	logo	can	be	used	to	create	signatures,	badges,	and	many	other
things
Image11086.PNG

Image11094.PNG

Image11101.PNG

Image11109.PNG

The	History	Brush	Tool,	and	the	History	Panel

The	history	brush	tool	 	reverts	part	of	the	image	you	want	to	what	it	used	to	be	in	a	previous	state.
To	understand	the	how	to	use	the	History	Brush	Tool,	you	need	to	understand	how	to	use	the	History
Panel	first,	so	let’s	start	with	that

The	History	Panel:-
The	History	Panel	shows	the	steps,	or	the	status	that	the	picture	went	through	to	reach	to	its	current
state.
To	access	the	History	Panel,	chose	Windows->History	from	the	Main	Menu:-



Suppose	you	have	created	a	new	picture,	here	is	how	it	will	look	like,	along	with	the	history	panel:-
48969.jpg

There	is	only	one	state	in	the	History	Panel,	which	says	“New”,	meaning	that	we	created	a	new
picture.
Let’s	pick	the	Brush	tool,	and	make	a	stroke	with	it,	here	is	how	the	canvas	and	the	History	panel
looks	like:-



48977.jpg

Now	we	have	a	new	state,	which	is	called	“Brush	Tool”,	meaning	that	we	used	the	Brush	tool	once,
let’s	make	another	stroke:-
48991.jpg

We	got	another	state	in	the	History	Pane,	which	is	called	“Brush	Tool”.
Suppose	we	want	to	go	back	to	a	previous	state,	to	do	that,	all	we	have	to	do	is	to	click	on	that	state,	to
try	that,	let’s	click	on	the	first	“Brush	Tool”	state:-



48984.jpg

Which	gets	us	back	to	how	the	picture	was	when	we	were	in	that	state:-
48998.jpg

Notice	that	the	second	“Brush	Tool”	is	grayed	out,	meaning	that	it	is	no	longer	affecting	the	picture,
you	can	still	look	at	it	to	go	back	to	that	state	by	clicking	on	it.	Bear	in	mind	that	this	state	and	all	the
other	grayed	out	state	will	be	deleted	once	you	edit	anything	on	the	picture	while	they	are	in	that	state
Now	we	are	familiar	with	the	History	Panel	let’s	get	back	to	the	History	Brush

Using	the	History	Brush	to	retrieve	part	of	a	previous
state
There	is	a	good	chance	you	know	what	the	History	Brush	does	from	the	title	above,	if	not,	you	will
do	by	the	end	of	this	section	J
Suppose	I	picked	the	following	candles	picture,	and	then	I	painted	some	red	with	the	Brush	tool	using
the	Soft	Light	Blending	Mode



Image11187.JPG

Now	suppose	I	don’t	want	the	candles	to	be	red,	we	can	simply	go	back	to	the	original	state	from	the
history	panel,	and	redo	the	painting:-
Image11195.PNG

But	wouldn’t	that	be	too	much	work?	Depending	on	what	you	are	working	on,	this	could	be	the	case.
Another	way	to	go	about	it	is	to	use	the	History	Brush	Tool,	which	allows	you	revert	the	area	you
paint	on	to	any	previous	state.
To	choose	the	state	you	want	the	History	Brush	to	revert	back	to,	click	on	the	small	square	besides	the
state	you	want	the	History	Brush	to	go	back	to:-
Image11203.PNG

After	you	select	the	state	you	want,	the	history	brush	icon	 	will	appear	besides	of	it,	meaning	that
when	you	paint	on	the	picture	using	the	History	Brush,	you	area	you	will	paint	on	will	revert	to	that
state,	the	icon	is	placed	besides	the	“Deselect”	state	right	here:-



Image11218.PNG

Now	let’s	paint	on	the	candles	using	the	History	Brush	Tool	 ,	notice	that	you	can	adjust	its	options,
like	the	Opacity	&	Flow,	or	the	softness	of	the	brush,	to	suit	your	needs.
Here	is	the	Candles	picture	after	I	reverted	the	candles	to	how	they	were	before	in	the	first	state:-
Image11233.PNG

We	are	going	to	examine	many	good	uses	of	the	History	Brush	tool	when	we	get	to	Photoshop	filters
and	Image	adjustment	tools~

Summary
History	brush	is	a	useful	tool	to	revert	parts	of	the	picture	to	any	state	in	the	History	Panel
History	Panel	allows	you	to	see	and	go	back	to	any	previous	state	in	your	picture,	it	is	a

convenient	way	to	“Undo”	anything	you	have	done	to	it
The	History	Panel	also	allows	you	to	choose	the	state	you	want	the	History	Brush	Tool	to	go

back	to	when	you	paint	using	the	tool

Photoshop	Filters



Image11242.JPG

Filters	are	one	of	the	easiest	tools	to	use	in	Photoshop,	and	many	of	the	filters	are	straightforward	if
you	know	what	they	do.	The	only	real	problem	with	them	is	that	some	of	the	parameter	has
ambiguous	names,	which	makes	those	a	bit	intimidating	to	learn.
Filters	are	also	a	great	way	to	create	effects,	and	they	can	be	used	in	an	innumerable	of	ways	and	for
all	sorts	of	things
Because	filters	are	all	about	experimenting,	I	won’t	be	covering	all	of	them,	but	we	will	take	a	good
look	at	some	of	the	most	important	ones,	plus	a	quick	look	at	some	other	ones	at	the	end	of	the
chapter,	I	will	make	sure	to	visit	this	chapter	and	add	more	contents	to	it	on	each	edition	of	this	book

Gaussian	Blur
The	Gaussian	blur	gives	you	a	very	good	way	to	blurs	your	image	as	much	as	you	want,	much	more
than	any	of	the	other	Blur	tools	and	filters.	Particularly	the	Blur	Tool
To	access	the	Gaussian	Blur	filter,	choose	Filter->Blur->Gaussian	Blur	from	the	main	menu
Image11254.PNG

The	Gaussian	Blur	dialog	appears:-
Image11266.PNG

There	is	only	one	option	in	the	dialog,	which	determines	the	amount	of	blur	you	are	going	to	apply	to
your	image.	And	you	can	have	as	much	blur	as	you	want.
Here	is	how	the	Gaussian	Blur	works:-



49055.jpg

Note:-	You	may	have	noticed	the	zoom	buttons	in	your	filter	settings,	these	buttons	allow	you	to
zoom	in	&	out	in	the	preview	window	on	the	top	of	the	filter,	which	is	helpful	to	see	what	a	certain
part	of	your	picture	will	look	like.	Though	you	can	use	filters	very	efficiently	without	even	knowing
about	this.	Also,	you	can	click	on	the	preview	window	and	drag	your	cursor	to	change	the	part	of	the
picture	that	is	shown	in	the	window

Motion	Blur
Motion	blur	adds	a	sense	of	motion	to	pictures	by	blurring	the	picture	in	a	certain	direction,	as	if
some	very	strong	wind	has	blurred	the	picture	in	that	direction.	Take	a	look	at	the	following	car
picture	to	see	how	the	Motion	Blur	filter	works:-
Image11288.JPG

Applying	the	blur	on	part	of	the	picture	can	creates	a	much	better	effect	than	if	it	was	applied	on	the
whole	picture	(which	could	be	done	using	the	History	Brush	 	):-



Image11304.JPG

To	access	the	Motion	Blur	filter,	simply	select	Filter->Blur->Motion	Blur	from	the	main	menu:-
Image11313.PNG

And	the	Motion	Blur	dialog	appears
Image11321.PNG

There	are	two	options	for	the	Motion	Blur,	Angle	and	Distance;	Angle	determines	the	angle	or	the
direction	of	the	motion,	you	can	type	the	angle	you	want,	or	use	your	mouse	cursor	to	change	it	from
the	little	circle	besides	it	to	adjust	the	angle.
Here	are	the	red	car	picture	after	I	applied	Motion	Blur	using	different	angles:-



49176.jpg

The	second	Motion	Blur	option,	which	is	the	distance,	determines	how	much	powerful	the	motion
blur	is	J
49124.jpg

Unsharp	Mask
Unsharp	Mask	is	a	very	popular	way	to	sharpen	images,	and	the	good	thing	about	sharpen	images
using	the	filter	is	that	you	can	tweak	the	amount	of	sharpening	until	you	are	satisfied,	it	will	also
ensure	that	you	won’t	overdo	it	when	you	sharpen	your	image
Let’s	see	the	Unsharp	Mask	filter	in	action	by	sharpening	the	following	suit	picture	at	the	right,	which
produced	the	picture	we	see	at	the	right,	notice	how	more	of	the	suit	details	become	available:-
Image11349.JPG

And	that’s	not	all,	the	Unsharp	Mask	can	sharpens	the	colors	of	the	suit,	as	opposed	to	the	details	of
the	suit	only:-
Image11364.JPG

And	you	can	also	sharpen	both	the	color	and	the	details,	which	produces	strong	results	to	some
degree:-



Image11372.PNG

If	you	learned	how	to	use	Unsharp	mask	to	sharpen	your	images	in	these	3	ways,	then	you	are	good	to
go,	so	let’s	see	how	to	do	that	J
To	access	the	Unsharp	Mask	filter,	select	Filter->Sharpen->Unsharp	Mask	from	the	main	menu:-
Image11380.PNG

The	Unsharp	Mask	dialog	appears:-
Image11387.PNG

There	are	3	parameters	in	the	dialog,	these	parameters	are	used	by	Photoshop	to	detect	the	edges	in
the	picture	to	do	the	sharpening,	while	it	is	useful	to	know	what	each	of	these	parameters	exactly	does,
learning	how	to	use	them	matters	much	more
The	first	option,	which	is	the	Amount,	determines	how	much	Photoshop	will	sharpen	your	picture,
using	this	option	while	keeping	the	Radius	parameter	at	a	low	value	produces	an	image	with	sharper
details



Image11395.PNG

The	second	option,	the	radius,	determines	how	much	you	want	to	sharpen	the	colors	of	your	picture,
but	this	will	only	work	as	long	you	kept	the	Amount	option	at	a	low	value:-
Image11402.PNG

And	of	course	by	increasing	the	Amount	&	Radius	parameters	high	together,	you	can	sharpen	both
the	details	and	the	color	together:-



Image11410.PNG

The	last	option,	Threshold,	can	be	easily	ignored	if	you	know	how	to	use	the	first	two	option,	it	kinds
of	alleviate	the	sharpening	effect,	which	can	be	useful	to	make	sure	you	won’t	overdo	it	when	you
apply	unsharp	mask	on	your	images.
To	see	how	this	option	works	in	action,	the	following	two	images	have	the	exact	same	settings,	but	the
second	one	has	the	Threshold	set	to	20,	which	alleviates	the	sharpening	applied	to	the	suit	quite	a	bit:-

Image11418.PNG

Add	Noise
Add	Noise	adds	noise	to	the	picture,	or	the	part	of	the	picture	you	selected.	This	is	useful	in	many



situations	&	designs;	like	in	case	you	want	to	make	a	certain	picture	look	dirty	or	old.
To	access	the	Add	Noise,	select	Filter->Noise->Add	Noise	from	the	Main	Menu
Image11426.PNG

After	that,	the	“Add	Noise”	dialog	appears
Image11437.PNG

The	first	option	in	the	“Add	Noise”	dialog	is	the	Amount	slider,	which	allows	you	to	determines	how
much	noise	Photoshop	is	going	to	add,	the	more	“Amount”	you	add	to	the	picture,	the	more	noisy	the
picture	becomes,	to	the	degree	that	you	will	not	be	able	to	see	the	picture	at	all
The	distribution	allows	you	to	choose	between	Uniform	&	Gaussian,	Uniforms	creates	a	totally
random	noise.	While	Gaussian	adds	more	pixels	that	are	of	the	midtones	of	the	colors	of	the	picture,
which	is	less	random	of	what	Uniform	does
Monochromatic	creates	a	white,	black	and	gray	particles/pixels	only,	instead	of	colored	particles



Image11449.JPG

Image11463.JPG

Median	Filter
The	Median	filter	does	a	very	nice	and	simple	thing,	it	reduces	the	noise	in	the	picture,	while	it	won’t
work	the	best	in	all	situations,	it	does	great	jobs	at	the	many	of	them.
One	of	the	best	uses	for	the	Median	filter	is	to	smoothen	the	skin	of	human	beings,	and	there	is	going
to	be	an	example	of	that	in	the	examples	section	at	the	end	of	the	chapter.
To	access	the	Median	filter	select	Filter->Noise->Median



Image11471.PNG

And	the	Median	filter	appears:-
Image11479.PNG

There	is	only	one	option	for	the	Median	filter,	which	is	the	radius,	which	determines	how	much
power	the	median	effect	is
Let’s	see	how	this	filter	works,	we	have	the	following	clock	picture,	which	is	all	clear	and	has	no
problem	at	all:-
Image11486.JPG

Now	let’s	add	some	dots	using	the	brush	tool,	to	see	how	good	the	median	filter	will	do	to	remove
them:-



Image11496.JPG

Now	let’s	apply	the	median	filter	on	the	clock,	to	see	how	it	works.	After	some	experimentation,	it
turns	out	that	setting	the	radius	at	18	does	the	best	job	for	removing	the	dots:-
Image11504.JPG

And	because	many	details	has	disappeared,	so	let’s	apply	the	median	filter	on	only	the	parts	of	the
picture	that	has	the	dots	on	it	(using	the	History	brush	 ),	and	this	is	what	we	get:-
Image11521.JPG

Pretty	neat,	huh.	Now	let’s	try	something	else,	and	add	%50	noise	to	the	clock:-



Image11531.JPG

And	let’s	apply	the	Median	filter	on	it	again,	using	20	Radius	(which	I	got	after	some	experimentation
again):-
Image11541.JPG

And	again,	to	avoid	losing	many	of	the	details	of	the	original	picture,	I	selectively	applied	the	Median
filter	using	the	History	brush	 	on	the	picture:-
Image11565.JPG

And	most	of	the	noise	has	been	eliminated,	while	we	lost	some	details,	the	picture	is	much	more
presentable	at	least.

Liquify	–	The	Best	Photoshop	Filter
The	Liquify	filter	turns	your	image	into	a	liquid,	so	that	you	could	manipulate	it	to	your	heart
contents
In	other	words:-	the	Liquify	Filter	allows	you	to	take	a	picture	like	this:-



Image11573.PNG

And	turn	it	into	something	like	this:-
Image11582.PNG

I	am	sure	you	have	seen	many	pictures	of	smiling	cats	and	other	things	on	the	Internet,	a	lot	of	these
have	been	made	using	the	Liquify	filter
I	am	going	to	cover	the	simple	mode	of	this	filter,	but	I	plan	to	cover	more	of	it	in	a	future	edition	of
this	book~
To	access	the	Liquify	Filter,	choose	Filter->Liquify	from	the	main	menu:-
Image11589.PNG

And	the	Liquify	Window	appears



Image11597.JPG

Let’s	take	a	closer	look	at	the	main	Liquify	tools:-
Image11605.PNG

Forward	Warp	Tool:-	Works	like	the	finger	tool,	and	has	a	similar	icon	to	it.	It	allows	you
to	drag	any	part	of	the	image	however	you	want,	and	it	is	the	most	important	tool	for	the
liquefy	filter.	Here	is	how	the	cat	picture	looks	like	after	I	pulled	his	ear	away,	I	overdid	it	a
little	bit,	but	it	is	for	the	sake	of	making	this	step	clear:-

49191.jpg

There	are	two	main	options	for	this	tool,	these	options	applies	to	almost	all	the	tools	in	the
Liquify	filter,	not	just	the	Forward	Warp	Tool:-

Image11621.PNG

Brush	Size	determines	the	size	of	the	Warp	Tool,	if	you	want	to	pull	a	huge	area,	like	when



I	pulled	the	ear	of	the	cat,	then	you	will	need	to	increase	the	brush	size
Brush	Pressure	determines	how	much	the	“liquified”	pixels	will	be	pulled	along	the	Warp

tool,	having	this	value	set	to	100	means	that	the	pixel	will	be	pulled	along	your	mouse	cursor
quite	easily	when	you	drag	them.	Having	it	set	to	a	low	value,	like	10,	will	make	it	super	hard
to	make	big	movements	on	the	pixels

Reconstruct	Tool:-	This	tool	works	like	a	history	brush	 	for	the	Liquify	filter.	It	reverts
the	parts	you	paint	with	the	tool	to	what	they	have	been	before	you	opened	the	Liquify	filter,	and
it	does	that	gradually,	meaning	that	when	you	paint	on	a	part	you	edited,	you	will	see	that	part
gets	back	to	where	it	was,	a	little	by	little.	And	if	you	kept	painting	it	will	return	to	how	it	was
before	you	opened	the	filter.	The	speed	the	of	the	revert	depends	on	the	value	of	the	“Brush
Pressure”	parameter

To	see	this	on	action,	let’s	take	a	look	at	the	Reconstruct	Tool,	say	I	am	still	playing	with	the	cat
picture,	and	I	kept	playing	with	it	until	I	got	the	following	picture	inside	the	Liquify	filter:-
Image11638.PNG

Assume	that	I	don’t	like	how	the	mouth	look	like,	and	I	decided	to	restore	how	that	part	looked	like
earlier	so	that	I	could	try	manipulating	it	again.	So	I	select	the	Reconstruct	Tool,	and	then	paint	a	little
on	the	mouth,	and	this	is	what	I	got:-

Image11649.PNG

As	you	can	see,	the	mouth	is	starting	to	get	back	to	where	it	was	before	I	opened	the	filter,	now	I	will



keep	painting	on	it	until	I	completely	get	it	back	to	its	original	location:-
Image11661.PNG

Now	I	introduced	the	Reconstruct	Tool,	it	is	time	to	explain	an	important	option	for	the	Liquify	filter,
which	is	the	“Restore	All”	button,	which	is	located	below	the	“Brush	Size”	&	the	“Brush	Pressure”
settings
Image11668.PNG

This	button	will	restore	the	photo	completely	to	how	it	was	before	you	opened	the	filter,	similar	to
what	you	can	get	by	applying	the	Reconstruct	Tool	over	the	entire	picture	J

Pucker	Tool:-	The	Pucker	tool	allows	you	to	pinch	any	part	of	the	picture	simply	by	clicking
on	it,	here	is	how	I	used	this	tool	to	make	the	cat	eye	smaller:-

49230.jpg

The	Brush	Pressure	option	doesn’t	apply	to	the	Pucker	Tool

Bloat	Tool:-	Similar	to	the	Pucker	tool,	except	that	it	makes	the	part	you	are	clicking	on
bigger,	just	like	I	did	with	the	poor	cat	eye	here:-



49238.jpg

And	again,	the	brush	pressure	option	doesn’t	apply	to	this	tool

Push	Left	Tool:-	This	is	such	a	weird	tool:-
It	moves	the	pixels	up	when	you	click	and	drag	the	mouse	to	the	right.
And	left	when	you	drag	it	up,
And	down	when	you	drag	it	to	the	left,
And	to	the	right	when	you	drag	it	down.

This	can	be	useful	in	case	you	want	to	resize	part	of	the	picture,	in	a	way	that	it	looks	like	it	has	been
sucked	into	or	out	of	a	certain	point,	you	can	do	that	by	clicking	and	rotating	the	cursor	around	that
part	you	want	to	resize,	clockwise	to	increase	its	size,	and	counterclockwise	to	decrease	its	size
Here	is	how	we	made	the	poor	cat	face	smaller	that	way:-
Image11691.PNG

And	here	is	how	if	got	bigger:-
Image11698.PNG

Hand	Tool:-	The	Hand	allows	you	to	change	the	part	that	is	shown	of	the	picture,	and	that’s
in	case	you	zoomed	in	and	can’t	see	the	whole	picture
Zoom	Tool:-	The	zoom	tools	works	the	same	way	the	zoom	tool	works	in	Photoshop,	it

allows	you	to	zoom	in	&	out	to	see	the	part	you	want	to	edit	more	clearly



A	quick	look	at	some	of	the	other	filters
There	are	many	other	good	filters	that	we	didn’t	take	a	look	at,	it	is	kind	of	hard	to	cover	all	the
filters	in	the	program	in	this	book,	but	it	won’t	hurt	to	take	a	quick	look	at	some	of	them

The	Emboss	Filter
Image11706.JPG

Find	Edges
Image11715.JPG

Wind
Image11724.JPG

Clouds
Image11734.JPG

Fibers



Image11746.JPG

Radial	Blur

Image11759.JPG

Summary
Filters	are	a	popular	way	to	modify	photos,	enhance	them,	and	add	effects	to	them.
Gaussian	Blur	is	a	very	good	way	to	add	a	powerful	blur	to	Photos,	and	much	more	than	the

Blur	Tool	allows	you	to
Motion	Blur	Filter	allows	you	to	add	blur	in	a	certain	direction,	which	adds	the	impression	of

motion	to	it
The	Unsharp	Mask	sharps	your	image,	its	colors,	or	both.	This	probably	is	not	the	most

accurate	way	to	describe	how	this	filter	works,	but	it	makes	it	very	easy	to	make	it	work	for	you
The	Add	Noise	filter	allows	you	to	add	noise	to	your	picture,	which	is	useful	way	to	create

multiple	of	designs
And	the	Median	filter	does	quite	the	opposite,	it	removes	particles	and	noise	from	pictures	to

a	good	extent
The	Liquify	Filter	is	so	much	fun,	it	liquifies	your	picture	and	allows	you	to	tweak	it	in	an

innumerable	of	ways.	Some	of	them	are	included	in	the	examples	section	below
There	are	many	other	filters	than	the	ones	I	introduced	here,	the	key	to	understand	filters	is	to

experiment	with	them,	though	some	of	the	filters	are	easier	to	understand	if	you	knew	what	they
were	made	for

Examples
Making	the	skin	smoother	using	the	Median	filter
As	I	promised	you	earlier	in	this	chapter,	here	is	an	example	of	how	to	use	the	median	filter	to
smooth	the	skin,	this	is	commonly	used	on	models	to	enhance	their	skins,	and	of	course,	I	selectively
applied	the	filter	on	the	girl’s	face,	because	I	don’t’	want	to	apply	the	Median	filter	on	some	of	the



other	parts	of	her	face,	like	the	nose

Image11767.JPG

Blurring	everything	around	your	subject	in	the	photo
The	Gaussian	blur	is	great	for	blurring	everything	around	your	subject,	so	that	the	subject	gets	all	the
focus	of	the	person	viewing	the	picture.	We	have	done	something	like	that	when	I	explained	the	Blur
Tool,	but	doing	it	using	the	Gaussian	Filter	is	much	better	&	effective:-

Image11776.JPG

Adding	motion	to	a	bullet
This	is	similar	to	the	car	example	we	saw	when	I	introduced	the	Motion	Blur,	but	it	is	applied	on	a
bullet	instead	of	a	car:-

And	we	can	place	the	bullet	in	some	picture	for	some	fun,	I	added	some	glow	to	the	bullet,	I	also
applied	the	Motion	Blur	filter	on	parts	of	the	room	to	give	impression	that	the	bullet	is	moving	so
fast:-
Image11792.JPG



Enhancing	the	quality	of	a	picture	by	sharpening	it
Take	a	look	at	the	following	picture:-
Image11800.JPG

It	looks	good	and	all,	but	it	can	still	be	enhanced	much	better	by	sharpening	it	using	the	Unsharp	Mask
filter:-
Image11809.JPG

If	you	zoomed	in	to	the	picture,	you	will	notice	that	many	details	in	it	has	became	clearer,	if	not,	then
let’s	sharp	it	once	more:-



Image11818.JPG

This	made	some	parts	of	the	picture,	like	the	laptop	keyboard,	look	much	better,	but	it	also	kind	of
destroyed	many	of	the	pictures	a	bit	too	much,	which	mean	we	should	stop	sharpening	the	picture,	and
maybe	take	the	second	one	as	the	final	one

Making	a	cat	more	fluffy	using	the	Liquify	filter
Just	like	I	was	able	to	play	all	sort	of	pranks	with	the	poor	cat	using	the	Liquify	Filter,	I	can	make	him
more	fluffy	that	way,	by	making	his	fur	rounder	and	his	eyes	bigger.	I	think	the	cat	is	very	beautiful
from	the	very	beginning,	but	making	it	even	more	beautiful	wouldn’t	hurt	much:-
49268.jpg

13	goes	31?
Take	a	look	at	the	following	girl	picture,	she	is	cute,	I	bet	she	is	going	to	be	a	fine	lady	when	she
grows	up:-



Image11836.JPG

A	good	way	to	find	out	how	she	is	going	to	look	like	when	she	is	like	20	or	30	is	to	use	the	Liquify
filter	to	make	her	look	a	bit	older,	here	what	I	got:-
Image11848.JPG

Image	Adjusting	Tools
Image11861.PNG

Image	adjusting	is	important	part	of	working	with	image,	especially	for	those	who	work	in
Photography,	or	have	that	as	a	hobby.
Image	adjusting	tools	allows	you	to	enhance	your	image	colors,	lighting,	or	even	change	them	so	that
they	have	no	colors	at	all,	and	a	few	other	things
Many	of	these	image	adjustment	dialogs	are	very	easy	to	use	as	long	you	know	the	terminology
behind	the	options	in	them,	which	is	why	most	of	this	chapter	will	focus	on	those	most	of	the	time



Image	adjusting	dialogs	can	be	accessed	by	selecting	Image->Adjustments	and	then	selecting	the
dialog	you	want	to	open.	Since	all	the	dialogs	can	be	accessed	from	the	same	menu,	I	won’t	be	telling
you	where	the	dialogs	are	located	like	I	did	in	the	rest	of	the	book
Image11868.PNG

Here	are	the	tools	we	are	going	to	cover	in	this	chapter:-

Bright/Contrast
Level
Color	Balance
Hue/Saturation
Invert
Desaturate

Bright/Contrast
As	you	could	guess	from	the	dialog	name,	Bright/Contrast	adjusts	the	Brightness	or	the	Contrast
values	of	your	pictures.
Bright/Contrast	dialog	is	probably	the	simplest	dialog	you	will	see	in	this	chapter,	it	only	has	two
sliders,	one	for	Brightness,	and	another	one	for	Contrast.
Image11876.PNG

Brightness	makes	your	picture	brighter	by	increasing	the	white	level	on	the	midtones	colors	of	the
picture.	Midtones	colors	are	the	colors	that	are	not	in	the	lighter	color	range	in	the	picture.	And
neither	are	the	shadows	or	the	darkest	areas	of	it.	Which	is	why	they	are	called	the	Midtones.
How	many	times	have	you	took	a	picture	with	your	digital	camera	and	it	ended	up	a	little	bit	dark,	just
because	there	hasn’t	been	enough	lighting	in	the	room,	brightness	is	one	of	the	tools	that	can	help	you



fix	this	problem.	Just	like	it	did	with	the	little	girl	picture	over	here:-
Image11883.JPG

When	Brightness	decreases,	it	decreases	the	light	in	the	room,	which	is	the	opposite	of	what	we
wanted	to	do	with	the	picture	above:-
Image11892.JPG

But	maybe	that’s	what	we	want,	as	I	used	the	History	brush	 	to	restore	some	of	the	darkened	picture
to	what	it	used	to	be,	which	created	a	nice	looking	effect:-
Image11908.JPG

Contrast	controls	how	much	difference	in	the	values	between	the	colors;	Pictures	with	low	Contrast
looks	dull,	while	pictures	with	high	contrast	can	look	too	strong	(specially	if	you	increased	the
brightness	along	with	it),	so	it	is	important	to	have	the	right	contrast	for	the	picture.
Here	is	how	low-contrast	pictures	can	look	like,	it	can’t	be	more	dull	than	that	in	my	opinion:-
Image11917.JPG

And	high-contrast	pictures	can	look	like	this:-
Image11926.JPG



It	is	usually	advisable	Brightness	&	Contrast	together	to	get	the	best	results:-
Image11936.JPG

The	“Use	Legacy”	checkbox	allows	the	Brightness/Contrast	to	affect	all	the	values	of	your	picture,
and	not	just	the	midtones,	this	is	how	this	dialog	used	to	be	before	Photoshop	CS3,	instead	of
affecting	the	midtones	colors	of	the	picture,	it	used	to	affect	all	the	colors	&	pixels	in	the	picture,
which	could	eliminate	some	important	values	in	your	picture.
Image11954.PNG

I	highly	advice	you	against	using	the	option,	no	matter	how	much	good	you	think	it	makes	your
picture.	Because	again,	that	will	make	you	lose	a	lot	of	values,	and	there	is	a	chance	you	will	end	up
with	a	bad	picture,	especially	if	you	plan	to	apply	filters	or	adjust	the	image	a	bit	more	after	that.
Here	is	our	little	girl	picture	after	I	applied	Brightness/Contrast	using	this	checkbox,	it	made	the
picture	brighter	indeed,	but	it	overdid	it,	as	there	are	not	much	dark	values	anymore,	and	some	bright
areas	became	too	strong:-

Image11969.JPG

Levels
Levels	adjust	the	white	level	of	the	picture,	think	of	it	as	an	advanced	way	to	adjust	the	brightness	of
the	picture.
If	you	understood	the	Brightness/Contrast,	you	will	have	an	easier	time	understanding	levels,	because
both	dialogs	almost	do	the	same	thing,	except	that	Levels	gives	you	more	control	over	the	contrast	&
the	tones	of	your	picture.
To	understand	how	Levels	work,	you	have	to	know	what	the	little	black	diagram	we	have	at	the
middle	of	the	dialog	is,	which	is	called	Histogram.	Understanding	won’t	just	help	you	understand	how
to	use	Levels,	but	also	how	to	use	many	of	the	other	Photoshop	tools	that	depend	on	it.



Image11977.PNG

The	Levels	Dialog,	along	with	the	Histogram	Dialog	at	the	middle	of	it

What	is	the	Histogram?
Histogram	is	a	chart	that	shows	you	the	distribution	of	the	values	inside	your	picture,	to	clarify	this,
take	a	look	at	the	following	7	X	7	picture:-
Image11985.PNG

This	picture	has	49	pixels,	with	3	color	values,	White,	Black	&	gray.	There	are	20	black	pixels,	19
white	&	10	gray,	so	a	simple	way	to	draw	the	diagram	for	this	picture	is	like	this:-



49278.jpg

Full	Histograms	usually	contains	the	values	from	0	(black)	to	255(white),	but	for	the	sake	of
simplicity	I	made	this	histogram	using	3	values	only,	if	the	7	X	7	picture	was	opened	in	Photoshop,	it
will	have	a	histogram	that	looks	a	bit	like	this:-
Image12000.PNG

As	you	can	see,	we	can	see	the	values	for	white	&	black	at	the	sides	of	the	Histogram,	and	the	gray
value	(which	is	71)	right	on	the	middle.	Of	course,	the	histogram	is	not	going	to	look	that	fancy	in
Photoshop,	but	I	guess	you	get	the	idea	on	how	it	works	J

Using	Levels	Dialog	to	adjust	your	images
So	the	Levels	dialog	adjusts	the	picture	contrast	by	manipulating	the	values	of	the	histogram,	you	can
use	Levels	in	some	good	extend	without	knowing	any	of	these	basics,	but	getting	to	know	them	will
help	you	use	it	much	more	efficiently
Take	a	lot	at	the	following	Squirrel	photo:-
Image12007.JPG



It	seems	a	little	bit	dark,	doesn’t	it,	now	let’s	open	the	levels	dialog	and	look	at	its	Histogram:-
Image12016.PNG

And	the	image	is	indeed	dark,	as	there	are	a	lot	of	pixels	with	dark	values,	this	is	not	exactly	a	bad
thing,	but	it	usually	is.	And	in	this	case,	we	want	the	values	to	be	more	evenly	distributed	to	some
degree
So	to	re-distribute	the	values	of	the	Histogram,	in	the	Levels	dialog,	drag	the	right	handle,	which	is
also	called	the	Highlights	handle,	to	the	left,	just	like	it	is	shown	here:-
Image12024.PNG

Here	is	how	I	dragged	the	Histogram:-
Image12032.PNG

Now	let’s	take	a	look	on	how	things	are	going	to	be	on	the	histogram:-
Image12041.PNG

The	part	framed	in	green	in	the	picture	above	is	going	to	stretch	and	become	the	new	Histogram,	and
the	part	framed	in	Red	is	going	to	be	eliminated.



Now	click	OK	in	the	Levels	dialog,	and	then	open	it	again,	here	is	how	it	looks	like:-
Image12052.PNG

Notice	how	the	part	of	the	Histogram	we	selected	has	been	stretched,	and	it	became	the	new
Histogram	now.	The	new	Histogram	looks	a	bit	choppy,	but	that’s	because	we	don’t	have	enough
values	to	fill	the	Histogram,	but	that’s	fine,	here	is	how	the	Squirrel	picture	looks	like	after	the
adjustment:-
Image12064.JPG

Which	looks	much	better,	or	has	a	better	exposure,	as	they	say	in	Photography~
Let’s	pick	another	picture:-
Image12072.PNG

This	is	such	a	good	picture,	except	that	the	light	doesn’t	seem	right.
Let’s	take	a	look	at	the	picture	Histogram:-



Image12080.PNG

That’s	such	an	irregular	histogram,	many	of	the	values	barely	has	any	pixels	assigned	to	them,	so
let’s	adjust	the	histogram	using	Levels,	this	is	how	I	adjusted	the	values:-
Image12087.PNG

If	you	have	the	“Preview”	checkbox	checked,	you	will	be	able	to	see	the	picture	change	in	real	time	as
you	move	the	handles.
Here	is	how	the	picture	looks	like	after	I	adjusted	it:-
Image12095.JPG

Doesn’t	it	look	much	better?
As	I	said,	you	don’t	have	to	understand	anything	about	histogram	to	use	Levels,	but	it	is	really	worth
it	in	the	long	term	to	learn	a	little	bit	about	it
Also,	you	don’t	need	to	open	the	Levels	dialog	every	time	you	want	to	see	the	picture	Histogram,	as
you	can	view	it	using	the	Histogram	panel,	which	can	be	accessed	by	choosing	Window->Histogram
from	the	main	menu:-



Image12103.PNG

Here	is	how	the	Histogram	panel	looks	like:-
Image12112.PNG

By	default,	the	Histogram	panel	shows	only	128	different	values,	as	opposed	the	full	256	values	we
have	seen	so	far,	this	is	because	the	panel	is	shown	in	the	compact	view	by	default,	to	switch	the
Expanded	view,	click	on	the	menu	button	on	the	corner	of	the	Histogram	panel,	and	then	choose
Compact	View	from	the	menu:-
Image12120.PNG

And	the	Expanded	Histogram	will	appear,	which	shows	more	information	and	values	than	before:-
Image12128.PNG

Color	Balance



Color	balance	allows	you	increase	or	decrease	the	value	of	a	certain	color	in	a	very	simple	way.
Say	that	you	have	the	following	Sunflower	iMac	picture:-
Image12137.JPG

It	seems	a	little	bit	yellowish,	something	that	we	want	to	change,	to	do	that,	all	we	have	to	do	is	to
decrease	the	Yellow	from	the	picture	to	some	extent,	which	produces	the	following	picture:-
Image12149.JPG

Which	looks	much	better.
Now	let’s	take	a	loot	at	this	car	picture:-
Image12162.PNG

The	picture	has	nothing	wrong	with	it,	but	suppose	we	want	to	add	some	blue	tone	to	it?	This	can	also
be	done	using	the	color	balance:-



Image12169.JPG

Now	we	know	what	the	color	balance	is	used	for,	let’s	take	a	look	at	the	dialog	where	we	can	do	all
that:-
49299.jpg

There	are	3	sliders	in	the	Color	Balance	dialog,	one	that	increase	or	decrease	Red,	another	that	do
that	to	Green,	and	the	third	to	do	it	to	Blue.	Dragging	the	slider	to	the	right	increase	the
corresponding	color	value,	and	dragging	it	to	the	right	will	decrease	the	color.
Of	course,	instead	of	pulling	the	sliders,	you	can	enter	the	exact	value	to	be	added/subtracted	to	each
of	the	3	basic	colors	fields:-



49306.jpg

And	of	course,	you	can	type	negative	numbers	in	the	fields	as	well
The	radio	buttons	at	the	bottom	of	the	dialog	determines	which	color	ranges	that	Photoshop	will	add
the	color	to.	It	can	be	the	shadows	(the	dark	areas	in	your	picture),	the	highlights	(the	areas	with	more
light	than	the	others	areas),	or	the	midtones	(the	area	with	values	in-between	Highlights	&	Shadows),
most	of	the	time,	you	will	want	to	balance	the	color	of	midtones,	but	it	is	very	useful	to	know	about
these.
49314.jpg

Hue/Saturation
The	Hue/Saturation	works	the	same	way	as	the	Color	Balance	dialog,	except	that	instead	of	adjusting
the	RGB	(Red,Green	&	Blue)	colors,	it	adds	to	the	HSL	values	instead.	HSL	is	one	of	many	ways	to
represent	color,	and	in	that	aspect,	Photoshop	is	giving	you	more	ways	to	adjust	your	colors,	which	is



a	good	thing.
If	you	are	reading	this	book	in	order,	then	you	already	know	what	each	of	the	HSL	color	system
components	is,	but	I	will	go	through	it	quickly	in	case	you	haven’t:-
H	in	HSL	stands	for	Hue,	or	the	color	itself,	red	is	considered	red	whether	is	light	or	dark,	and
whether	it	has	a	high	red	value	or	not.
The	S	stands	for	Saturation;	It	determines	how	much	of	the	color	there	is.	What	I	mean	is,	take
red	for	example,	red	can	be	faint	red	or	strong	one,	the	power	of	the	color	is	determined	by	the
saturation	value,	having	the	saturation	set	to	0	means	that	the	color	will	be	gray
The	L	in	HSL	stands	for	Lightness;	it	determines	how	dark	or	light	the	color	has.	Or	to	explain
it	in	another	way,	it	determines	how	much	white	there	is	to	the	color
All	the	HSL	3	values	work	together	to	help	you	adjust	your	images,	here	is	how	the	Hue/Saturation
dialog	looks	like:-
Image12200.PNG

The	way	the	dialog	has	sliders	makes	it	similar	to	the	Color	Balance	dialog,	using	it	is	easy	as	long
you	know	how	the	Hue,	Saturation	&	Lightness	values	do
To	play	with	the	Hue/Saturation	dialog,	let’s	take	the	following	flowers	photo,	which	has	flowers	of
multiple	colors:-
Image12208.JPG

As	I	said,	Hue	controls	the	color	itself,	so	by	increasing	or	decreasing	the	Hue	value,	all	the	flowers
colors	will	change	to	something	else:-



Image12216.PNG

Decreasing	the	Saturation	of	the	flowers	picture	takes	life	out	of	the	color	and	makes	the	colors	kind
of	depressing.	Unfortunately,	increasing	the	Saturation	in	this	picture	does	nothing	to	it,	because	the
flowers	in	the	picture	already	have	a	very	high	saturation
Image12224.PNG

Increasing	the	Saturation	in	another	picture	will	get	you	much	better	results:-
Image12233.PNG

The	last	option,	which	is	Lightness	allows	you	to	increase	the	white	component	in	the	picture,	to	some
extent,	it	controls	how	much	“Light”	there	is	in	the	picture:-



Image12247.JPG

Of	course,	when	you	adjust	the	HSL	values,	there	are	many	cases	where	you	will	need	to	adjust	2	or
more	values	at	the	same	time,	just	like	I	played	with	the	Saturation	&	Lightness	right	here:-

Image12260.PNG

Invert
Invert	is	a	simple	image	adjustment	option,	it	create	a	“Negative”	of	your	picture,	by	inverting	all	the
colors	in	it,	Invert	has	no	options:-
Image12267.PNG

Desaturate
Desaturate	turn	your	image	into	white	&	black,	it	simply	change	each	color	into	its	gray	equivalent,
there’s	no	options	to	set	here	at	all,	it	is	just	that	simple:-



Image12275.PNG

Disadvantages	of	editing	pictures	that	way,	and	what	to
do	about	this
All	these	adjustment	tools	are	nice	and	all,	but	they	have	one	serious	disadvantage.	After	you	edit	your
picture	using	these	tools,	the	original	image	will	be	gone,	and	unless	you	have	a	copy	of	it
somewhere	on	your	computer	or	on	the	Internet,	you	won’t	be	able	to	get	it	back.	This	is	what	is
called	“Destructive	Editing”.
The	solution	to	this	is	what	is	called	“Non	destructive	editing”,	which	preserves	the	original	picture,
but	still	allows	you	to	adjust	it	to	however	you	want	and	get	the	same	results.
Non-destructive	editing	works	by	creating	a	layer	that	does	affect	all	the	layers	below	of	it,	say	you
created	a	“Brightness	/	Contrast”	adjusting	layer,	all	the	layers	below	that	layer	will	be	affected	by	the
settings	of	that	layer.	That	means	you	can	move	any	layer	above	that	adjustment	layer	so	that	it	won’t
be	affected	by	it.	It	also	mean	that	at	any	time	you	don’t	want	that	layer	to	affect	your	picture,	you	can
easily	remove	it	or	hide	it.
Adjustment	layers	can	be	created	in	more	than	one	way,	my	favorite	way	to	create	them	is	from	the
Layers	Panel,	because	it	does	not	requires	me	to	open	any	additional	panel	to	take	some	real-estate	of
my	screen
To	create	an	adjustment	layer,	simply	click	the	 	button	in	the	Layers	Panel,	then	choose	the	kind	of
adjustment	layer	you	want	to	create:-
Image12290.PNG
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The	new	adjustment	layer	appears	in	your	Layers	Panel,	which	you	could	hide	or	delete	just	like	any
other	layer:-
Image12305.PNG

Somewhere	in	your	screen,	usually	in	the	upper-left	part	of	it,	the	Properties	panel	will	appear,	which
allows	you	to	adjust	the	correspondent	options	of	the	dialog	you	chose,	notice	how	the
Brightness/Contrast	settings	are	the	same	as	the	ones	we	saw	when	we	discussed	the	dialog:-
Image12312.PNG

If	you	don’t	see	the	Properties	panel,	you	can	choose	Window->Properties	from	the	main	menu:-



Image12320.PNG

Another	way	to	access	the	properties	panel	is	to	double-click	on	the	panel	of	the	adjustment	layer	in
the	layers	panel:-
Image12329.PNG

This	is	also	a	good	way	to	access	the	properties	panel	or	to	edit	the	parameters	of	a	certain	adjustment
layer
To	disable	the	adjustment	layer,	just	click	on	the	eye	icon	in	the	layers	panel	to	hide	it,	hiding	an
adjustment	layer	stops	it	from	affecting	the	layers	below	of	it
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And	because	adjustment	layers	affects	only	the	layers	that	are	below	it,	if	you	created	a	layer	and



placed	it	above	that	layer,	it	is	not	going	to	be	affected	by	the	adjustment	layer

Summary
Image	adjusting	tools	are	a	good	way	to	enhance	the	picture	colors	and	lighting,	plus	it

allows	you	create	some	good	effects	as	well
Brightness/Contrast	is	an	easy	way	to	enhance	the	brightness	or	the	contrast	in	your	pictures.

Or	if	you	want	to	manipulate	your	image	values	in	a	certain	way
Before	Photoshop	CS3,	the	Bright	/	Contrast	dialog	used	to	destroy	the	values	in	your

images,	you	can	still	make	the	dialog	work	that	way	using	the	“Use	Legacy”	checkbox,	but
that’s	totally	not	recommended.
Levels	dialog	allows	you	to	adjust	your	histogram	by	redistributing	parts	of	the	histogram	so

that	the	values	are	better	distributed	over	the	different	values	of	your	pictures
Histogram	is	small	charts	that	displays	all	the	number	of	pixels	that	has	a	certain	value,

sometimes	the	values	distribution	can	be	skewed	and	need	to	be	adjusting
The	Histogram	Panel	is	another	good	way	to	view	the	histogram	of	your	picture,	and	without

having	to	open	the	Levels	dialog
Color	Balance	allows	you	to	adjust	how	much	Red,	Green	or	Blue	are	there	in	the	picture,

either	to	fix	some	of	the	color	unbalance	in	it,	or	to	add	an	effect	to	it
Hue/Saturation	works	in	a	similar	way	to	Color	Balance,	but	it	adjust	the	HSL	values	of	Hue,

Saturation	&	Lightness.
Invert	creates	a	negative	of	the	picture,	similar	to	how	the	cameras	films	were	before	the

invention	of	digital	cameras
Desaturate	remove	all	the	colors	from	the	picture,	and	creates	a	black	&	white	picture	in	its

place,	this	is	useful	in	more	than	one	way,	you	can	use	it	to	examine	the	tones	of	the	picture,	or
to	create	old	looking	pictures

And	at	the	end
I	hope	you	enjoyed	this	book	and	benefited	from

it,	I	am	open	to	any	suggestions	on	how	to
enhance	it

If	you	liked	this	book,	please	tweet	about	it	and
tell	others	about	it,	as	that	will	help	me	expand	it

and	create	even	more	books	&	contents
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